
Macintos 
User'sGui e 
for desktop Macintosh computers 



Limited Warranty on Media and Replacement 
If you discover physical defects in the manuals distributed with an Apple product or in 
the media on which a software product is distributed, Apple will replace the media or 
manuals at no charge to you, provided you return the item to be replaced with proof of 
purchase to Apple or an authorized Apple dealer during the 90-day period after you pur­
chased the software. In addition, Apple will replace damaged software media and manu­
als for as long as 1he software product is included in Apple's Media Exchange Program. 
While not an upgrade or update method, this program offers additional protection for 
1wo years or more from the date of your original purchase. See your authorized Apple 
dealer for program coverage and details. In some coumries the replacement period may 
be different; check with your authorized Apple dealer. 

ALL IMPLIED WARRANTIES ON TIIE MEDIA AND MANUALS, INCLUDING IMPLIED 
WARRANTIES OF MERCHANTABILilY AND FITNESS FOR A PARTICULAR PURPOSE, 
ARE LIMITED IN DURATION TO NINElY (90) DAYS FROM THE DATE OF THE 
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT. 

Even though Apple ha-; tested the software and reviewed the documentation, APPLE 
MAKES NO WARRANlY OR REPRESENTATION, EITHER EXPRESSED OR IMPLIED, 
WITH RESPECT TO SOFTWARE, ITS QUAUlY, PERFORMANCE, MERCHANTABILilY, 
OR FITNESS FORA PARTICULAR PURPOSE. AS A RESULT, THIS SOFTWARE IS SOLD 
"AS IS," AND YOU, THE PURCHASER, ARE ASSUMING THE ENTIRE RISK AS TO ITS 
QUAI.IlY AND PERFORMANCE. 

IN NO EVENTWILLAPPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, INCIDEN­
TAi., OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE 
SOF1WARE OR ITS DOCUMENTATION, even if advised of the possibility of such dam­
ages. In panicular, Apple shall have no liability for any programs or data stored in or used 
with Apple products, including the costs of recovering such programs or data. 

THE \VARRANlY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU 
OF ALL OTHERS, ORAL OR WRITIEN, EXPRESSED OR IMPLIED. No Apple dealer, 
agent, or employee is authorized to make any modification, extension, or addition to this 
warranty. 

Some states do not allow the exclusion or limitation of implied warranties or liability for 
incidemal or consequential damages, so the above limitation or exclusion may not apply 
to you. This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state. 

Important 
This equipment has been tested and found to comply with the limits for a Class B digital 
device in accordance with the specifications in Part 15 of FCC rules. See insm1ctions if 
imerf erence to radio or television reception is suspected. 

DOC Class B Compliance This digital apparatus does nm exceed the Class B limits for 
radio noise emissions from digital apparaLus set out in the radio interference regulations 
of the Canadian Department of Communications. 

Observation des normes-Classe B Le present appareil numerique n'emet pas de 
bruits radioclcctriques depassant Jes limites applicables aux appareils numcriqucs de la 
Classe B prcscrites dans Jes reglements sur le brouillage radioclectrique edictes par le 
Ministere des Communications du Canada. 



Macintos 
User's Gui e 
for desktop Macintosh computers 

Part I 
Learning 

Part II 
Reference 

Part III 
Glossary 

PartN 
Index 



ti Apple Computer, Inc. 
This manual and the software described in it are copyrighted, with all rights reserved. 
Under the copyrighc laws, this manual or the software may not be copied, in whole or 
part, wichout written consent of Apple, except in the normal use of the software or to 
make a backup copy of the software. The same propriecary and copyright notices must 
be affixed to any permitted copies as were affixed to che original. This exception does 
nuc allow copies to be made for ochers, whether or nut sold, but all of che material pur­
chased (with all backup copies) may be sold, given, or loaned co anocher person. Under 
the law, copying includes cranslating into another language or format. 

You may use the software on any computer owned by you, but extra copies cannot be 
made for chis purpose. 

The Apple logo is a trademark of Apple Compucer, Inc., regisccrcd in che U.S. and other 
countries. Cse of the "keyboard" Apple logo (Option-Shift-K) for commercial purposes 
without the prior wri11en consent of Apple may constitute trademark infringement and 
unfair compecition in violation of federal and state laws. 

©Apple Computer, Inc., 1992 
20525 Mariani Avenue 
Cupeninn, CA 95014-6299 
( 408) 996-10 to 

Apple, the Apple logo, APDA, AppleLink, AppleShare, AppleTalk, NlJX, EtherTalk, 
HyperCard, HyperTalk, lmageWriter, LaserWricer, LocalTalk, Macintosh, and ProDOS 
are trademarks of Apple Compucer. Inc., registered in the U.S. and other countries. 

Apple Deskcop Bus, Balloon Help, Disk Firsc Aid, Finder, SupcrDrivc, and TrueType are 
trademarks of Apple Computer, Inc. 

Classic is a registered cradcmark licensed to Apple Compmer, Inc. 

AppleCarc is a service mark of Apple Computer, Inc., registered in chc U.S. and other 
countries. 

Adobe, Adobe lllustrawr, and PostScript are trademarks of Adobe S~'Scems 
Incorporaced, registered in che Uniced States. Adobe Phoroshop is a trademark of 
Adobe Systems Incorporated. 

Dolev PS is a trademark of Scitex Corporation Ltd. 

Exposure is a regisccred crademark of Preferred Publishers, Inc. 

Microsoft is a registered trademark of Microsoft Corporation. 

Nu Bus is a trademark of Texas lnscrnments. 

QMS is a registered trndemark and ColorScript is a trademark of QMS, Inc. 

QuarkXPress is a registered trademark of Quark, Inc. 

SupcrPaint is a registered trademark of Aldus Corporation. 

Simultaneously published in the United States and Canada. 

Mention of third-party products is for informational purposes only and constitutes nei­
ther an endorsement nor a recommendation. Apple assumes no responsibility with 
regard co chc performance or use of these products. 



Contents 

Radio and television interference xiii 

Preface How to Use This Book xv 

• Part I Learning Macintosh 1 

Chapter 1 Turning the Macintosh On and Off 3 
In this chapter 3 

Before you begin 3 

Turn your computer on 4 

When you 1Urn on your computer 5 

Turn your computer off 6 

What next? 6 

Chapter 2 Understanding the Desktop 7 
In this chapter 7 

Before you begin 7 

Use the mouse 8 

Point 8 

Click 9 

Press 9 

Drag 10 

How to hold the mouse 10 

\Vhen you move the mouse 11 

Choose a command 12 

When you talk to your Macintosh 12 

Open an icon 13 

Look at the contents of a window 14 

Make a window the active window 14 

Make a window bigger or smaller 16 

Move the hidden contents of a window into view 17 

What's on the desktop? 18 

Icons represent containers 18 

Windows let you view the contents of containers 19 

Menus offer you choices 19 

iii 



When to use the keyboard 22 

Modifier keys 22 

Arrow keys 22 

Function keys 22 

Close a window 23 

~'love a window 23 

Whal next? 25 

Chapter 3 Setting Up Your Programs 27 
In this chapter 27 

Before you begin 2 

Insc:n a floppy disk 28 

Why a floppy disk isn't floppy 29 

Initialize a disk 30 

Copy the con rems of a disk 31 

Floppy disks, hard disks, and startup disks 32 

·1 ~1ke a floppy disk our of ics drive 34 

Safeguard the comems of a disk 35 

'faking care of floppy disks 36 

Use the 'frash 36 

On your own: lnsiall your programs 38 

Throw away extra System Folders 39 

What next? 39 

iv Contents 

Chapter 4 Creating a Document and 
Saving Your Work 41 
In this chapter 41 

Before you begin 41 

Open a program 42 

Create a document 43 

Save your work 43 

Save it or say so long 44 

Switch progrnms ~5 

'l\vo types of programs 46 

And then there's the: Finder -46 

Close a documem ~7 

What next? 47 

Chapter 5 Changing a Document and 
Printing Your Work 49 
In this chapter 49 

Before you begin 49 

Open a documenr 50 

Change a document 50 

Save vour work so far 53 

Taking a shortcut 53 

Make more changes to a document 54 



Choose a printer 57 

If your printer is not on a network 57 

If your primer is on a network 58 

Print a document 59 

Quit a program 60 

Make a backup copy 61 

What next? 62 

Chapter 6 Organizing Your Work 63 
In this chapter 63 

Before you begin 63 

Make a copr of a document 64 

Change rhe name of an icon 66 

Save another version of a document 68 

Save? - or Save A-;? 69 

Open a document while its program is the active program 70 

Organize icons in a folder 70 

Use an alias 72 

\Xfhar's an alias? 73 

Creare stationery 75 

On your own: Fill out some stationery 77 

What next? 77 

Chapter 7 Learning More About Your 
Macintosh 79 
In this chapter 79 

Before you begin 79 

Use Balloon Help 80 

Use the Maci11tosb Reference 81 

What's in ,Haci11tosb l?efere11ce 82 

What next? 83 

• Part II Macintosh Reference 85 

Chapter 8 Setting Up Your Macintosh System 87 
Setting up your computer hardware 87 

Health concerns associated with computer use 88 

Musculoskeletal discomfort 88 

Arranging your office 89 

Avoiding farigue 90 

\Xfhat about electromagnetic emissions? 90 

Adjusting your keyboard 91 

Comems v 



Sening up your system software 92 

Insralling, reinstalling, or updating system software 92 

Before you begin 92 

Installing a standard S)1Stem 93 

Installing a customized system 94 

Srnning up with a Ooppy disk 96 

Setting up your programs 96 

Installing a program 96 

Checking for computer viruses 97 

Working with several programs at a rime 98 

Switching programs 98 

vi Contents 

Finding out what programs are open 98 

Hiding and showing windows on the desktop 99 

Changing the amount of memory a program uses 99 

Chapter 9 Hard Disks and Floppy Disks 101 
Initializing disks 101 

Initializing a hard disk 102 

Initializing a floppy disk 103 

Erasing a disk 105 

Designating a hard disk as the startup disk JOS 

Protecting the information on a disk 106 

Locking a Ooppy disk 107 

Locking a file 107 

Backing up your files 108 

If you can't save files on a floppy disk 108 

Ejecting a disk 109 

If you can't eject a floppy disk 109 

Disk care 110 

Hard disk precautions 110 

'testing and repairing disks 110 

Using Disk First Aid 111 

'lesting a hard disk 112 



Chapter 10 Organizing Your Files 113 
Straightening up your files 113 

Using folders to organize your files 114 

Creating and naming folders 114 

Saving your files where you want to 115 

Making items easier to find 116 

Using an alias 116 

Creating an alias 116 

Uses of aliases 116 

Locating the 01iginal of an alias 117 

Installing an item in the Apple menu 1 ·17 

Moving an item to the desktop 118 

Finding a file or a folder 118 

Finding an item by name 118 

Finding an item by other characteristics 119 

Finding items through a two-stage search 121 

Uses of the Find command 121 

Creating a template 122 

Getting information about your files 123 

Using the Info window 123 

Using the View menu 124 

Chapter 11 Adapting Your Macintosh 
to Your Own Use 125 
Specifying which items you want opened at startup 126 

Installing an item in the Apple menu 126 

Installing files in the System Folder 126 

Removing files from the System Folder 127 

Changing the items in the Label menu 128 

Setting the elate and time 129 

Changing the format for dates 130 

Changing the format for times 132 

Setting a time for the Alarm Clock to go off 133 

Turning the alarm off 134 

Adjusting the way the mouse works 134 

Adjusting the way the keyboard works "135 

Controlling the pointer from the keyboard 136 

Making keyboard shortcuts easier to type 137 

Adjusting the keyboard for very slow typing 137 

Displaying numbers and currency 138 

Serring the alert sound 139 

Installing a sound 140 

Removing a sound 140 

Recording sounds 140 

Contents vii 



Changing rhe deskrop pattern 142 

Adjusting rhe blinking of a menu item 143 

Adjusring the blinking of the insertion point 144 

Changing the way the contents of windows appear 144 

Changing the appearance of icons 145 

Changing an icon 145 

Assigning a label and a color ro an icon 146 

Changing the highlight color 147 

Changing the color of windows 148 

Displaying colors or grays 149 

Configuring multiple monitors 150 

Adjusting screen brighrness 151 

Magnifying the screen image 152 

Turning off the Empey Trash warning 154 

Managing memory 154 

Checking memory use 154 

Tips for using memory efficiently 155 

Adjusting the disk cache 156 

Using hard disk space as memory 157 

Turning on 32-bit addressing 159 

viii Contents 

Chapter 12 Printing 161 
Before you print 161 

Choosing a primer 161 

If your printer is nm on a network 162 

If your printer is on a network 163 

Selecting Page Serup options 164 

Updating printer drivers on networked computers 165 

Priming your work 167 

Printing the contents of a window 168 

If the printer doesn't print your document 168 

Tips for improving printing 169 

Printing while using the computer for other work 169 

Working with fonts 171 

Outline fonts and birmapped fonts 171 

Installing fonts 172 

Removing fonts 172 

·n-ansferring fonts to a LaserWrirer printer 173 

Finding out about available fonts 174 

Using the LaserWriter Font Utility 175 

Initializing a hard disk attached to a primer 175 

Turning the printer's sample page on or off 175 

Resrarring a l.aserWrirer printer 176 

Transferring a PostScri pt file ro a LaserWriter 176 



Chapter 13 Using Your Macintosh on a 
Network 177 
What you can do on the network 177 

Setting up your Macintosh on a nerwork 179 

Connecring ro a ne1work 179 

Turning on Apple'falk 180 

Selecting a network connection 180 

Naming your Macintosh and irs owner 182 

Gaining access ro files on shared disks 183 

Before you begin 183 

Connecting w a shared disk 184 

Disconnecting from a shared disk 185 

Using an alias to connect quickly co a shared disk 186 

Connecting automat ically when you start up 186 

Working with files and folders on other computers 187 

Creating a new folder on another com purer 18 

Changing your password 188 

Giving folder ownership to someone else 189 

Sharing your own files 189 

How file sharing works 189 

'li.trning file sharing on 190 

'Ii.trning on guest access 190 

Selecting a folder or disk to share 191 

Turning off access ro a shared folder or disk 192 

Naming a registered user 193 

Sening a registered user's password 194 

Naming a group of users 194 

Seeing who·s in a group 195 

Selecring a user or group to share a folder or disk 196 

Preventing users or guests from accessing your 
computer 197 

Removing a user from a group 198 

Removing a user or group from your list of registered 
users 198 

Giving away ownership of a folder or disk on your 
computer 198 

Turning file sharing off 199 

Contents ix 



Monitoring file-sharing activity 200 

Disconnecting someone who is connected to your 
computer 201 

Gaining access to your computer from another 
computer 202 

Changing your password 203 

Using access privileges 204 

Understanding access privileges 204 

Sening access privileges to folders and disks 205 

Access privilege strategies 206 

Working with privileges that others have set 207 

Checking your access privileges 207 

I.inking rrngrams 208 

Linking to a program on another computer 208 

Disconnecting a program link 209 

Allowing other people to link to your programs 209 

Turning program linking on 210 

Selecting a program for linking 210 

Allowing guests to link to your programs 211 

N;1ming specific users to link to your programs 211 

Using communications products with System 7 212 

Using the Communications Toolbox 212 

Using Data Access Language 212 

x Comems 

Chapter 14 Expanding Your Macintosh 
System 213 
Connecting hard disks and other SCSI devices 213 

Installing a device driver 214 

Sett ing the SCSI ID number 214 

Attaching a SCSI device 215 

Connecting a printer 217 

Connecting a modem 217 

Connecting an external floppy disk drive 218 

Connecting a trackball or other ADB device 218 

Connecting headphones or speakers 219 

Connecting a microphone 219 

Connecting additional monitors 220 

Installing expansion cards 220 

Nul3us power requirements 221 

Expanding memory 221 



Chapter 15 Care and Maintenance 223 
Handling system componencs 223 

Moniror 224 

Keyboard 224 

floppy disks and drives 225 

Power supply 225 

Cleaning system components 225 

(leaning the mouse 226 

Maintaining the proper operating environment 227 

Changing the clock banery 227 

Chapter 16 Tips and Troubleshooting 229 
Getting the best-looking fonts 229 

'faking a "snapshor·· of the screen 230 

When you run into trouble 230 

'fake your time 231 

Start over 231 

Rebuild your desktop regularly 232 

Solutions to common problems 232 

The computer is turned on bm the screen is dark 232 

When you start up, an icon appears in the middle of the 
screen and the deskrop doesn't appear 233 

The pointer doesn't move when you move 
the mouse 234 

Typing on the keyboard produces nothing 
on the screen 234 

A dialog box with a bomb appears 235 

The poimer .. freezes·· on the screen 235 

Your program quits unexpectedly 236 

Summary Working on the Macintosh 
Desktop 237 
using the mouse 237 

Working with icons 239 

Working with windows 240 

Working with menus 243 

Keyboard shortcuts in the Finder and in directory 
dialog boxes 245 

Working with disks 245 

Working with programs 246 

Contents xi 



Appendix A Keyboards and Character Sets 248 
Apple Keyboard II 248 

Apple Keyboard 250 

Apple fatended Keyboard II 252 

·ryping non-English characters and special symbols 254 

Appendix B Exchanging Disks and Files 
With MS-DOS and Apple II Computers 256 
Initializing a disk in MS-DOS or ProDOS format 256 

Convening files to and from MS-DOS or ProDOS format 258 

Other file-conversion options 260 

xii Conrenrs 

More information about Apple File Exchange 
options 260 

Appendix C Where to Get More Information 
About Your Macintosh 261 
Macintosh user groups 261 

Technical information 262 

Apple Technical Library 262 

Apple Communications Library 262 

APDA 262 

Assistance for hardware and software developers 263 

Information about copying software 263 

Glossary 265 

Index 283 



Radio and television interference 

The equipmenc described in this manual generates, uses, and can radiate 
radio-frequency energy. If it is not installed and u ·ed properly-that is, in striu 
accordance with Apple's instructions- it may cause interference with radio and 
telerision reception. 

This equipment has been tested and found to comply with the limits for a 
Class l3 digital device in accordance with the specifications in Part 15 of FCC 
rules. These speciAcations arc designed to provide reasonable protection 
against such imerfercncc in a residential installat ion. However, there is no 
guaramee that imerference 11·ill not occur in a particular installation. 

You can determine 11·hether your computer system is causing imerference bv 
lllrning it off. If the interference stops, it was probably caused by the computer 
or one of the peripheral devices. 

If your computer system does cause interference to radio or television 
reception. II~' to correct the interference by using one or more of the following 
measures: 

• Turn the television or radio antenna until the interference stops. 

• Move the computer to one side or the other of the television or radio. 

• Move the computer farther away from the television or radio. 

• Plug the computer into an outlet that is on a different circuit from the 
television or radio. (That is. make certain the computer and the television 
or radio are on circuits controlled by different circuit breakers or fuses.) 

If necessary, consult your authorized Apple dealer or an experienced 
radio/television technician for additional suggestions. You may find helpful 
the following booklet, prepared by the Federal Communications Commission: 
Inte1fere11ce f-la11dbook (stock number 004-000-00345-4). This booklet is 
available from the U.S. Govcrnmem Priming Office, Washington, DC 20402. 

6 Important: Changes or modifications to rhis product not authorized by 
Apple Computer, Inc., could void the FCC Cenification and negare your 
authority to operate the product. 

This product \1·as tested for FCC compliance under conditions that included 
rhe use of shielded cables and connectors between system components. It 
is important that you use shielclecl cab:es and connecrors to reduce the 
possibility of causing interference to radios, television sets, and other 
electronic devices. 

For Apple peripheral devices, you can obtain the proper shielded cables 
from your authorized Apple dealer. For non-Apple peripheral devices, 
contact the manufacturer or dealer for assistance. ~ 
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Preface 

How to Use This Book 
This book has two pares. Pan I, Learning Macintosh, covers 
everything you need to know to begin using your Macintosh 
computer. Part II, Macintosh Reference, contains information 
that you may want as you become more proficient in using 
your Macintosh. 

Go through Part I first if you are new to computers or new to the 
Macintosh. Read the chapters in sequence, from Chapter 1 to 
Chapter 7. When you're done with Part I, you can start learning 
the programs that you intend to use with your Macintosh. 

Use Pare II as you would a dictionary or encyclopedia: tum to it 
when you need specific information, and then read only those 
parts chat give you char information-so you can go on with your 
work. 

'lo find information in this book, use the index and the table of 
contents. Also, use the glossary and the summary, "Working on 
the Macintosh Desktop" (on the green pages after Chapter 16), 
if you're looking for shore definitions or brief summaries of 
concepts and procedures. 

If you need information on setting up your Macintosh or on 
features specific co your particular model, go to che setup book 
that came with your computer. 

Use this book in combination with the setup book and the books 
and disks that came with your application programs to find the 
information you need. You can also find useful information 
through Balloon Help, a feacure of your Macintosh system that 
is explained in Chapter 7. 

Welcome to Macintosh. 

xv 





Part I 

Learning Macintosh 
Chapter 1 Turning the Macintosh On and Off 

Chapter 2 Understanding the Desktop 

Chapter 3 Setting Up Your Programs 

Chapter 4 Creating a Document and Saving Your Work 

Chapter 5 Changing a Document and Printing Your Work 

Chapter 6 Organizing Your Work 

Chapter 7 Learning More About Your Macintosh 

Co through Learning Macintosh ifyou are new to computers or 

new to the Macintosh compute1: Read the chapters in sequence, 

.fi"om Chapter 1 to Chapter 7. Everything you need to know to 

begin using the Macintosh productive(v is covered in this part of 

the book. 

Before you use learning Macintosh, you should have already 

• set up your Macintosh according to the instructions in the 

setup book that came with your computer 

• gone through the Macintosh Basics tour, supplied on disk 

with your computer 

When you're clone with this part of the book, you can start 

learning the programs that you intend to use with your 

Macintosh. (Turn to the materials that came with the 

programs-all the skills you learn in Learning Macintosh 

will prove useful in any Macintosh program.) 

For information that you may need as you become more 

proficient in using your Macintosh, go to Part II, Macintosh 

Reference. 



To find information in this book, use the index and the table of 

contents. Also, use the glossary and the summary, "Working on 

the Macintosh Deskcop" (on the green pages after Chapter 16), 

if you 're looking for short definitions or brief summaries of 

concepts and procedures. 

If you need information on setting up your Macintosh or any 

information on features specific co your particular model, go to 

the setup book that came with your computer. 

2 

Use this book in combination with the setup book and the books 

and disks that came with your application programs to find the 

information you need. You can also find useful information 

through Balloon Help, a feature of your Macintosh system that is 

explained in Chapter 7. 



Chapter 1 

Turning the Macintosh 
On and Off 
In this chapter 

You 'II learn how to 

• rurn the Macintosh on and off 

Also, you'll learn about 

• the srarrup disk 

• the Macinrosh desktop 

It will take about five minutes to go through this chapter. 

Before you begin 

You should have already 

• set up your Macintosh according to the instructions in the 
setup book that came with your computer 

• gone through rhe ,\!/acintosb Basics tour. supplied on disk 
with your computer 

• read the inrroducrion to th is section of the book (page I) 

3 



Turn your computer on 
How you turn on your Macinrosh depends on which model it is. 
For specific information, go to the setup book that came with 
your computer. 

6. Important: If an external hard disk or other external devices 
are connected to your Macintosh, turn on those external 
devices before you turn on the Macintosh. 6. 

• If your Macintosh is the Macintosh LC or it does not have a 
separate monitor (like the Macintosh Classic), press the on/off 
switch on the back of your computer. 

J 

·:· If the Macintosh LC monitor doesn't turn on, make sure 
that the monitor's on/off switch is on. (If you don't know 
where the switch is, go to rhe manual that came with your 
monitor.) ·:· 

4 Chapter 1: "li.1rning the Macimosh On and Off 

• If your computer is one of the Macintosh II models (such as 
the IIci or the Ilfx), press the Power On key on your keyboard. 

Power On key [J 

D Power On key .. . 

. . . . 

·:· If tbe monitor doesn't turn on, make sure that its on/off 
switch is on. (If you don't know where the switch is, go ro 
the manual that came with your monitor.) ·:· 



When you turn on your computer 

The Macintosh looks for a startup disk, which is a disk that 
contains the information it needs to "start itself up." In your 
case, the startup disk is a hard disk that's inside or connected 

8 
t0 your computer When the Macintosh finds a startup 
disk, it displays rhe icon shown at left and proceeds 
tO srart itself up. 

When your compurer is done starting itself up, the screen 
displays rhe Macinrosh "desktop." The desktop is a field of gray 
(or another color) with 

• a menu bar across the top (containing rhe names and icons 
of menus) 

• an icon near rhe upper-righr corner represenring rhe 
startup disk 

• a Trash icon near rhe lower-righr corner 

Chaprer 2, "Understanding rhe Deskrop," gives you more 
information on these features. 

Menu bar 

:llllliiiiil!lli+-Srartup 
disk 
icon 

Trash icon 

if the Macintosh doesn't find a startup disk, it displays this icon 
instead. In this case, you may need to prepare a stanup disk 

or connecr one to your computer. Go to Chaprer 8 
(in Part II of chis book) or your scrup book for 
instructions. 

Chapter I: 'li.1rning the Macinwsh On and OfT 5 



Turn your computer off 
Before you can rum off your computer, you need ro know how 
10 use rhe mouse to choose a command from a menu. The 
Macintosb Basics tour lets you practice choosing commands. If 
you need more pracrice, go through the next chapter (Chapter 2) 
and rhen come back ro th is section to turn off your compurer. 

1. Point to the Special menu name in the menu bar. 

2. Press and hold down the mouse button. 

3. Drag through the items in the menu until the Shut 
Down command is highlighted, then release the mouse 
button. 

Clean Up Desktop 
E:m1>t1_l ·rrnst1 ... 

E:jec'f Ui~k :•:[ 
Erase Disk ... 

Restart 
Shut Down 

6 Chapter I : '!urning che Macin1osh On and Off 

If your Macintosh does nor have a separate moni tor (like the 
Macintosh Classic), press the on/off switch on rhe back of the 
compurer when a message on ·creen indicates thar it's safe to 
do so. 

• If your Macintosh is the Macintosh LC, press the on/off switch 
on the back of rhe computer when a message on screen 
indicates that ifs safe ro do so, and swirch off the moniror 
as well. 

• l f your com purer is a Macinrosh IJ or a ponable moc.lel, rhe 
com purer and rhe monitor turn off by themselves. 

6 Important: If an external hard disk or ocher external device 
is connecred to your Macintosh, rum off chose external 
devices afrer you rurn off rhe :'viacimosh. 6. 

Turn off your computer ar the end of your work day or when you 
know you won't be using it for several hours. 

What next? 
Go to Chaprer 2, where you' ll learn how co work on the 
Macintosh cleskrop. 



Chapter 2 

Understanding the Desktop 
In this chapter 
You'll review how to 

• use the mouse 

• choose a command 

• open an icon 

• look at the contents of a window 

• close a window 

(The /vlacinlosb Basics tour introduced you to these skills.) 

You'll learn how to 

• move a window 

Also, you'll learn about 

• using the keyboard 

It will cake about 30 minutes to go through this chapter. 

Before you begin 
You should have already 

• gone through Chapter 1 

If you rurnecl off the Macincosh at the encl of Chapter 1, turn it 
back on now. 

7 



Use the mouse 
You use rhe mouse to control rhe movements of a pointer on 
screen. Usually, rhe pointer is an arrow that's ser at an angle. 

= 

fill 

Much of rhe work you do on the Macintosh uses four mouse 
actions: pointing, clicking, pressing, dragging. 

8 Chapter 2: Understanding the: Deskwp 

Point 

You point to an object on screen by moving the mouse so rhat rhe 
pointer is posirioned on that object. When the pointer is an arrow, 
the very tip of the arrow must be exactly on rhe object. 

liil 

Practice by pointing to different objects on the Macintosh 
desktop, such as the startup hard disk icon near the upper-right 
corner, the Trash icon near the lower-right corner, and the Help 
menu icon near the right corner of the menu bar. 



Click 
You click an object on screen by pressing and quickly releasing the 
mouse button while the pointer is on that object. 

liil 

Practice by cl icking different objects on the Macintosh desktop, 
such as the startup hard disk icon near the upper-right corner and 
the Trash icon near the lower-right corner. 

.. . ......... . .. 
:::::::::::::::::::::::::::::::::::::::::::::::::::: 
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When you click an icon, it becomes highlighted (the icon is 
darkened), which means that it is selected. A selected icon is the 
object of whatever action you choose next. 

Press 

You press by holding down the mouse button without moving the 
mouse. Don't bear down on the mouse itself. 

= 

!iii 

Practice by pressing the menu names and menu icons in the menu 
bar (start with the Apple menu icon in the left corner, through the 
menu names, and across to the Help and Application menu icons 
in the right corner). Pressing a menu name or icon "pulls clown" 
the menu. Read the items in each menu you pull clown . 

Rbout This M acintosh ... 

~ Rlarm Clock 
filill Calculator 

~Chooser 
~ Contro l Panels 
[@)Key Caps 
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Drag 

You drag an objecc on screen by poirning co chac objecc and 
holding clown che mouse bunon while you move rhe mouse. 

= 
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How to hold the mouse 
• You can use the mouse with either hand. Most people 

prefer to use it with their dominant hand (the right if 
they're right-handed, the left if they're left-handed). If yo~ 
want to switch mouse positions, go to the setup book that 
came with your computer. 

• Keep the heel of your hand on your desk. (Your arm will 
tire quickly if you hold your hand up in the air.) 

• Lightly rest your index and middle fingers on the mouse 
button. 

• Make sure that the mouse cable is pointing away from you. 



Practice by dragging the startup hard disk icon and the Trash icon 
around the Macintosh desktop. Make sure you return the icons 
close to their original positions. 

When you drag an icon, an outline of the icon follows the pointer 
on the screen. When you release the mouse button, the icon itself 
moves. 

When you move the mouse 
• Glide the mouse over the surface of your desk. Dun'L press 

down on it. 

• If you run out of room on your desk as you're moving the 
mouse, pick it up and put it down where there's more 
room. When you pick up the mouse, the pointer on screen 
does not move, or does so only slightly. 

= 

liil 
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Choose a command 
Choosing a command involves a combination of the mouse 
acrions you've reviewed. 

1. Point to the Special menu name in the menu bar. 

2. Press to pull down the Special menu. 

3. Drag to the first item in the menu (the Clean Up 
Desktop command) so that it is highlighted, then 
release the mouse button. 

11 

[jPc1 Di~k '.•:( 
ErnsH Hi~k ... 

Restart 
Shut Down 

When you choose the Clean Up Deskrop command, the 
startup hard disk icon and the Trash icon return exactly ro 
the positions they occupied when you fi rst turned on the 
computer (as long as they're already close co their original 
positions). 
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When you talk to your Macintosh 
Talking Macintosh always involves rwo steps: 

1. selecting an object on the screen, and 

2. choosing the action you want to perform on the object. 

An icon or a window on the Macintosh desktop, text in a 
word-processing program, a picture in a graphics program­
all of these are objects that you can select. 

The actions you choose to perform on a selected object are 
usually commands (like the Open command), but you can also 
perform actions directly using the mouse (like dragging an 
icon). 

When you select an object, you're telling the Macintosh to acr 
upon that object. 

Talking Macintosh is like using a very simple language with 
only rwo kinds of words: 

• nouns (the objects), and 

• verbs (the actions) 

and with only one rule to remember: 

• First the noun, then the verb (to this object, do that 
action). 



Open an icon 
Opening an icon is your first exercise in "talking Macintosh": 
telling your com purer what you wanr ir to do. 

1. Click the startup hard disk icon (unless it's been 
changed, it should be named "Macintosh HD") near 
the upper-right corner of the screen to select it. 

Make sure rhar the icon is highlighted (darkened), which 
means rhat it's selected. 

-~ llMHDtUft 

2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the 
File menu) so that it is highlighted, then release the 
mouse button. 

[!OS(~ Window 

Get Info :!C l 

When you choose the Open command, the selecrccl icon (in 
this case, rhe Macinrosh HD icon) opens inro a window (the 
Macinrosh HD window). The icon itself becomes ftllecl in with 
a pattern of clots, indicating char it has been opened. 

ID M acintosh HD Pli! 
3ittmS 3.6 f"S in disk 34.4 MB ann~lt 

ii llJ ~ ~ 
Rod Mt &,!stem Foldt< TuchT•xt 

'o 
12.I ~ QJ 
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Look at the contents of a window 
Every window has several features that help you view the 
window's contents. You can 

• make the window bigger or smaller 

• move any hidden contents into view 

Before you work with the contenrs of a window, you need to 
make that window the active window. 

Make a window the active window 

You can have several " ·inclows on screen, but only one window at 
a time can be the aclive window. 

The Macintosh HD window should already be on your Macintosh 
desktop. (The window appeared when you opened the 
Macintosh HD icon.) 

1. Click the Trash icon near the lower-right corner of the 
screen to select it. 

Make sure that the icon is highlighted, which means that it's 
selected. 

1-t Chapter 2: lndcrstanding the Deskcop 

2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the 
File menu) so that it is highlighted, then release the 
mouse button. 

Print ~ :)(<P 
[ ln~rn Window :)(<W 

Get Info 3€ 1 

When you choose the Open command, the selected icon (in 
this case, rhe Trash icon) opens into a window (the Trash 
window). The icon itself becomes filled in with a parrern of 
dms, indicating that it has been opened. 



You should now have two windows on your Macintosh 
desktop: rhe Macinrosh HD window and rhe 1hsh window. 
The Trash window is the active window because you opened 
the Trash icon most recently. 

lit.ms 

• i 
Ru d Mt 

ID 
Goittms 

l¢T 

Mnclntosh HD 
3.6 M9 in disk 

~ ~ 
Si.isttm Foldtt'" THchhxl 

Trash 

34.4 t1I •v•Uab,. 

E!ll 

~ 
t--

to 
IOlr;lJ 

Active 
window 

5. Click anywhere in the Macintosh HD window to make it 
the active window. 

The active window is the one with solid lines across the top 
(the title bar), on either side of its title. When windows 
overlap, the active window is the one that's on top. 

iD 
3;ttms 

11 -RtadMt 

.----
~ 

01 

Mnclntosh HD 
3.6 M8 in disk 

Lll ~ 
S!Jstfln f oldtr TuchTtxt 

1!11 
34.4 M8 •v•ll•blt 

~ 

~ 

to 
IOI\! 

Active 
window 

co11ti1111es .,.. 
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Make a window bigger or smaller 
Yuu can change a window's size by dragging irs size box or by 
clicking irs zoom box 

1. With the Macintosh HD window the active window, 
point to the size box in the lower-right corner of the 
window. 

ID Moclntosh HO 0 & 
3 ltems 3.6 MB in disk 34 .4 MB •v.til•blt 

Ii ~ ~ .Q, 
' -

Rtod ..,. ~st.m f o\dH' TuehT• xl 

~ 
!QI T<5 '2JI-- Size box 
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2. Drag the size box in any direction, then release the 
mouse button. 

An ourline indicates the window's new size. The outline 
follows the pointer as you drag. You can drag in any direction 
to make the window bigger or smaller, wider or narrower. 

ilD Mocintos~H~ PIE 
3ittms: 3.6 MB .,~ I 34.4 MB.tv.tfl.t>lt 

fl ~ ~ 1 ~ 

Ru d Mt &js t•m Folder Tt,.hTf-~· ---
-al 

io 
¢] IC: ~l;li 

3. Click the zoom box near the right end of the title bar. 

m M11clntosh HO Zoom box 
3 it•ms 3 .6 MBin dlsk 34.4 H8 AV41flab)t 

ii L!J ~ ~ -
Rud Mt S\js tern Folder' TuchTtxt 

izy 
~ ~'21 

The window "zooms" to a size that shows all of its contents. 



4. Click the zoom box again. 

The ,,·indow zooms back ro irs previous size (the size Lha1 you 
changed it to in seep 2). 

Clicking the zoom box is a quick way ro view as much of a 
window's conrenrs as your screen size allows. 

Move the hidden contents of a window into view 

Wirhout changing the size of rhe window, you can view any 
contents that are currently out of sight by using rhe window's 
scroll bars and scroll arrows. 

1. With the Macintosh HD window the active window, 
click the System Folder to select it. 

ID Moclntosh 110 E!l!i 
3it•ms 3.& MB tn disk 34 4 M8,anil~ ... 

g - ~ ~ 611 47 

Rud Mt M•MiM5 Tt<K:hf•xt 

to 
l2l. ~'2l 

Make sure that the icon is highlighted, which means that it's 
selected. 

2. Point to the File menu name in the menu bar. 

3. Press to pull down the File menu. 

4. Drag to the Open command (the second item in the 
File menu) so that it is highlighted, then release the 
mouse button. 

When you choose rhe Open command, rhe selected icon 
(in this case, rhe Svstem folder) opens inro a window (rhe 
System folder window). 

You should now have three windows on your Macintosh 
desktop: the Macintosh HD window, the Trash window, and 
the System Folder window. The System Folder window is the 
active window because you opened the System Folder lase. 

; . Point to the size box in the lower-right corner of the 
System Folder window. 

co11ti1111es ..,. 
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What's on the desktop? 

The Macintosh desktop is a field of gray (or another color) with 
a menu bar across the rop, an icon near the upper-right corner 
representing the startup disk, and a Trash icon near the lower­
righl corner. 

The desktop is your work space on the computer-as the rop 
of a wooden desk is a work space. It gives you a familiar way of 
thinking about how t0 use the Macintosh. 

Aside from the field of gray (the "surface" of your work space), 
the Macintosh desktop has icons, windows, and menus. 

• Icons represent containers. 

• Windows lee you view the contents of containers. 

• Menus olTer you actions Lhat you apply to selected 
containers (or cheir contents). 

Icons represem containers 

You can chink of icons as containers. Icons can contain ocher 
icons, or they can contain informacion. 

For example, the startup disk icon near the upper-right corner of 
the deskrop contains the System Folder icon. The System Folder 
icon contains che programs and ocher files (more icons) that 
contain the information the Macintosh needs to start 
itself up. 

18 Cliapttr 2: C11dtrsta11di11g tilt Dtsktop 

Several types of icons represent different types of containers. 

Hard disks and floppy disks are like filing cabinets. You use disks 
ro store files-programs you use and documents you create. 

1. 
Hard Disk Floppy Disk 

Shared disks are like filing cabinets containing office supplies or 
records that you share with others in your work group. Your 
Macintosh needs to be connected to a network before you can 
use shared disks. 

~ 
NetMart Community Communique 

Shared Disk lduna Stacks 



Folders are like folders in a file drawer. You use folders to 
organize your files. 

Sy stem Folder Manila Folder 

June Letters House Plans Mailing Lis ts 

Programs are files containing instructions to the computer that 
let you do certain rypes of work. 

Teach Text SketchP ad MemoMaker BeanCounter 

Documents are files containing words, pictures, numbers, 
sounds-whatever you create using programs. 

Kitchen plans Rough sketch 

g 
D 
Sandino 

Invi tation 

g 
D 
Memo State Budget 

The Trash is a container for files that you no longer wane 
or need. 

I 
Trash 

Windows let you view the contents of containers 

Windows let you see what's "inside" all of these containers. 
When you open a disk icon, the window that appears shows you 
what's on the disk. When you open a document icon and the 
document is a memo, for example, the window that appears lets 
you see the memo. 

Menus offer you choices 

Like the menus in a restaurant, Macintosh menus let you 
choose. You choose among different actions that the computer 
can perform on containers (icons) or the coments of containers 
(words in a memo) that you've selected. 
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6. Drag the size box diagonally to make the window 
smaller (about half its current size), then release the 
mouse button. 

! i Q 

~ I 
Control P~""lt 

e ~ ~ 1' 

w 
Applt ~ ltHM 

FVM:t• r Prtftrtnets ~rapbook Ftlt ! j 

G
~--~e;::s-----~ 1_.:1 

T©-,-----,-B-r-----' "' 
¥~1tff'l"d Pri\tMonitor Ooctments 

1¢1 

m S stem Folder ~ 
10iltms 3 .6 MB fndisk 34.4 MB ann.b\t 

w [QJ rm 
Applt M.nu lttms Exttnsk>ns System 

The bars across the bottom (the horizontal scroll bar) and 
along the right (the vertical scroll ba r) of the Sysrem Folder 
window should now be gray, indicating that the window has 
contents that you cannot see at its current size. 
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7. Press the right scroll arrow at the right end of the 
horizontal scroll bar. 

s s tem Folder f!li 
10 1ttms 

w [QJ 
Applf. Mtnu It.ms Exttnsions 

The contents of the window scroll past, bringing into view the 
icons that had been out of sight and to the right. 

The scroll box moves ro the right across the bar, showing what 
pan of the window's contents you're looking at. 

8. Press the left scroll arrow at the left end of the 
horizontal scroll bar. 

The contents of the window scroll past, bringing back into 
view the icons that had been our of sight and to the left. 

The scroll box moves ro the left across the bar, showing what 
pan of the window's contents you're looking at. 



9. Drag the scroll box toward the middle of the horizontal 
scroll bar, then release the mouse button. 

I _ Sys tem Folder 
IOittms 3.6 MB in disk 34.4 MBn<11ffablt 

w LQ] LiJJ 
0 @§] r"; 

le Mtnu lttms Extensions $1,is\em Conlrol Panell 

Now you see the icons near the middle of the window. 

10. Press the down scroll arrow at the bottom end of the 
vertical scroll bar. 

I Sys tem Folder 

till ~ 
0 

Syst tm Control P.,-if'ls 

The contents of the window scroll past, bringing into view the 
icons that had been out of sight and toward the boctom. 

The scroll box moves down along the bar. 

11. Press the up scroll arrow at the top end of the vertical 
scroll bar. 

The contents of the window scroll past, bringing into view the 
icons that had been out of sight and rowarcl the top. 

The scroll box moves up along the bar. 

12. Drag the scroll box toward the middle of the vertical 
scroll bar, then release the mouse button. 

Sy st em Folder 
3.6M8Wldisk 

Now you see the icons near the middle of the wmclow. 

6. Remember: Changing the size of a window or moving the 
contents of a window does 1101 change its comenrs. The 
contents remain the same; only what you see of the contenrs 
changes. 6. 
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When to use the keyboard 
You use the keyboard to type text and numbers, of course, as 
you would on a typewriter. (For touch typists, Macintosh 
keyboards have raised dots in the middle of the D key and the 
K key to help position your fingers on the home row.) 

Depending on the program you're using, you can use special 
keys on the keyboard to give commands to the computer and to 
replace or change the effect of cettain mouse actions. Macintosh 
keyboards have three types of special keys: modifier keys, arrow 
keys, and function keys (Chapter 5 gives you examples of how to 
use these special keys). 

Modifier keys 

All Macintosh keyboards have four modifier keys: Shift, 
:If: (Command), Option, and Control. 

Pressed by itself, a modifier key does nothing. You need to press 
it in combination with another key (or while using the mouse). 
The modifier key "modifies" the ocher key or the mouse action, 
giving a different result. 

You type a capital letter, for example, by pressing the Shift key 
with a letter key. Most programs let you give commands by 
pressing the :If: key with certain letter keys. 
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Arrow keys 

All Macintosh keyboards have four arrow keys: Up Arrow, 
Down Arrow, Left Arrow, and Right Arrow. 

Many programs let you use the arrow keys as well as the mouse 
to control the movements of the pointer on screen. 

Function keys 

Extended Macintosh keyboards have a row of function keys 
across the top of the keyboard. 

Some programs let you give commands, or a sequence of 
commands, by pressing certain function keys. 

0 

[OJ IUIUIUIU IUIUIUIUI IUIUIUIUI IUIUIU - - - '.8J 
0 

1::1 Modifier key:; D Function kc)'S D Arrow keys 



Close a window 
When you no longer need to see the conrenrs of a window, you 
can close it by clicking the close box. 

1. With the System Folder window the active window, 
point to the close box near the Ief t end of the title bar. 

2. Click the close box. 

The window closes, and the System Folder icon is no longer 
filled in with a parrern of dots, indicating that it is not open. 

You should have two windows on the Macintosh deskrop: the 
Macinrosh HD window, which is now Lhe active window, and 
the '!J·ash window. 

Move a window 
You can move a window anywhere on screen by dragging its 
title bar. By changing the position and the size of windows, you 
can arrange windows in any \\ ay that works best for you. 

1. Point to the title bar of the Macintosh HD window 
(anywhere on the title bar except the close box or the 
zoom box). 

Mocintosh HD 0!! Title bar 
3 ittms 3.6 MB in dtsk 34,8MB•v1ilablf' 1-.J 

• . - ~ ~ 
~sttm f oldtr Read He Teach Text 

2. Drag the title bar in any direction, then release the 
mouse button. 

When you drag a window's title bar, an outline of the window 
follows the pointer on screen. When you release the mouse 
button, the window itself moves to the position of the outline. 

Mocintosh HD 0!! 
3 i tmis 

llJ a ~ Q 

5\1st""' Foldrr IR .. d M< 
~ ----------1 

TnchTtxt 

I ! 
I i I I 
i ~ I I 

¢I Tt5 '21 

Trosh I 
&»o it tms I 

t-----------·--·-----·--·----·-------·j 
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3. Click anywhere in the Trash window to make it the 
active window. 

4. Point to the title bar of the Trash window (anywhere on 
the title bar except the close box or the zoom box). 

5. Drag the title bar in any direction, then release the 
mouse button. 

Notice that the Trash window, because it is the active window, 
stays on top of the Macintosh HD window if the two windows 
overlap. 

M8clntosh HD 
3 lttm> 3.2MB Yi disk 34 .8 MB n.110.b~ 

rn:i II ~ 
Sys l•m Foldtr RtodMt TuchT•xt 

... i 
m Trash Bl! 

iifOittm' I 
AA 
I 

0 1 IQ'i!J 
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6. Click anywhere in the Macintosh HD window to make it 
the active window. 

7. Close the Macintosh HD window by clicking the close 
box near the left end of the window's title bar. 

Iii 
Rod Mt 

<>T 

Macintosh HD 

(';., M. 
~ 'fy 

$4,fsi•m Fo~ TuchT•xt 

The window closes, and the Macintosh HD icon is no longer 
filled in with a patrern of clats, indicating that it is not open. 

The 'frash window (the remaining window on the Macintosh 
desktop) becomes the active window. 



8. Close the Trash window by choosing Close Window 
from the File menu. 

You choose Close \Xlinclow by poinring ro the File menu name, 
pressing ro pull clown che menu, dragging w lhe Close 
Window command, and, wi th the command highlighted, 
releasing rhe mouse burron. 

Of course, you can also close the window by cl icking its close 
box. 

What next? 

Go to Chapter 3, where you'll learn how ro set up your programs, 
or take a break. Remember co turn off your Macinrosh if you'll be 
away for more than a few hours. 
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Chapter 3 

Setting Up Your Programs 
In this chapter 

You 'll learn how to 

• insert a floppy disk 

• initialize a disk 

• copy the contents of a disk 

• take a floppy disk out of its drive 

• safeguard the contents of a disk 

• use the 'Ii·ash 

Ymi"ll also learn about 

• types of floppv disks 

• the difference between hard disks and floppy disks 

• caring for floppy disks 

And you'll learn more about 

• the startup disk and the System Folder 

lt will take about 40 minutes to go through this chapter. 

Before you begin 

You should have already 

• gone through Chapters 1 and 2 

Also, you need 

• a new floppy disk 

If you turned off the Macintosh at the encl of Chapter 2, turn it 
back on. 
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Insert a floppy disk 
You shou ld be able co get floppy disks from wherever you got 
your Macintosh. The 3.5-inch (89-millimeter) floppy disks that fit 
in your ~lacinrosh computer's SuperDrive come in two types: 
high-density and clouble-siclecl. Your ~ lacinrosh uses either type. 

Double-sided (SOOK) 

I ligh-densitr 
disk symbol 

Some older Macinrosh models, however, clo nor have the 
SuperDrive floppy disk drive and cannot properly use high­
density disks. 
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1. Write "Practice" on a blank disk label. 

2. Affix the label onto your new floppy disk. 

How the label goes onto the floppy disk is apparent from the 
molding of the disk's protective plasric case. Do nor affix the 
label over rhe metal shurrer. 

3. Hold the disk between thumb and forefinger, with your 
thumb on the label and the metal shutter pointing 
away from you. 

4. Push the disk into the computer's SuperDrive, label 
side up and metal shutter first, until the SuperDrive 
pulls the disk in the rest of the way. 



Why a floppy disk isn't floppy 
A floppy disk is made of thin, flexible material with a magnetic 
coating. To protect it and to make it easier to handle, the floppy 
disk itself is enclosed in a rigid plastic case, which gives the 
floppy disk its "non-floppy'· character. 

A metal shutter on the plastic case allows access to the floppy 
disk, which carries information in the form of magnetic signals. 
The shutter moves our of the way when you insert the floppy 
disk in a disk drive. 

You can use either of two types of 3.5-inch (89-miUimeter) 
floppy disks in your computer's SuperDrive: high-density and 
double-sided. 

·:· lfyou use anotber Macintosh: Some older Macintosh 
computers may not have the SuperDrive floppy disk drive 
and therefore cannot use high-density disks. Use only 
double-sided disks on rhese older Macintosh computers. ·:· 

High-density disks can hold 1.4 megabytes (MB) of information 
(about 300 typewritten pages). Double-sided disks can hold 
800 kilobytes (K) of informacion (about 200 typewritten pages). 
(One thousand C\vency-four kilobytes make a megabyte.) 

I page 

~ 
4K 

300 pages 
ZOOpagcs ~ 

~ ~ 
800K 1.4 MB 

Flopp)' disks 

10,000 pages 

5.000 pages 

20 MB 40MB 

I lard disks 

Floppy disks are also called diskettes. 
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Initialize a disk 
Before you can use a new Ooppy disk, you need to prepare it so 
that the computer knows where to store and retrieve information 
on the disk. Preparing a disk is called initializing. Initializing a 
disk is like drawing rhe lines on a newly paved parking lot: you 
don't know what firs where unti l you figure out how much room 
you have. 

1. After you insert your practice disk into the SuperDrive, 
read the dialog box that appears on screen. 

If you inserted a high-density disk, this dialog box appears: 

r - ,1 This disk i s unrea dable: 

uo you w ant to lnltlallze It ? 

R Eject D ( lnlllallze J 

lf you inserted a clouble-sidccl disk, chis dialog box appears: 

liT'il This disk is unreadable: 

I§ Do you w ant to iniliollze II? 

(( Eject lJ (One- Sided J (Two- Sided) 
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2. Depending on which dialog box appears, click Initialize 
or Two-Sided. 

Anocher dialog box appears: 

/I\ This process will erase all 
ill information on this disk. 

Cancel ([ Erase )J 

This dialog box gives you one lase chance to cancel. It alerts 
you that you're about to erase-and therefore lose-any 
information that may be on the floppy disk. In chis case, 
because the floppy disk is new, you have no information 
to lose. 

3. Click Erase. 

A rhircl dialog box appears: 

~ 
Please name this disk: 

(I DK JI 



4. Type "Practice". 

If you make any ryping errors, press rhe Delere key ro 
backspace over rhem. 

When you name a disk, you can type up to 27 characters, 
including spaces. You can nor use a colon (:) in rhe name. 

5. Click OK. 

The computer takes ahour a minure ro initialize the disk. A 
series of messages appears on the screen to let you know how 
rhe process is going. 

When the computer is clone initializing the floppy disk, the 
disk's icon appears on rhe Macintosh desktop cl irecrly below 
the Macintosh HD icon (the startup hard disk icon) near the 
upper-right corner. 

ti: fil e Cdit uu~w ulbe-,- Sprcinl lIJ1f 
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Copy the contents of a disk 
Most programs you ger are supplied on one or more floppy disks. 
You can more efficienrly use a program if you first install it on 
your hard disk (copy it from its floppy disk to your hard disk). 

To pracricc copying the contenrs of a floppy disk ro your srarrup 
disk, use your practice disk (even if there's nothing on it). 

1. Make sure that the Practice floppy disk icon is selected. 
If it isn't, click the icon (not its name). 

(1) ~ 
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Floppy disks, hard disks, and startup disks 
Both floppy disks and hard disks function like filing cabinets: 
you store files in them. The differences between floppy disks 
and hard disks are in how much information they can store, how 
quickly you can retrieve information from them, and how easily 
you can carry them around. 

You can store much more information on a hard disk and 
retrieve it much faster than you can on a floppy disk. 

And while you can carry a floppy disk in your shirt pocket, a 
hard disk is sealed in a hard disk drive, which is installed inside 
the computer or enclosed in a plastic box that's connected to 

the computer. 

D 
:------- -- -: 
' ' , _____ -- - - _1 

lnrernal 
hard disk 

Extcrnal 
hard disk 

32 Chapter 3: Setting Up Your Programs 

~ 
Floppy 

disk 

You can tell whether a disk is a floppy disk or a hard disk by 
looking at its icon on the desktop. 

[. 
Hard Di sk 

~ 
Floppy Disk 

The disk whose icon appears near the upper-right corner is the 
startup disk, which contains the information that the Macintosh 
uses ro start itself up. 

That "startup" information is contained in programs and other 
files that are in the System Folder on the startup disk. The 
startup disk must have only one System Folder. If it has more 
than one, the computer becomes confused about where to get 
the information it needs to stare up and run, with unpredictable­
and undesirable-results. 



2. Drag the Practice floppy disk icon to the Macintosh HD 
icon until both icons are highlighted, then release the 
mouse button. 

Both icons are highlighted when the tip of the arrow pointer 
reaches the Macintosh HD icon as you drag the Practice 
floppy disk icon. 

C1l ~ .................................. ................................. .................................. ................................. 
::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

ililllilililililililllllililllilill 
::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 

When you release the mouse button, the Macintosh copies 
the contents of the Practice floppy disk onto Macintosh HD 
(your startup hard disk). The copy is in a folder named 
Practice, which is now on Macintosh HD. 

3. Click the Macintosh HD icon to select it. 

4. Choose Open &om the File menu. 

You choose Open by pointing to the File menu name, 
pressing to pull down the menu, dragging to the Open 
command so that it's highlighted, and releasing the mouse 
button. 

The Macintosh HD window appears, showing you the 
contents of the startup hard disk. The contents should 
include a new folder called Practice, which the computer 
created when it copied the contents of the Practice floppy 
disk to Macintosh HD. 

You may have to make the window bigger or use the scroll 
bars to find the Practice folder. 

5. Click the Practice folder to select it. 

6. Choose Open &om the File menu. 

You choose Open by pointing to the File menu name, 
pressing to pull down the menu, dragging to the Open 
command so that it's selected, and releasing the mouse 
button. 

The folder holds the contents of the floppy disk you've copied 
(in this case, the folder contains nothing because there's 
nothing on the Practice disk). 

7. Close all the windows you have on the Macintosh 
desktop. 

You close a window (when it's the active window) by either 
clicking its close box or choosing Close Window from the File 
menu. 
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Take a floppy disk out of its drive 
While rhere's only one " ·ay to insen a floppy disk inco rhe 
SuperDrive. rhere's more than one war co rake it our. Here is the 
besr wav: 

1. Make sure that the Practice floppy disk icon is selected. 
If it's not selected, click it. 

(1J (9) 

:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::: 
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2. Eject the floppy disk by choosing Put Away from the 
File menu. 

New Folder 3€N 
Open 3€0 
Print >)(:p 

I: loirn Window >)(:UJ 

Get Info 3€ 1 
Du1>lic<11 (~ >)(:I) 

Make Alias 
Put Away WY 

................................................. ~ ................ . 
Find... 3€F 
Find Again 3C G 

Page Setup ... 
Print Desk top ... 

You choose Pur Away by poinring co the File menu name, 
pressing ro pull clown rhe menu, dragging to rhc Put Away 
command so that it 's highlighted, and releasing the mouse 
button. 

Put Away pucs the object you've selected back in its place (in 
this case, il allows you to remove the floppy disk rrom the disk 
drive and put it away). 



Safeguard the contents of a disk 
You can lock a disk so [ha[ i[s comen[s can nm be changed in any 
way. When a disk is locked, you cannm change the files that are 
on it, delete any files, or stare additional files. 

To practice locking and unlocking a floppy disk, use your practice 
disk. 

1. Hold the practice disk between thumb and forefinger, 
with your thumb on the label and the metal shutter 
pointing away from you (as if you were going to insert 
the disk into a drive). 

2. Find the square hole in the near-left corner of the 
floppy disk. 

A moveable tab on the back side of the disk should be 
blocking the hole, indicating that the disk is unlocked. 

·!· !/you're using a bigb-densi~l'./lO/J/JY disk: You 'll notice an 
additional square hole, across the label from the first hole. 
This second hole has no moveable tab and is always open. ·:· 

3. Turn the disk over and lock the disk by sliding the tab 
on the back side of the disk so that the square hole is 
open. 

••• ••• 
••• • • 

• •••• ·~·t-----­• • 

Locked Unlocked 

Use your thumbnail or a push pin [O move the tab. 

4. Unlock the disk by sliding the tab back so that the 
square hole is blocked. 

Your practice disk should be unlocked so you can use it to 
srore files in the next chapter. 

Chapter 3: Setting Up Your Programs 35 



Taking care of floppy disks 
Follow the instructions about care and maintenance that came 
with your disks. At minimum, remember these three points: 

• Keep the disks away from magnets. Information on the 
disks is in the form of magnetic signals, so a magnetic field 
can destroy that information. Televisions and monitors, 
telephones, loudspeakers, and certain kinds of lighting 
ftx:tures all have magnets. 

• Protect disks from extremes of temperature and humidity. 

• Do not open the disk's metal shutter. Touching the disk 
inside the shutter could damage it. 
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Use the Trash 
\Xn1en you no longer need or want a file or folder, you throw it 
away by dragging its icon to the Trash. (A file can be eiLher a 
document or a program.) Practice using the Trash by throwing 
away the Practice folder, which you created when you copied the 
contents of your Practice disk onto Macintosh HD. 

1. Click the Macintosh HD icon to select it. 

2. Choose Open from the File menu. 

ibu choose Open by pointing to the File menu name, 
pressing to pull down the menu, dragging to the Open 
command so that it's highlighted, and releasing rhe mouse 
button. 

The Macintosh HD windm\' appears, showing you the 
contents of the startup hard disk. The contents should 
include the Practice folder. 

You may have to make the window bigger or use the scroll 
arrows to find the Practice folder. 

3. Click the Practice folder icon to select it. 



4. Drag the Practice folder icon to the Trash icon until 
both icons are highlighted, then release the mouse 
button. 

Both icons are highlighted when the tip of the arrow pointer 
reaches the Trash icon. 

When you release the mouse button, the Practice folder 
"disappears" into the Trash. When you put a file or folder in 
the Trash, the Trash icon bulges to indicate that it is no longer 
empty. 

5. Open the Trash icon. 

You open an icon by clicking it to select it and then choosing 
Open from the File menu. 

When you open the Trash icon, the Trash window appears. 
The Practice folder you've just thrown away is in the window. 
Anything you put in the Trash stays there until you empty the 
Trash. 

You can put anything that's in the Trash back where it was by 
clicking it to select it and then choosing Put Away from the 
File menu. (Or you can drag it back where it was.) 

6. Choose Empty Trash from the Special menu. 

A dialog box appears asking you to confirm that you want to 
permanently remove the contents of the Trash. If you change 
your mind, you can click the Cancel button. 

Clicking OK empties the Trash, and you lose anything that's 
in it. 

7. Click the OK button. 

Notice that the Trash icon no longer bulges, indicating that it 
is empty. 

8. Close the Trash window by clicking its close box. 
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On your own: Install your programs 
If you have any disks con raining programs (such t:lS word 
processing or grnphics) that you plt:ln to use on your Macintosh, 
install the programs now on your hard disk. If you do nor have 
any program disks yet, go to the next chapter. 

6 Important: Some programs need robe installed in a 
specific way, so follow the instructions that came with each 
program. 6 

If a program didn't come with specific installation instructions, 
these general instructions cell you how to copy the coments of a 
program disk Lo your startup disk: 

1. Lock the program disk. 

The program disk contains your master copy of the program. 
Locking the disk protects its contents but doesn't keep you 
from copying the con rems onto another disk. 

2. Insert the program disk into the floppy disk drive. 
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3. Drag the program disk icon to the Macintosh HD icon 
(your startup hard disk icon) until both icons are 
highlighted, then release the mouse button. 

Both icons are highlighted when the tip of the pointer arrow 
reaches the Macintosh HD icon as you drag the program disk 
icon. 

When you release rhe mouse bu tton, a series of messages 
briefly appears on screen to let you know that the computer 
is copying the contents of the program floppy disk onto 
Macintosh HD. The copy is in a folder on Macinrosh HD with 
the St:lme nt:lme as the program disk. 

4. Eject the program disk by making sure it's selected and 
then choosing Put Away from the File menu. 

5. If the Macintosh HD window is not on the desktop, 
open the Macintosh HD icon. 

When you open the Macintosh HD icon, the Macintosh HD 
window appears, showing you the contents of your startup 
hard disk. Among its contents is the program folder holding 
the contents of the disk you've copied. 

6. Click the program folder to select it. 



7. Choose Open from the File menu. 

The folder window appears, showing the contents of the 
program folder. The folder has the same contents as the 
program disk. 

8. Look for a System Folder in the program folder. 

Some program disks have a System Folder (so they can be 
used as startup disks). If the program disk vou \ re copied 
has a System Folder, you now have two System Folders on 
Macintosh HD. 

Throw away extra System Folders 
Your startup disk must have only one System Folder. W'henever 
you copy the contents of a program disk to your startup hard disk, 
check to see that you have not copied an extra System Folder. If 
you have, throw away the extra System Folder. 

1. Drag the extra System Folder to the Trash in the lower­
right corner of the screen until both icons are 
highlighted, then release the mouse button. 

2. Choose Empty Trash from the Special menu. 

A dialog box alerts you that you're about to throw away­
permanently-the contents of the 11-ash (in this case, the extra 
System Folder). 

3. Click OK to confirm that you want to throw away the 
contents of the Trash. 

4. Close the program folder window by clicking its 
close box. 

What next? 

Go to Chapter 4, where you.II learn how to create a document. 
Or rake a break. Remember to turn off your Macintosh if you'll 
be away for more than a few hours. 
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Chapter 4 

Creating a Document and 
Saving Your Work 
In this chapter 

You'll review how to 

• open a program 

• create a documem in a program 

• save your work 

• switch programs 

• close a document 

(The Macintosh Basics tour disk introduced you to these skills.) 

You'll also learn about 

• what happens when you open a program icon 

• why it's imporrant to save your work 

• rhe difference between application programs ancl system 
software 

It will rake about 30 minutes to go through this chapter. 

Before you begin 

You should have already 

• gone through Chapters 1 through 3 

If you turned off the Macintosh at the end of Chapter 3, turn it 
back on. 
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Open a program 
1b practice using a program to create a documenc and save your 
work, you can use 'JeachText, a simple word-processing program 
rhar comes with your com purer. 

1. If you closed the Macintosh HD window at the end of 
Chapter 3, open the Macintosh HD icon. 

Tb open the icon, cl ick ir to select it and rhen choose Open 
from the File menu. 

The Macincosh HD window appears, showing you the 
contents of your startup disk. The contents include a program 
called 'leach'lext. 

2. Open the TeachText icon. 

TeachTe-xt 

'lb open the icon, click it to select ir and then choose Open 
from the File menu. 
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When you open the Teach Text program, 

• an untitled window appears 

• 
• 

the menu bar shows TeachText menu names 

the Application menu icon in the right corner of the menu bar 
becomes the leachlext icon 

Application menu 
(Teach'lexc icon) 

-~· -

11__ __________ -£'.lg. :~J!WH' 

Untit led 'le3ch'lext window 

The unritled window contains nothing because you haven't 
written anything in it. It remains unritled unril you save 
wharever you've written and give it a name. The file that you 
create and name is called a document. 



Create a document 
The untitled window is like a blank sheer of paper, a document 
waiting robe created. In the upper-left corner of the empty 
documenr is a blinking vertical line. The line is called the 
insertion point, because it marks the place where the text you 
type will be inserted. 

As you type, you use the Macinrosh keyboard as you would a 
typewriter keyboard, except: 

• If you make a mistake, press the Delete key to backspace 
over it. 

• Don't press the Return key when you get to the encl of a line. 
Keep typing. The text will continue on the next line 
automatically. 

Type the following text: 

Sailing across an unknown sea , we saw the 
lights of a city in the d istant horizon . Was 
it another strange land , with strange and 
cruel people speaking different languages , 
eaLing different food , wearing different 
clothes? We wished it were home . 

You will be changing this text in the next chapter. 

Save your work 
Until you save your work, it exists only in the computer's 
memory-like thoughts that are lost unless you write them clown. 

1. Choose Save from the File menu. 

N(lll' :)(:N 

Open... :)[:!) 

Close :!CW 

Saue As ... 

Page Setup ... 
Print.. . :ICP 

Quit 

The dialog box that appears lets you name the document and 
decide where you wanr the computer to store it. 
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2. Type "Opening Lines". 

~---=I==· =M=o=ci::::nt:::o:::sh:::H:::O•::::=_I ~""="'= Macintosh HO 
D Heoll M•~ ~ [ Ejec1 ) 
D System Folder 
<ii lenchreu1 ( Desk top ) 

[ New LJ J 

Cancel J 

.____ _______ ___._'{}= ([ Soue JJ 

.._I ~-:~-~-,:-":_sl_i:o_e:-'--~m-e_n_t _us_: _ _.I ® EJ O ~ 

Because the word "Untitled" is selected (it's highlighted) 
when the dialog box appears, all you have to do is starr typing. 
Whatever you type replaces the selected text. You'll learn 
more about selecting text later. 

3. Click Save. 

ID Openln lines I 
Saf l fng across an unknown sea, we saw the light s of 11 city In the -0 
distant horizon. Wes It another st range land, wi th strange and 
cruel people speaking di fferent languages, eating different f ood. 
wear ing diff erent cl othes? We wished It were home! 

The window is now titled "Opening lines" and the document 
has been stored on Macintosh HD. 
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Save it or say so long 
You need to save your document before you turn off the 
computer. 

Using a Macintosh may seem like using a typewriter, pencil and 
ledger~ paintbrush and canvas, or pen and drafting paper-
but a computer is unlike those other tools in one important 
aspect: anything you create on a computer exists only 
temporarily in the computer's memory until you save 
your work . 

That is, until you tell the computer to record your creation 
on a disk, your finest work is no better than a mental note­
forgorten faster than you can turn off a switch. 



Switch programs 
The Opening Lines window is the active window and TeachText is 
the active program, but Teach Text is not the only program that's 
open. 

The Finder- the program that displays the Macintosh desktop­
is also open, but right now it is not active. (The Finder is always 
open when your Macintosh is on.) 

You can have several programs open at one time (how many 
programs depends on how much memory your computer has), 
but only one program at a time can be the active program. The 
active program is the one that's "on top" of other open 
programs-just as the active window is on top of other windows. 

1. Make the Opening Lines window smaller by dragging 
its size box and releasing the mouse button. 

After you resize the window, you should be able to see the 
Macintosh HD icon in the upper-right corner of the Macintosh 
desktop. 

2. Make the Finder the active program by clicking the 
Macintosh HD icon or anywhere on the desktop. 

The Finder becomes the active program. Notice that 

• the Macintosh HD window appears on top of the Opening 
Lines window 

• the menu bar shows Finder menu names 

• the Application menu icon in the right corner of the menu 
bar becomes the Finder icon 

* Fiie Ed it Ulew Lo bel Specia l 

Openln lines 
~. Salling across an unknown see, we saw the ligh ts of a city In the 

:: ~~~~~nple~~~8z;;~:~~ 1~1ar~~~~~ ~~~a~~e ~:~~~~~t h d~~~:~~~i°~:od. 
~ wearing Macintosh HD 

Notice the icon in the Macintosh HD window representing the 
document Opening Lines, which you've just created and 
saved on Macintosh HD. 

continues ...., 
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Two types of programs 
Programs that you use to do your work on the computer are 
called application programs, or applications, because they're 
ways of app~ying computer technology to the work that you do. 

Word-processing programs, for example, are applications 
because they enable you to write memos, reports, papers, 
theses, novels- whatever you need or want to write. And if 
your work involves creating graphics, calculating numbers, 
composing music, or keeping track of large amounts of 
data-there are application programs for your work as well. 

Most Macintosh programs work in similar ways, so most of 
what you le~rn using one application you can use in other 
applications. 

Programs that the computer uses to operate, on the other 
hand, are called system software (or "the operating system"). 

And then there's the Finder 

Between you and system software is an application called the 
Finder, which is the program that displays the Macintosh 
desktop. It's called the Finder because, like the viewfinder in a 
camera, it gives you a view of all the objects-disks, programs, 
documents-that you have in your computing work space 
(your "desktop"). 

Using the Finder, you can tell system software what you want it 
to do for you: which disks you want to use, which programs and 
documents you want to open, where you want files to be stored. 
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3. Make the Opening Lines window active by 
clicking anywhere in it. It's partially hidden by the 
Macintosh HD window. 

The Opening Lines window comes back to the top. It's now 
the active window, and Teach'Jext becomes the active 
program. 

You make a window active by clicking any part of it. The 
program that "owns" the window becomes active as soon as 
the window becomes active. 

4. Make the Finder the active program by choosing Finder 
from the Application menu in the right corner of the 
menu bar. 

You choose Finder by poinring to the Application menu icon, 
pressing to pull down the menu, dragging to the item 
"Finder" so that it's highlighted, and then releasing the mouse 
button. 

The Finder becomes the active program, and the 
Macintosh HD window becomes the active window. 



5. Make TeachText the active program by choosing 
TeachText from the Application menu. 

Hide Finder 
Hide Others 
Stiow flll 

./ l.2J Finder 
~Tea c: hTeHt 

'leachText becomes the accive program, and the Opening 
Lines window becomes the active window. 

From the Application menu, you can choose the open 
program that you want to make the active program. All open 
programs are listed in the Application menu. The icon at the 
top of the Application menu is the icon of the active program. 

Close a document 
When you close a document, you do not close the program that 
you used to create it. (Closing a program is called quftt;ng.) The 
program remains open and remains the active program until you 
quit the program or make another program the active program. 

1. If the Opening Lines window is not the active window, 
click anywhere in it to make it the active window . 

2. Close the Opening Lines window by clicking the close 
box near the left end of the title bar, or by choosing 
Close from the File menu. 

The Opening Lines window closes bur 'leachText is sti ll the 
active program. Notice that 

• the menu bar sti ll shows Teach Text menu names 

• the Application menu icon in the right corner of the menu 
bar is still the 'leachText icon 

What next? 

Go to Chapter 5, where you' ll learn how to revise your document 
and then print it. 

Chapter -1: Creating a Document and Saving Your Work 47 



Chapter 5 

Changing a Document and 
Printing Your Work 
In this chapter 

You'll learn how to 

• open a document 

• change a document 

• choose a printer 

• print a document 

• quit a program 

• make a backup copy of a document 

You'll also learn about 

• double-clicking as a way to open icons 

• using keyboard shortcuts 

Ir will rake about 40 minutes to go through this chapter. 

Before you begin 

You should have already 

• gone through Chapters 1 through 4 

Also, make sure that 

• your computer is connected to a printer 

A piinrer can be connected directly co your computer, or it can be 
connected through a network. 

Go to the instructions that came with your primer if you need to 
connect it to your computer. 

If your computer is connected to a network, find out from your 
network administrator (or the person who set up your computer) 

• which primer on the network you can use 

• where it is on the network (irs "zone," if the network has 
zones) 

• what its name is (every printer on a network has its own 
name) 

If you turned off the Macintosh at the end of Chapter 4, turn it 
back on. 
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Open a document 
When you open a document, the program that you used to create 
that document becomes the active program. 

1. If you closed the Macintosh HD window at the end of 
Chapter 4, open the Macintosh HD icon. 

To open che icon, cl ick it to select it and then choose Open 
from the File menu. 

The Macinrosh HD window appears, showing you the 
contents of your startup hard disk. The contents include the 
Teach Text program and the Teach Text document called 
Opening Lines, which you created in Chapter 4. 

2. Open the Opening lines icon. 

Q 
D 

Opening Lin es 

You can open an icon by double-clicking it: click the icon 
twice in rapid succession, without moving the pointer. 
Double-clicking an icon has the same effect as selecting the 
icon and then choosing the Open command. 
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\X~1en you open Opening Lines, Teach'Iexr becomes the active 
program. (Teach Text is the program that you used to create 
Opening Lines.) Notice that 

• the Opening Lines window appears 

• che menu bar shows Teach Text menu names 

• che Application icon in the righc corner of the menu bar 
becomes the TeachText icon 

• rue Edit 

110 OpeninQ Lines 
tseitling across en unknown see. we $G°W--the-ffghts of ft ctty In the 
cHs lonl horizon Wes it 1mother s tronge lend, with s trenge end 
cr1..1el people speaking c:llf ferent 1engueges. eeting different food, 
weering different clotnes? We wished it were home 

Change a document 
The Opening Lines window shows you the text you typed in 
Chapter 4. You will be making some changes to the text using 
techniques that work in most Macinrosh programs. 

Keep two things in mind: 

• The insertion point-the blinking vertical line-is where 
anything you type appears. 

• The I-beam pointer replaces Lhe arrow pointer when you're 
dealing with text. You control the I-beam pointer wich che 
mouse as you would the arrow pointer. 

I 



1. Locate the insertion point. It should be in the upper­
left corner of the document. 

2. Locate the I-beam pointer. If you don't see it, move the 
mouse slightly. The pointer moves as the mouse moves. 

Now you're ready to insert some text. 

3. Move the I-beam pointer to the immediate left of the 
word "an" (after "Sailing across"). 

4. Click. By clicking, you put the insertion point where 
you were pointing with the I-beam pointer. Anything 
you type is inserted at that point. 

I Openlnq Lines 
Selling ecross jan unknown see, we sew the lights of e city In t he 
dl stont horizon. Wes ll enother stronge lond, with stronge ond 
cruel people speaking different lenguoges, eotlng different food, 
weerl ng different clothes? We wished It were home. 

5. Type the words "the blackness of space, adrift in". 

If you make any typing errors, press the Delete key to 
backspace over rhem. 

Openlnq lines 
Soiling ocross the blackness of space, adrift 1n jen unknown see, 
we sow the light s of o city In the dis t ant horizon. Wes It another 
strange lond, with s trange end cruel people speaking different 
lenguoges, eating different food, wearing different clothes? We 
wis hed It were home. 

Nexr, you'll change some text. 

6. Move the I-beam pointer to the immediate left of the 
word "lights" (after ''we saw the"). 

7. Drag horizontally, selecting the word "lights", then 
release the mouse button. 

To drag, hold the mouse button down as you move the 
mouse. The selecred word is highlighted (surrounded by 
black or anorher color). 

l! D Opening lines Pili. 
Seiling across the blackness of spoce, odrlft In en unknown seo, 
we sow the 1111111 of e city in the dis tant hori zon. Wes It another 
s trange lend, with s trenge end cruel people speeklng different 
lenguoges, eating different food, wearing different clothes? We 
wished it were home. 

8. With "lights" selected, type the words "clear blue". 

Whatever you type replaces the text you selecred. If you make 
any typing errors, press the Delete key to backspace over 
them. 

9. Now move the I-beam pointer to the immediate left of 
the word "city" (after "of a"). 

Openinq lines 
Selling across the blackness of space, edrHt In en unknown seo, 
we sow the clear blue of o FllY In the distant horizon. Wes It 
enother s t renge lend, with s trenge end cruel people s peeklng 
different lengueges, eetlng different food, weari ng different 
clothes? We wished It were home. 

continues ~ 
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10. Drag horizontally, selecting the word "city'', then 
release the mouse button. 

' • ! - -_- --=-- - Opening Lines 
Soiling ecross the blackness of spece, adrift In on unknown see, 
we sew the cleor blue of o •In the distant horizon. Wes It 
enother strenge lend, with strenge end cruel people specking 
different longuoges, eeting different food, wearing different 
clothes? We wished It were home. 

11. With "city'' selected, type the word "planet". 

Whatever you type replaces the text you selected. 

12. Move the I-beam pointer between the letters "n" and "t" 
in the word "distant" (after "in the"). 

f i• ' ---=---------== Openlnq Lines 
Selltng ecross the blackness of spece, edrifl in en unknown see, 
we sow the cleer blue of e plenet In the dlste'* horizon. Wes It 
enother strenge lend, with strenge end cruel people speaking 
different languages, eetlng different food, wearing different 
clothes? We wished it were hOme. 
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13. Drag horizontally, selecting the letter "t" and the word 
"horizon", then release the mouse button. 

, ,. -- Openln.!!_ Lines 
Selling across the blackness of space, adrift In en unknown see, 
we sew the cleor blue of e planet In the dlste~ Wes It 
another strange lend, with strenge end cruel people speoklng 
different longuoges, eottng different food, wearing different 
clothes? We wished It were hOme. 

14. With "t horizon" selected, type the letters "ce". 

If the period is missing after "distance", type one now. 

!ID Openlnq Lines 
Soiling across the blackness of space, edrifl In on unknown see, 
we sow the cleor blue of o plonet In the dlstencij. Wes It another 
s trenge lend, with strenge end cruel people speaking different 
longuoges, eottng different food, wearing different clothes? We 
wished It were hOme. 

If you make any typing errors, press the Delete key co 
backspace over them. 



Save your work so far 
The changes you've made so far are nor part of Openi ng Lines 
uncil you save them ; that is, you need to tell the computer to 
record the changes in the document that's stored on Macintosh 
HD (your startup hard disk). 

Until you save them, the changes are in a very temporary, 
electronic state. You could lose them if power to the computer 
were interrupted or if a problem with a program caused the 
computer to stop working properly. 

Choose Save from the File menu. 

Or hold down the ~ (Command) key on the keyboard as you 
press the S key. Pressing ~-S is a keybuard shurtcut for choosing 
Save from the File menu. 

Save regularly, and save often. 

Taking a shortcut 
Many commands that you choose from menus can also be 
given using keyboard shortcuts. A keyboard shortcut is a 
combination of keys that you press at the same time to get 
the same result as choosing a command from a menu. One of 
the keys is always the ~ key or another modifier key. 

For example, instead of choosing Save from the File menu, 
you could press the ~ key and the S key together. 

You can find out the keyboard shortcuts for commands by 
pressing a menu name and looking at the commands in the 
menu. Any keyboard shortcuts are shown in a column next to 
the commands. 
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Make more changes to a document 
You've saved the changes you've made so far: the changes are 
now parr of the document that's stored on Macintosh HD. You 'll 
be making a few more changes before you're clone. 

You continue by moving some text to another place in the 
paragraph. 

1. Move the I-beam pointer to the immediate left of the 
words "We wished" (the start of the last sentence). 

2. Click. By clicking, you put the insertion point where 
you were pointing with the I-beam pointer. 

3. Move the I-beam pointer between the letter "e" in 
"home" and the period at the end of the last sentence. 

4. Hold down the Shift key on your keyboard and click to 
select the words "We wished it were home". 

Holding clown the Shifc key as you click selects the text 
between the insertion point and wherever you click. 

iiO Opening Lines -0~1 
Sai ling ccross the blcckness of space, adrift in en unknown sea, IO 
we sew the cl ecr blue of c planet in the di stcnce. Wes I t cnother 
st range lend, with strange end cruel peopl e specking diff erent 
languages, ecling dif ferent f ood, wearing di fferent clothes? n 
w 1 shed 1 t were home 
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;. With "We wished it were home" selected, choose Cut 
from the Edit menu. 

Choosing Cut removes whatever you've selected from the 
document and stores the selected material in a temporary 
electronic space called the Clipboard. 

Copy 
Paste 
Clear 

I~ 

:)(<2 

3€C 
3€U 

Select All 3€ A 

Show Clipboard 

6. Move the I-beam pointer to the immediate left of the 
words "Was" (in "Was it another strange land"). 

7. Click to set the insertion point. 



8. Choose Paste from the Edit menu. 

Select Rll 3€R 

Show Clipboard 

The words "We wished it were home" appear at the location 
of the insertion point. When you choose Paste, the Macincosh 
takes whatever's in the Clipboard and puts it in the document. 

Next, you'll delete a sentence. 

9. Drag the I-beam pointer across the words "Was it 
another strange land" to select them, then release the 
mouse button. 

If the words are on two lines, drag clown co the second line 
and release the mouse button when the pointer is to the 
immediate right of the word "land". 

'!n Opening Lines Pl! 
Selling across the blackness or spece, edrHt In en unknown see, 
we saw the clear blue or c planet in the distance. We wished It 
were home\ ·d, 11 onutl1er _ ,, ""1e lane, with strange and cruel 
people speaking different languages, eellng d1ffer ent rood, 
wearing di f f erent clothes? 

10. With "Was it another strange land" selected, choose 
Clear from the Edit menu. 

When you choose Clear, the Macintosh removes the selected 
text from the document. (Pressing the Delete key once has 
the same effect.) 

lJniio :)(<2 

Cut 3€H 
Copy 3€C 
Paste 3€U 
Clear . 

Select Rll 3€R 

Show Clipboard 

continues II> 
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11. Select the word "cruel" (after "strange and") by double­
clicking it. 

You can select a word by double-clicking it: point to it with the 
I-beam pointer and click twice in rapid succession, without 
moving the pointer. 

!ID Openlno lines • • 
Se111ng ecross the blackness of spece, edr1fl In en unknown see, IOI 
we sew the cleer blue of e plenet In the dlstence. We wished it 
were home, with s trange end m people speeking different 
lengueges, eet1ng different food, weer1ng different clothes? 

12. With "cruel" selected, type "wonderful". 

Whatever you type replaces the text you selected. 

13. Drag the I-beam pointer across the question mark 
(after "different clothes") and the stray period at the 
end of the paragraph, then release the mouse button. 

·k- -=-= --·_ -~- Openlno lines 
Se111ng ecross the bleckness of spece, edr1fl In en unknown see, 
we sew the clear blue of e plenet in the dlstence. We wished 1l 
were home, with strange end wonderful people speeking different 
lengueges, eeting different food, weerlng different clothe 
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14. With the question mark and the period selected, type 
a period. 

You may have left extra spaces or no spaces between words. 
If you did, position the I-beam pointer where you need to 
delete or add a space, click to set the insertion point, and 
press the Delete key or the Space bar as necessary. 

Openlno lines 
Selling ecross the bl eckness of spece, edrlft In en unknown see, --1-0-1 
we sew the cleer blue of e plenet In the distence. We wished It 
were home, with s trenge end wonderful people speaking different 
lengueges, eeting different food, weerlng different clothes! 

15. Choose Save from the File menu (or use the keyboard 
shortcut 3€-S). 



Choose a printer 
Before you can print a document, you have to tell the Macintosh 
which printer to use by choosing a printer in a program called the 
Chooser. 

You don't need to choose a printer every time you print. You need 
to choose one only when you wane to use a printer for the first 
time and whenever you decide to change printers. 

How you use the Chooser depends on whether your Macintosh is 
connected directly to the printer or connected to a network. 

If your printer is not on a network 

Make sure that you've connected the printer according to the 
instructions that came with it and that you know which port you 
used (on the back of the computer) to connect the printer. 

1. Choose the Chooser from the Apple menu. 

About TeachTeHt ... 

~ Alarm Clock 
llifil Calculator 

'°'Chooser I 
~ Control Panels' 
[@)Key Caps 
i;:J Note Pad 

~Puzzle 
ffiJ Scrapbook 

The Chooser window appears. 

continues .... 
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2. Click the icon representing the printer you want to use. 
Make sure the icon is selected. 

ID 

~ 
AppltShar• 

..... 
lllllmm!n 

~ 
LO AppltT ... qt'W'ritH" 

~ 
Ptn:on.11 .. .'w'ritf'r SC 

~ 
App~htk. .. igtW'rittr 

@ 
Lu t rVr1tt r 

~ 
LO~'w'nttr 

Chooser 

jQj I Select c port : 

lo! 

[Q] 

II 

0 Active 
AppleTclk @ Inactive 

jQj 

tQJ 

7.0 

·:· lf )lou bave a Personal l.aserWfriter SC, go ro srep 5 afrer you 
cl ick rhe Personal LaserWrirer SC icon. ·:· 

3. Click to select the icon representing the port that you 
used to connect the printer. 

You have rwo choices: the prinrer porr or rhe modem porr. 
The primer porr is auromarically selected. Click the icon rhat 
matches the icon of the porr (on rhe back of the computer) ro 
which you connecred rhe printer cable. 

4. Click the word "Inactive" next to the word ·~ppleTalk". 
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5. Close the Chooser by clicking the close box near the 
upper-left comer of the Chooser window. 

The Opening Lines window should now be rhe acrive window. 
(If ir isn'r, cl ick anywhere in ir ro make ir rhe active window.) 

If your printer is on a network 

Find our from your network adminisrraror (or the person who set 
up your comruter) which prinrer you can use, which zone if s in 
(if your network has zones), and whar its name is (every printer 
on a network has irs mrn name). 

1. Choose the Chooser from the Apple menu. 

~ Control Panels 

[@)Key Caps 

b:J Note Pad 

~Puzzle 
ffil Scrapbook 

The Chooser window appears. 



2. Click the word ·~ctive" next to the word ·~ppleTalk". 

If Active wasn't already selected, a dialog box appears. 
Click OK. 

IOI 

~ ~' 
A.ppl•Sh•r• AppleTalk. .. 9f''W'rit•r 

~ ~ > I 

~ !m19t 'w'rltt r 

AppleTalk Zones: 
i .. "1-! 

Loading 
No Parking 
0 
Taxi 
Testing 
Twihght 
Unloading 

Chooser 

I<> 

I . 0 

I Select a LaserWriter: 

I II Backside 
FaV 
Isadora Duncan NTX 
Jaunt (LW plus) 
Marathon (LW NTX) 
OMS Co 1 orScrl pt I 00 
Sojourn (LW NTX) 
Trek (NTX) 
nm me arr when yru·re done. 

0 

Background Printing: ® On O Off 

@ ACllYe 
AppleTalk 0 Inactive 

7.0 

3. Click the icon representing the type of printer you want 
to use. 

4. If you see a list of AppleTalk zones, click the zone 
where the printer is located. 

You may have ro cl ick the up and clown scroll arrows to find 
the zone. The zones are listed alphabetically. 

5. Click the name of the printer you want to use, even if 
it's the only one that appears. 

6. Click the close box near the upper-left corner of the 
Chooser window. 

If you changed printers, a dialog box appears. Click OK. 

The Opening Lines window should now be the active window. 
(If it isn't, click anywhere in it ro make ir the active window.) 

Print a document 
Once a printer has been selected in the Chooser, priming 
becomes a two-step process. To practice printing, use the 
Opening Lines document you creared. 

1. Make sure that the Opening Lines window is the active 
window, then choose Print from the File menu. 

New :)[( N 

Op!'IL.. :)[(!) 

Close 3€ W 
S<H•(~ :)((S 

Saue As ... 

Page Setup ... 

!iDTji &ii 
................................ ... ~ ...... 

Quit 3€0 

co111i11ues ..,.. 
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If the Opening Lines window is not the active window, click 
anywhere in it to make it the active window. 

The dialog box that appears when you choose Print offers you 
many options, depending on the program and the printer 
you're using. You can learn more about these options from 
the instructions that come with your programs and from 
Macintosh Reference, Parr 11 of this book. 

LoserWrlter " Isadora Ouncon NTH" n Print B 
Coples:limJ Poges: ® Rll 0 From: D To: D [ Cancel J 

Couer Page: ®No O First Poge O Los t Page 

Poper Source:® Poper Cossette O Monuol Feed 

Print: ®Block & White O Color/ Groyscole 

Oesllnotlon: ®Printer O Pos1Scrlpt8 Fiie 

2. Click the button labeled Print. 

The printer you chose prints your Opening Lines document. 

Quit a program 
Quitting a program closes the program as well as any documents 
you may have open that were created using that program. 
Quitting a program is nor the same as closing a document (which 
you did at the end of Chapter 4) . Closing a document leaves the 
program open and active. 
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• Make sure that the Opening lines window is the active 
window, then choose Quit from the File menu. 

N(m• :)[:N 

D(H~IL.. :)[:() 

Close X W 
S<ll•(l :)[:S 

Saue Rs ... 

Page Setup ••• 
Print... X P 

Quit , 3€0 

Or press the ~ key and the Q key together. 

·:· If a dialog box asks whether you want to save any changes, 
click Save. ·:· 

The Opening Lines document and the Teach Text program 
are closed, and the Finder, the program that displays the 
Macintosh desktop, becomes the active program. 



Make a backup copy 
Scoring a copy of your work on another disk is wise practice, like 
saving regularly and saving often. In case a file or an entire disk is 
damaged, you have a copy of the file on another disk as a backup. 
(It seldom happens, but if it happens once to you, it's happened 
once too often.) 

To practice making a backup copy, put a copy of Opening Lines on 
your practice disk. 

1. Make sure your practice disk is unlocked. 

A moveable tab on the back side of the case should be 
blocking the square hole near the lower-left corner (when you 
hold the disk as if to insert it), indicating that the disk is 
unlocked. 

2. Insert the practice disk in your computer's floppy disk 
drive. 

The Practice disk icon appears on the desktop, directly below 
the Macintosh HD icon. 

3. Drag the Opening Lines icon to the Practice disk icon 
until both icons are highlighted, then release the 
mouse button. 

Cl) ~ 
:~:~:~:~ :~:~: ~:~:~ :~ : ~ :~:~:~:~ :~:~:~:~ :~ :~ :~:~ :~:~:~:~:~:~:~:~:~:~:~ :~:~:~:~ :~:~:~:~:~: ~: ~: ~:~:~:~: ~ :~:~:~ :~ : ~:~:~:~:~:~:~:~:~: 

t!: 
____ -----11§ ::::::::::::::::::::::rn::::::::::::::::::::::: ~:i:i:i :i:i:i:~ :::~:::::: 

34 2 MB available :.;.;.;.;.;.;.;.;.;.:.;.;.;.;-:-:-:-:-:-:-:Macintosh HD :-: 

I 
l!l·Ndlft.141&$1 

Both icons are highlighted when the tip of the pointer arrow 
reaches the Practice disk icon. 

When you release the mouse button, the Macintosh copies 
the contents of the Opening Lines icon to the Practice disk. 

You copy an icon when you drag it to a different disk. When 
you drag it elsewhere on the same disk, you are merely 
moving the icon. 

continues ~ 

Chaprer 5: Changing a Documenr and Printing Your Work 61 



4. Open the Practice disk icon. 

You open the Practice disk icon by clicking the icon to select it 
and then choosing Open from the File menu, or you can 
double-cl ick the icon. 

The Practice disk window appears, showing that a backup 
copy of the File, also called Opening Lines, is scored on the 
noppy disk. 

5. Eject the Practice disk from the disk drive. 

You eject the disk by cl icking the Practice disk icon ro select it 
and then choosing Put Away from the File menu. 

New Folder 3CN 
Open aco 
Print >)(<P 
I: los<~ Window :)(<UJ 

Get I nfo 3C I 
0U!>liC<l1 (~ :)(:!) 

Make Rlias 

~.!!!.i.~.'..!.'~~·*·-·--'.~l!.!1 
Find ... 3CF 
Find Rgain 3C G 

Page Setup ... 
Print Desktop .. . 
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What next? 

Go to Chapter 6, where you'll learn how ro organize your work. 
Or take a break. Remember ro turn off your Macintosh if you' ll be 
away for more than a few hours. 



Chapter6 

Organizing Your Work 
In this chapter 
You'll learn how to 

• make a copy of a document 

• change rhe name of an icon 

• save anorher version of a documenr under a different name 

• open a documenr while its program is rhe acrive program 

• organize icons in a folder 

• use an alias for a document or program 

• create stationery 

• throw away files you no longer want or need 

You 'll also learn about 

• the difference between Save and Save As 

• whar an alias is 

It wi ll take about an hour to go rhrough chis chapter. 

Before you begin 
You do not need to go through this chapter before you start 
learning how to use your Macintosh programs. 

You should have already 

• gone rhrough Chaprers 1 through 5 

If your Macintosh is off, turn it back on. 
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Make a copy of a document 
In the course of your work, you'll often want co make a copy of a 
document so you can preserve the original while making changes 
to the copy. To practice making a copy of a document, first create 
a new documenr, as you did in Chapter 5. 

1. If you closed the Macintosh HD window, open the 
Macintosh HD icon. 

'lb open the icon, click ii to select it and then choose Open 
from the File menu. Or double-click the icon. 

The Macintosh HO window appears, showing you the 
contents of your stanup hard disk. 

2. Open the TeachText icon. 

Tb open the icon, click it to select it and then choose Open 
from the File menu. Or double-click the icon. 

\\~1en you open the l eachText program, 

• an untitled window appears 

• che menu bar shows l eachlext menu names 

• the Application menu icon in rhe right corner of the 
menu bar becomes che TeachTexc icon 

The untitled window concains nothing because yuu haven't 
wriccen anything in ic. le stays untitled until the firsr time you 
save your work (name the document and score it on a disk). 
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3. Type the following text: 

Dear Mom and Dad , 

This letter is overdue , I know, but until I 
sat down to write, I had no idea how long 
overdue it is . Time sure flies when you 
don ' l twv~ ~nough o[ il . 

Julie and I are doing well . The dog is 
getting better all the time . How are you 
all? 

Remember: 

• If you make a mistake, press the Delete key co backspace 
over it. 

• Don't press the Return key when you get co the encl of a 
line. Keep typing. The cexc will continue on the next line 
automatically. 

• Press rhe Return key only when you want to start a new 
paragraph. 

• The inserrion point-the blinking venical line- is where 
che cexc you type will appear. 

• The !-beam pointer replaces the arrow pointer when 
you're dealing with text. You control the I-beam pointer 
with the mouse as you would the arrow poinrer. 



4. Choose Save from the File menu. 

The dialog box that appears lets you name the document and 
decide where you want the computer to store it. 

5. Type "Letter to Parents". 

le::> Macintosh HD""" I c::> Macintosh HD 

~) D1H~oio1.1 l.in<i~ 0 ( Ejt~1:1 l 
l.) Ht~Ol1 Mt~ 

CJ System Folder [ Desktop J 

~ ·r.~1u:hl"<m1 I New CJ J 

( Cancel ] 

I ~ ([ Saue ll 
Saue this document as: • ~ g 
I Letter to Parent~ I ® O 0 Q 

Usually you need to select text or set the insertion point 
before you type text. In this case, because "Untitled" is 
selected when the dialog box appears, all you have to do is 
start typing. Whatever you type replaces the selected text. 

6. Click Save. 

The window is now titled "Letter to Parents" and the 
document has been scored on Macintosh HD (your startup 
hard disk). 

7. Close the Letter to Parents window. 

To close the window, click the close box near the left end of 
the title bar, or choose Close from the File menu. 

The window closes, and TeachTexc remains the active 
program. 

8. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active program. Among the contents 
of the Macintosh HD window is the Letter to Parents icon, 
representing the document you created and saved. 

9. Locate the Letter to Parents icon in the Macintosh HD 
window. 

You may have to make the window bigger or use the scroll 
arrows to find it. 

10. Click the Letter to Parents icon to select it. 

I 
LeHet· to F.'..::it·erit::: 

conlinues ~ 
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11. Choose Duplicate from the File menu. 

I 

New Folder :ICN 
Open 3€0 
Print 3€P 
Close Window 3€W 

Get Info 3€ 1 
Wi1ttm•· '.la• 
Make Rlias ~ 
Put Humq ')(:'./ 

Find... :ICF 
Find Rgain 3€6 

Page Setup ... 
Print Window ... 

Another icon, labeled "Leuer ro Parents copy'', appears in the 
Macintosh HD window. Notice that the icon (as well as its 
name) is selected and that the Letter to Parents icon is no 
longer selected. 

Letter to its 

Letter to Parents co ' 
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Change the name of an icon 
You can change the name of any icon ro anything you like, using 
spaces, capital and lowercase letters, numbers, and any other 
characters except a colon (:). If you open the icon, you'll see that 
the name of its window has also changed. 

1. Drag the "Letter to Parents copy" icon away from the 
original icon so that the two icons do not overlap. 

2. Click the name (not the icon) "Letter to Parents copy" 
(even if the icon is selected). 

When the name is selected, it is highlighted and a box appears 
around it. Notice that when you point to rhe selecrecl name, 
the arrow poinrer becomes an I-beam poinrer. 

11uul-._1 

3. With the name selected, type "Letter to Sister". 

Or drag the I-beam poinrer over the words "Parents copy" to 

select them, and then type "Sister" to replace them. 

Another way to select a word is to double-click it: click 
anywhere inside the word twice in rapid succession, without 
moving the pointer. 

Whatever you type replaces the selected text. 



4. Press the Return key. 

[J1 
D 

Letter to Pa rents 
I 

Li:-ttt?r tci Sisti:-r 

Now you have rwo documents. One is a copy of the other bur 
they have different names. You can revise one without 
changing the other. 

5. Open the Letter to Sister icon. 

'lo open the icon, click it to select it and then choose Open 
from the File menu. Or double-click the icon. 

Teach Text becomes the active program. 

6. Drag the I-beam pointer over the words "Mom and 
Dad" to select them. 

letter to Sister E!ll 
Deer 11m1111101gm1. 10 
This letter ts overdue, I know, but until I set down to wri te, I hod 
no tdee how long overdue ll 1s. Time sure fltes when you don't hove 
enough of tl. 
Julie end I ere doing well The dog ts gelling better ell the lime. 
How ere you ell? 

7. Type "Sis". 

Whatever you type replaces the selected text. 

Letter to Sister E!J1 
Deer St_,, 
Thts letter Is overdue, I know, but until I sol down lo write, I hed 
no ldee how long overdue tl is. Time sure files when you don't 
hove enough of It 
Julie end I ere dotng well. The dog Is gelli ng better ell the lime. 
How ere you ell ? 

8. Choose Save from the File menu. 

9. Choose Close from the File menu. 

Or click the close box near rhe upper-lefr corner of the Letter 
co Sister window. You now have two slightly clifferem versions 
of your letter: one for your parents, and the other for your 
sister. 

Teach Text remains the active program. 
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Save another version of a document 
There is another way to make a different version of a document. 
You Giil stay in the program you're using to create the document 
and save a different version under a different name. 

1. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active program. 

2. Open the Letter to Parents icon. 

'lb open the icon. click it to select it and then choose Open 
from the File menu. Or double-click the icon. 

Teaclflext becomes the acti\'e program. 

3. Drag the I-beam pointer over the words "Mom and 
Dad" to select them. 

4. Type ''Juan". 

Whatever you type replaces the selected text. 

IDP ... S Letter lo Parents 0 § 
Deor Ju•1. IO 
This letter Is oYerdue, I know, but until I sot down t o write, I h6d 
no tdee how long oYerdue it ts . Time sure flies when you don't have 
enough of It. 
Julie end I ore doing well. The dog 1 ~ getttng better ell the time. 
HEJW ere you oll? 
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5. Choose Save As from the File menu. Do not choose 
Save. 

N (Hll :)(<N 

f) (H? ll ,, , :)(• f) 

Close 3C W 
Saue 3C S 
Saue Rs ... 

Page Setup ... 
Print ... 3CP 

Quit 360 

Choosing Save would change the original leuer (so that the 
letter lO your parenrs \\'ould read "Dear Juan··). 

Choosing Save As, in contrast, lets you create a new document 
based on the original document, but including the changes 
you made. 

The dialog box that appears lets you name the new document 
and decide where you want the computer ro store it. ''Lener 
to Parents," the name of the original documem, is already 
selected and ready t0 be changed. 



6. Type "Letter to Juan". 

l=Moclntosh 110"' l = Macintosh llD 

D le11er lo Parnnh IQj [ [ject ) 
D let1e1 l o \ 1s lci 
D Opening l111<1• 

D Reo11 Me 
D System Folder 
~ Ieoi:llleic1 

( Desktop J 

( New Ll ) 

( Concel ) 

I loJ (( Soue J 
suue this document os: Q g 

j Le ttertoJun~ I ®D OQ 

Whatever you type replaces the selected text. 

7. Click Save. 

The new document, "Lener to Juan," now appears in the 
active window, replacing the original document, "Lener to 

Parents." Notice that the window's title bar now says, ''Letter 
to.Juan··. 

The original document is set aside, unchanged (if you open it, 
you'll find that the first line is still .. Dear Mom and Dael"). 

Save?-or Save As? 
Choosing Save scores the changes you've made to the active 
document (the document in the active window) since you 
opened it or since the last time you chose Save. 

Choosing Save As, on the other hand, creates a new 
document that includes the changes you've made. Save As 
sets aside the original document without storing the changes 
(in other words, the 01iginal document remains unchanged 
from when you opened it or last chose Save). 

After you give the new document a name, it replaces the 
original document in the active window. The title bar of the 
active window shows the name of the new document. 
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Open a document while its program is the 
active program 
You can open a document wirhour making rhe Finder rhe acrive 
program and rhen opening irs icon on rhe Macintosh desktop. 
You can open a document while lhe program thar you used to 
create ir remains rhe active program. 

1. Close the document "Letter to Juan." 

Click rhe close box near the upper-lefr corner of the 
document window or choose Close from rhe File menu. 

TeachTexr remains rhe acrive program. 

2. Choose Open from the File menu. 

I: lose ))(:UJ 

The dialog box thar appears lers you find the document you 
want ro open. 
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3. Click "Letter to Parents." 

I= Macintosh Ho..- I 
D l etter t o Juen {} 

b · •r:.f! I I • 

D l e tter to Sister "If" 

D Opening lines 
D Read Me 
CJ System Folder 

izy 

4. Click the Open button. 

= Macintosh HD 

[ ~·ci J 

[ Desk top ) 

[ Cancel J 

([ Open JJ 

The ·'Letter to Parents"' documenr window appears. 

Organize icons in a folder 
Sooner or larer, in the course of your work, you'll have too many 
documents and programs to keep track of easily. The Macintosh 
offers numerous tools and techniques (all of rhem explained in 
/vlacintosb Reference, Part ll of this book) w help you organize 
your work. Creating a folder and purring files in it is the simplesr 
wav. 



1. If "Letter to Parents" is open and TeachText is the active 
program, choose Quit from the File menu. 

The Finder becomes the active program. 

2. If the Macintosh HD icon is not open, open it. 

The Macintosh HD window should be the active window. 

3. Choose New Folder from the File menu. 

Opi~n • :)(:!) 

f>rin t :)[:f> 
Close Window 3CW 

An icon named "untitled folder" appears in the Macintosh HD 
window. The icon, including irs name, is already selected. 
(The name is highlighted and has a box around it.) 

~ 

4. Type "Letters to Family''. 

-

Whatever you type replaces the selected text. If nothing 
happens when you type, cl ick the name so that a box appears 
around it and then try again. 

5. Drag the Letter to Parents icon to the new folder icon 
until both icons are highlighted, then release the 
mouse button. 

I 
Letter to P at-ent::: 

~ 
D 

Letter to Juan 

;-·······, 

, ........... .! .J.. 
L....... · ·~ 

Lettt?t""s teo F.~mil1.1 

g 
D 

Letter to Sister 

co111i111.1es IJl> 
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6. Drag the Letter to Sister icon to the Letters to Family 
folder icon until both icons are highlighted, then 
release the mouse button. 

I 
r······~ 

, ..........•. ' .......... , . . . . . . . . ··········· ......... .. 
Letter to Sister Letters to F amill.l 

The Letters to Family folder now contains Lener co Parents 
and Letter ro Sister. You can open the Letters to Family folder 
icon if vou wam to make sure that they are there. 

Use an alias 
As you work, you may find it handy to have the same program or 
document stored in more than one folder, so you can open it 
quickly when you're in a parricular folder. 

1. If the Macintosh HD icon is not open, open it. 

The Macintosh HD window should be the active window. 
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2. Choose New Folder from the File menu. 

An icon named '·umitled folder'' appears in the Macintosh HD 
window. The icon, including its name, is already selected. 
(The name is highlighted and has a box around it.) 

3. Type "October Letters". 

-

Whatever you type replaces the selected text. 

4. Open the Letters to Family folder icon. 

5. Click the Letter to Sister icon to select it. 

I 
Letter to Sister 



What's an alias? 

An alias is a way to represent a program or document in any 
folder without having to make a copy of the file. An alias 
merely "points" to the original file that it represents, so when 
you open an alias, you're actuaJJy opening the original file. Any 
changes you make and save are stored with the original file, 
so you see them when you open any of the aliases for the 
original file (you can make as many aliases for a program or 
document as you need). 

~~ 
A l~·s Ot·i9in .~ 1 

~~ 
A H.:.·s Ot·i9ina 1 

You could make copies of a program or document and put 
them in separate folders, but the copies would take up much 
more room on your disk than a single copy. And if you want 
the copies to be always exactly alike, you 'd have ro make the 
same changes to each copy if you make any changes to one 
copy. 

Using aliases instead of making copies of a program or 
document lets you save space on your disks. 

6. Choose Make Alias from the File menu. 

New Fold er 3€N 
Open 3€0 
Print 3€P 
Close Window 3€ W 

Get Info 3€ 1 
Duplicate 3€0 
Make Alias IJ 

An icon named "Lerter to Sister alias" appears on top of the 
Lcw.:r w Sister icon. The icon and its name are already 
select.eel. 

Letter to •r 

1..etter to s;ster al~s 

Note that the name of the alias appears in italics. The name of 
an alias appears in italics so you have a way to tell which icons 
are aliases. 

co11ti1111es II>-
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7. Drag the Letters to Family window to the right. You 
should be able to see the October Letters folder in the 
Macintosh HD window behind it. 

8. Drag the Letter to Sister alias to the October Letters 
folder in the Macintosh HD window, then release the 
mouse button. 

Macintosh HD 
71tems Letters to Famll Em 

3items 3.6 MB in disk 34.4 MB ~nlllbi. 

Rea~.~ 51 B -' i l•ttff to Pannts 

IM@.Mr:::::! 
r.21 
D 

L•tter to Juan 

B l•tttr·~·.,. 
IB$1AMMM 

l-0-
i!> 

You may have to change the size and position of the Letters to 
Family window so you can see both icons. 

9. Open the October Letters folder icon. 

10. Open the Letter to Sister alias icon. 

TI1e document Letter to Sister opens, and 'Ieach1ext becomes 
the active program. 

The insertion point (the blinking vertical line) should be at 
the beginning of the document, to the left ofD in "Dear''. 
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11. Type "16 October 91" and press the Return key once. 

Letter to Sister Pill 
16 October 91 Ii> 
joeer Sis, 
This letter is overdue, I know, but until I sat down to wnte, I had 
no idea how long overdue It Is. Time sure flies when you don't have 
enough of it. 
Julie and I ere doing well. The dog is getting batter all the time. 
How are you all? 

12. Choose Save from the File menu. 

13. Choose Close from the File menu. 

The Letter to Sister document closes, and TcachTcxt remains 
the active program. 

You can open the original Letter to Sister icon (in the Letters 
to Family folder) and see that it is now dated 16 October 91. 

Letter to Sister is now available in both the Letters to Family 
folder and the October Letters folder. By keeping the original 
in one folder and an alias in the other folder, you have access 
to the same letter from either folder. 

14. Close all the windows on the desktop. 



Create stationery 
In your work, you may find it convenient to have a documenr that 
serves as the comrMer equivalenr of stationery, like a memo pad 
or "While You Were Out" form. Each rime you need a sheer, you 
rake one from your endless supply of stationery and fi ll it in. 

To practice creating stalionery, create a document in kach'lexr 
that works like a memo pacl. 

1. With TeachText the active program and no TeachText 
window open, choose New from the File menu. 

3€0 

Close 8UJ 
Sape 8S 

If Teach Text is not the acrive program, open the ·ieach'lext 
icon in the Macintosh HO windo\\', or choose TeachText from 
the Application menu. 

An untitled Teachkxt window appears. 

2. Type the following text: 

DATE : 

TO : 

FROM : [Type your name here . l 

RE : 

3. Choose Save from the File menu. 

The dialog box that appears lets ~1ou name the clocumenr and 
decide where you wanr the computer LO srore it. 

·:· (f'Macintosb HD does not appear ahol'e tbe list, click 
Macinrosh HD above the Eject button. ·:· 

4. Type "Memo Pad". 

J= Macintosh HD..,.. I = Macintosh 110 

D le11<ff 1o .Junn <> [ E,ler.t ) 
CJ l e tters to Family 
CJ October letters [ Desktop ) 
Cl lllH~nmq line~ ( ,......, ) 
D tlt~lld '1e New L...J 

CJ Syst em Folder 
<ll reoct1Ten1 J Cancel ) 

I @ ([ Soue D 
Saue this document os: I ® Q O r;J 
I Memo Po~ 0 Cf! 
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Because ·'Untitled·' is selected when the dialog box appears, 
all you have co do is start typing. Whatever you type replaces 
the selected text. 

5. Click Save. 

The window is now ticled "Memo Paci" and the documenr has 
been srored on Macintosh HD. 

6. Close the Memo P'ad document. 

1b close the window, click the close box near the left encl of 
the title bar, or choose Close from the File menu. 

The window closes, and TeachText remains the active 
program. 

7. Click the Macintosh HD icon, the Macintosh HD 
window, or anywhere on the desktop. 

The Finder becomes the active program, and the Macinrosh 
HD window becomes the active window. Among its contents 
is the Memo Paci clocumenc icon. 

8. Click the Memo P'ad icon to select it. 
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9. Choose Get Info from the File menu. 

Duplicate 
Make Rllas 

ll€N 
3€0 
9€ P 
ll€W 

3€0 

The Info window that appears contains information on the 
selected icon. 

10. Click "Stationery pad" near the lower-right corner so 
that an X appears in the checkbox. 

l~D~ Memo Pod Info 

13 MomoP..i 

kind : r.~r.xt s:b\ionfrv pid 
Stz:e : I K on disk ( 1'9 ~tH ustd) 

Yher• : Ml<:Wltos.h HD: 

Cr•ait•d : Tut,~ 3, 1991, 6 :57 AM 
Modified : Tu•,~ 3, 1991, 6:57 AM 
Y•rsion : not 41Y.\il~le 

Comm•nts: 

0 Lock• d ~ Sbtion•r\t paid 



Clicking "Stationery pad" converts Memo Pad from an 
ordinary clocumenr to a stationery pad. When you open a 
stationery pad, an untitled window appears showing a blank 
"form., from that stationery, or a dialog box appears asking 
you ro name the new document. 

You cannot change the stationery pad itself un less you turn 
it back into a regular document. You do this by opening the 
stationery pad 's Info window and clicking "Stationery pad., 
again to remove the X. 

11. Close the Info window. 

To close the windO\\", click the close box near the left encl of 
the title bar, or choose Close \Xfinclow from the File menu. 

Note that the Memo Pad icon has changed from an ordinary 
document icon to a stationery pad icon. 

Q 
Q 

Memo Pad 

On your own: Fill out some stationery 
Open the Memo Paci stationery pad icon and type a short memo. 

Remember to click the I-beam pointer where you wane your text 
to appear before you start typing. Clicking in this way sets the 
insertion point (the vertical blinking line). 

Choose Save from the File menu, name your memo. cl ick the 
Save button, and choose Quit from the File menu. 

Note that the Memo Paci stationerv icon remains in the 
Macintosh HD window. The icon for the memo vou created 
(an ordinary document icon) should also be in the window. 

What next? 

Go to Chapter 7, where you'll learn how to find out more about 
vour Macintosh. Or rake a break. 

Remember to turn off your Macintosh if you ·11 he away for more 
than a few hours. 
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Chapter 7 

Learning More About 
Your Macintosh 
In this chapter 
You ·111earn how ro 

• use rhe Balloon Help sysrem 

• use 1Hacintosb R~ference, Parr II of this book 

You'll also learn about 

• the contents of !Vlacintosb Reference 

Ir will rake about 20 minures to go rhrough rhis chapter. 

Ar the end of rhis chaprer, you'll be ready to srnn learning rhe 
programs that you intend to use on rhe Macintosh. 

Before you begin 
You should have already 

• gone through Chapters 1 rhrough 6 

If you turned off the Macintosh at the end of Chapter 6, turn ir 
hack on. 



Use Balloon Help 
Balloon Help explains the function or significance of icons, 
menus, commands. and orher fearures on the Macintosh screen 
using balloons similar to those you see in comic strips. The 
balloon points to the object it explains. 

Many Macintosh programs have Balloon Help. 

1. Point to the Help icon near the right end of the menu 
bar. 

2. Press to pull down the Help menu. 

, 

3. Drag to the Show Balloons command (the second item 
in the Help menu) so that it is highlighted, then release 
the mouse button. 

Finder Shortcut s 

After you choose Show Balloons, balloons containing explanatory 
text appear next to objects that you point to on screen. 
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4. To show a balloon describing the Wastebasket, point to 
the Wastebasket icon. 

Except for the fact that balloons appear next to objects that 
you poim ro, the way you work is the same: you can select 
icons, choose commands, and so on. 

; . Point to the Macintosh HD icon (your startup hard 
disk). 

A balloon appears next to the icon. 

6. Click the Macintosh HD icon to select it. 

You can select the icon even with the balloon showing. 

7. Point to the File menu. 

A balloon appears next to the menu name. 

8. Press to pull down the File menu. 

The balloon disappears when you pull clown rhe menu. 

9. Slowly drag to the Open command so that it is 
highlighted, then release the mouse button. 

Notice that a balloon appears next to a command if you pause 
briefly as you drag past it. 

The Macinrosh HD window becomes the active window. To 
see more balloons, you can point to different pans of the 
window and to different icons in the window. 



10. Choose Hide Balloons from the Help menu. 

Finder Shortcuts 

To choose Hide Balloons, point to the Help icon in the menu 
bar, press to pull clown the Help menu, drag to the Hide 
Balloons command so that the command is highlighted, ancl 
release the mouse button. 

Hide Balloons and Show Balloons replace each other in the 
Help menu (after you choose one, the other appears in its 
place). 

Use Macintosh Reference 
Macintosh Reference, Part II of this book, contains all the 
information you need to use your computer effectively and 
efficiently. Unlike Parr I, which is meant to be read from beginning 
to encl, Parr II is meanr to be used like a dictionary: you turn to it 
when you need to look up some information, and then you read 
only that information. 

To help you find the information, this book has a table of 
contents, an index, a glossary, and a summary after Chapter 16 
(on the green pages). To practice using the reference, look up a 
few topics that you'll probably need to know about in the near 
future. 

1. Find "Cleaning the mouse" under Chapter 15 in the 
table of contents. 

2. Go to the page that you're referred to and read about 
how to clean the mouse. 

3. Use the index to find information on erasing floppy 
disks. 

Erasing a disk is the same as initializing. Initializing a new disk 
is explained in Chapter 3 of this book. 

Several index entries refer you to the information you need. 

• You could look under "disks" and find "erasing." 

• You could look under "erasing" and find "disks." 

• You could look under "floppy disks" and find "erasing." 

co11ti1111es II> 
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What's in Macintosh Reference 

Parr II of this book, Macintosh Reference, has almost no 
information on using application programs. Your best source 
of information aboll[ a particular program is the set of books 
and disks that came with that program. 

Macintosb Reference has detailed information on 

• setting up your system software 

• using hard disks and floppy disks 

• organizing your files 

• adapting your Macintosh to your own use 

• printing 

• using ),Our Macintosh on a network 

• expanding your computer system 

• care and maintenance 

• rips and troubleshooting 

The serup book char came with your computer has 
information on the features specific ro your particular model. 
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4. Go to the pages that you're referred to and read about 
erasing disks. 

Some of the pages are about initializing disks. 

5. Find "Glossary" in the table of contents. 

6. Look up "keyboard shortcuts" in the glossary. 

Using keyboard shortcuts as a way of choosing commands is 
explained in Chapter 5. 



What next? 

Congrmulations. You've gone through the lvlacintosb Basics tour 
and you're clone with Learning Macintosh, Pan I of this book. 
You've been introduced to and practiced everything you need to 
know to start using the Macintosh in a productive way. 

There is more to learn before you're using your computer in the 
most effective and most efficient ways-but you'll be learning 
those ways as you use your programs and gain more experience 
with the Macintosh. 

At this point, you could 

• stan learning how to use your Macintosh programs 

• go to Chapter 11 to learn about ways to adapt your Macintosh 
co your speci fic needs or preferences 

• go to Chapter 13 to learn about using your Macintosh on a 
nerwork with printers and other computers 

• rake a break 

To help you find information in rhis book, use the table of 
contents; the index; the glossary; or the summary, "Working on 
the Macintosh Desktop," on the green pages after Chapter 16. 
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Part II 

Macintosh Reference 
Chapter 8 Setting Up Your Macintosh System 

Chapter 9 Hard Disks and Floppy Disks 

Chapter 10 Organizing Your Files 

Chapter 11 Adapting Your Macintosh to Your Own Use 

Chapter 12 Printing 

Chapter 13 Using Your Macintosh on a Network 

Chapter 14 Expanding Your Macintosh System 

Chapter 1; Care and Maintenance 

Chapter 16 Tips and Troubleshooting 

Summary Working on the Macintosh Desktop 

Use this part of the book as you would a diction my or 

encyclopedia: Titrn to it when you need specific information, 

and then read only those parts that give you that information­

so you can go on with your work. 

Macintosh Reference contains liule or no information on how co 

use your application programs. If you need information on a 

particular program, go ro the books and disks cliac came with that 

program. 

If you're new to computers or new to the Macintosh, go through 

the Macintosh Basics rour and Part I of chis book, Learning 

Macintosh, to learn basic Macintosh skills before you use 

Macintosh Reference. 
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lb help you find information in this book, use the index and the 

table of contents. Also, use the summary, "Working on the 

Macintosh Desktop," on the green pages after Chapter 16 and 

the glossary at the back of the book if you're looking for short 

definitions or brief summaries of concepts and procedures. 

If you need information on setting up your Macintosh or any 

information on features specific to your particular model, go to 

the setup book that came with your computer. 
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disks that came with your application programs, and Balloon Help 

to find the information you need. 



Chapters 

Setting Up Your 
Macintosh System 
In this chapter 

• Sening up your computer hardware 

Health concerns associated with computer use 

Musculoskeletal discomfort 

Arranging your office 

Avoiding fatigue 

Whar about elecrromagneric emissions? 

Adjusting your keyboard 

• Serring up your system software 

Installing, reinstalling, or updating system software 

Srarting up with a floppy disk 

• Setring up your programs 

lnsrall ing a program 

Working with several programs at a rime 

Setting up your computer hardware 
For information on assembling the hardware components of 
your com purer system, go to the serup book that came wirh 
your Macintosh. 

If you're connecting your Macintosh to a printer, a modem, an 
exrernal floppy disk drive, an external hard disk drive, or other 
external devices, go ro the instructions that came with the device, 
or see Chapter 14, "Expanding Your Macintosh System." 

If you're connecting your computer to another Macintosh or w a 
printer on a network, see Chapter 13, "Using Your Macintosh on a 
Network." 
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Health concerns associated with computer use 

Muscle soreness, eye fatigue, and other discomforts and injuries 
sometimes associated with using computers can actually occur 
from performing any number of activities. In fact, misuse of the 
same muscles during multiple activities can create a problem that 
might not otherwise exist. For example, if you engage in nonwork 
activities chat involve repetitive slress on the wrist-such as 
bicycling-and also use your computer's keyboard improperly, 
you may increase your likel ihood of developing wrist problems. 
Preventing health problems is a multifaceted task that requires 
careful attention ro the way you use your body every hour of 
every clay. 

The most common health effects associated with using a 
computer are musculoskeletal discomfort and eye fatigue. We'll 
discuss each area of concern below. 

Musculoskeletal discomfort 

As with any activity that involves sining for long periods of time, 
using a computer can make your muscles sore and stiff. To 
minimize these effects, set up your work environment carefully 
(using the guidelines that follow) and take frequent breaks to rest 
tired muscles. 
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Another rype of musculoskeletal concern is repetitive stress 
injuries (RSis), also known as cumulative trauma disorders 
(CTDs). These problems can occur when a certain muscle or 
tendon is repeatedly overused and forced into an unnatural 
position. The exact causes of RSis are nor rurally undersrood, but 
in addition to an awkward posture, such factors as the amount of 
repetition, the force used in the acriviry, and the individual's 
physiology and lifestyle may affect the likelihood of experiencing 
an RSI. 

RSis did not suddenly arise when computers were invented; 
tennis elbow and wri ter's cramp, for example, are two well-known 
RS!s rhar have been with us for a long time. One RSI discussed 
more often today, however, is a wrist problem called carpal runnel 
syndrome, which may be aggravated by improper use of 
computer keyboards. This nerve disorder results from excessive 
pressure on the median nerve as ir passes through the wrist to the 
hand. 

This section offers extensive advice on selling up your desk, chair, 
and keyboard to minimize the possibility of developing an RSI. A5 
mentioned earlier, however, the effects of repetitive movements 
associated with using a computer can be compounded by those of 
other work and leisure activities to produce or aggravate physical 
problems, so proper use of your computer system must be 
considered as just one element of a healthy lifestyle. 

No one, of course, can guarancee that you won't have problems 
even when you follow the most expert advice on using computer 
equipment. You should always check with a qualified health 
specialist if muscle, joinc, or eye problems occur. 



Tb prevent discomfort and eye fatigue: 

• Arrange your work space so that the furni ture is properly 
adjusted for you and doesn't contribute ro an awkward, 
inappropriate working posture. 

• Take frequent short breaks ro give your muscles and eyes a 
chance co rest and refresh. 

The suggestions that follow should make your work more 
comfortable. 

Arranging your office 

Here are some guidelines for adjusting the furniture in your office 
to accommodate your physical size ancl shape. 

• An adjustable chair that provides firm, comfortable suppon is 
best. Adjust the height of the chair so your thighs are 
horizontal, your feet fiat on the fioor, and the backs of your 
knees slightly higher than the sear of your chair. 

The back of the chair should support your lower back (lumbar 
region). Follow the manufacturer's instructions for adjusting 
the backrest to fir your body properly. 

• When you use the computer keyboard, your shoulders should 
be relaxed. You upper arm and forearm should form a right 
angle, with your wrist and hand in roughly a straight line. 

You may have ro raise your chair so your forearms and hands 
are at the proper angle to the keyboard. If this makes it 
impossible to rest your feet fiat on the fioor, you can use a 
footrest ro make up for any gap berween the fioor and your 
feet. As an alternative, if you have a modular desk system, you 
can lower the deskrop ro eliminate the need for a footrest. 
Another option is to use a desk with a keyboard tray that's 
lower than the regular work surface. 

• If you use a mouse, position the mouse at the same height as 
your keyboard. When you slide the mouse around, move your 
entire arm; avoid resting your arm on the desk and simply 
bending your wrist as you move the mouse. 

• Arrange the computer so the top of the screen is at or sl ightly 
below your eye level when you're sitting at the keyboard. The 
best distance from your eyes to the screen is up to you, 
although most people seem ro prefer 18 to 28 inches (45 to 
110 cm). Position the computer to minimize glare and 
reflections on the screen from overhead lights and windows. 

If your Macintosh comes with a separate monicor, you may 
want to use a tiltable monitor stand. The stand lets vou set the 
monitor at the best angle for viewing, helping to reduce or 
eliminate glare from lighting sources you can't move. 
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Avoiding fatigue 

These tips will help you get the most out of your work sessions 
with rhe computer. 

• Change ~1ou r seated position, stand up, or stretch whenever 
you start ro feel tired. Frequent short breaks are helpful in 
reducing fatigue. 

• Use a light much when typing and keep your hands and 
fingers relaxed. 

Some computer users may develop discomfort in their hands, 
wrists, or arms after intensive work without breaks. If you 
begin to develop chronic pain or discomfort in your hands, 
wrists, or arms, consult a qualined health specialist. 

• Eye muscles must work harder LO focus on nearby objects. 
Occasionally focus your eyes on a distant object, and blink 
often while you work. 

• Clean your screen regularly. Keeping the screen clean helps 
reduce unwanred reflections. 
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What about electromagnetic emissions? 

There has been recent public discussion of the possible health 
effects of prolonged exposure to extremely low frequency (ELF) 
and very low frequency (VLF) electromagnetic fields. Such fields 
are associated with electromagnetic sources such as television 
sets, electrical wiring, and some household appliances-as well as 
computer monitors. 

Apple Computer has reviewed scientific reports and sought the 
counsel of government regulatory agencies and respected health 
organizations. Based on the prevailing evidence and opinions, 
Apple believes that the electric and magnetic fields produced by 
computer monitors do not pose a health risk. 

In response to those customers who wish to reduce their 
exposure to electromagnetic fields, Apple is taking steps to lower 
the emission levels of its products. Apple is also actively 
encouraging further scientific research so it can continue to 
promote the health and safety of its customers and employees. 



Adjusting your keyboard 

I f you bought the Apple Extended Keyboard II wirh your 
Macinrosh, or if you have the Apple Keyboard II, you can adjust 
the angle of the keyboard so that your hands and wrists arc 
relaxed and you're comfortable as you rype. 

The Macintosh Classic or Macintosh LC standard keyboard has 
tabs on either side that swing out under the keyboard, changing 
the angle of the keyboard on your desk. 

The Apple Extended Keyboard II has a sliding cab in the back that 
controls how much a bar extends under the keyboard, changing 
the angle of the keyboard on your desk. 

Apple Extended Keyboard II 

A bar extends 
as the slide is moved, 
increasing the 
keyboard angle. 
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Setting up your system software 
Your Macintosh cannot operate without system software-the 
programs and other files that the Macinrosh needs to start itself 
up and to run die application programs you use. When you turn 
on your Macinrosh, it looks for a disk chat conrains the system 
software (in a folder called the System Folder). Any disk that 
contains the system software is a startup disk. 

Almost always, the startup disk is a hard disk that's inside or 
connected co your computer. A floppy disk can also be a startup 
disk. 

I f your Macintosh cannot find a startup disk, it displays this icon in 
the middle of the screen: 

If you see this icon, you have to install system software on your 
computer 's internal hard disk (or an external hard disk chat you 
turned on before you wrned on your Macintosh). 

·:· {/you'ue already installed system sojiware and you see this 
icon, you may need to reinstall system software. See "Starting 
Up With a Floppy Disk" later in this chapter. ·:· 
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Installing, reinstalling, or updating system software 

You use the Installer program to install , reinslall, or update system 
software on a hard disk that you want to be able co use as a 
startup disk. 

6 Important: Before you install a new version of system 
software, make a backup copy of the old version on another 
disk in case you need ir ar a later time (to run a program that 
is incompatible with the new version, for example). 6. 

When you use the Installer to update your system software, you 
keep any fonts, sounds, drivers, and ocher files you may have 
installed in addition to standard system software. (You could 
throw away your current System Folder and replace it with the 
newer one, but then you'd lose those special files.) 

Before you begin 

To install, reinstall, or update system software, you need 

• an initialized hard disk 

• the set of Macintosh sysrem software disks chat came with 
your computer or that you purchased as a separate system 
software kit. If your disks came with your computer, the 
Installer program is on the disk named Install Me First. If you 
purchased the System 7 upgrade kit, the Installer program is 
on the disk named Install. 



If your Macinrosh is connecred to a nerwork and you have access 
ro rhe Insraller program and sysrem software on a Ale server or 
another com purer, you don'r need the system software disks. You 
can open rhe Insraller program and then follow rhe procedure 
below, beginning wirh step 4. 

If you have a hard disk thar hasn't been initialized (rhat is, irs 
icon cloesn'r even appear on rhe Macinrosh desktop), go to 
Chaprer 9, "Hard Disks and Floppy Disks," for instrucrions on 
inirializing a hard disk. 

.A. Warning: If you purchased a hard disk wirh rhe A/UX 
operaring sysrem insrallecl on it, do nor inirialize rhar disk; 
doing so will erase A/UX. See rhe instrucrions rhat came wirh 
rhe NUX operaring system . .6. 

Installing a standard system 

The Installer program's Easy Install dialog box lets you install the 
srandarcl sysrem software on your Macintosh. 

1. Turn off your Macintosh. 

2. Insert the Install Me First disk into the internal floppy 
disk drive. (Or, if you are using disks that came with 
the System 7 upgrade kit, insert the Install disk. You 
don't have the Install Me First disk.) 

If your Macintosh has two floppy disk drives, you can use 
either one. 

3. Turn on your Macintosh. 

The Insraller program opens automarically. 

4. Click OK or press the Return key on your keyboard. 

The Easy Install dialog box appears. 

Parts or the svstem 
software to h·c installed 

Easy Inst all 
,--
i Click lnst nll to updet e to Uersion 7.0 of 

H:ncintosh II Sy stem Software 
Any [Histing Printing Software 
File Sharing Software 

I ! on the hard disk named 

! ? Hnrd disk #2 
1-.. 

( Help ) 

Disk on which svstem 
software will be ·installed 

---

Button to switch 
ro a different disk 
ror installat ion 

t-------, 

([ lnst oll l) 

! 
I 

I 
I 
I 
I 
l 

( Eje< I Olsk ) 

L{ Swi tch Disk J 
·--·---···--.. ----·-·--

,.{ Customize J 
( Quit ) 

Button ro chan 'e to g a 
customized installation 

continues II> 
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5. Make sure that the hard disk indicated in the box is the 
one you want to install system software on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 

6. Click Install or press the Return key on your keyboard. 

The lnsraller begins ro install sysrem software for your 
Macimosh model. 

7. Follow the instructions that appear on screen. 

When a disk is ejected and you see a message instructing 
you ro insert anorher sysrem software disk, insert the disk 
specified. 

8. When you see a message reporting that the installation 
was successful, click Quit or press the Return key to 
quit the Installer program. 

If a message reports that installation was nor successful, follow 
the instructions on screen to try installing again. 

9. Click Restart in the dialog box that appears when you 
quit the Installer. 

The Macintosh restarts using the newly installed system (or 
using your currenr srarrup disk if you already have one). If you 
want ro change your startup disk, see "Designating a Hard 
Disk as the Startup Disk" in Chapter 9, "Hard Disks and 
Floppy Disks." 
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Installing a customized system 

Cuswm installation allows you ro select the combination of 
sysrem files, drivers, and other files you wanr for your own specific 
needs. You can also use custom installation ro install or update a 
single system software component or to save space on your 
startup disk by not installing files thar you don'r need. 

1. Turn off your Macintosh. 

2. Insert the Install Me First disk into the internal floppy 
disk drive. (Or, if you are using disks that came with 
the System 7 upgrade kit, insert the Install disk.) 

I f your Macintosh has two floppy disk drives, you can use 
ei ther one. 

3. Turn on your Macintosh. 

The Installer program opens auromarically. 

4. Click OK or press the Return key on your keyboard. 

The Easy Install dialog box appears. 

5. Make sure that the hard disk indicated in the box is the 
one you want to install system software on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 

6. Click the Customize button. 

The cusrom inscallation box appears. All parts of the system 
software are lisretl, anti you have a choice of scandard or 
minimal system software for each model of the ~lacinrosh 
computer. 



7. Scroll through the list of items and hold down the Shift 
key as you click the items you want to install. 

Click the items you want to select; 
Shirt-click to select multiple items. 

Software for lmageWrlter LQ tft 
Software for RppleTolk lmogeWriter LQ f"-
-·-------··-·--------·- ·---------------1;-,, 
RppleShore (workstation software) ··:.: 
File Shoring Software 

TokenTalk software IO 
j l .. ,s), ~ EthnT•lk SOftVU• 1 
' ~· Size · 221< I f .· o~t .. ; 'w'ed,Oct 16, 1991 

i ~ion: 7 .0 
j Thts ~·~ootuis the soft'W'.w• nHMd to un !Jotr J 
! HacintOSh in J;n EttwrT"lk n.twork. Alt EthKTalc card must b+ 

L::.::.:~~-~~:·~-~::_:~-~ft ... :_~·---··-----··-
Information about the item selected 

(( Install J) 

= Walthrop 

( [jec1 lli•k J 

( SmH1:t1 Dl•k J 

( Easy Install ] 

Quit 

·:· lfyou want to install a srnall :iystem to conserve space on 
your sranup disk, click the "Minimal sofrware" option. ·:· 

6. Important: Be sure to install the system software Ales that 
your Macintosh uses w communicate with the printers and 
any ocher devices you use. 6. 

8. Click Install or press the Return key on your keyboard. 

The Installer begins to install system software for your 
Macinwsh model. 

9. Follow the instructions that appear on screen. 

When a disk is ejected and you see a message instructing 
you to insert another system software disk, insert the disk 
specified. 

10. When you see a message reporting that the installation 
was successful, click Quit or press the Return key to 
quit the Installer program. 

If a message reports that installation was nor successful, follow 
the instructions on screen to try installing again. 

11. Click Restart in the dialog box that appears when you 
quit the Installer. 

Make a backup copy of the System Folder or its contents on one 
or more floppy disks (or on another hard disk), and keep the 
disks in a safe place. 

... {/your 1\tlacintosb is running ~}'stem G, you cannot use desk 
accessories and lh 1eType fonts supplied with System 7. Also, 
you may notice extra or missing folders on any disk that 
contains System 7. The contents of the System 7 disk will 
appear normally when you resume running System 7. ·:· 

.A. Warning: Your startup disk must have only one System 
Folder. Having more than one System Folder on your startup 
disk can cause your Macintosh to malfunction and cause you 
to lose information. Use the Find command (in the Finder's 
File menu) to see if there is more than one System Folder on 
your hard disk. ~ 
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Starting up with a floppy disk 

You need a hard disk as rhe startup disk ro use Macinrosh syscem 
software version 7, bur if you 're unable rouse your hard disk, you 
can stan up your Macinrosh b}' inserting rhe Disk Tools disk in 
the inrernal floppy disk drive and rhen turning on your compuLer. 
This disk contains programs that you can use ro initialize, rest, and 
repair disks. 

If your startup hard disk has malfunctioned, see "'lesting and 
Repairing Disks" in Chapter 9, "Hard Disks and Floppy Disks." 

Setting up your programs 
In addition LO seLUp information, this section describes how co 
work with more than one program ar a time. 

Installing a program 

You can inscall many application programs simply by copying 
rhem from the original disk co your hard disk. (Some programs 
have specific installation procedures. See Lhc.: insLrucLions that 
came with }'Olli. program.) 

Be sure you're ;Kting within the terms of the software license 
agreement before you install programs on a computer. The 
license agreemcnc specifies how many copies of the program you 
can make for yourself and others. 
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6 Important: Some program disks contain a System Folder. 
Whenever you copy the conccnts of a program disk to your 
startup hard disk, check that you have not copied an extra 
Sysrem Folder. If you have, throw away the extra Sysrem 
Folder. 6. 

Put only one copy of each program on your hard disk. Having 
more than one copy of the same program on rhe disk can lead ro 
problems when you're using rhe program. 

If you want co open a program automatically when you start up 
your Macintosh, go co "Speci~1i ng Which !rems You Want Opened 
ar Stanup'' in Chapter 11, ''.AdapLing Your Macintosh to Your Own 
Use'' for inscruccions. 

You can also put a program or an alias for it in the Apple menu, so 
you can open the program more conveniently. See "Installing an 
Item in rhe Apple Menu" in Chapter 11. 

~ Important: Keep the original program disk in a safe place as 
a backup copy. If the program on your hard disk malfunctions 
consistently, you can replace iL with a fresh copy from your 
backup disk. ~ 

I f a program malfunctions consisLcntly, and installing a fresh copy 
of the program does nor correct the problem, you may need ro 
find our from rhe software manufacturer whether rhe version of 
rhe program you have is compatible with the Macinrosh system 
software you're using. (You can often upgrade to Lhc latest 
version of a program at no charge or for a modest fee.) 



Checking for computer viruses 

ln recent years, "viruses"-malicious programs that damage files 
or erase disks- have become a significant problem for people 
who use computers. A virus can be introduced into your 
Macintosh system from a disk you or someone else puts in a disk 
drive, from a nernu rk device such as a file server, or from an 
electronic bulletin board service. 

You can use any of several virus-detection and -el imination 
programs to check your Macinwsh disks for viruses. Such 
programs arc available from user groups, computer bulletin 
boards, and dealers. 

Even if you don't notice problems with your computer's operation 
or with rhe information on your disks, you should check for 
viruses frequently if you exchange disks or information with other 
users. 

• Whenever you gee a disk from anyone-even if it's commercial 
software-check ir for \·iruses before using it or copying 
anyrhing from it to your hard disk. 

• Check your startup disk and mher disks regularly with a virus­
detecrion program and correct any problems it finds. 

• If your Macintosh is on a network or you use a modem to 
connect with information services or bulletin boards, check 
for viruses as often as it's practical- ideally, each time you 
copy any information from an outside source. 

• If you are pan of a work group that includes a number of 
Macinrosh users, set up a "virus-detection station" that 
everyone can use to check disks (and to copy the latest 
version of the virus-detection software your group uses). 

• If you give informat ion to other Macimosh users on disks or 
send information electronically, make certain tliac there are 
no viruses on your computer system before distributing the 
information. 

• Since new r iruses appear regularly, make sure you have the 
latest version of any virus-detection software. 

• To avoid compatibili ty problems, be sure to use only one 
virus-detection program at a time. 
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Working with several programs at a time 

You can keep as many programs ancl clesk accessories open at the 
same time as your computer's memory allows. 

All open programs are listed in the Application menu, which 
appears at the right encl of the menu bar. The active program's 
name has a checkmark nexr to ir, ancl its icon appears in the menu 
bar as the Application menu icon. 

Stmw HH 

./ i2J Finder 

~TeachTeHt 

Commands used to hide or 
displav windows currently 
open 

Open programs 

Chcckmark indic:Hcs the 
program curremh1 in use. 
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Switching programs 

You swiLch between open programs or desk accessories by 
choosing their names from the Application menu in rhe right end 
of the menu bar. 

If a program ·s icon is cl immecl in the menu, that means its 
winclows are hidden. You can choose it from Lhe Application 
menu to display its winclows. 

You can also click in a winclow that ·'belongs"' roan open program. 
or double-click a program icon (or the icon of a clocumem that 
was created in the program) ro make that program Lhe active 
program. 

Finding out what programs are open 

If you have several programs and winclows open, you can find out 
which program is active ancl \rhat ocher programs are open h}' 
pulling clown the Application menu. 



Hiding and showing windows on the desktop 

You can hide all the open windows except chose of rhe active 
program by choosing the Hide Others command in the 
Application menu. Though hidden. the other windows remain 
available. 

When rhe command takes effect, all windows except those 
belonging ro rhe active program arc hidden. 

The windows remain hidden until you S\\'itch ro anmhcr open 
program, at ,,·hich time that program's open winclO\\'S arc 
displayed. Jf you want to see rhe ,,·indO\\'S of all your open 
programs. choose Show All from the Application menu. 

Changing the amount of memory a program uses 

All open programs use a cerrain amount of your computer's 
random-access memory (RAi\I). Each program sets aside the 
amount of memory ir needs. (For more information. see "Tips for 
Using ~ lemory Efficienrly" ·" Chapter l l.) 

On rare occasions you ma~' need ro increase or decrease rhe 
amounr of memory a program sets aside for itself. You might wanr 
LO increase rhe amount so you can open more documents at 
once. or you might ,,·ant ro decrease it so you can open more 
programs at once. You adjust the program ·s memory size in irs 
Info window. 

1. Quit the program if it's open, and then click the 
program's icon to select it. 

co11li1111es ... 
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2. Choose Get Info from the File menu. 

The Info window appears. 

10~ TeachTeHt Info 

a TefChTtx t V 5\1s lt mSoftw¥t7.1 

Kind : applic~Uon pr09ram 
Sizt: 36K on disk (36,6S3 b\jlt s use-d) 

Yhtrt : Cup•rtlno Ddn 

Cr .. ted : ThtJ, Apr2S, 1991, 12:00PM 
Hodifitd : Thu, Apr2', 1991, 12:00PM 
Vers ion : 7.0, ()App" Computf'f', flc. Program manufacturer's suggested 

Commeots: .---+---- minimum memory 

r~------+--,J 
1~-1991 

r ·H• moriy requir•m•nts-~· ~., 
I S~sttd st:• : 192 K I 
• r.::;::;---i .. _L_ 'lb define the minimum memory I Minirnumsl«: ~K~ 

O L••••d L Pr.1 .. .,4 slz.: ~ K 1 you require, type the number here. 
The program won't open unless 
this much memory is available. 

To define how much 
memory you prefer the 
program to use, type a 

number here. When extra 
memory is available, the 

program uses this amount. 

Yciu cannot use a number larger 
than the "Preferred size." 

You can use a number smaller than 
the "Suggested size." 
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3. Drag across the box containing the number you want to 
change (either "Minimum size" or "Preferred size"). 

"Preferred size" can't be smaller than "Minimum size," but 
some program manufacturers set the "Minimum size" smaller 
than "Suggested size." If you are nor satisfied with a program's 
performance, type the "Suggested size" in the "Minimum size" 
box. 

4. Type the number of kilobytes (K) of memory you want 
the program to set aside for itself. 

• If you find that the program frequently runs out of 
memory, cry increasing both the "Preferred size" and the 
"Minimum size." 

• If you don't have much extra RAM on your computer, try 
lowering the "Minimum size." If you type a size smaller 
rhan "Suggested size," some programs will perform 
accepcably. Others may work more slowly, show other 
performance problems, or not work at all. 

5. Close the Info window. 

If you typed a number smaller than the "Suggested size," 
you'll see a message asking you to confirm your decision. 



Chapter 9 

Hard Disks ai1d 
Floppy Disks 
In this chapter 
• Initializing disks 

• Erasing a disk 

• Designating a hard disk as rhe sranup disk 

• Protecring the information on a clisk 

Locking a Floppy disk 

Locking a file 

Backing up your files 

• If you can·r save files on a Floppy disk 

• Ejecring a disk 

• Disk care 

Hard disk precautions 

• 'lesting and repairing disks 

Using Disk first Aid 

Testing a hard disk 

Initializing disks 
Ref ore you can use a new clisk, you need to initialize it- to 
prepare it so that the computer knows where to store and retrieve 
information on the disk. 

.A. Warning: You lose any information you may have on a disk 
when you initialize or reinitialize it . .& 

Most hard disks designed for use with the Macintosh are already 
initialized (rhat is, ready ro store information) when they leave rhe 
facrory. When new, the 3.5-inch (89-mill imeter) Floppy disks rhat 
your Macintosh uses need ro be inrializecl. 

IOI 



Initializing a hard disk 

If vou have a hard disk that hasn·r been initialized. its icon does 
not appear on screen when vou srarr up your Macintosh using 
another hard disk or a floppv disk as a swnup disk. (Sec 
Chapter 14, "Expanding Your Macinrosh Sysrem," if you need 
instrucrions on connecring a hare.I disk ro your compurer. See 
Chapter 8, ··setting Up Your .Vlacinrosh System," if you need ro 
creare a srarrup disk .) Make sure rhar mu rurn on the hard disk 
before you turn on your i\facinrosh. 

If your hard disk's icon does nor appear on screen, use the 
Apple HD SC Setup program, on rhe system software flopp~' 

disk labelccl Disk 'fools. ro initialize and name rhe disk. 

A Warning: If you purchased a hard disk \\'ith the A/UX 
operating system installed on it. clo not initialize rhar disk: 
doing so will erase A/UX See rhe insrrucrions rhar came wirh 
rhe A/UX opera ring sysrem. • 
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1. Locate the Apple HD SC Setup icon and open it. 

Apple HD SC Setup is on the system software floppy disk 
labeled Disk Tools. If vou·re alreaclr using a hard disk as a 
srartup disk, you can cor y the program ro ~1ou r starrup disk 
and open the program from there. 

.~~ ... 
IE'._J 

1. I 
App le HD SC Setup 

A dialog box appears. The name of the hard disk currently 
selected for initialization is shown as the "volume name.'· The 
SCSI ID number of the selcetccl hard disk is clisplayecl above 
the Drive button. (The ID number of an inrernal hard disk 
is 0. The ID number of an external hard disk is usually preset 
LO 5.) 

Apple HO SC Setup 

[ I nilialize J 

[ Update J 

[ Partition ) 

[ Tes t J 

([ Quit JJ 

scs1 oeutce: 0--11--- SCSI ID number 
of the currem 
hard disk 

~ The uolume na.:n-;-is Hard cfuk---1~ The name of the 
~ 112 current hard chsk 



2. If the "volume name" or the SCSI ID number shown 
does not belong to the hard disk you want to initialize, 
click the Drive button until the hard disk you want to 
initialize is the selected hard disk. 

You can nor initialize your currenr sranup disk or the disk that 
the Apple HD SC Setup program is on. 

3. When the SCSI ID number (and name, if any) of the 
hard disk you want to initialize is shown, click the 
Initialize button. 

A dialog box appears in which you must confirm or cancel 
your decision. 

4. Click the Init button to initialize the hard disk. 

Messages appear to update you on the initial ization process. If 
a message reports that initialization failed, begin the process 
again. 

5. In the dialog box that appears asking you to name the 
disk, type a name and then click OK. 

6. Click Quit when the message reports that initialization 
was successful. 

Initializing a floppy disk 

Before you can use a new noppy disk, you need to initialize 
it-prepare it so that the computer knows where to store ancl 
retrieve information on the disk . 

1. Insert your new floppy disk into the floppy disk drive. 

If you inserted a high-density disk, this dialog box appears: 

I· -.-1 This disk is unreadable: 

Do you w ant to ini tialize it? 

n Ej ect U [ Initialize ) 

If you inserted a clouble-siclecl (SOOK) disk, this dialog box 
appears: 

lf.(ll This disk is unreadable: 

S Do you wan t t o initialize i t? 

ll Ejec t J) (one- Sid ed) [Two- Sided) 

co111i1111es "" 
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2. Depending on which dialog box appears, click Initialize 
or Two-Sided. 

Another dialog box appears: 

/.\_ This process will erase all 
ill Information on this disk. 

cancel ll Erase Jl 

This dialog box gives you one last chance to cancel. It alerts 
you that you're about to erase-and therefore lose-any 
information that may be on the floppy disk. 

3. Click Erase. 

A third dialog box appears: 

Please name this disk: 
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4. Type the name you want for the disk. 

If you make any typing errors, press the Delete key to 

backspace over them. 

When you name a disk, you can type up to 27 characters, 
including spaces. You cannot use a colon in the name. If you 
don't name the disk, it will have the name "Untitled." 

5. Click OK or press the Return key on the keyboard. 

The computer takes about a minute to initialize the disk. A 
series of messages appears on the screen to let you know how 
the process is going. 

When initialization is completed, the floppy disk's icon 
appears on the desktop. You can rename the disk by clicking 
its name and typing a new one. 



Erasing a disk 
Erasing a disk actually initializes ir. 

.6. Warning: You lose any information you may have on a disk 
when vou erase it. _. 

1. Click the icon of the disk you want to erase. 

2. Choose Erase Disk from the Special menu. 

A dialog box appears, giving you a chance ro cancel the 
procedure. 

3. Depending on the type of disk you're erasing, click 
Initialize or Two-Sided. 

Designating a hard disk 
as the startup disk 
If you use more than one startup disk with your Macintosh, you 
can specify which hard disk you want used as the startup disk the 
next time you turn on your computer. 

1. Choose Control P'anels from the Apple menu and then 
open the Startup Disk control panel. 

ID~ Startup Disk ~ 

St le-ct a Startup Disk: 

- c::::::J t:@IMM W1llhl"Op 

2. Click the icon of the disk you want to use as the startup 
disk. 

cu11ti1111es ~ 
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3. Close the Startup Disk control panel. 

When yuu 1 urn un your Macintosh, it looks for a srartup disk (a 
disk containing a System Folder) in the following sequence: 

1. internal floppy disk drive 

2. second internal floppy drive (if any) 

3. external floppy drive (if any) 

~. startup device selected in the Startup Disk control panel (if 
any) 

5. internal SCSI hard disk (the computer waits a few seconds f()I' 
the internal hare! disk to warm up) 

6. external SCSI hard disk (if there is more than one, it looks for 
the hard disk with the greatest SCSI ID number) 

7. inrernal hard disk (rhe computer returns to this drive ancl 
waits another few seconds) 
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If no startup disk is found, the computer displays a blinking 
question mark in the middle of the screen. 

·:· {/yo11111a11t to ~ipass the internal bard disk as a startup disk. 
press ~-Oprion-Sh i ft-Delere "·hen rhe computer starts up. ·:· 

6 Important: If you use any external hard disks, turn them on 
and wait a few seconds before you turn on your Macintosh; 
otherwise, rhe com purer will not recognize them. ~ 

Protecting the information on a disk 
You can protect all the information on a floppy disk and you can 
lock individual clocumenrs and application programs. Another way 
to protect your work is to keep backup copies of all your files. 

The information in a locked document or on a locked disk can't 
be changed or thrown away, but it can be opened or copied. 



Locking a floppy disk 

'lb lock a floppy disk: 

• Slide the tab on the back side of the disk so that the 
square hole is open. 

Use your rhumbnail ro move rhe tab, or a push pin inserted 
inro the notch next to the tab. 

• • • . . . 
••• • • . .. 

~·~·~~~~~·· ~· ~· ~~~~~ 

Sliding rhc tab back so that it covers the square hole unlocks 
the disk . 

Locking a file 

You use the Get Info command to lock a clocumenr or program. 
Locking a program may affect its operation. 

1. Click the icon of the file you want to lock. 

2. Choose Get Info from the File menu. 

The file's Info windO\\' appears. 

3. Click the Locked box in the lower-left corner so that an 
X appears in the box . 

;o~ From Amy Info = 
rJ From""' 

Kind :Tuchl•xt ~t 
Size: 1Kon disk( 161 ~te-s:ust-d) 

'w'h•re : J 's disk : From Amy 

Crt'iltt'd :Mon,Oet8, 1991, 10:33PM 
Modifie d :Mon,Oot 8, 1991, 10:3SPM 
Version : not 1v 1i11bl• 

Commf nts: 

~Locked 0 Sbtioneriy pad 

co11li1111es Ill> 
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4. Close the Info window. 

·:· l.ockingfolders: You can't lock a folde1~ bur you can lock rhe 
items in a folder. Also, you can protect the contents of folders 
that you're sharing on a network. (See Chapter 13, "Using 
Your Macintosh on a Network," for more in formation.) ·:· 

·:· Locking an alias: You can lock an alias, bur doing so does nor 
lock rhe original file. Locking an alias merely protects it from 
being thrown away. ·:· 

Backing up your files 

You can back up the work you store on a hard disk by copying 
individual files onro another disk in the usual way (dragging their 
icons ro rhe icon of the orhcr disk). You can back up the contents 
of an entire floppy disk by dragging its icon ro another floppy disk 
icon or a hard disk icon. 

You can also use a commercial backup program to copy some or 
all files from a hard disk to anorher hard disk, to a rape drive, or to 
a series of floppy disks. 
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If you can't save files on a floppy disk 
If you can't save files on a floppy disk, rhen rhe disk is damaged or 
locked, it's too full ro store more information, or the disk drive is 
nor working properly. 

• Make sure the locking tab on rhe back of the disk is in the 
unlocked position (so rhat the square hole is closed). 

• If you see a message reporting that the disk is nor initialized, 
and you know that ir has been initialized, eject the disk and 
carefully insert it again. If the same message appears, the disk 
is probably damaged. (You may be able to recover the 
information on ir with Disk First Aid or a disk-recovery 
program; see "Testing and Repairing Disks" lacer in this 
chapter.) 

• If you see a message reporting that rhe disk is full , eject that 
disk and insert another rhar has adequate space for your 
document, or erase unneeded files from the disk. 

• Check rhe disk for obvious damage ro the plastic case or rhe 
sliding metal shutter. 

• Insert a different disk and rry saving again. If you can't save on 
the second disk, the problem may be with the disk drive. 

• Before concluding that rhe disk drive is the problem, save 
your files on a disk in a different drive, if you have one, and 
then resrart the Macintosh. 'fry using a disk that you know is 
nor damaged in rhe suspect drive. See your service provider if 
you still can't save any files using that drive. 



Ejecting a disk 
You can eject a floppy disk by doing one of the following: 

• Click the disk icon to select it and choose Put Away from the 
file menu. The icon disappears from the desktop. 

• Drag the disk icon ro rhc 'frash icon. The disk icon disappears 
from the desktop. (Dragging a disk to rhe Trash does not 
erase the disk's contents.) 

• Click the cl isk icon to select it and choose Eject Disk from the 
Special menu. The disk's icon remains on the desktop, but it's 
climmecl. 

You can use rhe first rwo methods to remove a hard disk icon 
from the Macintosh desktop (or to remove an icon for a disk that 
you're connected to over a network). 

All three methods also work with CD-ROM discs. 

If you can't eject a floppy disk 

The signal to eject the disk is not reaching the computer or the 
disk or drive is damaged. 

1. Hold down the ~ and Shift keys and press the 
number 1 key in the top row of the keyboard to eject 
a disk in the internal drive; press ~-Shift and the 
number 2 to eject a disk in an external floppy drive 
or the second internal drive. 

2. If step 1 doesn't work, turn off the Macintosh. If the 
disk isn't ejected, then hold down the mouse button 
when you turn the computer on again. 

3. If step 2 doesn't work, locate the small hole to the right 
of the disk drive's opening, and carefully insert the end 
of a large straightened paper clip into it. Push gently 
until the disk is ejected. Do not use excessive force. 

4. If step 3 doesn't work, take the computer or disk drive 
to your authorized Apple service provider to have the 
disk removed. 
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Disk care 
for information on Floppy disk care, see Chapter 3, "Setting Up 
Your Programs;' or read the instructions that came with your 
floppy disks. 

Hard disk precautions 

Hard disk drives are verv delicate mechanisms and should be 
handled wi th care. 

• Do not roughly handle a hard disk or a computer with an 
internal hard disk. :--Jevcr move either when it's rurncd on and 
the hard disk drive is operating. 

• Do not place your ~ lacin co:;h on its side unless ir is designed 
to operate this ,,·ay: it could damage the hard disk. Sec your 
setup hook w check if your Macimosh model can be placed 
on its side. 

• Always keep rhe hard disk on a srurdy, level surface. 

• Opera te a hard disk at temperatures berwcen 10 and 
-10 degrees Celsius (50 and I 0-1 degrees Fahrenheit) and at 
a relative humidity of 20 to 80 percent. 

• Do not spill any liquids on or near the drive. 

• Do not expose rhe drive to hazardous vapors. such as rhose 
from cleaning solvents. 
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Testing and repairing disks 
Both floppy disks and hare! disks can become damaged from 
repeated use and handling. If you see a message reporting rhat a 
disk is damaged or unreadable, Disk first Aid or Apple HD SC 
Serup (borh programs are supplied with the system sofrware) may 
help diagnose and correcr rhe problem. 

If ~nu can·r srart up from a hard disk or don·r see irs icon on rhc 
deskrop, the computer docs nor recognize rhe disk or the disk 
drive is not working properly. 

• If rhe hard disk drive is an exrernal one, make sure it is turned 
on and its cable is connected firmlv. rhen restart rhc 
~ lacinmsh. 

• If rhe disk dri\'e is an internal one, turn off the ~facimosh , \\"ait 
al least 10 seconds, rhcn turn it on again. 

• If the hard disk is your sranup disk, srart up with a c.l iffcrenr 
disk and, if Lhe disk's icon appears, reinstall rhe system 
software on the hard disk. 

• If you have more than one hard disk in your Macinrosh 
system, check the SCSI ID number of each external hard disk 
and all or her SCSI devices connected to your com purer. If two 
devices have the same ID number, or if any exrernal device 
has the ID number 7 or 0, the computer will nor recognize 
one of the devices. 



Using Disk First Aid 

You can test floppy disks and hard disks with the Disk First Aid 
application. Disk First Aid also repairs some types of disk damage. 

1. Locate and open the Disk First Aid icon. 

Disk First Aid is on rhe svsrem sofrware disk labeled 
Disk Tools. 

~ 
Disk First Aid 

A dialog box appears. 

2. Click the Drive or Eject button as necessary until the 
name of the disk you want to test appears. You may 
have to insert the damaged floppy disk. 

3. Click Open or press the Return key. 

The name of the disk you selected appears, and a message 
reports that Disk First Aid is ready. 

4. Choose Repair Automatically from the Options menu, 
or click the Start button to begin testing the disk. 

S Fil e Edit 

Ready to s 

Uolume: Archiues 

Start 

5. When testing and repair are completed, choose Quit 
from the File menu. 

·:· lfyou want to test another disk, choose Close from the file 
menu, then select and open the other disk (as in step 2) . ·:· 

If Disk First Aid doesn't correct the problem: 

• Use Disk First Aid one or rwo more rimes with the disk. 
Occasionally, repeating this process corrects the problem. 

• Cse anorher disk repair or recovery utility. Some disk repair 
util ities let you recover information from a damaged disk. 

• Consult a technician or other specialist for help. 

• Once you have recovered all the informarion you can. erase 
(reinitialize) the disk. If reinitializing doesn't work, discard rhe 
damaged disk. 
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Testing a hard disk 

You can test a SCSI hard disk with the Apple HD SC Serup 
program. 

1. Locate and open the Apple HD SC Setup icon. 

Apple HD SC Setup is on the system software disk labeled 
Disk 'fools. 

~ 
I. I 

App le HD SC Setup 

A dialog box appears. 

Rpple HO SC Se tup 

[ I nl tlollze J 

[ Updat e J 

[ Partition J 

[ Tes t J 

(I auit J] 

scs1 oeulce: 0--11-- Thc disk's SCSI ID number 

~ Th-e uolume -;;;.;eisli~-;ddl;;-_r--Thc disk's name 
~ #2 
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2. Click the Drive button until the name of the disk you 
want to test appears as the ''volume name." 

3. Click Test. 

A dialog box appears asking you to confirm that you want ro 
rest the disk. 

4. Click OK. 

5. When a dialog box appears telling you that testing is 
complete, click Quit. 

If the test reveals a problem, you may be able to correct it by 
using Disk First Aid or another disk repair utili ty, or you may 
have tO reinitialize the disk. Consult a technician or other 
specialist for assistance if necessary. 



Chapter 10 

Organizing Your Files 
In this chapter 
• Straightening up your files 

• Using folders to organize your files 

Creating and naming folders 

• Saving your fi les where you wam to 

• Making items easier to find 

Using an alias 

Installing an item in the Apple menu 

Moving an item to the desktop 

• Finding a file or a folder 

Finding an item by name 

Finding an item by other characteristics 

Finding items through a two-stage search 

Uses of the Find command 

• Creating a template 

• Getting information about your files 

Using the Info window 

Using the View menu 

Straightening up your files 
Choose the Clean Up command from the Special menu to 

straighten up the icons in the active window or on the desktop. 
(The form of the Clean Up command changes depending on 
which items are active or selected.) 

Hold clown the Option key while choosing Clean Up Window to 
arrange icons alphabetically by name or according to the list view 
displayed most recently in that window. Holding down the Option 
key also moves the icons to the top left ponion of the window. 

Hold down the Option key while choosing Clean Up Desktop to 
line up icons near the right edge of the screen. 

If one or more items are sclccred, holding down the Shift key 
while choosing the Clean Up command rearranges the selected 
items only. 
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Using folders to organize your files 
Like paper filing systems, the Macintosh uses folders ro store and 
organize documents. You can place one folder inside another to 

creace a hierarchy of files that has many levels. 

. . . . . . . . . . . . . . . . . 
Budgets Proposals 

. . . . . . . . . . . . . . . . . . . . . . . . . . 
Feasibiliq1 

swclies 

. 
Resumes 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Corn men ts 
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Issues 
list 

Creating and naming folders 
Most programs let you create and name a new folder in the 
directory dialog box that appears when you first save a document, 
or when you choose Save A<; from the File menu to save another 
version of a document. 

When you're working on the desktop (when the Finder is the 
active program), you create and name a new folder as follows. 

1. With the Finder the active program, choose New Folder 
from the File menu . 

A new folder named "umitled folder" appears in the active 
window (or on the desktop if no window is active). The name 
is already selected . 

2. Type a name for the folder and press Return. 

You move, copy, and remove folders in the same way that you do 
any other icons. (See the summary, "Working on rhe Macintosh 
Desktop," on the green pages after Chapter 16, for instructions.) 



Saving your files where you want to 
The first rime you save a document that you're creating in an 
application program (or whenever you choose Save As from the 
File menu to create anorher version of a document), a direc101y 
dialog box appears. A direc101y is the list of files and folders 
contained in a folder or a disk. 

You use the directory dialog box to name your document and 
decide where to store it. Directory dialog boxes vary slightly from 
program to program, but every directory dialog box has certain 
features. 

The currcm tlirectorr· 
a lisc of the files and ' . 
folders in the folder 
or disk that's named 
in che pop-up menu 
above the directory 

Use 1his pop-up 
menu 10 choose 
a higher-level 
direcwry. 

The name 
ofrhe 
currcnr 
disk 

= Macintosh HD• = Macintosh HD 

Click 10 list the 
disks on the 
.'vlacinrosh cleskrop 
in the currem 
directory. 

~D-,ff-n~m=1-0=1 =re=11o=r=1 =91===='---~ 
Eject 

D App. progroms 
D a rt fo1111 
D art samples 
D !lelstl 0:"27f'JO 
[] Dook ll~t 

Soue this document es: 

'lype the name 
of che documem 
here. 

Cone el 

StlUC 

When you open 
a folder, its 
contents are 
lis1cd in rhc 
current direcrorv. 

Click w create a 
new !()Ider. 

Click Save when vou have 
named the docu1i1cm and the 
clirccrory you want to put it in 
is the currern clirectorv. 

A similar dialog box appears when you choose Open from the File 
menu to open a document that was created in the program you're 
currently in (the "active" program). The dialog box lets you find 
the document and open it. 

l= Walthrop ..,..j 
0 

I il!m!JI! I • 

D art- 10/ 4 
D car Info 
D Casper maps 
D Enuelopes 
D Glossary 
D JH Status reports 
D M at ching Deuel. 
D old backups 
D Paint pies 
D Picture O 

= Walthrop 

r:jcHt 

Desktop 

Open 

Cancel 
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Making items easier to find 
Your Macintosh offers several ways to make a file, folder, or other 
item easy to find and open. You can 

• create aliases for the item and put the aliases wherever it's 
convenient for you 

• install the item in the Apple menu 

• move the item to the Macintosh desktop so that it's in 
plain sight 

Using an alias 
An alias serves as a signpost to a file, a folder, a disk, or another 
item (even a shared item that you access over a network). You can 
make as many aliases for an item as you want. See Chapter 6, 
"Organizing Your Work," for more information on aliases. 

Creating an alias 

1. Click to select the item that you want to make an 
alias for. 

2. Choose Make Alias from the File menu. 

The alias appears on top of the original. Its name is in italics 
and ends with "alias." The name is already selected. 

3. If you wish, change the name of the alias, then move it 
to wherever you want to put it. 
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Uses of aliases 

Alias of 

Any document or 
folder that could be 
stored in several 
places 

Apple Menu 
Items folder 

A program that 
must be located 
with associated files 

A document or folder 
stored on a separate 
archive disk 

A program, document, 
or folder on a file 
server 

Location 

Every pan of your 
filing system where 
that item logically 
fits 

On the desktop 

On the desktop; in 
the Apple menu 

Anywhere on your 
primary disk or 
disks 

Anywhere on your 
primary disk or 
disks 

Purpose 

Access to key information 
from several places 

Easy way to put items imo or 
take items out of the Apple 
menu 

Starting the program without 
opening the folder or disk in 
which the original and its 
associated files arc located 

When opened, the alias 
displays a message with the 
name of the disk needed, then 
opens the original when the 
disk is inserted. 

When opened, the alias 
automatically finds and 
opens its original on the 
server, essentially creating an 
automatic server connection. 

·:· Trouble? If you open an alias and nothing happens, or you see 
a message reponing that the original file isn't available, then 
the alias is damaged or the original has been deleted. Open 
the alias's Info window to find out where its original is. ·:· 



Locating the original of an alias 

You can locate the original of an alias by opening the alias's Info 
window. 

1. Select the icon of the alias whose original you want 
to ftnd. 

2. Choose Get Info from the File menu. 

The alias's Info window appears. 

ID~ JH memos alias Info ~ 

Kind :~lias 

S ize-: 1K on di$k ('21 b4i1 t ts usf'd) 

'lfh•n: s;: b~ •2 : ......... 2 •Hu--+-- Location of the original- includes 

Cre;1ted :Mon,Oct7, 1991 ,8:4 1 AM 
Hodifie d :Hon,Oct7, 199 1,8;4 1 M1 
Originill : SE b.,ckup • 2 :choonr2 

Commf'nts: 

0 Lockod ( Find Orlgl~i) 

folder levels and disk name (if the 
original is on a different disk) 

3. Click the Find Original button. 

The window containing the original item opens, with the 
item's icon highlighted. 

I f you deleted the original, you'll see a message reporting that 
the original can't be found. Aliases are not deleted when the 
original files are cleletecl. 

Installing an item in the Apple menu 

You can install a file or other item in the Apple menu so you can 
open it by choosing it from the menu. 

1. Open the System Folder icon and locate the Apple 
Menu Items folder. 

2. Locate the item you want to install in the Apple menu 
and drag it (or its alias) into the Apple Menu Items 
folder inside the System Folder. 

The item appears immediately in the Apple menu. 

You remove an item from the Apple menu by opening the Apple 
Menu Items folder and dragging its icon (or its alias) our of the 
folder. 

·:· 'fi·ouble? If the Apple menu does not contain the items it 
should, make sure that the Apple Menu Items folder is in the 
System Folder of your startup disk. Also, open the Apple 
Menu Items folder co check that all the items that you wanr in 
rhc menu are in the folder. ·:· 
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Moving an item to the desktop 

You can make an item easy to find by dragging its icon to the 
deskrop. The icon srays there until you remove the disk on which 
the item is actually srored. 

If you've placed an icon on the deskcop, you can put ir back in its 
original locarion bv using the Pur Away command. 

1. Click to select the item you want to put back in its 
original location. 

2. Choose Put Away from the File menu. 

Finding a file or a folder 
When the Finder is rhe active program, you can use the Find 
command in the File menu to find a file or folder on any disk 
whose icon is on rhe desktop. (The Find command cannor locare 
irems inside rhe System file, such as fonts and sounds. You must 
open rhe Svstem file ro see its conrents.) 
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Finding an item by name 

1. Choose Find from the File menu, or press ~-F. 

The dialog box that appears lers you find a file or a folder by 
searching for its name. 

Find 
You type the name 
(or partial name) you 

Find: I 1-t-- wanL to ftncl here. 
'----~~~~~~~~~~ 

[ More Choices l [ cancel ] [( Find 1Ht-- Clicking this button 
starts a search. 

Clicking this button displays a larger 
dialog box \1·ith more choices of 
search characteristics. 

If the dialog box has more items in it than shown here, cl ick 
the Fewer Choices button in rhe lower-left corner. 

2. Type the name (or part of the name) of the file or folder 
you want to find. 

Ir doesn't marrer whether you capitalize any letters, as long as 
the letters or numbers you rype are in the name of the item 
you're looking for. 



3. Click the Find button. 

The first item rhat matches the name (or partial name) you 
typed is shown highlighted in a Finder window. If no item is 
found , your Macimosh makes the alert sound. 

4. To see the next matching item, choose Find Again from 
the File menu, or press ~-G. 

If no more items arc found, your Macintosh makes the alert 
sound. 

Finding an item by other characteristics 

You can use the Find command to find a file or a folder by 
searching for its size, its label, rhe date ir was created or modified, 
or other characteristics. 

1. Choose Find from the File menu. 

The Find dialog box appears. 

2. Click the More Choices button. 

The dialog box rhat appears lets you set different search 
characteristics through pop-up menus that together form a 
search order. 

Pop-up menus 
of search 
characieristics 

Tvpe text (when 
searching for 1ex1) 
or set ·1 claie here 

Find 

Option to displ:i)' 
search results all 
at once (insiead 
of one at a iime) 

Find and select Items whose 

I name • II contains ·n J 
-------

Search L on all disks 

·------
l Fewer Choices J 

Clickin ' this hunon g 
displays a smaller 
dialog box. 

•J O all at once-

( Cancel ) ll 

POHi I p menu of 
search lncat ions 

--
Find JJ 

Click in !hi. g s bullon 
begins 1he search. 

The content. of the middle pop-up menu and the text area vary 
according to the item selected in the left pop-up menu. 

3. Press the pop-up menu on the left to open it, drag to 
choose an item, and then release the mouse button. 

4. Press the pop-up menu in the middle to open it, drag to 
choose an item, and then release the mouse button. 

co11lin11es ~ 
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5. Adjust the date, choose an item, or type text in the 
upper-right area of the dialog box. 

Clicking a number selects it; clicking the up or 
down arrow changes 1hc selected numbei: 

Find 

Find and select Items whose 

date modified ..-11 Is before ..- 1 

Search I on oil disks 

I 
IO/lll90 

O all at once 

[ Fewer Choices ) [ Cancel ) ( Find D 

6. Choose a search location from the pop-up menu 
labeled "Search." 

You can choose to search all disks, a specific disk, or the active 
Finder window. 

Find 

Find end select items whose 

I date modified ..- 11 is before ..- 1 IO/lll90 (;) 

---- -------- ----
Search v'on oil disks 0 oil ot once 

I I -- ---·-· 
, ___ ,, _________ 

on "SE backup #2" 
[ J (( l) [ Fewer Cho - - Cancel Find 

January folder 

Disk selec1ed for searchin ' g 
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7. If you want all found items displayed at once, click the 
checkbox labeled "all at once" so that an X appears. 

8. Click the Find button when you've finished setting your 
search characteristics. 

The first item that matches your search characteristics is shown 
highlighted in a Finder window. To see the next item found, 
choose Find Again from the File menu (or press :tt:-G). 

When the items found are displayed all at once, they are shown 
highlighted in one or more Finder windows. 

Ii[ 

A list view shows the 
contents of folders at 
all levels on the disk, 
in outline form. 

)- R..,clMo 

• 1H1414;;5w1m1 ---l 
D HVt thlsl 

Items found in the search 
are highlighted. 

J 's disk 
Siu L.st Modifttd 

3K "'tel, Oct 10, 1990, 11 :13 PM ~ 
ISK Fri, S.p 29, 1989, 1 0 :~9 AH 11m1 

v D Scanntr 

71< Thu,Oct 4 , 1990,S:SOPM ,liil!I 
- Hon, Oct a, 1990, 2:04 PH :j!~ I 

29K Thu, Juo22, 1989,2 .49PM ~ 
• MAINM 34K Thu~Jun22, 1989,2 :51 PH ·-p ,....._... 382K Hon, ""97, 1989, 7 :16 AH ·- lm:l~· r .. 

I> 0~""' - Hon Octa 1990 2:0SPM 

Indentation indicates that the item 
located is inside a folder. 



Finding items through a two-stage search 

You can use two sets of characteristics and locate the items that 
meet both sets of characrerisrics. 

1. Choose the first set of characteristics you want to 
search for. 

2. Click the "all at once" box so that an X appears. 

Checking "all at once" displays rhe irems found highlighted in 
a lisr. 

3. Click the Find button. 

The items found are shown highlighted in a Finder window. 

4. Choose the Find command again, before you click or 
take any other action. 

You choose Find before raking any other acrion so the items 
locared in rhe firsr srage of the search remain highlighted. 

5. Choose the second set of characteristics you want to 
search for. 

6. Choose "the selected items" in the Search pop-up 
menu. 

7. Click Find to begin the second stage of your search. 

The search is limited to the items found in the firsr srage, 
and only those matching both sers of characteristics are 
highlighted. 

Uses of the Find command 

The Find command can help you locate files quickly, organize 
large quantities of documents, and develop an efficient system for 
backing up and archiving your work. 

Search characteristic 

Name 

Kind 

Size 

Label 

Lock 

Modification elate 

Creation date 

Can be used to locate 

l. Files whose names you can't recall exactly 
2. J\11 items for which you use a standard name, 

such as status repons or expense reports 

I. All application programs 
2. All aliases 

Large files, to make space <1vailable on a disk 

All the files to which you added the same label 
(such as "top secret") 

Locked files, to unlock them for editing 

All files changed since a certain date, for regular 
backup of new and changed files 

J\11 files created before a certain date, for 
archiving or erasing outdated material 
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Creating a template 
Most documents can be saved as or convened into a statione1y 
pad, which is a template form of the document. The template 
retains the format and contem it had at the time you made it into 
stationery, and you can use it repeatedly as a master for similar 
documents. 

Many application programs let you save a document as a 
stationery pad when you first save the document or choose Save 
A'> from the File menu. If the direcrory dialog box that appears has 
a stationery pad option, you can click it to save your new 
document as a template. 

l=Wolthrop ..,., 

D flnnual rnpm1 91 
D App. progroms 
D m1 fonn 
Dar t samples 
[) Ehlhl.I B/27!9 I 
D Hook li~t 
D Car info 
D Cospar maps 
Ci I-Inane~ n•1mrt 

= Wolthrop 

~ ( Ejec1 J 

( Desktop J 

[ New CJ J 

Regular 
~---:=:=~L- document icon 

When this button is selected, the 
clocumenr is saved as a stationer~· pad. 
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If the program you're using does nor offer a stationery pad 
option, you can use a document's Info window to create a 
stationery pad. 

1. Click to select the icon of the document you want to 
use as a template. 

2. Choose Get Info from the File menu. 

3. Click "Stationery pad" near the lower-right corner so 
that an X appears in the checkbox. 

=~ Memo Pael Info 

13 Memo Pad 

Kind : TlachT•xl sbHontr"\I pad 
Stze : IK on disk(19 b4Jlts ustd) 

Created : Tut, Sfp 3, 1991, 6:.57 AM 
Modifie d : TOf, Stop 3 , 1991, 6 :57 AM 
Ver sion : not iV-iili blt 

Comments : 

0 Loc lced t8J Sbtionerv p~d 

Clicking "Stationery pad" converts the clocumem from an 
ordinary document to a stationery pad. 

4. Close the Info window. 

The documem icon has changed imo a stationery pad icon. 



When you open a stationery pad, an untitled window appears 
showing a blank "form" from that stationery, or a dialog box 
appears asking you to name the new documenr. 

You cannot change the stationery pad itself unless you turn it back 
into a regular document. You do this by opening the stationery 
pacl 's Info window and clicking "Scacionery pad" to remove the X. 

Getting info1mation about your files 
When you're working on the desktop, you can choose the Ger 
Info command from the File menu co get information abou t a file, 
such as when a document was created or how much memory a 
program needs. 

You can also use the View menu to sec certain types of 
information about the files listed in a Finder window. 

Using the Info window 

The Get Info command displays information about a selected item 
in a window. 

1. Click to select the item you want information about. 

2. Choose Get Info from the File menu, or press ~-1. 

~ Reed Me Info 

~ RudMe 
~ SoeJsttm Softv.ar• 

IC ind : documtnt 
S tz:• : 3K on di$k ( 1,622 tMiitn us.cf) 

Yhere : J 's disk: Rud M• 

Cre~ted :Tho, Jo~ 11 , 1991, 11 :13 PM 
Hodifi•d :lr'•d, Nov 6, 1991 , 12:00 PM 

Version : not ini1ibk 

Comm•nts : 

0 Lockod 0 Sbtionery paid 

Besides getting information, you can use the Info window to 
lock a file (so it can't be changed or thrown away), turn a 
document into a stationery pad, change a program's memory 
allocation, and change the file's icon. (See Chapter 11, 
'Mapting Your Macintosh to Your Own Use," for information 
on the last rwo procedures.) 

You can type comments in the Info window and later search 
for them with the Find command. 

3. Click the close box. 
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Using the View menu 

You can use rhe View menu ro display rhe conrems of a window 
by icon or small icon, or you can lisr them according to name, 
size, kind, elate, or label. (See Chapter 11, '/\clapting Your 
Macintosh ro Your Own Use," for information on using the Views 
control panel ro change how files are lisrecl and what information 
is incluclecl.) 

Windows are set to show irems in the icon view. One of rhe list 
views (name, size, kind, label, or elate) is useful when you have 
roo many files to see easily as icons or if you warn your files 
arranged according to a particular attribute. For example, listing 
documents by the elate and rime of their most recent mocliflcarion 
makes backing up files an orderly task. 

The typc of list displayed is underlined. 

J H doto/2 
Sin Kind L~1 Last Modified 
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When rhe contents of a window are displayed as a list and you 
want them arranged in anorher list view, you don't have to use the 
View menu. You can cl ick a column heading (such as Size or the 
Last Modified elate) to rearrange the list according ro that 
heading. 

See the summary, "Working on the Macintosh Desktop," on the 
green pages after Chapter 16 for information on using a list view 
to select items in different folders. 



Chapter 11 

Adapting Your Macintosh 
to Your Own Use 
In this chapter 
• Speci~ring which items you want opened at startup 

• Installing an item in the Apple menu 

• Installing files in the System Folder 

• Changing the items in the Label menu 

• Sening the elate and time 

• Choosing formats for displaying the date and time 

• Setting a time for the Alarm Clock to go off 

'IL1rning the alarm off 

• Adjusting the way the mouse works 

• Adjusting the way the keyboard works 

Concrolling the poincer from the keyboard 

Making keyboard shortcuts easier co type 

Adjusting the keyboard for very slow typing 

• Choosing formats for displaying numbers and currency 

• Setting the alert sound 

Install ing a sound 

Removing a sound 

Recording sounds 

• Changing the desktop pattern 

• Adjusting the blinking of a menu item 

• Adjusting the blinking of the insertion point 

• Changing the way the contents of windows appear 

• C.hanging the appearance of icons 

Changing an icon 

Assigning a label and a color to an icon 

• Changing the highl ight color 

• Changing the color of windows 

• Displaying colors or grays 

• Configuring multiple monitors 

• Adjusting screen brightness 

• Magnifying the screen image 

• 1L1rning off the Empty Trash warning 

• Managing memory 
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Specifying which items 
you want opened at startup 
To have a file (a program or a documenr) open auromarically 
when you srarr up your Macinrosh, drag rhe file's icon or irs alias 
to rhe Startup Items folder, which is inside rhe Sysrem Folder. 
Anv programs or documents (or their aliases) that you put in 
the Starrup Items folder are opened when you starr up your 
Macinrosh. You can have as many files open automatically as 
your computer's memory allows. 

If you no longer want a file to open automatically when you starr 
up your Macintosh, remove the file 's icon or its alias from the 
Startup Items folder. 

Installing an item in the Apple menu 
'lb have a program, documenr, or orher irem appear in the Apple 
menu, drag the item's icon or its alias ro the Apple Menu Items 
folder, which is inside the System Folder. 

You remove an item from the Apple menu by opening the Apple 
Menu !rems folder and dragging the item's icon (or its alias) our 
of the folder. 
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Installing files in the System Folder 
Certain types of programs and other files need to be installed in 
the System Folder so your Macintosh can use them as pan of the 
system software. These files include 

• ~)!stem extensions and coillrol panels (also called INITs and 
CDEVs) 

• files of preferences for application programs 

• drivers for printers, scanners, and other devices 

• sounds (insrrucrions for installing sounds are in this chaprer) 

• fonrs (see Chapter 12, "Printing," for instructions on installing 
fonts) 

Usuallv, you install these files by dragging their icons to rhe 
System Folder icon (no! the System Folder window). Somerimcs 
rl~ese files are installed using an insraller program rhat comes with 
rhe files. Check the insrructions that came with the files for any 
specific installation procedure. 



These files are stored in specific folders inside the System Folder. 
When you drag a file 's icon to the System Folder icon, your 
Macintosh recognizes which type of file it is and stores the file in 
the appropriate folder. 

This folder holds networking 
software, printer sofrware. and 
other system extensions. 

liD--
8items 

w 
Apple Menu Items Extens\ons 

@] 
Startup Items 

This folder holds settings 
for application programs. 

The Svstem file holds fonts. 
sounds. kevboard lavouts, 
and orher ,:esources'. 

S1,1stem 

§ 
ControlP~ts 

1---1=
0 :i--_This program 

Finder 
manages the 
Macintosh 
desktop. 

This file holds items vou 
put in the Scrapbook. 

If you drag one of these files to the System Folder window instead 
of the System Folder icon, the file is not stored in the appropriate 
folder automatically. Items you want in the Apple Menu I tems 
folder or the Startup Items folder inside the System folder need 
to be dragged to either folder directly. (See the instructions in this 
chapter for installing Apple menu items and speci~1ing the files 
you want opened at sranup.) 

Removing files from the System Folder 

You remove a file from the System Folder by dragging its icon our 
of the System Folder. 

Depending on the external devices you use, whether or nor 
you're on a network, and how you use your Macintosh, you can 
remove the following types of files from your System Folder if you 
want to conserve space on your startup disk: 

• drivers for printers or Other devices you don't use (for 
example, the ArpleTalk lmagc\Vritcrdriver) 

• networking drivers, if you are not on a network (such as 
AppleShare software) 

• Apple menu items you don't use (you need the control 
panels, but you may not need the Calculator or the Puzzle, 
for example) 

• extra fonts, sounds, or keyboard files you have installed 

Be sure you have backup copies of the files on floppy disks before 
you remove them from your System folder. 
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Changing the items in the Label menu 
You can change the labels (and colors, if your monitor displays 
colors or shades of gray) available in the Label menu. You make 
these changes in the Labels control panel (choose Control Panels 
from the Apple menu and open the Labels control panel). 

Labels 

iO~ Lnbels~ 

L:J 
liil IH<>t I 
[ii] I in p' !2:"' I 
[ii] leoo1 It--
[ii] lPtNONI I 

Labels 

[ii] lPro~t I I 
1iiJ IPro~1 2 I r=- --' 

Colors 

Tb change a label, drag across it to select it and then type your 
new label. 
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To change a color: 

1. Click the color you want to change. 

The color wheel dialog box appears. 

New color or gray is in top half, 
current color or gray in bonorn half 

Color for Essent101· 

Numbers correspond to 
the selected color or 

gray on the wheel. 

----1i~11-- Circle 
indicates 
selected 
color. 

13righrness 
control 

Wheel shows colors or grays available. 
(When four colors or grays are 
selected, letters appear in the wheel 
indicating color values.) 



2. Click a color on the color wheel to select it. 

The new color is displayed in the top half of the color square. 
The currem color remains in the bottom half of the square for 
comparison. 

3. To experiment with other colors or shades, drag the 
pointer around the wheel or click at another point on 
the wheel. 

The new color is displayed in the upper half of the color 
square as you drag or·click. 

4. Click OK when you have selected the color you want. 

The color wheel dialog box closes. 

5. Close the Labels panel. 

The labels and colors you choose remain in effect until you 
change them. 

Setting the date and time 
Your Macintosh has a clock that keeps track of the date and time 
(a battery keeps it running when the computer is turned off). 

Many programs rely on the clock to enter times and dates in 
documents you create or print. The Date & Time control panel 
also lets you decide how to display the date and time of day on 
your Macintosh. 

1. Choose Control Panels from the Apple menu. 

2. Open the Date & Tune control panel. 

[ij 
Date & Time 

!lo Dot e & nme 

l!j] Current dot e I @ Current time 

To change the date, --l---1-4/llll9 2 J [;I 
1
1 I 1:55:16 PM I 

click the clay, month, or 
year to select it. Then [ Dote Formats ... I I ( Time For mats ... I 
type the number you 

wam or click the up or 
clown arrow umil the 

number appears. 

conlinues .,. 
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!iO- -- Dote & Time 

~ Current date 

I 4114192 

( Dol e Formats ... J 

Q) Current time 

I •=m 59 PM I: 
(Time Formats ... J 

To change the time, click 
the hours, minutes, or 
seconds co select them. 
Then type the number 
you want or click the up 
or down arrow umil the 
number appears. 

·:· Another way to cbange Lbe date and time: You can also use 
the General Controls panel ro change the date and time. The 
Date & Time control panel offers the advantage of a variety of 
ways ro display elates and times. ·:· 
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Changing the format for dates 

1. To change the way the date is displayed, click Date 
Formats. 

Dote fr Time 

~ Current dote 

1 4/ 14192 

( Dote Formats ... ) 

Q) Current time 

I 1: 11 :39 PM I 
(Time Formats ... J 

2. In the Date Formats dialog box that appears, make the 
changes you want. 

At the bottom of the dialog box you can see samples of the 
formats you choose. 



To artach a prefix to a long date 
or change the separators 

between elements in the date, 
type the charmers you want in 

these text boxes. 

To change the elements in 
a long date format, choose 

the ones vou want from 
these 1)01H1p menus. 

The "Long elate" and "Short date" formats shown 
arc standard in the United States. If you change 
anything, you create a "Custom" format. 

~ Date Formats: __ u_.s_. ______ ..... _ 
r· long date ............................................................................ ! 

i Preti 1 

Weekday ...,. I, I 
Month ...,. I I 
Day ...,. 1, ! 

I i 

._~~~--J 

, ... Short date ..................................................... . ..... ..., 

l Month/Day/Year ...,. I 

I ~;~;;~; :;;: ::~ ::ynth 

1 

· D Show century 

'---·-···-···-··········--·--····--·--·-·-···-·····-······················-j 

'lb change the order of 
elements in a short date, 
use this pop-up menu. 

To change the separntor 
between month, dav, 
and vear in a short (late. 
type. the character here. 

Samples of the formats \.'OU r" Samples .................. ·-··----·-·--·····-·-···-·-···········-······--····--································-·· .... -; 
--tt--;-· Tuesday, April 14, 1992 ! 

choose appear here in long Tue, Apr 
14

, 1992 ! 
cancel ___ 'lb dose che dialog box 

without changing the 

date, a~~~e:i~':!~l~I~~~~*~~'. l. ............................................................... -~~~.~!.~~ ................................................................. ..J OK 

'lb use the changes you've made 
to the way dates are displayed, 

click OK. 

way elates are displayed, 
click Cancel. 

Chapter 11: Adapting Your Macintosh to Your Own Use 131 



Changing the format for times 

1. To change the way the time is displayed, click Time 
Formats. 

Dote & Time 

~ Current dote 

I 4114192 

[ Dote Formots ... ) 

Q) Current time 

I 1:1 1:39 PM I 
[ Time rormots ... J 

2. In the Tune Format dialog box that appears, make the 
changes you want. 

At the bottom of the dialog box, you can see samples of the 
formats you choose. 

The formats shown are 
standard in the United States. 
If you change anything, you f reate a '·Custom" format. 

I Q) Time Format: ._I _u._s_. _____ ..... _,I 
'Jo change the text that identifies 

,.- Clock .... - ......... - ......... - .......... - ...... -.... , 

Choose the 24-hour or 12-hour clock. i i _ __..__._. _,. 24 hour I 
When you choose the 12-hour clock, ® 12 hour i 

you can also choose either 0:00 or 12:00 Noon & midnight: i 
to represent noon and midnight. O O:OO I 

® 12:00 ! 
··-·-··············-·--·········-···-·-·-···-~-·········-··' 

r- Format ...... ____ ,, .. ,_ .. _,, .. __ , ............ .:::::;.-] times before noon and after noon, 
· ......__-++-_ type the text here. I Be fore noon: I RM 

I Rfter noon: I PM J 

! ......... _ .. ~.:.~.~-~:~.:.~'.-._~ .... --.... -..... _; 

'lb change the separatur between 
hours, minutes, and seconds, type 
the character here. 

0 Use leading zero for hour [cancel }-j 1-- 'fo close the dialog box without 
changing the way times are 

Samples of the formats you _-41. __ .... :·-- sa1m;:
1;~···~-~-....... -····-··~·;~·~ .. ·~-~-....... ) 

choose appear here representing <-..................................................................................... ; 

[[ OK displayed, click Cancel. 

before-noon and after-noon times. 
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Tb use the dianges you 've made to the 
way times are displayed, click OK. 



Setting a time for the 
Alarm Clock to go off 
You can ser rhe Alarm Clock ro alerr you when ir's rime for an 
appointment or a meering. 

1. Choose Alarm Clock from the Apple menu. 

The Alarm Clock opens. 

2. Click the upward-pointing lever near the upper-right 
corner to expand the Alarm Clock. 

r;:;----:-:=:-:::-:-;::::......_ __ l.cver to make the Alarm Clock 
I D 3:52:18 PM .... ] I I · "' )iggcr or smal er 

The lever points downward, and rhe Alarm Clock expands ro 
its fu ll size. 

0 3:52:40 PM ' 
6/21/90 

l;:;'1i~iF::;=t---Thc highlighted icon indicates what 's 
@ IEi ~ ~ displa)1ed in the middle section- the 

date, in this example. 

3. Click the alarm clock icon in the lower-right corner to 
select it. 

The alarm clock icon is highlighted when you select it. The 
time that appears in the middle section is rhe current alarm 
clock setting. 

4. Click the hours, minutes, or seconds in the alarm clock 
setting to select them. 

Up and down arrows appear to rhe right of the time display. 

5. Click the up or down arrows repeatedly until the hour, 
minute, or second when you want the alarm to go off 
appears. 

6. Repeat steps 4 and 5 as necessary. 

conri1111es ~ 
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7. Click the button to the left of the alarm clock setting to 
turn the alarm on. 

When you click, the button moves up and the alarm clock 
icon changes ro indicate that the alarm is rurnecl on. (Clicking 
again turns the alarm off.) 

Buuon in the upper position 
indicates that the alarm is on. 

___ Icon showing ringing alarm 

8. Click the close box to close the Alarm Clock. 

The alarm wil l not go off unless you close the Alarm Clock or 
click the lever ro make the alarm clock smaller, click 
elsewhere in the clock, or make another window active. 

Turning the alarm off 

When the svsrem clock reaches the time set for the alarm, the 
alen sound plays twice (the menu bar Rashes once if the speaker 
volume is ser ro zero) and an alarm clock icon blinks over the 
Apple icon at the left encl of the menu bar. 

To turn off the alarm, choose Alarm Clock from the Apple menu 
and click the hurron ro the left of the alarm clock setting so that 
the burron moves down. 
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Adjusting the way the mouse works 
You can adjust rwo aspects of mouse operation in the Mouse 
comrol rancl: tracking, which is the relation between mouse 
movement on your desk and pointer movement on the screen, 
and double-clicking speed. 

1. Choose Control Panels from the Apple menu. 

2. Open the Mouse control panel. 

Mouse 

!!D~ Mouse 

0 000®00 
Y~rlJ Slo>at Slo"W Fut 

+ + + 
• o • o • @ 

Ooubl<-Cllck Spttd 



3. Click the tracking speed you want. 

If you click Fast, the pointer moves more than twice as fast as 
you move the mouse. The Very Slow option is useful for 
drawing with the mouse or a graphics tablet because the 
pointer moves at a constant speed relative ro mouse 
movement. 

Your choice rakes effect immediately and remains in effect 
until you choose a different tracking option. 

4. Click the double-clicking speed you want. 

You may have to adjust the double-clicking speed if your 
Macintosh often interprets two clicks as a double click, or a 
double click llS two single clicks. 

+·.....----+-- The space between arrows 
O corresponds to the interval between 

Doub l e-Click Speed clicks. 

:'>louse button highlights twice at tht: 
interval selected when vou click a button. 

Your choice remains in effect unti l you choose a different 
double-clicking speed. 

Adjusting the way the keyboard works 
You can adjust the rate ar which a character repeats when its key 
is held clown as well as the delay before the character begins 
repeating. You can also change the keyboard layout. 

1. Choose Control Panels from the Apple menu. 

2. Open the Keyboard control panel. 

= Ke•Jboard 

Options for the speed a1 
which a character repea1s 

ID~ I! K~boord 

Kt\I Rtpu Rat" Ot lay Until Rtpnt 

r 000@01 O [O®OOI 
Slow Fut Off Lo119 Short 

K'°"boir-d t ...,out 

li2JDvorek jQ 

'o 

Options for delay before a 
charactt:r ht:gins repeating 

Op1ions for kerboarcl layout 
(if more than one keyboard 
layout is installed) 

co11ti1111es .,. 
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3. To adjust the rate at which a key repeats when it is held 
down, click the button for the rate you want. 

After you close the control panel , your choice remains in 
effect until you change it. 

4. To adjust the delay before keys repeat, click the button 
for the delay you want. 

If the keys repeat when you don't want them to, you should 
adjust rhe keyboard's sensitivity ro your rouch by serring a 
longer delay before a character begins repeating. (lf you cl ick 
the Off button, the keys don't repeat ar all.) 

After you close the control panel, your choice remains in 
effect until you change ir. 

5. To change the keyboard layout, click the name of the 
keyboard layout you want to use. 

Depending on which country you bought your Macintosh in, 
you may have a choice of more than one keyboard layour. 
(Additional keyboard layouts are available from various 
sources, and you install them in rhe System Folder as you 
would fonts or sounds.) 

After you close the control panel, your choice remains in 
effect until you change it. 

6. Close the Keyboard control panel. 
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Controlling the pointer from the keyboard 

With a Macintosh system software feature called Mouse Keys, you 
can use the numeric keypad on the right side of the keyboard 
(instead of the mouse) ro conrrol the movement of the poinrer on 
the screen. 

To turn Mouse Keys on, press :tt:-Shift-Clear (the Clear key is on 
the numeric keypad). 

To rum Mouse Keys off, press Clear. 

With Mouse Keys on, you can cl ick, drag, and perform all the 
usual mouse actions from the numeric keypad. The 5 key serves 
as the mouse burton: press once to click; press twice to double­
click. The 0 key locks the mouse button down for dragging. The 
decimal point key (to the right of 0) or the 5 key unlocks the 
mouse button. 

0 

IA--+-+-- Press once to 
dick; press twice 
to double-dick. 

Press either key 
to release the 
mouse bunon. 

Press to lock 
mouse bucton 
down for dragging. 



You can adjust how quickly the pointer moves on the screen and 
how long the delay is before the pointer starts moving when you 
press a mouse key. You make these adjustments in the Easy 
Access control panel (choose Control Panels from the Apple 
menu and open Easy Access). 

Making keyboard shortcuts easier to type 

With rhe Macintosh system software feature called Sticky Keys, 
you can type keyboard shortcuts (such as :tt:-S for the Save 
command) without actually pressing the keys simultaneously. 

'lb turn Sticky Keys on or off, press the Shift key five times without 
moving the mouse. 

\Xfirh Sticky Keys on, you can type a keyboard shortcut by first 
pressing the modifier key (:tt:, Option, Control, or Shift) and then 
pressing the character key. An icon in the right end of the menu 
bar (to the right of the Application menu icon) changes to 
indicate whether Sticky Keys is on and whether a modifier key has 
been rressed or locked. 

Sticky 
Keys 

~fl. 

~ 

A modifier A modifier key is locked 
key has (pressing the key twice 

~'" p~ocd ~•• .l.~" it fot ~p~K'I "'°). 

You can have Sticky Keys make an alert sound when a modifier 
key is pressed. You set this option in the Easy Access control 
panel (choose Control Panels from the Apple menu and open 
Easy Access). 

Adjusting the keyboard for very slow typing 

The Macintosh system software feature called Slow Keys lets you 
type very slowly and ignores accidental keystrokes by delaying the 
acceptance of the next keystroke. 

To turn Slow Keys on or off, hold clown the Return key for about 
four seconds, until an alert sound indicates that the feature is on 
or off. 

You can adjust how long you want Slow Keys to delay acceptance 
of the next keystroke. You can also set Slow Keys to make an 
audible click each time a key is pressed. You make these 
adjustments in the Easy Access control panel (choose Control 
Panels from the Apple menu and open Easy Access) . 
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Displaying numbers and currency 2. Open the Numbers control panel. 

You can choose from several different formats for displaying 
numbers and currency. 

1. Choose Control P'anels from the Apple menu. 
Number-s 

The formats shown here are 
srnndard in the United States. 
If you change anything, you 
create a "Custom'· format. 

Number 
'lo change the decimal ~eparator, 
type the character in this box or 

press the arrow and choose a 
separator from the pop·up menu. 

t3 Number Format: U.S. 
'--~~~~~~~-' 

r· Separators ·················-····················; . . 

Decimal: El i 
r·· Currency ···············-··············· ....... 1 
l ! 

'10 change the currency 
symbol, type the 
character(s) you want. 

·10 change the thousands ~eparator, --+-T_h_o_u_s_a_n_d_s~:,..-_E} j 
i @ Before number 

1-'--1-- 'lo place rhe currency 

... ?. .. ~.~~-~-~ --~-~-~-~-~-~ ........... : symbol before or after type the character in this box or .................................................................. .. 
press tile arrow and choose a 

separator from the pop·up menu. 

r· Sample ................................................ , 

L. .... -.......... ~ .. ~ .'..=.~-~:.~.~ .................. J 

Samples of the formats vou 
choose appear here. 
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tiie number, click the 
appropriate buuon. 



Setting the alert sound 
Many programs have the Macintosh make a sound, called the alert 
sound, when your attention is required or when you're giving a 
command or attempting an action that the computer cannm 
recognize or perform at that time. 

You can choose among several sounds rhat you want the 
Macintosh ro make. You can also set the sound's volume. 

1. Choose Control P'anels from the Apple menu. 

2. Open the Sound control panel. 

~ 
Sound 

The Sound window aprears. The alen sound that your computer 
is currently using is already selected. 

3. Click the alert sound that you want the Macintosh 
to use. 

iD Sound 
Spt-••r Alf.rt Sounds 
Yolumo 

~i.t }01 

'! Ou>CI: 6 -
~ - Simpl< Sttp . - Sosumi 

3 - . WildEe-p 

2 -
I 
0 - tzy 

When )'OU click a sound co select it, it's played ar the current 
volume selling. 

Your Macintosh may have sounds installed in addition to those 
shown here. It may also have additional features in its Sound 
control panel, such as controls for recording sounds. See 
"Recording Sounds" later in chis chapter for information on 
recording sounds. For information on any additional features, go 
to the setup book that came with your Macintosh. 

4. Drag the slide control up or down to set the volume 
level. 

·:· {f you want to be alerted silenl~JI: Drag the slide control to 
zero. Instead of hearing an alert sound, you'll see the menu 
bar flash. ·:· 

5. Close the Sound control panel. 
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Installing a sound 

The Macin tosh comes with a srandard ser of alerc sounds. You can 
get additional sounds from various sources. To install a sound, you 
drag its icon to the System Folder icon (not the System Folder 
window). The sound is automatically installed in the System file, 
where it belongs. 

~ 
Oom-pah 

Once you add a sound to the System file, it is listed in the Sound 
control panel. 
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Removing a sound 

You can remove sounds in Lhe Sound control panel. Make sure 
you have a backup copy of the sounds on floppy disk before you 
remove rhem from your Macintosh system. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel. 

3. Click to select the sound you want to remove. 

Make sure you select the correct sound. You cannot undo the 
next step. 

4. Choose Cut or Clear from the Edit menu. 

S. Close the Sound control panel. 

You can also remove a sound by dragging its icon our of the 
System file and our of the System Folder. If your Macintosh can 
record sounds, you can remove a sound by cl icking to select it 
and then cl icking the Remove button. 

Recording sounds 

Some Macintosh models (such as the Macintosh LC) can accept 
and process sound input. These computers come with a sound 
input port, to which you can connect either a microphone (to 
record sounds that you create) or a phono jack adapter (to record 
sounds from another audio source such as a compact disc or an 
audio cassette). 



You can record a sound and add it co your available alert sounds in 
the Sound control panel. Make sure you've connected a 
microphone to your Macintosh as described in the setup book 
that came with your computer. 

1. Choose Control Panels from the Apple menu. 

2. Open the Sound control panel. 

The Sound control panel appears. Icons representing the 
available sound input devices appear near the bottom of the 
window. 

3. Click the icon that represents the sound input device 
you want to use. 

Microphones (Options ... ) 

4. Click the Add button. 

A dialog box that looks like the controls of a tape recorder 
appears. 

5. To record your new sound, click the Record button. 

Recording begins immediately; you have ten seconds co 
record your sound. There is no recording volume control. 

~~Cillm <J 
Record Stop Pause Play 

:DO 
0 seconds :10 

6. Click Stop to stop reconling. 

[ Concel J 

([ StUJt~ l) 

7. To listen to the sound you recorded, click Play. 

8. To save the sound you recorded, click Save. 

A dialog box appears in which you name your new sound. 

9. 'fype a name for the sound. 

10. Click OK. 

Giue this sound a name: 

I Andrea's first wor~ I 

( Cancel J n OK J 

The new sound appears in the Alert Sounds list in the Sound 
control panel. 

When you're finished recording new sounds, close the Sound 
control panel. 
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Changing the desktop pattern 
You can change the pattern that appears on the Macintosh 
desktop in rhe General Controls panel. 

1. Choose Control P'anels from the Apple menu. 

2. Open the General Controls panel. 

~ 
Gener .a 1 Controls 

M...,Bllnkln; 

000® 
Off I 2 3 

ru t 

Time (9 
10:27:51 AM 

@t2hr".024hr. 

Oat~ raAJ 
3/28/90 
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You can choose from a variety of patterns provided for the 
Macintosh desktop, or you can create your own design by 
editing one of the patterns supplied. If your Macintosh can 
display colors or shades of gray, you can also select your own 
colors to use in the pattern. 

r:::;:~~~~=:=l-- Panern-edicing area 
(magnified view of pattern) 

Desktop Pattern 

••• • 
Miniature desktop 

Color bar for selecting 
colors or shades of gray 

3. To see the patterns available, click either of the small 
triangles at the top of the miniature desktop on the 
right side of the Desktop P'attern area. 

The pattern changes each time you click. 

4. To choose a pattern, click the miniature desktop to see 
the new pattern on your desktop. 

The new pattern replaces the current pattern for the desktop. 
The desktop pattern remains in effect until you change it. 



5. To edit a pattern, click in the square to the left of the 
miniature desktop. 

Each clor in the square changes color when you click it Your 
changes are displayed in the miniature desktop. 

Desktop Pattern 

••• • 
6. To use another color, click the color in the color bar 

(under the words "Desktop Pattern") to select it, then 
click the dots you want to change. 

You can also change the color of an existing panern by 
double-clicking a color in the color bar and choosing a new 
color from the color wheel in che dialog box char appears. 

7. When you've finished creating your new pattern, click 
in the miniature desktop to display the pattern on your 
desktop. 

By double-clicking in che miniature desktop, you can save che 
new panern. Otherwise it is lost when you display another 
partern in che miniature desktop. 

Adjusting the blinking of a menu item 
You can change che number of rimes a menu irem blinks when it's 
chosen. You make chis adjustment in the General Conrrols panel 
(choose Comrol Panels from the Apple menu and then open the 
General Comrols panel). 

To adjust menu blinking, click the buuon for the number of times 
you wane the menu item to blink. Clicking the Off button prevenrs 
a menu item from blinking. 

Menu Blinking 

0 00@ 
Off 1 2 3 

The option you selected remains in effecL until you change it 
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Adjusting the blinking of 
the insertion point 
You can adjust how quickly the insenion point blinks (the 
inscnion point indicates where any text you type will appear). You 
make this adjustmem in the General Controls panel (choose 
Control Panels from the Apple menu and then open the General 
Controls panel). 

'lb adjust the blinking of rhc insertion poinc, cl ick the button for 
the blinking rate you want. 

Rate of Insertion 
Point Blinking 

·::: I( 
O@O 

Slow Fast 

When you click, the insertion point in the control panel shows the 
rate of blinking you selected. 

The option you selected remains in effect until you change it. 
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Changing the way the contents 
of windows appear 
You can change the way the contents of Finder windows are 
displayed in the different views available from rhe View menu 
(icon view, small icon view, and rhe list views by name, size, kind, 
label, and dare). You make these changes in the Views control 
panel (choose Comrol Panels from the Apple menu and open the 
Views control panel). 

Views 

Use the Views control panel to change 

• the font and font size used in all views (press to open the 
pop-up menu, then drag to choose a font or a size) 

• the arrangement of icons or small icons in icon and small icon 
views 

• the size of icons used in list views 

• what information is included in list views, including folder 
sizes and rhe amount of avai lable space on disk 



Options for 
layout of icons 

Pop-up menu of fonts for 
icon names and list views 

Ulews 
Pop-up menu of font 

Fonl to.- v;.ws: Geneuo ,.. ~ ,.. t---t-- Sizes for iCOn names 
'-----'--'-----' and list views 

.. Icon Yft ws ·-···--·---------··--··-----··--·----·----.. --------! 
D D D D @ Stra\ghl ortd I 

0 Alw'VS sn>p lo 9'"id 
1 D D D D 0 s1o990r ..t ortd ! 

rtstv;.:· ~--~-----, 
I r -.. [8J sno" ri<• 1 

I [8J Show kind ,i 
@ Q Q [8J Show I.WI 

I 
[8j Show da\t ,i 

0 Calculate foldtr s:ins 0 Show vtrsfon 

D Show dist..: mro in ht~tr D Sho.,,, cornt"nfflts i 
·-----------··-------' 

Options for the size 
of icons displayed in 
list views 

Options for information 
displayed in list views 

Option ro snap icons 
to an invisible grid 
whenever they are 
moved 

The options you select remain in effect until you change them. 
(See the summary, "Working on the Macintosh Desktop," on the 
green pages after Chapter 16 for more information about using 
windows and list views.) 

Changing the appearance of icons 
You can customize icons by changing the icons themselves. If your 
Macintosh displays color or shades of gray, you can have icons 
appear in a specific color that's associated with a label. 

Changing an icon 

In a graphics program, you can create or copy the picture you 
want to use as an icon, and then paste it into an icon's Info 
window. 

Some icons can't be changed, including those for control panels 
and ocher parts of the system software. Every icon fits inside a 
32-pixcl square. (A pixel, or picture element, is the smallest dot 
you can draw on the screen.) 

1. In a graphics program, select the picture you want to 
use for the icon. 

· - - - -1------- A moving clashed line 
: ~ 1 indicates the selected area 
1 \ill' in many graphics programs. 
'----' 

continues .,... 
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2. Copy the picture by choosing Copy from the Edit menu. 

3. Switch to the Finder, then click to select the icon you 
want to change. 

4. Choose Get Info from the File menu. 

The icon's Info window appears. 

5. Click the icon at the upper-left corner of the Info 
window to select it. 

A box appears around che icon when ic's selecced. If no box 
appears when you click, the icon can't be changed. 

~D~ ouerseas accounts Info~ 

6 ov•rsus •ccounts 

Kind: folder 
Siu: ttro Kon disk (0 bl.Jl., us+d), fM o 

u ..... 
Yht r •: J's disk : unt itk-d fold.r 

CrH1t~d: 'w'•d, Oct 9, 1991, 9:25 AM 
Modif fed : Vtd, Oct 9, 1991, 9:2S ~ 

Commt nts: 

A box around the icon 
indicates that it's selec1ccl. 
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6. Choose Paste from the Edit menu. 

The piccure you copied replaces the selected icon in the In fo 
window. If che piccure is bigger than the icon, it auromarically 
shrinks ro At. 

~!!!!! ouerseas accounts Info ~ 

I~ I oversm-ts 

7. Click the close box to close the Info window. 

You can change an icon back to ics original by cl icking che 
picture in the upper-left corner of the In fo window and 
choosing Cut from the Edit menu. 

Assigning a label and a color to an icon 

You can add a label and its associaced color ro each icon. A label is 
different from the icon's name. The label is visible only when che 
conrenrs of a window are displayed as a lisr. The associated color 
is visible whenever che Macinrosh is set to display colors or grays. 

Labels provide a way co group relacecl Ales (choose By Label from 
the View menu). If you have a color monicor, you can identify 
related icons by assigning a label and its color co each group. 

To assign a label and color to an icon, click the icon to select it and 
then choose the label (and irs color) that you want from the Label 
menu. 



Changing the highlight color 
If your Macintosh displays colors or shades of gray, you can 
change the color your Macintosh uses ro highlight selected text 
on the screen. You make this adjustment in the Color concrol 
panel (choose Control Panels from the Apple menu and open the 
Color control panel). 

~ I~ 
Color 

Color 

Highlight color. • Black & White ... 

ltiliilWWWI 

Window color: CJ Standard ... 

Pop-up menu of choices for 
highlight color 

Pop-up menu or choices ror 
window color 

You can also use the Color control panel ro change the color of 
window borders (go to "Changing the Color of Windows" in this 
chapter). 

1. Press the "Highlight color" pop-up menu to open it and 
drag to choose a color or choose Other. 

If you choose a color, it appears in the ··sample texl" box 
when you release the mouse buuon. 

If you choose Other, the color wheel dialog box appears. 

:"ic11· color or grav is in top hair, 
current color or gray in bo110111 hair 

Choose 8 highlight COIOP 

Hue 
So lurution 

Brightness 

:"lumbers correspond to 
the selected color or 

gray on the wheel. 

~---i=:i--.4f-- Circle 
indicates 
selected 
color. 

Brightness 
control 

Wheel shows colors or gravs available. 
(When ruur colors ur grays arc 
.~elected, letters appear in the wheel 
indicating color values.) 

co11/i1111es ..,. 
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2. To change the brightness of the color wheel, drag the 
scroll box up or down. 

3. Click a color on the color wheel to select it. 

The new color is displayed in the top half of the color square 
if your moniror is set ro display 16 or more colors or grays. 
The current color remains in the bottom half of the square for 
comparison; you can click there to go back ro it. 

4. To experiment with other colors or shades, drag the 
pointer around the wheel or click at another point on 
the wheel. 

The new color is displayed in the upper half of the color 
square as you drag or cl ick. 

5. Click OK when you have selected the color you want. 

The dialog box closes. The new highlight color is displayed in 
the "Sample text" box in the Color conrrol panel. 

The highlight color you specified takes effect immediately and 
remains in effect unril you change it. 
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Changing the color of windows 
If your Macintosh displays colors or shades of gray, you can 
change the color of window borders. You make this adjustment in 
the Color control panel (choose Control Panels from the Apple 
menu and open the Color control panel) . 

Color 

• _J Color~ 

Highlight color: • Black & White .... 

liilllbiWI 

Window color: D Standard 

Pop-up menu of choices 
for highlight color 

Pop-up menu of d1oices 
for window color 

You can also use the Color control panel ro change the color your 
Macintosh uses to highlight selected text on the screen (go to 

"Changing the Highlight Color" in this chapter). 

lo change the color of window borders, press the pop-up menu 
labeled "Window color" to open it and then drag ro choose a new 
color. 

The color you choose takes effect immediately and remains in 
effect until you change it. 



Displaying colors or grays 
If your Macintosh displays colors or shades of gray, you can 
designate the number of colors or shades of gray you want 
displayed. (How many colors or shades your Macintosh can 
display depends on the video capability it has. See the setup book 
that came with your Macintosh and the instructions that came 
with your monitor for more information.) 

You sec the number of colors or grays in the Ylonitors conrrol 
panel (choose Control Panels from the Apple menu and open the 
Monitors control panel). 

rs 
Monitors 

IDlll!!!!iiiim Monitors 
Chw.acttf'"istics of Hltcltd monitor 

®°""'··~ Oeoio.-"LJ (options ... ] 

Dr• monitors ind rntnu btr to rt1l"r.t • tti.m, 

( Identify J 

You also use the Monitors comrol panel to configure your 
monitors if you have more than one (go to "Configuring Multiple 
Monitors," the next section in this chapter). 

1. If you have more than one monitor, click the icon of 
the monitor whose colors you want to adjust. 

A dark border appears around the icon to show that it is 
seleccecl. 

2. Click the Grays or the Colors button. 

Some monitors can display only shades of gray, even if you 
click the Colors bunon. 

3. Click the number of colors or shades of gray you want 
displayed on the selected monitor (or click Black & 
White). 

Your changes cake effect immediately. The number of colors or 
shades of gray you specified remains in effect until you change ic. 

·:· {[your J\llacintosb bas built-in uideo (you didn't have to install 
a video card in your Macintosh before you could connect a 
monitor), increasing the number of colors or grays you wanr 
displayed increases the amount of memory your Macintosh 
uses for its video display and decreases the amount of 
memory available to run your programs. Your programs' 
performance may suffer as a result. If you want to change the 
amount of memory set aside for video, click the Options 
button in the Monitors control panel and click the appropriate 
butcons in the dialog box that appears. ·:· 
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Configuring multiple monitors 
If you use more rhan one monitor wirh your ~lacinrosh , you need 
ro inclicale rhe monitors· positions and designate one as the main 
monitor (rhe one that displays the menu bar). 

Yc)ll make rhese ;1djus1mems in the .\lonitors control panel 

(choose Control Panels from rhe Apple menu and open the 
Monitors comrol panel). 

[D 
Monitors 

:0 Monitors 

Chlt.ottris tios of 1tltottd monitor: 

Clicking Options opens a dialog 
box char lists the type of video 
card ro ll'hich the selected 
monitor is connected. ~~::'.D Options ... 

Dr morntOf's ¥Id mtn1.1 b¥ to r'Hl'r ~ DrJg the tiny white menu bar to 
the monitor you wa111 to display 

R=:;:;::;:::;::::i---ft-- the menu bar. 

1.-;.;..;;.,,;,_1-----tt-- The dark line around a monitor icon 
indicates that it is selectc:d. 

Colors in this box 
correspond to the 
number of colors 
the selected 
monitor is ~et to 
display. 

Clicking Idernify displays e;ich 
moniwr's ID number nn its screen. 

Icons for the monirors 
connected w the ~lacintosh, 
showing their ID numbers and 
their relative positions 
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)bu also use the Monitors control panel LO ser rhe number of 
colors or shades of gray you i;ram displayed (go to "Displaying 
Colors or Grays .. in rhis chapter). 

1. Check the ID numbers of your monitors by clicking the 
Identify button. 

A large number appears in rhe center of each monitor's 
screen; it corresponds to rhe number of the icon in rhe 
control panel. 

The ID numbers help you ident if}' which icon belongs ro 
which monitor. 

2. Decide which monitor is your main monitor and drag 
the menu bar to the top of that monitor icon. 

The menu bar snaps to the rop of rim monitor icon when you 
release rhe mouse bunon. 

If one of your monirors displays colors or shades of gray, you 
may wam to make it the main monitor so you can use lhe 
color capabilities of your programs and of rhc Finder. 

If your monitors are differem sizes, you may want to make rhe 
largest one the main moniLOr because some programs limit 
their window size to rhe size of rhc main monitor. 



3. Drag the icons of the other monitors to their positions 
relative to the main monitor. 

To avoid becoming disoriented when you're using rhe 
monitors, posi tion rhe monitor icons so that they correspond 
ro their actual positions on your desk. 

The pointer can cross from one screen to another where the 
monitors' icons touch in rhe control panel. 

4. Choose Restart from the Special menu. 

The positions you speci fied remain in effect until you change 
them and rescan your computer. 

Adjusting screen brightness 
Most Macintosh models have l.Jrighu1ess and cumrasL dials on rhe 
monitor or a brighmess dial on the computer itself. See the setup 
book that came with your com purer or the instructions that came 
with your monitor for more information. 

Brightness 
control 

Contrast control 

Rrightncss control 

A few models do not have brightness and contrast dials. I f your 
Macintosh does not have such dials, you adjust screen brightness 
in rhe Brighmess control panel (choose Control Panels from tbe 
Apple menu and open the Brightness control panel). 

Br-ightness 

'lb adjust screen brightness in the Brightness concrol panel, drag 
the slider con trol to the left or the right. 

·:· 71p: If an image is lefr on the screen for several hours or 
more, it may begin to "burn in" and damage che screen. You 
can use "screen saver" programs, available from various 
sources, to dim the screen auromatically or display a moving 
image after a set period of inactivity. ·!· 
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Magnifying the 
screen image 

The CloseView control panel lets you magnify 
the image on your Macintosh screen up to 
sixteen times. It is supplied on one of the 
Macintosh system software disks. 

CloseView is not automatically installed by 
the Installer program when you install system 
software. 
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To install CloseView: 

1. Locate the CloseView control panel. 

CloseView 

2. Drag the Close View icon to the 
System Folder icon (not the System 
Folder window) on your startup 
disk. 

3. Choose Restart from the Special 
menu. 

To turn CloseView on or off, press 
~-Option-0. 



To turn the magnification on or off, press 
~-Option-X. (When CloseView is on and 
the magnification is off, a rectangle on the 
screen indicates which area will be magnified. 
You can move the rectangle by moving the 
pointer.) 

To increase or decrease magnification, press 
~-Option-Up Arrow or ~-Option-Down 
Arrow. 

You can set additional options in the 
CloseView control panel (choose Control 
Panels from the Apple menu and open the 
CloseView control panel): 

D CloseUiew Turns 
CloseView 
on or off Cl~e 

View 
1---

@ Black on White 

0 White on Black 
1---

Keyboar d 
.....-

@on 
Shortcuts Qoff 

I-

························· 
."?.~.~.;·~.~·.·.-.-_] l ~ = 

'······················· 

© 1988-199 ~' Apple Compu er, Inc . 

Inverts Turns 
screen shortcuts 
image on or off 

~ @off 
~a€0 

Magnification 

~g~ @off ~a€H 

~a€t 
~: ~a€-), 

l a€ = .-.~.~·F.~·~.~·~.-.-.J 

Berke le 
developed by 
Sy stems , Inc. 

r--

Turns 
magnification 
on or off 

Keyboard 
shortcuts 

Arrows chanoe b 

magnification 
power 
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Turning off the Empty Trash warning 
When you choose Empty 'frash from the Special menu, a dialog 
box appears warning you that you will not be able to recover the 
conrencs of the Trash once it's emptied. (The warning helps you 
avoid throwing away items uninrentionally.) 

You can turn off this warning in the 1hsh 's Info box. 

1. Click the Trash icon to select it. 

2. Choose Get Info from the File menu. 

3. Click the checkbox labeled "Warn before emptying" to 
remove the X. 

l b turn the warning back on, click the checkbox so that an X 
appears. 

You can also override the Empty 11-ash warning when it is on by 
holding down the Option key when you choose the Empty Trash 
command. 

Unril you choose the Empty Trash command, items in the Trash 
conrinue ro occupy space on your disk. 
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Managing memory 
Occasionally you may need to make adjustments in how your 
Macinrosh uses its random-access memory (RAM) in order to 
work efficiently wi th large programs or with several programs 
at once. 

Checking memory use 

You can find our how much memory your Macintosh has, how 
much of it is not being used, and how much memory is being 
used by each program you have open. You find this information 
by making che Finder the active program and choosing Abour This 
Macintosh from the Apple menu. 

m About This Mocintosh BJ! 

Systt>m Sortv~r• 7 .0 
I°--! Macintos h llfM @>Applo Comc><Jt..-, Inc. 1983-1991 

Tobl Hemor\I : :511~ l~rg•st Unused Block : 3,~1 91< 

Total mcmorv 
in this · 
Macintosh -

~ ~sttm Sofht•n I~ 

~ Tf'.lChhxt 1921( 

I-' -

Pro rams Mcmor g y 
currently allocated for 
open each program 

c::J 
~ 

'oi 
~ 

The bar indicates how muc h memory a 
program reserves for its own use. The dark 
porrion is the amount it is acwally using. 

Your Macinrosh must have ac least 2 megabytes (MB), or 
2048 kilobytes (K), of RAM co use Syscem 7. 



You can adjust how much memory a program sers aside for itself 
when you open it. For instructions, go to "Setting Up Your 
Programs" in Chapter 8. 

Tips for using memory efficiently 
With System 7 you can have two or more programs open al Lhe 
same time, but only one program can be active ar a rime. Closing 
a window does not quit the active program or free much 
memory. You must choose Quit from the File menu to quir rhe 
program and make more memory available. 

If there is not enough memory available ro open a new program, 
rhe Macintosh promprs you to quit other programs. The 
Application menu at the rop-right corner of the screen shows you 
which programs are open. 

Hide Finder 
Hid e Others 
Stlow fill 

./~ Finder 
~ TeachTeH t 

If you have opened and closed several programs, your computer's 
memory can become fragmented so that you can't open a large 
program. You can solve this problem by quitting all open 
programs and restart ing the computer. 

If you do not use any local area network services, such as an 
electronic mail program, a file server, or a shared printer, you can 
make more memory (abour l OOK) available by turning off 
AppleTalk in the Chooser. Select Chooser from the Apple menu, 
click rhe Inactive button at the lower right, close the Chooser, and 
then choose Restart from the Special menu. To turn AppleTalk 
back on later, click the Active button, close the Chooser, and then 
choose Restart from the Special menu. If your printer is 
connected directly to your computer's printer port, you need to 
reselect the printer in the Chooser every time you turn AppleTalk 
off, and again when you tu rn it back on. 

If you aren't using file sharing, you can make more memory 
available by turning off this feature. To rurn off file sharing, open 
the Sharing Setup comrol panel. (Choose Comrol Panels from the 
Apple menu, then open the Sharing Setup icon.) In the File 
Sharing section of the control panel, click Stop. A message 
appears asking how many minutes the computer should wait until 
file sharing is turned off. 'lype a number and then cl ick OK. 

If your System Folder contains system extensions you don't need, 
you can make more memory available by removing them. For 
instance, if your Macintosh won't be connected to a host database, 
you can remove the DAL (Data Access Language) extension. 
Likewise, if your Macintosh won't be connected to a network , you 
can remove the AppleShare extension. 'lb remove a system 
extension, drag its icon our of both the Extensions folder and the 
System Folder ro another location on your hard disk. Then choose 
Rescan from the Special menu. 
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Adjusting the disk cache 

The disk cache is memory seL aside LO help programs work more 
quickly and efficiently. The memory in the disk cache is nor 
available for opening more programs or documents, so the size of 
the disk cache affects how many files you can have open at the 
same time. 

The preset and maximum sizes of the disk cache depend on the 
amount of memory your Macincosh has. If you often wanr to open 
more programs than memory allows, set the disk cache ro a 
smaller size-such as 32K or 64K. 

You set the size of the disk cache in the Memory control panel 
(choose Comrol Panels from the Apple menu and open the 
Memory control panel). 

Memory 
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'lb set the size of the disk cache, click the up or down arrow next 
ro the Cache Size box. The new size rakes effect after you choose 
Restart from the Special menu. 

ID Memory 

Yrtu.1.......,,,, 

00n 
@Off 

32·Bn Addrusing 

00n 
@011 

c.-stu 112111( 1 fIDi- Arrows adjust the cache. 

i=Hummer -.j 
Avail.1blt on disk: 27M 
Tot.11 mt1TlOnJ : 4M 

This buuon sets the 
disk cache at the 
recommended size 
(which depends on 
the amoum of RAM in 
your compurer). II also 
affects other Memor)' 

[ use oeroults ~~-control panel scu ings. 

Depending on your Macintosh model, you also use the Memory 
control panel ro adjust how virtual memory is used and co turn 
32-bir addressing on or off (sec "Using Hard Disk Space as 
Memory" and "'Il.1rning On 32-bit Addressing" in this chapter). 



Using hard disk space as memory 
Some Macintosh models can use space on a hard disk to increase 
the computer's memory. The disk space, called virtual me11101y, 
is not available for storing information when it is being used for 
this purpose. 

Your Macintosh should contain enough built-in memory for your 
regular needs-that is, for the programs you frequently have oren 
simultaneously. You can use viitual memory when you want to 

open additional programs or to work with extremely large 
documents that can't be opened while using only the built-in 
memory. 

Virtual memory is more effective when you are using several small 
programs simultaneously. It is less effective when using one very 
large program. 

If your Macintosh can use virtual memory, you can adjust its use 
of virtual memory in the Memory control panel (choose Control 
Panels from the Apple menu and open the Memory control 
panel). 

Memory 

Memory Pop-up menu of hard 
disks in use (dimmed 
when vinual memon' 

Disk C~he 
AlW¥JS: On 

Yir"tu.11 Hemorv 

00n 
@Of f 

Cid>< Siu 

s.1tc1 H ... • o.... /r- is off) . 
f= Hummer •l 
Avoii.t>lt ...... , 27H Space available on rhe 
rot•'""""'"'I '"\ disk Hu111111er 

---
3
-

2
--s-n Add- .. -•• -ir'<l------'--~- 1-- Tora! memory 

~ Q0n (exclusively HAM in this 
@off example; includes virtual 

memory if ir's on) 
( Use Oef oulls J 
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You also use [he Memory control panel w adjusr rhe size of the 
disk cache and (depending on your Macinrosh model) co wrn 
32-bit addressing on or off (see ''.Adjusting the Disk Cache" and 
"Turning On 32-bit Addressing" in this chaprer). 

1. Click the On button to turn on virtual memory. 

The Select Hard Disk pop-up menu becomes active (black) 
when you click On. 

2. Press the pop-up menu to open it and drag to choose 
the hard disk on which space will be allocated for 
virtual memory. 

3. Click the up and down arrows to adjust the amount of 
disk space to be used as virtual memory. 

The Memory control panel is preset to allot the same amount 
of virrual memory as the amount of RAM installed in your 
Macintosh. Choosing a larger amount of virtual memory is 
likely to slow rhe computer's performance. 

It is recommended that you accept the preset size. The 
numbers for ''.Available on disk" and '1\fter restart" change as 
you adjust [he amount of disk space. 
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4. Choose Restart from the Special menu. 

After you restart, your compurer's total memory (as indicated in 
the window that appears when you choose About This Macintosh 
from the Apple menu) includes the virtual memory you set aside 
on the hard disk. 

6 Important: \'(!hen you turn on virtual memory, the system 
software creates a file named VM Srorage in your System 
Folder (if the startup disk is used for vinual memory) or on 
the t.lesktop (if another hard disk is used for virtual memory). 
This file is large-the size of the compmer's RAM and the 
designated amounr of virtual memory combined. For 
example, if your Macintosh has 4 MB of RAM and you add 
2 MB of vi nu al memory, the VM Storage file will occupy 
6 MB of space on your startup disk. 6. 



Turning on 32-bit addressing 

Some Macintosh models can use very large amounts of memory 
(more chan 8 megabytes) by taking advantage of a feature called 
32-bir addressing- the use of very long (32-digit) binary numbers 
co control the way data is manipulated. 

If your Macintosh can use 32-bit addressing, you can rurn the 
fearure on or off in the Memory control panel (choose Control 
Panels from the Apple menu and open the Memory control 
panel). 

To turn 32-bit addressing on or off, click the appropriate buttons 
in rhe conrrol panel, then choose Restarr from the Special menu. 

Memory 

M emory 

Virtual~mon; 

00n 
@off 

S.J.ct Hud C>isk : 

[= Hummer .. -] 
Av~i11blt on disk: 27M 
Tobl m•morw : 4M When you turn on 32-bit 

··---------------------··----------····· addressing, a status 
32-Bit Addnssin9 

Oon 
®o« 

---t-- message appears here. 

[ Use Deroulls ) 

You also use the Memory comrol panel to adjusr the size of rhe 
disk cache and (depending on your Macintosh model) co set aside 
hard disk space for use as memory (see '1\djusring the Disk 
Cache" and "Using Hard Disk Space as Memory" in this chapter). 
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Chapter 12 

Printing 
In this chapter 
• Before you print 

Choosing a printer 

Selecting Page Setup options 

Updating printer drivers on networked computers 

• Printing your work 

Printing the contents of a window 

If the primer doesn't print your document 

• Priming while using the compurer for other work 

• Working with fonts 

Outline foms and bitmapped fonts 

Installing fonLs 

l{emoving fonLs 

Transferring fonts to a Laser\Xfriter printer 

Finding our about available fonts 

Using the LaserWriter font Utility 

Before you print 
Before you can print, your Macintosh must be connected lo a 
printer~ either directl}' or over a network. See the instructions that 
came with your printer if you need information about connccring 
it to your computer. 

Then, you must tell your Macintosh which printer to use by 
choosing the primer. 

Choosing a printer 
You tell the Macintosh which printer to use by choosing the 
printer in a program called the Chooser. You don't need to choose 
a printer every rime you princ. You need to choose one only when 
you're using a printer for the first time and whenever you decide 
to change printers. 

How you use the Chooser depends on whether your Macintosh is 
conneGecl directly ro the printer or connected ro a network. 
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If your printer is not on a network 

Make sure rhar you've connecred rhe primer according to rhc 
instructions that came with it and that you know which port you 
used (on the back of the computer) to connect the printer. 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 

2. Click the icon of the printer you want to use. Make sure 
the icon is selected (highlighted). 

~o Chooser 

~ ~' 
~ j Select o port: 

I ~ 
AppltSh.ar• App1•T.ak .. g•'W'rittf" I 

II ~ I ~ 
~· I m!l'lll!!I lJnrWrittr 

~ ~ I • LQ AppltT ... 9tWr1ttf' LO lm.a9t'w'rHtr 

g to 
Pet'S00..1 ... W'ritff' SC 

I 'o AppteTelk 0 Active 
I ® lnecllve 
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·:· !fyour printer's icon does not appear in tbe Cboose1; then 
the appropriate printer driver-the program that 
communicates wirh, or "drives," rhe printer- has nor been 
installed in your System Folder. Close the Chooser and install 
the driver you need. You can use rhe Customize option in rhe 
Installer program (see Chapter 8, "Setting Up Your Macintosh 
System"), or you can install the driver directly by dragging its 
icon inro the System Folder. If your printer is nor an Apple 
printer, review the instructions that came with it for 
information 0 11 installing ils driver. ·:· 

If you have a Personal Laser\Xfriter SC, close the Chooser window 
after vou cl ick the Personal Laser\Xfrirer SC icon. 

3. Click the icon representing the port that you used to 
connect the printer. Make sure the icon is selected. 

You have only rwo choices: the printer port or rhe modem 
port. Click rhe icon rhar marches the icon of the porr (on the 
back of the computer) to which you connected the primer 
cable. 

4. Click the Inactive button next to the word "AppleTalk." 

If the Inactive wasn't already selected, a dialog box appears. 
Click OK. 

5. Close the Chooser window. 



If your printer is on a network 

Find our from your network administrator (or rhe person who ser 
up your computer) which printer you can use, which zone ir's in 
(if your nerwork has zones), and what its name is (every printer 
on a network has irs own name). 

1. Choose the Chooser from the Apple menu. 

The Chooser window appears. 

2. Click the Active button next to the word ·~ppleTalk." 

Jf Active wasn't already selecred, a dialog box appears. 
Click OK. 

'lipes of devices <Mtilable ·mies of individual printers 

Chooser 

~ .~. 
~Vnt"' ~ 

AooleTolk Zones· 

4th fl oor wes t 
Slh flo or east 
'1H1 f l oor 1 l t 
6th fl oor east 
6th fl oor west 

:"Jen (a pr 
if rhc ~ 1acintosh is on a 
net work that h:t~ zones) 

0 

' 

Select a LaserWri er 

Accounting 
Humen Resources 
Marketing 
Sales 

0 

Background Printing @ On O Off 

AppJeTalk • Active 
0 Inactive 

.pplelalk must IJe active to 
use an\' net work devices. 
including network printers. 

3. Click the icon representing the type of printer you want 
to use. 

You may have to click rhe up and clown scroll arrows co find 
the icon. 

·:· [(yow· pri11ter's icon does not appear in the Cboose1: rhen 
the appropriate printer driver-rhe program chat 
communicates with, or "drives, .. the printer-has nor been 
installed in your System Folder. Close the Chooser and install 
rhe driver you need. You can use the Cusmmize option in the 
Installer program (see Chapter 8, .. Serring Up Your Macintosh 
System"), or you can install the driver dircclly by dragging its 
icon into rhe System Folder. (If you install the LascrWritcr 
driver, be sure 10 install the PrinrMoniror program also.) If 
your primer is not an Apple printer, review the instructions 
that came with it for information on installing its driver. ·:· 

4. If you see a list of AppleTalk zones, click the zone 
where the printer is located. 

You may have co click the up and clown scroll arrows to find 
the zone. The zones are listed alphabetically. 

5. Click the name of the printer you want to use, even if 
it's the only one that appears. 

co11ti1111es .,. 
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6. If you want to be able to use your Macintosh for other 
work while it's printing documents, click the On 
button next to Background Printing. 

The background printing oprion is available only if both rhe 
PrintMonitor program and the Laser\Xfriter driver have been 
installed in your System Folder. (See "Priming While Using the 
Computer for Other Work" in rhis chaprer for informarion 
about using PrintMonitor.) 

7. Close the Chooser. 

Selecting Page Setup options 

You use the Page Setup dialog box when you've selected a new 
prinrcr in rhe Chooser or when you wanr to use a different paper 
size or printing option. 

• Choose Page Setup from rhe File menu and select rhe options 
you want. 
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When a LaserWriter printer is chosen, this Page Setup dialog 
box appears: 

Pop-up menu of special paper sizes 

loserWrlter POJLe Setup l~J 
Poper. ® US letter O R4 letter 

O US legal O 85 letter 0( Toblold ...,. ] [Cancel ) 
r--

Reduce or l11!I!JI% Printer Effects: [ options] 
I- Enlorge: 181 Font Substitution? 

Orientation l8l Te Ht Smoothing? 

-~ 
181 Grophlcs Smoothing? 
181 Foster Bltmop Printing? 

g tile Up 11 I , 
percentage of original opens a dialog box for 

selecting enhancements 
ro rhe printed image. 

When an lmageWriter printer is chosen, this Page Setup dialog 
box appears: 

lmogeWrlter ldtJ] 
Paper: ® US letter O R4 letter 

0 us legol O lntemotlonol Fonfold 
O Compu ter Paper 

Orientation 

II~ 
Special Effects: D Toll Adjusted 

D 50 3 Reduction 
D No Gaps Between Poges 

[ Concel J 



You can choose Show Balloons from the Help menu to get 
descriptions of the enhancements provided in the Options dialog 
box, or check your printer 's manual for details. 

You'll see different options for each type of printer you use. Some 
programs provide additional options. Options you set in the Page 
Setup dialog box remain in effect until you change them. 

Updating printer drivers on networked computers 
All computers on a network that share one or more printers must 
have the same version of the primer driver software that 
communicates with (or "drives") the printers. When someone on 
the network sends a document to the printer using a version of 
the printer driver that's di fferent from the last version the printer 
recognized, the printer restarts itself (which takes time and clears 
any fonts from its temporary memory) . 

6 Important: All computers on a network must have the same 
version of printer drivers in their System Folders. 6. 

If your Macintosh is pan of a network, you or your network 
administrator should update the printer drivers on any Macintosh 
computers on your network that are running any system software 
version earlier than version 7.0. You do not have to update other 
components of the system sofrware; version 7.0 printer drivers 
work with earlier versions of the system software. 

To update printer driver sofrware, you use the Installer program 
and the accompanying Printer Update document (both files are 
on one of the system software disks that came with your 
computer). 

~ 00 
Installer Printer Update 

You can store these files on a file server or a shared disk on the 
network and install the update from there. 

1. Locate the Installer and Printer Update files (supplied 
on one of the system software disks), and then open 
the Installer icon. 

A dialog box appears, showing the printer driver icons and 
explaining your installation options. 

co11ti11ues ~ 
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2. Click OK. 

The Easy Install dialog box appears. 

Drivers to be updated 

~---
1 I n Install D 
I I on the hard disk named 

j c:::i Hard disk #2 

Help 

Disk on which drivers will he updated 

( E je<t Dist ) 

( Switch Disk J 

( Customize ) 

Quit 

3. Make sure that the hard disk indicated in the box is the 
one you want to update the printer drivers on. If a 
different disk name appears, click the Switch Disk 
button until the correct disk name appears. 
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4. If you want to install different printer drivers in 
addition to those already on your disk, click the 
Customize button, then click the names of the drivers 
you want to install. 

If you want to update only the drivers that are already 
installed on your disk, go to step 5. 

When you click Customize, the custom installation dialog box 
appears, showing a list of the printer drivers available. Press 
the Shift key while you click if you want to select more than 
one printer driver. 

Printer drivers available 

Cilek the Items you want to select; 
Shift-click to select multiple Items. -Software for LaserWrlter ~ [ los1~111 ) 

~oftware for Personal LaserWrlter SC 

c:::> Hard disk #2 

t<> 
( Ejec1 m~k ) 

( Switch Disk ) 

------
(Easy Install) 

I Quit I 



5. Click Install. 

6. Click Quit when you see a dialog box reporting that 
installation was successful. 

If a dialog box reports that installation was not successful, try 
che update again. 

Printing your work 
The mosc common way to print a document is while it's open and 
while ics window is the active window. You can also print 
documents while chc Finder is the accive program. 

1. Make sure that the document you want to print is in 
the active window. 

·:· lfyou're prinlingfrom tbe Hnde1; click che icon of che 
document you wam to prim (or cl ick several document icons 
while holding clown the Shift key). •:· 

2. Choose Print from the File menu, or press ~-P. 

A dialog box appears, in which you Gm set printing options. 
The options vary depending on the printer you have chosen 
and che program in which the document was created. 

If a LaserWriter printer is chosen in the Chooser, chis dialog 
box appears: 

Paper-recd Number 
method or copies 

Page range (clicking All prints the entire 
clocumem; entering page numbers in the 
,From and lo boxes prints those pages only) 

loserWrll r "lnserWrller" I! Print ~ 

Coples:llllJ P11ges: !> flll 0 From: D To: D I Cnncel J 

Couer Page: ® No O Firs t Page O Les t Page 

Poper Source : ® Poper Cosse tte O Monuul Feed 

Print: ® Block & White O Color/ Groyscole 

Oestlnntlon: ® Printer O Postscripts File 

·:· Pri11ti11g color or gray-scale documents: You can print color 
or gray-scale documents on any color printer that can use the 
LaserWriter driver. If you print a color document on a printer 
that prints only in black and whice, che documern will be 
produced in a halftone format; that is, it will be composed or 
pauerns or dots. ·:· 

Some programs offer additional printing options, such as the 
order in which a document's pages are printed. Sec the 
manuals that came with your programs for more information 
on their printing features. 

3. Click the Print button in the upper-right corner. 

After a moment, a status box appears. If background printing 
is turned on in the Chooser, che status box disappears after a 
few seconds, and you can do ocher work while printing 
continues. 
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Printing the contents of a window 
You can print the contents of the active window when you're 
working in the Finder. 

1. Make sure that the window whose contents you want to 
print is the active window. 

2. Choose Print Wmdow from the File menu. 

A dialog box appears. 

3. Select the options you want. 

4. Click the Print button. 

The window's conrencs are printed in rhe format currencly 
displayed, including items not visible on the screen. 

When no window is active, you can prim the contents of the 
Macintosh desktop by choosing Print Desktop from the File 
menu. 
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If the printer doesn't print your document 

The Print command isn't reaching the printer, the printer is 
gerring conflicting signals, or the printer isn't working properly. 

• Check tliac the printer is turned on and warmed up (if it's a 
LaserWri ter, it should have printed a sample page). 

• Check the cable connections to the prin ter. 

• lf your printer is an lmageWriter, make sure that the Select 
light is on. (Press the Select button to turn the light on.) A 
dialog box on the screen may inform you that the printer is 
not responding. 

• Check that the printer (and its name, if it's a LaserWriter) is 
selected in the Chooser. 

• Make sure that you are using the same version of the printer 
driver as all other people on your network. 

• Jf an error message states that the printer could not print your 
document, turn off the printer for at least 10 seconds, then 
turn it on again and wait for the printer to warm up before 
trying to print again. 



Tips for improving printing 

There may be cimes when your Macincosh does noc have enough 
memory available co print a clocumenc properly. If chis happens, 
the printed oucput may not look correct. Bitmappecl fonts may be 
subsricutecl for Truel ype f onrs, or characters or lines may be 
missing. To Ax this problem, try the following: 

• Immediately after you select the Print command, quit the 
application program from which you're printing. (Save your 
work, choose Print from the File menu, cl ick Print in the 
dialog box that appears, and quit the program.) To make more 
rnemoq1 available, you need to rake these seeps before 
printing begins, and you shouldn't open a program again until 
printing is finished. You must be printing in the background 
to do this. (See "Printing While Using the Computer for Other 
Work" for more information about background printing.) 

• If possible, simplify che design of your document by using 
fewer type styles or sizes. Simpler documents require less 
memory ro print. 

You may also norice char programs that can prinr several views of 
the same document (such as some presentation programs) 
display the same Prine dialog box more than once while priming. 
If you reselect the same options each time the dialog box appears, 
printing will proceed normally. 

Printing while using the computer 
for other work 
You can use your Macintosh for other work while you're printing 
on a LaserWriter printer if the background printing option is 
turned on in the Chooser. (See "Choosing a Printer'' in this 
chapter for information about turning on background printing.) 

You can control background printing with PrintMoniror, a program 
that 's installed auromacically when you insrall system software 
using rhe lnsraller program's Easy lnsrall option. 
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1. After you have started printing a document, choose 
PrintMonitor from the Application menu. 

When background priming begins, PrintMoniror opens 
automatically and its name appears in rhe Application menu at 
rhe right end of rhe menu bat: 

When you choose irs name from rhe Application menu, rhe 
PrintMoniror window appears. 

Name of the document being printed 
and printer currently in use 

PrlntMonltor 

1 ~ Read Me El' Wellesley 
2 ~ Benana Slug Lyrics El' Wellesley 

Documents to be 
printed next (a 
selected item can 
be removed from 

w1 1 the list) 

l-0-
Clicking this 
button lets vou 

r Set Print Time ... l I set the print time. 

One Page To Print 
status: starting Job 

Clicking this button cancels 
the current printing job. 
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--+-- Description and 
status of the 
current job 
appear here. 

You can use PrintMonitor to 

• monitor rhe status of printing 

• cancel a document currently printing or waiting to print 

• sec the time you want a document to print (elate and 
hour) or postpone a job indefinitely 

• monitor paper supply (PrintMonitor's icon blinks at the 
right end of the menu bar when the printer is out of 
paper; you can change the notification method with the 
program's Preferences command in the File menu.) 

• signal when to feed paper manually (PrinrMoniror's icon 
blinks at the right end of the menu bar to signal that you 
muse confirm rhe manual operation; you can change this 
notification with rhe program's Preferences command in 
rhe File menu.) 

2. Select the options you want, and then click the dose 
box. 



Working with fonts 
A font is a collection of letters, numbers, and symbols in a 
distinctive typographic design. 

When you install Macintosh system software, several fonts are 
installed in the Fonts folder, which is in the System Folder on your 
startup disk. You can install aclclitional fonts and remove fonts. 

Additional fonts are supplied on one of the system software disks. 
Fon rs are also available from independent manufacturers, user 
groups, and computer bulletin board services. 

Outline fonts and bitmapped fonts 
Your Macintosh uses two types of fonts: 

• outline fonts 

• bitmapped fonts 

Both types of fonts are installed in the Fonts folder in the System 
Folder of your srarrup disk when you install system software. 

Outline fonts (also called scalable or variable-size fonts) describe 
each letter, number, or symbol as a mathematical formula that 
defines the character's shape and adjusts itself to make the 
character 's size larger or smaller. Your Macintosh, therefore, needs 
only a single outline font in a particular typeface (such as Times) 
to be able to print or display that typeface in different sizes. 

The outline fonts supplied with Macintosh system software are 
called 11·uelype fonts. 

~ 
Courier 

·:· \Vben your Macintosh is running ~ystem 6, you cannot use 
True1)1pe fonts supplied with System 7. •!• 
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Bitmapped fonts (also called fixed-size fonrs), on the other hand, 
describe each character as a grid of black and white dots (called a 
bit map), which is a rendering of the character 's shape in a 
specific size. 

1::-B±i IBl 

Your Macintosh needs a separate bitmappecl font of a typeface in 
each size it prints or displays, such as 12-point Times® or 10-point 
Helvetica®. 

rd] 
Monaco 9 

An outline fom character is like a cookie recipe that you can use 
to make as big or as small a batch of cookies as you need. A 
bitmapped font character is like a cookie cutter: it gives you one 
size-that's all. 

For information on how the system software finds the fonts it 
needs, see "Getting the Best-Looking Fonts" in Chapter 16, "Tips 
and Troubleshooting." 
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Installing fonts 

'IO install a font: 

1. Quit all programs that are open. 

Pull down the Application menu to make sure that the Finder 
is the only open program. Choose any mher open program 
from the Application menu and then choose Quit from the 
File menu. 

2. Locate the icon of the font you want to install and drag 
it to the System Folder icon (not the System Folder 
window) on your startup disk. 

You can click multiple font icons while holding clown the Shift 
key t0 select more than one icon. 

A dialog box appears, letting you know that the fonts will be 
stored in the Fonts folder, where the}' belong. 

3. Click OK. 

Removing fonts 

lb remove a font: 

1. Open the System Folder on your startup disk. 

2. Locate the Fonts folder and open it. 

3. Locate the icon of the font you want to remove and 
drag it out of the Fonts window and out of the System 
Folder window. 

4. Close the Fonts window and the System Folder window. 



Transferring fonts to a LaserWriter printer 

If you're using a LaserWrirer primer chat's equipped to handle 
PostScript® and you wane to prim using PostScript outline fonts 
that are not built into your printer, you can transfer, or download, 
outl ine fonts from your System Folder to the primer. (PostScript is 
a programming language that describes rhe characters, symbols, 
and images appearing on each page of a document.) 
Downloading fonts saves you printing time if you plan to print a 
batch of documents that use those fonts. 

When you download a font, it's stored in the printer's memory or 
on a hard disk attached to the printer. You can download as many 
outline fonts as the printer's memory and hard disk space allow. 

You download a font using the LaserWriter Font Utility, which is 
supplied on che system software disks. 

1. Locate and open the LaserWriter Font Utility icon. 

~ 
Laser"w'riter Font Utility 

2. Choose Download Fonts from the File menu. 

A dialog box appears. 

[ Downlood t o 
® Printe r 

J O 1'r111tt1r•s <H~k(~) 

Fonts to download: 
Courie r IQ 
Courier-Bold 
Courler- DoldObllque 
Courie r - Oblique 
He luetico 
Heluetlcll-Bold _ 

Q 

r--{ Add ... [ Remot•e 

( Con eel ) [ Download} 

g mis 11ul!on c11sp1ars a curcciorr aia1og 
box for localing and selcuing atltli1ional font~. 

Fonts currently 
available for · 
downloading 

Clicking this 
hullon removes 
anv fonts sclcc1ecl 
in ihc lis1. 

Clicking 1his 
bullon downloads 
all foll!s listed 10 
1he primer. 

3. If the font you want to download is not listed, click the 
Add button to add fonts to the list. 

A directory dialog box appears, which you use to locate the 
fonts you want. 
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4. Click the name of the font you want, then click Add. 

You can press rhe Shifr key while you click co selecr more rhan 
one fonr. 

lei! Condensed Garamond "'I 
---0 D fiaramBollta • 

D Garomlig 
D Goramlig Ila 
D GC Print er Fonts 
D GC Screen Fonts 

l<>I 

= Hard disk 

f: ltH t 

Deskt op ] 

H Add id 
( Done ] 

;. When you've added all the fonts you want to download, 
click Done. 

The direcmry dialog box closes and the fonts you added are 
listed in the Font Utility dialog box. 

6. Click the Download button to send all the fonts in the 
list to the printer or its hard disk. 

A status box appears. You can click Cancel to stop the process. 

7. Click OK when the status box reports the results of 
downloading. 

8. Choose Quit from the File menu. 
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Finding out about available fonts 

Most application programs have a Font menu that lists the fonts 
installed in ~'our Fones folder, though some programs do not list 
them all (you can open the Fones folder icon, inside the System 
Folder, to sec al l the fonts scored there). 

The LaserWrirer Fane Uriliry program (supplied on the system 
software disks) provides three ways to see the fonts available for 
printing on a LaserWriter. You can display a list of fonts on the 
screen, print a catalog of fonts, or prim a set of font samples. You 
choose the method you wane from the LaserWriter font Util ity's 
File menu. 

Download Fonts... :!CD 
Display Ruailable Fonts ... :!CL 
I nitinliz.e Pr in h~r·s Di~lc.. 

Displars a window 
lis1ing all font~ 
currc111lr al'ailahlc to 
the p1inicr 

Pri111s a list of the 
Page setup... t foms"•;bhlcto 
Print Font Catalog... 3CP the pri111er 
Print Font Samples... Prints a sample of 

each fo111 available 
Quit 3CQ lO the printer 



Using the LaserWriter Font Utility 

While the LaserWriter Font Utility is most useful for transferring 
(or downloading) fonts from your System Folder ro a LaserWrirer 
printer and finding our about available fonts, you can also use the 
program to 

• initialize a hard disk attached to a printer 

• control whether a printer prims a sample page when you turn 
it on 

• restart a printer 

• send PostScript files to a printer 

The LaserWriter Font Utility program is supplied on the system 
software disks. 

Initializing a hard disk attached to a printer 

Some printers let you atcach a hard disk so you can store fonts on 
it (in addition to the fonts stored in the printer's memory). See 
the manuals that came with your prin ter if you need information 
about connecting a hard disk. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Initialize Printer's Disk from the File menu. 

A dialog box appears. 

3. Click the Drive button until the hard disk that's shown 
is the one you want to initialize. 

4. Click the Initialize button. 

Turning the printer's sample page on or off 

The LaserWriter prints a sample page each time it is turned on or 
restarted. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Start Page Options from the Utilities menu. 

A dialog box appears. 

Printer s tort poge: 

@ On 
Q Off 

[ concel] QO 

3. Click the On or Off button. 

4. Click OK. 
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Restarting a LaserWriter printer 

Restaning the printer clears irs memory, removing the fonts 
scored there and making room for ocher fonts chat you may want 
to transfer co rhe printer. 

1. Open the LaserWriter Font Utility icon. 

2. Choose Restart Printer from the Utilities menu. 

A dialog box appears. 

Lt Rre you sure you wont to 
restort your Post script printer? 
Doing so will erose all fonts In 
the printer 's memory. 

H Cancel J I Res tart J 

3. Click Restart. 

Transferring a PostScript file to a LaserWriter 

You can use rhe LaserWriLer Font Utility to send a file in Postscript 
format to a LaserWriter. (PostScript is a programming language 
that describes the characters, symbols, and images in a file to be 
printed or displayed.) 

1. Open the LaserWriter Font Utility icon. 
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2. Choose Download PostScript File from the Utilities 
menu. 

A dialog box appears. 

3. Click th~ name of the file you want to download to the 
printer, and then click Open (or double-click the 
name). 

A second dialog box appears, asking you to name a file that 
saves a record of the PostScript activil}'. This file has the preset 
name "PostScript Log." 

l= Trouel disk ..-1 = Trauel disk 

Cl 7.D beta draft ( Eject J 
Cl 7.D ngs 
[) octluwlndow ( Desktop J 
Cl Amsterdam 
Cl Rrt ldens ( New CJ ) 
[) Disk to Burr 

S1111e Postscript output as: ( Cancel J 

(( Soue U Postscript Log 

The name of a printing log, which 
records Pos1Script activity 

4. Type a name for the printing log, then click Save. 

The file is sem to the primer and a record of the PostScript 
activity is saved in the printing log. 

You can open the printing log to see the sequence of 
PostScript commands when the file was sent. 



Chapter 13 

Using Your Macintosh 
on a Network 
In this chapter 

• What you can do on the network 

• Setting up your Macinrosh on a network 

• Gaining access co files on shared disks 

• Working with files and folders on orher computers 

• Sharing your own files 

• Using access privileges 

• Linking programs 

• Using communications products with System 7 

What you can do on the network 
You can clo several things with your Macintosh once it is 
connected ma network: 

• Gain access 10 information on other computers. 

Working at your own computer, you can connect to other 
computers and gain access ro Ales that arc stored there. 
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• AllO\Y access to information on your own computer. 

You can designate che contents of specific folders and hard disks 
on your computer as ·'shared files'' chac ocher people can gain 
access to over the network. 

• Print documents on nerwork printers. 

You can prim documents on ne1work primers as you would on 
printers chat are connected clirecLI)' to your computer. 
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• Link your programs to programs on ocher computers. 

You can link your programs to programs on orhcr computers in 
order to share features berween those programs. For example, 
you could link a word-processing program to a dictionary 
program to check the meaning and spelling of the words in 
a document. 

• Update files over the network automatically. 

L~ 
2 ~ ·~ 

You can automatically update documents created in programs that 
use the Macintosh system sofrware's puhlish-and-subscribe 
f ea Lure (see the documenration that came with your programs for 
information about this feature). 



Setting up your Macintosh on a network 
Before you can use your Macintosh on a network, you have to 
physically connect your computer to the network, install 
networking software, make sure that your computer can 
communicate with the network, and identify your computer and 
yourself to others on the network. 

If you have a network administrator, he or she may have already 
set up your Macintosh on rhe network. Before you proceed, ask 
your network adminiscrator whether these tasks have been 
completed. 

Connecting to a network 
Your Macintosh has built-in AppleTalk networking software rhat 
allows your computer t0 connect to a network quickly and easily. 

If you're using a Local'lalk network (a type of Applefalk network), 
then all of the software and hardware you need is already built 
into your Macintosh. You can connect your computer t0 the 
network by plugging Locallalk-compatible cables into the back of 
your computer. If you need more information, see the 
documentation that came with your cables. 

lf you're using an Ethernet or a Token Ring network, your 
Macintosh needs both an EtherTalk or a Tokenlalk expansion card 
installed in one of its expansion sloes and the appropriate software 
to communicate with the nerwork. (See the documentation that 
came with your expansion card if you need more information.) 

The EtherTalk and the 'IbkenTalk software are provided on the 
system software disks that came with your computer. If a network 
expansion card was already installed in your computer when you 
installed system software, the software for it was installed 
automatically. If you installed the expansion card a:fter you 
installed the system software, you need to install the network 
software separately (see "Install ing a Customized System" in 
Chapter 8, "Setting Up Your Macintosh System"). 
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Turning on AppleTalk 

The first time you turn on your computer after you have 
connected it to a network, you need to make sure that 
AppleTalk is turned on. 

1. Choose the Chooser from the Apple menu. 

2. Click the Active button to turn on AppleTalk. 

ID 

~ .... 
~ 

rmimm Appl<T•lc. .. 90 ... rit.,. 

~ ~ 
~Yrittr" LHH''W'r'1ttf" 

AppleTBlk Zones: 
Engl neeri ng 

raphlCS 
Merketing 
Pro~uclion 

Publ1collons 
Reseerch 

3. Close the Chooser. 

Chooser 

0 

<> 

Select e fi le server: 

ArtlrlclBl Intelligence 
Artiste 
Comer Pocket 
Generel Purpose 
Greg's Mec1ntosh 
Kil t y Mergole's Mec1ntosh 
Monterey 
Niles Devls's Mec1nt osh 
Sonome 
Venture 

(f UK )J 
-

AppleTelk • Active 
O lnective 

Pl 
active before vou can 
use a nerwork. 

AppleTalk remains on umil you turn it off in the Chooser. 
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Selecting a network connection 

If you 're using a LocalTalk network, go to the next section, 
"Naming Your Macintosh and Its Owner." 

If you want to use an EtherTalk or a l bken'falk network 
connection rype or switch between two or more types of network 
connections, you have to select which connection you wanr in the 
Network comrol panel. 

1. Choose Control Panels from the Apple menu and 
double-click the Network icon to open it. 

II 
Network 

·:· ({you can't fi11d the Network control panel: The Network 
control panel, EtherTalk software, and 'lokenTalk software 
were installed only if you already had built-in Ethernet or an 
EtherTalk or l bkcnTalk expansion card in your computer 
when you installed the system software. If you have bu ilt-in 
Ethernet or an expansion card installed now and no Network 
control panel appears in the Control Panels folder, use the 
Installer program to install Ether'Ialk or TokenTalk software. 
(See ·'Installing a Customized System" in Chapter 8.) ·:· 



2. Click the icon of the network connection you want to 
use. 

Network 

Stltot JO ,\ppltT~'k conntction; 

II .. ~ Elh<rTal< 

A dialog box warns you that you may be disconnected from 
any network services (such as ptinters or file servers) that you 
are using wi th your current network connection. This means 
that vou must reconnect to the network services on the new 
network. 

3. Click OK. 

Next, you need co select the network zone your computer will 
use. 

4. Double-click the icon of the network connection you 
chose in step 2. 

The default zone that's preselected by 
your network administrator 

Cl 
Sales Grouplf" 
Finance 
Product Support 

~ 

Please select 
this computer's 
RppleTalk zone. 

l[ OK )J [ Cancel 

5. Click the name of the zone you want to use. 

Zones are set up by a network administrator and are used to 

distribute the devices on a network among groups for easier 
access. 

6. Click OK. 

7. Close the Network control panel. 

You can now use the network connection you selected. 
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Naming your Macintosh and its owner 

Before you begin to use rhe network, you must give your 
Macintosh a name and name yourself as its owner. The name you 
give your Macintosh appears in the Chooser of other computers 
on the network so that people on the network can gain access to 

fi les on your computer. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

~ 
Sharing Se~up 

·:· Ifyou can't find or can't open tbe Sbaring SeLufJ icon: Make 
sure that the Sharing Setup icon is in the Control Panels 
folder, and that the File Sharing Extension file and the 
Network Extension file arc in the Extensions folder inside the 
System Folder. If not, place them there and restart your 
computer. ·:· 
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2. Type your name in the box labeled Owner Name and 
press Tab. 

i§O Sharin!I Set up 

~ Network Identity 

OwMr NinW : l!Mi1$tilM.f4. ) 
Owotr Pusvord: I•••••••• I 

::::======~~~~~~~ 
H.ticintosh HMM : !Jonathon JoMs"s: Macintosh I 

3. Type your password in the box labeled Owner Password 
and press Tab. 

Your password can be up to eight characters long. After you 
press Tab, your password is replaced by bullets ( • ) so others 
can't read it. 

4. Type a name for your Macintosh in the box labeled 
Macintosh Name. 

This is the name others will see on the network. 

5. Close the Sharing Setup control panel. 



Gaining access to files on shared disks 
You can retrieve and store information on orher computers 
connected to your network. For example, a coworker can 
place some files for you on a shared disk called afile server­
a computer on the network dedicated to storing shared files. 
Private Macimosh computers on your network might also 
have shared disks. 

Before you begin 

Before you store or retrieve information on the network, do the 
following: 

• Find out the name of the shared disk you want to 
access and the name of the computer that it's on. 

• lf your network has zones, find out the name of the 
zone the computer is in. 

• Find out if you are registered on the computer or if it 
allows guest access. 

A Macintosh owner or network administrator can limit access 
to files on a shared disk. Ask the Macintosh owner or network 
admin istrator what type of access you have to the files. 

• If you're a registered user, find out the name and 
password you need to use. 

Find out exactly how your name and password are spelled, 
including capitalization. 
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Connecting to a shared disk 

1. Choose the Chooser from the Apple menu. 

2. Make sure that AppleTalk is active. 

3. Click the AppleShare® icon in the upper-left section 
of the Chooser window. 

AppleShare icon 

!O - -·--

s ..... 
~ 

llm!m!!ZI Appi.Tdc..-90'w'rlt..-

~ @ 
~"f/ntff' Luff'Vrittr 

AppleTelk Zones: 
Engineering .. 
Mcrkel1ng 
Production 
Publ1cel1ons 
Research 

File servers and other 
computers 11·ith shared disks 

Chooser 

~ 
Select e file server: 

Arllflc1el Intelligence t- Artiste 
Comer Pocket 
Generel Purpose 

Jo 
Greg's Mec1nlosh 
Killy Mcrgolc's Macintosh 
Monterey 
Niles Dev1s's Macintosh 

<> Sonome 
Venture -

(I CIK J) 

'o AppleTelk 
®Active 
O lneclive 

··;;;:;::: 

IQ 

'o 

·:· If the AppleSbare icon does 1101 appear: Make sure rim 
the AppleShare file is in the Extensions folder in your 
System Folder. ·:· 
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4. If your network has zones, click the zone the computer 
is in. 

If you don't see a box labeled ApplcTalk Zones, skip this step. 

5. Click the name of the computer you want to use. 

·:· if the 11a111e you want isn't listed: Make sure you have 
selected the correct zone. If the zone is correct, make sure 
the computer is turned on. ·:· 

6. Click OK. 

7. Click Guest or Registered User. 

~ 
Co nne ct to the fil e serue r "Rrlls te• in: 

click here ifn Gues t 
you arc not ®Registered user 

registered on 
the c<_>mputer Nome: I J ona thon Jones 

that you're Passw or d: I I (Scra mb led) 

connecting to. 

[ Cancel ( Se t Pessword ) n OK Jl 

If you are a guest, click Guest and go lO step 10. If the Guest 
option is dimmed, guests do not have access to this computer. 



8. If you are a registered user, make sure the name in the 
box is correct. 

Capitalization does nor need w march. 

9. Type your password. 

Capitalization needs to march. 

10. Click OK. 

·:· ((your password is not accepted: Make sure that Caps Lock 
is noL on. Type your password again, Laking care noL Lo 
make r~1ping errors. ·:· 

11. Click a shared disk to select it. 

~ llr.!.illi. 
Select th e Items you wont to use: -

' rg~ 
Adom's Folder D 
Bollerplote D 
Ill< hn~r nrt olo 
Checked Items ( l8l ) will be opened ot -
sy stem s tartup time. 

( Concel ) ~ OK ~ 

Dimmed items are not available to vou. 
or you're already connected to thern. 

Shared disks 
and folders 

12. Click OK. 

After you cl ick OK, the icon of the shared disk appears on 
your desktop. 

13. Close the Chooser. 

Disconnecting from a shared disk 

When you 're finished using a shared disk, close any open files 
or programs on the shared disk and then disconnecL in one of 
the follo\\'ing \\'ays: 

• Select the shared disk icon and choose Put Away from the 
File menu. 

• Drag the shared disk icon to the Trash. 

• If you are finished working for the day, choose Shut Down 
from the Special menu. Shutting down aurommically 
disconnects from the shared disk. 
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Using an alias to connect quickly to a shared disk 

By making an alias for a shared disk, you can connect to that disk 
by simply opening the alias. 

1. Connect to a shared disk. 

2. Select the shared disk icon. 

3. Choose Make Alias from the File menu. 

4. If you wish, rename the alias, then drag it to a 
convenient location. 

5. Next ti.me you want to connect to the shared disk, 
open the alias you created in step 3. 

If you originally connected to the shared disk as a registered 
user, a message appears. Type your password. 

If you connected to the shared disk as a guest, this message 
does not appear. 

The shared disk icon appears on your desktop. 
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Connecting automatically when you start up 

You can connect automatically to one or more shared disks 
whenever you turn on your computer. 

1. Connect to the computer that has the shared disk you 
want to open. 

2. Click the cbeckbox next to the name of the shared disk. 

~ Artis te 

Select the Items you w ent to use: 

' 
• . Adam's Folder 

Click one of Bollerple t e 
these Richner Rr t 

i;.;;.:c.;..;.:.;:.;__;.;.;..;.~~~~~~~-"=-"-' 

buttons lO Checked items ( 181 I will be opened et 
indicate syst em st artup time. 
\\'hether • Seue My Name Only 
'II I 0 Soue My Name ond Password rou 1avc 

to enter vour 
passwo;·d at 

startup. 

( Cancel ) ([ OK )J 

Check a box to connect 
automatically when you 
lUrn vour computer on. 



3. If you're connecting as a registered user, click the 
button that indicates whether you want the shared disk 
to save your name only, or both your name and your 
password. 

To prevenr unauchorized people from gaining access to che 
shared disk, click "Save My Name Only." When you stare up 
your computer, you 'II need to enter your password to connecc 
co che shared disk. 

4. Click OK. 

5. Close the Chooser. 

Working with files and folders 
on other computers 
Once you are connecccd co a shared disk, you can use the files 
and folders on it as if they were on your own computer. 

You may nor be able to open some items on a shared disk because 
the owner hasn't given you access to those items. for in formation 
on how to check your access privileges, sec "Working Wich 
Privileges That Ochers Have Set" later in chis chapter. 

Creating a new folder on another computer 
You can creace a new folder on a shared disk (as long as you 
have the correcc access privileges). If you are a registered user, 
you become the owner of any folder that you creace. If you are 
connected as a guesc, you share ownership of the folder with 
all guests and registered users. 

The icons of f olders that you own have a darkened rab. 

LJ 
When you own a folder, you can determine who can use it and 
in what way. See "Using Access Privileges" later in chis chapcer 
for more informacion. 

Chapter 13: Using Your Macint0sh on a Ne1work 187 



Changing your password 

If you are a registered user, you may be able ro change the 
password you use to access a shared disk. (Your network 
adminisrraror can restrict this capability.) 

1. Connect to the computer that has the shared disk 
you want. 

2. Click the Set Password button. 

~ 
Connect to the rue seruer " Ar tiste• es: 

Q !iuest 
® Regist ered user 

Name: I Jonothon Jones 

Password: I I (Scrnmbled) 

[ Cancel J [ S~t Password J ([ OK )J 

Click hen.: 10 change 
\'Our pa~s11·ord. 

If a message tells you that you cahnor change your password, your 
network administrator has turned off this feature. 
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3. Type your current password. Then press Tab and type 
a new password. 

A bullet ( • ) appears for each letter you rype. 

Old password: 

New password: 

( Concel ) (~J 

4. Click OK. 

5. Click OK in the dialog box that appears. 

6. Retype your new password and click OK. 

Your new password is now in effect. 



Giving folder ownership to someone else 

You can give awa}' ownership of any folder you own. Once you do 
so, however, the new owner can resrricr your access ro that folder. 
Make sure you have copies of any files you may need before you 
give ownership of a folder ro someone else. 

1. Connect to a shared disk. 

2. Click to select a folder that you own. 

3. Choose Sharing from the File menu. 

4. Type the name of a registered user or group in the box 
labeled Owner. 

; . Close the dialog box. 

A message asks you to confirm that you want ro change the 
owner of the folder. 

6. Click OK. 

The user or group char you named assumes ownership 
immediately. 

Sharing your own files 
You can share files stored on your Macinrosh with others on rhe 
network. For example, members of your work group can connect 
to your computer and open a file from their own computers. 
(They do nm have LO be using System 7.) Or, if you have both a 
desktop Macinrosh and a Macinrosh PowerBook computer, you 
can transfer files from one computer co the ocher wi thout using 
floppy disks. 

You control what you share and with whom ~'OU share it: 

• You share only folders you specify. 

• You share only with the people you specify-one person, 
a group of people, or everyone on the network. 

• You can sec everything on your own computer from another 
computer on rhe network. 

How file sharing works 

There are three steps to sharing a folder or disk: 

• rurn on file sharing 

• select a folder or disk to share 

• decide whom you wam ro share ir wirh 

The folder or disk you share is nor accessible to anyone bur you 
until you choose whom you want to share it with. 
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Turning file sharing on 

1. Choose Control Panels from the Apple menu and 
open the Sharing Setup icon. 

m 
Shat-ing Setup 

Make sure rhe boxes in rhe Network Iclenrity section of 
the conrrol panel are filled in. 

2. In the section labeled File Sharing, click the 
Start button. 

Shoring Setup e Ne twork Identity 

Ownt,. N¥nt : l@NISUM I 
o-.-n.,- P1nYord: !•••• .. •• I 

:=:=::===--~~~~~~ 
~\itosh N.-nt: l.JoNthon Jonts's Macintosh 

Cl. k I I F-, "" '"'"" ' IC l CJ'C L_J 
10 Start file [ St or I ) [-r~!~~~~;~-;~·~Ci~k"St•rt to allow oth;:;~-;J 

sharing. -~~~.!!..!!'!..'~~~-~~!'.:.': ______________ ·---·---

~ Progrom linking 

~
Status 

( Stort J Pr .. 09". ..- linking u off. Click St.rt to a llo'w' oU..r 
_urs to link to 'ijOlW" shairtd pt'OC)r"MnS. 
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3. Close the Sharing Setup control panel and the Control 
Panels folder. 

If you want to give everyone on the network access ro the items 
you share, continue wirh the nexr section, "Turning On Guest 
Access. " Otherwise, go to the following section, "Selecting a 
Folder or Disk ro Share." 

Turning on guest access 

If you wam all users connected ro rhc nerwork to have access to 
your shared folders and disks, you need to turn on guest access. 

Even when guesr access is turned on, no one but you has access 
to any of your folders or disks until you specifically share them. 
You can always limit access to any folder. 

lb rurn on guest access: 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

~ 
Users & Groups 



2. Open the <Guest> icon. 

!ID users Ii' Groups ~!:!ml 
3ittms 

!O 

[J • 0 
Jonathon ...ion.s Nilts Divis 

'--------'-"-- <Guest> icon 
0 
'211 

3. Click the checkbox labeled ''Allow guests to connect" to 
place an X in it. 

'lo allow guests 
to connect to 

your compute1; 
click to place an 

X in this box. 

1IDJ <Gues t> 

LJ File Shor ing 
,'J;;;, 
-@ Allow C)Jtsts lo ~ct 

~ Program linking 

0 A11ov psts lo link to progrMM 
on this ~intosh 

0 5 

4. Close the window and click Save in the dialog box. 

You can still restrict access to any folder or disk you share, 
as described in the section "Using Access Privileges," later in 
this chapter. 

Continue with the next section to select a folder or disk to share. 

Selecting a folder or disk to share 

You can share any folder, hard disk, or CO-ROM disc connected to 
your com purer (you cannot share fioppy disks). You can share up 
to ten folders or disks at a time. (This number does not include 
folders within the folders or disks you share.) 

1. Make sure file sharing is turned on. 

2. Select a folder, hard disk, or CD-ROM disc to share. 

3. Choose Sharing from the File menu. 

4. Click the box labeled "Share this item and its contents" 
to place an X in it. 

iiD For nu Eyes 

LJ 'tther~ : Jo~thon Jone.s's Macintosh: 
F'or All E~es 

Click here --+-o-· this Utm Mid its contonts 

to share the 
item you've 

selected. 

SH SH HMct 
Fo~s Fflts ~ 

Owner : I (·l~..t ~ i !8i l8l 
User /Group : I ti-}!rt ~I !8i l8l 

Evtq1ont ~ ll:<J 

0 M1k1111 currtnt~ •nclosed folders like this ont 

0 C.tn't bf mov.d, r~ or dflttfd 

!8i 
!8i 
!8i 

For information about the other checkboxes in this window, 
see "Using Access Privileges" later in this chapter. 

continues .,_ 
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5. Close the window and click Save in the dialog box. 

Ar this point, only you have access ro the item you shared 
and the files and folders inside it, unless you rurned on guest 
access. If you haven't turned on guest access, continue with 
the section ·'Naming a Registered user'" co name the specific 
people you want to share your folder or disk wich. (The 
settings you choose in the checkboxes for Users, Groups, 
and Everyone can take effect only if you allow guest access 
or register users in the Users & Groups control panel.) 

If you shared a folder, its icon appears on your desktop with 
a darkened tab and network cables: 

Q, 
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When people on the network are connected to your shared 
folder, its icon appears with faces in the center: 

~ 
:~: 

~ Important: Before you put programs inside shared folders 
or disks, remember that copyright laws may prevent those 
programs from being shared. Check the applicable licensing 
agreements and folio\\· their specifications. ~ 

Turning off access to a shared folder or disk 

Any shared folder or disk can be made private again. 

1. Select the shared disk icon. 

2. Choose Sharing from the File menu. 

3. Click the box labeled "Share this item and its contents" 
to remove the X. 

Your changes rake effect immediately. If people are connecred 
ro your computer, you see a message asking if you want m 
proceed. 



Naming a registered user 
You can register as many as 100 people and groups combined, but 
for best network performance you should name no more than 50. 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

n 
Users & Groups 

2. Choose New User from the File menu. 

An icon labeled New User appears. Its name is selected 
for editing. 

·:· Ifyou can't find the New User command: Make sure the 
Users & Groups window is active. ·:· 

3. Type the name of a person you want to register. 

Make sure you notify the person of the exact name you type. 
(Capitalization does not have to match.) 

m Users & Groups 01! 
3 lt•ms 

[] 0 n M '.'kw user icon 

Jonathon JonH <GuHt> --- - - --- - - -- -

L 
0 
Qi1 

4. To register more users, repeat steps 2 and 3. 

Tb assign passwords or to name groups of users, continue with 
the next two sections. lf you want to start sharing immediately, 
go to "Selecting a User or Group to Share a Folder or Disk" later 
in this chapter. 

Chapter 13: Using Your Macintosh on a Network 193 



Setting a registered user's password 

You can assign passwords for registered users to veri~1 their 
iclentiries when rhey want ro gain access ro your computer. 

1. Open a user icon in the Users & Groups control panel. 

The user's name 

!IDJ Niles Douis 

Us•r P.iii.SS ... ord : L____J 

LJ File Shoring 
~. 

181 Allow our to COMfCt 

[8J Allow unr to ch.1n9e pusvord 

I_, ~ 

~ Program Linking 

0 Allov U$tr to link to progr¥ns 
on this M~in tosh 

·1ype a password 
for rhis user 
here. 

2. Type a password in the User ?assword box, then 
press Tab. 

The password can be up to eight characters long. When you 
press 111b, the password is replaced by bullets for privacy. 
Make sure ro inform the user of the exact password, including 
capitalization. 

3. Close the window, and then click Save in the dialog 
box. 

194 Chapter 13: Using Your Macinrosh on a Network 

Naming a group of users 

You can name several registered users as a registered group. 

1. Open the Users & Groups control panel and choose 
New Group from the File menu. 

An icon labeled New Group appears. The name is selected 
for editing. 

liD Users & Groups E!l!il 
6 ittmS 

0 1 

D 0 \Iii 1 1 Group icon 

Jonathon Jonts Cl'.Jut.st> 

0 
Nilts:Oavts 

0 
Elltn Fitz.'W'attf' 

0 
Barb Huc)t'ws 

Drag user icons 
to the group icon. 

IOI 
12JI 



2. Type a name for the group. 

3. Drag user icons to the new group icon. 

The icons are not moved inside the group icon, as [hey would 
be if it were a folder. Dragging the icons creates a member 
icon inside the group icon. You don't need to cl rag your own 
icon to the group icon because you have access to the entire 
contents of your computer (unless you specify orherwise) . 
You don't need to include the < Gues[> icon in any group. 

To allow this group ro gain access w a shared folder or disk, 
go to the section "Selecting a User or Group to Share a Folder 
or Disk." 

Seeing who's in a group 
• To see the names of all group members, open the 

group icon. 

i!D Testing Teom 01 
3ittms 

~ ~ ~ 
~ 

EUto Fitz:v Jttf' B.rb~s N1luOavts 

'o 
12.I ~'2:1 

You can open any member icon to see or change the serrings 
you've made for tlm user. 

• To see all the groups that a user belongs to, open the 
user 's member icon or user icon. 

The user's name 

l~D . Niles Dauis 

User Pus'W"ord: h I I It I I I Ml 

LJ File Sharing 
'~' 

{8J Allow user to conneot 

(8] Allow user t o char19t password 

Groops: 
THting Team 
Cracker jack Tum 
luoch Gr'oup 

1 t=i ' Tht: groups this 

~Program Linking 

0 A1lo.., user to link to prOCJYams 
on this Maclntosh 

user belongs Lo 
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Selecting a user or group to share a folder or disk 

You can give one regiscered user or group exclusive access co 
a shared folder or disk on }'Our compucer. 

1. Select a folder or disk to share. 

2. Choose Sharing from the File menu. 

3. Click the box labeled "Share this item and its contents" 
so an X appears. 

4. Choose a user or group from the User/Group 
pop-up menu. 

i!_D For All Cy_es 

LJ Yhere ; Joru1thon Jonts's MfcTitosti 

.~ 
ror All Et,1t1 

('81 ShMt this Utm .Ind 1ts oonttnls 

s.. Stt 
Foldtf's f11ts 

Ovn-. : I Jonothon Jonos • I 181 l8l 
Un r/Group : • <Nont> 181 l8l 

Ttsting Tum 
Cr.cktrJa<:k Tum 

181 l8l 
0 Makt ~11 cur Lunch Group Hkt this ont 

---··--·--·-·-· 0 C•n't btmo Nllts D•vts . 
Ell<n Fitzv•t<r 
Jon.11thon Jonts 

M•l<t 
0.009ts 

181 
181 
181 Registered users 

and groups appear 
in this menu. 
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5. To share the item with only the user or group you've 
chosen, make sure there isn't an X anywhere in the 
third row of checkboxes (to the right of Everyone). 

I! 
LJ Yhere : 

:-s.='. 

For All Eues 

JoMthon JonH's ~fntosh . 
ror All Evts 

181 Sl>Kt thfs lttm #Id ils -.tonts 

s.. s.. Mlkt 
Foldtrs FiWs C~s 

Ov M r : I Jon•thon Jonos • I 181 181 
User /Group : I Ebrb tuJhts ... ) [81 181 

[ YtfVOM 0 0 
0 Mok• •TI e<rrtntl<j tnelostd foldtrs 11<• this..,. 

0 C¥i#t bt movtd,. rf'NfMd or Otltttd 

181 
l8l 
0 

6. Close the window and click Save. 



Preventing users or guests 
from accessing your computer 
1. Choose Control Panels from the Apple menu and open 

the Users & Groups icon. 

~ 
Uset·s & Groups 

2. To deny access to a specific user, open the user icon. 

The user's name 

ID Niles oouls 

Us:tf'PHSWOl"d: ~ 

LJ Fiie s110rlng 

·1· 1 1 ~· () l Cn\' l8J Allow ustr to OOMtOt 

acccsS [8J Allo'W UJtr to changt password 

to this user, 
click to 

remove che X 
in chis box. 

GrOU!> I: 
TtstincJ Tttm 
Cr.tektf"j1ck Tum 
L"'°h Group 

~ Program linking 

0 Allow ustr to h•k to pr09'..,,. 
on this MKtntosh 

To deny access to guests, open the <Guest> icon. 

'le> deny access 
ro guescs, 

click w remove 
the X in this box. 

Im <Guest > 

LJ File Shoring 
.~ 
------(8l Allow gutsts to conntot 

~ Program Linking 

D Allow 9'1t'Jts to link to procyams 
on this Macintosh 

E!ll ' 

3. Make sure there isn't an X in the checkbox allowing 
guests to connect. 

4. Close the window and click Save. 

If you deny access co a user who is currently connected, he 
or she is disconnected immediately. That user is no longer a 
member of any groups, and can connect only as a guest. 

If you deny access ro guests, any guests curremly connected 
arc disconnected immediately. 
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Removing a user from a group 

1. In the Users & Groups control panel, open the 
group icon. 

2. Drag the member icon to the Trash. 

3. Choose Empty Trash from the Special menu. 

Removing a user or group from your list of 
registered users 

You can remove a rcgisrcrcd user or group at any rime. When 
you remove a user, he or she will no longer be a member of 
any registered groups. 

1. Open the Users & Groups control panel. 

2. Drag the user or group icon to the Trash. 

3. Choose Empty Trash from the Special menu. 

If rhe user is currenrly connected, he or she is cl isconnecred 
immecliarclv. 

You cannot throw awav rhc < Guest > icon or the owner icon. 
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Giving away ownership of a folder or disk on your 
computer 

You can give away ownership of a shared folder or disk on your 
Macinrosh ro a registered user or group. 

13ecause you are the owner of your Macinrosh, the new owner of 
a folder or disk on your computer cannot restrict your access to 
it. However, the new owner can change the access privileges 
that other people have to the folder or disk. If you give away 
ownership of a folder or disk, make sure to remove any folders 
or documenrs rhar you don't wanr others ro see or change. 



1. Select a shared folder or disk. 

2. Choose Sharing from the File menu. 

3. Choose a name in the Owner pop-up menu. 

i!_O For All Eyes 

LJ Yhe,-e : Jon.1lhon JonH's Maointosh • 

,;!\;;;;;;;;, 
For Al1 EyH 

(8J Shirt thts ittm and its conttnts 

s.. s.. Mtkt 
f'otdffs F1\ts C'-901 

Ovner : <~ Ustr> 18! Ii?! 18! 
User /Group : THlin9 Tum 181 181 l'8l 

Cr.cktr"jtck Tum 
18! 181 181 lunch°'""'-" 

0 Mab• l1 cu- Hilts D1ivis hke thls OM 

0 C..'tbo mo E11tn F1tz:wJttr I 
• Jon•thon JoMs 

If you selecr <Any User> , rhen anyone on rhe nerwork can 
change rhe access privileges or ownership of the item. 

4. Close the window and click Save in the dialog box. 

;. Click OK again to confirm that you want to change 
ownership. 

Turning file sharing off 
You can rurn file sharing off al any time. When file sharing is off, 
people on the nerwork cannor access folders or disks on your 
complller, and you cannor access your compurer from anorher 
compurer on rhe nerwork. 

When you rurn file sharing back on, rhe items you shared before 
arc available again auromarically. 

1. Choose Control P'anels from the Apple menu and open 
the Sharing Setup icon. 

m 
Shar-ing Setup 

co111i11ues ... 
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2. In the section labeled File Sharing, click the Stop 
button. 

A dialog box appears in which you can specify a delay before 
file sharing is turned off. If you specify a delay, users who are 
connected to your computer are warned to save their work 
and disconnect. 

How mony minutes until file 
sharing is disabled? 

IU•MI 
Cnncel ([ OK I) 

3. Type the number of minutes you want to elapse before 
file sharing is turned off. 

To turn file sharing off immediately, type the number 0. 

4. Click OK. 

If someone is using files on your Macintosh when file sharing is 
turned off, any changes he or she has nor saved will be lost. 
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Monitoring file-sharing activity 

\Vhen file sharing is on, you can see 1,vho is connected to your 
computer and what folders or disks you've shared. 

• Choose Control Panels from the Apple menu and open the 
Pile Sharing Monitor icon. 

[ii 
File Sharing Monitor 

Users connecrecl to your 
computer are listed here. 

iiD File Shllring Monitor 

l2J Jonathon Jones's Macintosh 

_ Q Shared I terns QI ConnectedlUsers 

11 I s .. ky"• foldor 0 
Fo ( ers anc G•t Yow Rtports Htr• 

{] <Guest> 
0 Niles:Davls 

disks being '0 ' An Ey•• 

shared o 
are listed Fiie Sharing Actluity: 

here. 1d1• Busy 
( Dis< 0 111H>C1 

To disconnect a useJ 
select his or her name 

and then click here. 

b 



Disconnecting someone who 
is connected to your computer 
You can disconnect users who are currently connected to your 
Macintosh in the File Sharing Monitor control panel. 

1. Select the user or users you want to disconnect. 

2. Click Disconnect. 

3. Type the number of minutes that you want to elapse 
before users are disconnected. 

How mony minutes until select ed 
users are disconnected? 

-concer J t""=--u""K=--""'n 

If you speci~1 a delay, users are warned to save their work 
and disconnect. It's a good idea to give people enough time 
to save changes they have made. ·10 disconnect a user 
immediately, rype 0. 

4. Click OK 

A message remains on the screen until the time is up. Click 
Cancel if you don't want to disconnect the users. 

5. When the designated amount of time has elapsed, 
close the File Sharing Monitor. 
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Gaining access to your computer 
from another computer 

You can connect to your own Macintosh from anorher computer 
on the network and access everything on the disks attached to 

your computer. 

1. Make sure that file sharing is turned on. 

2. Choose Control P'anels from the Apple menu and open 
the Users & Groups icon. 

e 
Users & Gro1Jps 
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3. Open the owner icon (the one with the bold outline). 

4. Click the boxes labeled 'Wow user to connect" and 
'Wow user to see entire disk" to place an X in them. 

liOiiiliiill Jonathon Jones~ 

\Vith an X in this box. 

vou can connect to vour =Fl_] 
'computer from another ~. File Sharing 

COmpUter: Allow USH' to ..,.....1 

l8J Allow ustt" to chln9f ~JS'W'Or'd 
\Vi[h an x in this bCJX, Allow USH' to stt ontrt disl< 

\'OU can see everyth111g Group='.:...' --------,;;'1 

· on vour computer. I ~ 

When these boxes are checked, you can see and use 
everything on your disks while you're using another 
computer. 

lb restrict your access, click a checkbox to remove the X. 



5. Close the window and· the Users & Groups 
control panel. 

6. Leave your computer turned on. 

'lo gain access ro your com purer, connecr to it as a registered 
user. Type your owner name and password as they appear in rhe 
Sharing ScLup co11Lrol panel of your computer. Then connecr as 
you normally woulcl. 

·:· ~(vou are unable to connect to your computer: Make sure 
that your com purer is turned on, that file sharing is turned on, 
and that you have rhe correct access privileges. Make sure that 
you type your password exactly as it is entered in the Sharing 
Setup conrrol panel, irtclucling capitalizarion. •!• 

Changing your password 

You can change the password you use to gain access to your own 
computer from anorher computer. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

m 
Sharing Setup 

2. Type a new password in the box labeled Owner 
Password and press Tab. 

'ID. Shoring Setup 

~ Network Identity 

·1 ~·pe 
vour new 
password 

Owner Pusword: l~.; •. ;..~.; .. ;";.~11==========::.-11 -- here. 
Owner NMne: l@MMIMr.4 ] 

M.cintosh Name: (Jon•thon .JonH's M.iolntosh 

Remember rhe capitalization. Your password is replaced by 
bullers to keep ir private. 

3. Close the Sharing Setup control panel. 

Your new password is now in effect. 
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Using access privileges 
Access privileges let you control what other people can do with 
the information you share on a network. For example, you might 
wanr to let people see a file but prevenr them from changing it. 

Understanding access privileges 

You can ser access privileges for any shared folders on your own 
computer and any folders you create on another Macincosh. 
Owners of orher computers can set access privileges thar restrict 
whar you can do with rheir shared disks. 

Three categories of people can have access privileges ro shared 
disks and folders: 

• Tbe owne1: The owner of a folder can change the access 
privileges to that folder. You become the owner of a folder 
automatically when you create it. You can keep ownership or 
give it away. 

• A registered user or group. A registered user has special 
access to shared disks over the network. A registered group is 
a group of registered users. 

• Eve1yo1ie. This category includes the owner, registered users, 
and guests. 
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There are three types of access to shared items: 

• See Folders allows people to see, open, and copy the folders 
within a folder or disk. 

• See Files allows people to see, open, and copy the files within 
a folder or disk. 

• Make Changes allows people to make changes to a folder or 
disk-copy, delete, or change any of its contents. 

The rable indicates which privileges you need in order to take 
cerrain actions with items in a shared folder or disk. 

Make 
Action See Folders See Files Changes 

-

Copy or move files to a folder D D [Z1 

Copy a file from a folder D [Z1 D ... 

Copy a folder from a folder [Z1 D D 
Create a folder in a folder [Z1 D [Z1 

Delete a file from a folder D [Z1 [Z1 ... 

Delete a folder from a folder [Z1 D [Z1 ... 

Open and use a file in a folder D [Z1 D 
Save changes to a file in a folder D [Z1 . [Z1 ' 



Setting access privileges to folders and disks 

You can sel access privileges for shared folders or disks on your 
own computer and for folders char you own on ocher compulers. 

1. Select the folder or disk. 

2. Choose Sharing from the File menu. 

The dialog box you see may be slighlly differem from lhe 
one pictured. 

1m: For All ~s 

Q Yh•n: Jon•thon .Jonff's M1e1nto$h: 
For All ['1jH 

l8J Sharf' this itf'm .rld tts conttnts 

s.. s.. MM<t 
Foldtrs ni.. °""9tS 

Ownor : I Jon•thon Jonts • I 181 
Uur/Group : I <Nont> ·I 181 181 181 Use these boxes to set 181 181}1-

E • • ..,,,.... 181 181 181 access pnvilegcs. 

0 f"'W:t •11 cwrtnt)J tneloud foldtrs 1ib this OM 

D C..'t t>. moved, rtn¥notd Of' dtltttd 

• If you've selected a folder inside a shared folder, lhe 
checkbox ac che top is labeled "Same as enclosing folder." 

• If you've selected a folder on another computer, the 
Owner and User/Group areas are text boxes, not 
pop-up menus. 

• If you've selected a folder you do nol own, all che 
checkboxes and their labels are dimmed. 

3. Choose a registered user or group to share the 
item with. 

Choose from the list of users and groups in the pop-up menu, 
or type the name of a registered user or group in the box. 

4. To set access privileges, click the appropriate checkbox. 

• To set the same privileges for the folders within lhis folder 
or disk, place an X in the box labeled "Make all currcmly 
enclosed folders like this one." If you're working with an 
item that comains a large number of folders, such as a 
CD-ROM disc, this action may cake a few minutes 
to complete. 

• To prevent the folder from being changed, place an X in 
che box labeled "Can't be moved, renamed, or deleted." If 
you check this box, no one-not even you- can change 
lhe folder. 

• Lf you want the folder to have che privileges set for the 
folder or disk enclosing ic, place an X in the checkbox 
labeled "Same as enclosing folder." This box on ly appears 
for folders inside shared folders. When you move such a 
folder to another folder, its access privileges change to 

reflecl lhose of the enclosing folder. 

5. When you're finished setting access privileges, close 
the Sharing dialog box and then click Save. 

The access privileges take effect immediately. 
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Access privilege strategies 
Access privileges can be combined in several ways. A few common 
and useful strategies arc summarized here. 

• Allow everyone on the network all access privileges. 
As long as you've wrned on guesr access, everyone on rhe 
network can open, read, and change the files and folders. 

See See Make 
Files Folders Changes 

Owner l8l [8J [8J 

User/Group [8J [8J [8J 

Everyone [8J [8J [8J 

• Keep a folder or disk private. 'lb keep a folder or disk on 
your own computer private, clo nor share ir. lb keep your 
folder on another computer private, use these serrings. You 
have full access but no one else can see, open, or use its 
contents. 

See See Make 
Folders Files Changes 

Owner [8J [8J [8J 

User/Group 0 0 0 
Everyone 0 0 0 
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• Allow access to one other person or group. This set of 
privileges allows the owner of the item and one registered 
user or group to use the item. 

See See Make 
Folders Files Ch•nges 

Owner [8J [8J [8J 

User/Group [8J [8J [8J 

Everyone 0 0 0 

• Keep a folder private but allow others to place files or 
folders into it. People on the network can deposit files or 
folders into this folder but cannot see, remove, or change its 
comencs. (This configuration is sometimes called a drop box.) 

See See Make 
Folders Files Changes 

Owner [8J [8J [8J 

User/Group 0 0 [8J 

Everyone 0 0 [8J 

• Set up a folder as a bulletin board. People can open and 
read rhe files in this folder hut cannot change them. 

See See Make 
Folders Files Changes 

Owner [8J [8J [8J 

User/Group [8J [8J 0 
Everyone [8J [8J 0 



Working with privileges that others have set 

When you are using the By Icon or By Small Icon view, rhe 
appearance of shared folders indicates rhe access you have. 

Icon Meaning 

.-. 
LJ 

.• ~-· 

LJ 
[]J 

I' ]{J 

A darkened rah indicates rhat you own the folder 
and can set its access privileges. 

A plain tab indicates that you Giii open and use the folder . 

A strap indicates that you cannot open and use rhe folder. 

A strap with an arrow indicates that )'OU can put files 
or folders into the folder, but you cannot open it or 
use anv files or folders within il. 

Checking your access privileges 

When you open a folder on anorher computer, icons under the 
title bar inclicare the privileges that you clo not have. 

~~~ 
You can'r 
make changes. 

You can't 
see files. 

You can't 
see folders. 
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Linking programs 
Some Macimosh programs can exchange informarion direccly 
wich mher programs. For example, one program mighc be able co 
inscrucr another program co add a row co a spreadsheec or change 
che fonr size of a paragraph. 

Programs implemem linking in various ways and nor all programs 
have chis capability. See rhe documentarion thar came wich your 
programs for more information. 

Linking to a program on another computer 

You can only link co programs rhar are shared. 

1. Within your program, choose the menu command that 
allows you to link programs. 

The menu location and command name depend on che 
program you're using. You use a dialog box to find che 
program chat you want co link to. 
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Crnnpu1crs available 
for prog1~1111 linking 

Choose a program to link to: 

t--_ Macintoshes Programs 

Artiste n CADWorks ~ ~ 
Dlene·s Mectntosh The Bottom Line 
Monter~ WordRighter 

-I W!lll!. !W!,• 

Niies Devl s"s Mecintosh Jd venture 
'-

AppleTelk Zones 

Engineeri ng <> .. 
Mcrkellng f;;:1 

Production tzy 
Publicet1ons '~ 

Research JO [ Cencel ) ~ OK ~ 

1g1 g n 
the selected comprner 

2. If your network has zones, select a zone in the lower­
left section of the dialog box. 

3. Select the Macintosh you want to connect to in the 
upper-left section of the dialog box. 

4. Select the program you want to link to. 



5. Click OK. 

In most cases, you need to identify yourself as a guest or 
a registered user. 

~ 
Connect t o shored disk " Artis te" os: 

Q Guest 
® Registered User 

Nome: jJonothon Jones I 
Possword: II I 

[ Cancel J n OK n 

6. Click Guest or Registered User. 

If you are a guest, click Guest and go to step 9. If the Guest 
option is dimmed, guests do not have access to this computer. 

7. If you are a registered user, make sure that the name 
is correct. 

8. Type your password. 

9. Click OK. 

The two programs are now linked. 

Disconnecting a program link 

'lb disconnect a link co a program on another computer, quit the 
program you used to create the link. 

Allowing other people to link to your programs 

You can allow people on the network to link to programs on your 
computer. 

• First you rurn on program linking. 

• Then you make a program available for linking by sharing ic. 

• Finally, you either allow guest access or allow specific people 
to link. 

These steps :lre outlined in the following sections. 

Chapter 13: Using Your Macintosh on a Network 209 



Turning program linking on 

When you turn program linking on, your computer is visible to 
others on the network \rhenever they attempt to link a program. 
Before you turn program linking on. make sure that AppleTalk 
is active and that you have named your Macintosh. 

1. Choose Control Panels from the Apple menu and open 
the Sharing Setup icon. 

2. In the section labeled Program Linking, click the 
Start button. 

ID -Shoring Setup 

19) Network Identity 

.Jon.tthoo Jchts: 

~ Pus'W'ord : I•••••••• I 
:::====~~~~~~~~ 

Owntt" U.vnt 

M~tntosh NlnM · l .. b u thon .JonH's M.c1nto:sh I 

LJ File Sharing 

( start ) fF~~:~~ing ,;-;,f.-Ctkk- St;-t- lo-~-lk,~ other users J 

L~~~~~~~.:_ ___________ J 

Click to turn ~ rrogrom Linking 

on P,1;:~~ii·:~~1 start 1·;;~:;r~·~·ii~k"~l,"~!f.-c1i;;;·5_t:;;-t~-;-ii~;;;-;;;;;;;··-11 -~.~~~.~:~ .. ~~~-~-~~:.-~.~~~.~-~~.:-·~·---····-··-· 

3. Close the Sharing Setup control panel. 

Once program linking is turned on, you must select programs 
ro share before network users can link lO them, as described 
in the next section. 
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Selecting a program for linking 

Before a network user can link to your program, you need to 

share it. 

1. Select a program to share. 

If the program is open, you must quit before you can share it. 

2. Choose Sharing from the File menu. 

3. Click the box labeled ''Allow remote program linking" 
to place an X in it. 

ll~WordAlghter 

\X'i th an X in thb hox. 
1hb program is 

~ V 'W'or<Rtghttt" 

Kind :.aipp1~hon prOCJf'Mn 
Vh•n·: Jon1thon ... ton.s 's 

MK1nto1h YR f oldt-r 
Yorclhghlff" 

al'ailable for linking I Pr~grom linking 

On the Jll:t\\'OJ"k. -L-i Allow rM10tt pr09<">m hnl<1n9 

If the box is dimmed, rhc program docs not support linking, 
and you cannot share it. 

4. Close the window. 

Ar this point, no one bur you can link to your programs until 
you rurn on guest access or name registered users. 



Allowing guests to link to your programs 

You can let everyone on rhe ncrwork link to your shared 
programs. 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

2. Double-click the <Guest> icon. 

3. Click the box labeled ''.Allow guests to link to programs 
on this Macintosh" to place an X in it. 

With an X in this 
box. guests can link 

to programs on 
your Macintosh. 

,;o <Gu es t> 

Q me Shoring 
~ 

(8J Albw guHts to connect 

~ Program linking 

-0 A11ow 9u.sts to link to preo;r ams 
on tMs Macintosh 

4. Close the window. 

0~ 

Guest users can now link to any of rhe programs you're 
sharing, as long as the programs are open. 

Naming specific users to link to your programs 

You can iclenrify rhe registered use1·s and groups you wanr to link 
to your programs. 

1. Choose Control Panels from the Apple menu and open 
the Users & Groups icon. 

2. Open the icon of a user. 

3. Click the box labeled ''.Allow user to link to programs 
on this Macintosh" to place an X in it. 

With an X in chis box. 
this user can link to 

your programs. 

J f'he user's name 

l~D==---z3 Niles Douls 

Us er P~ ssvord : (===:J 

0 File Sharing 
;l\;;;;;;;;, 

£8] .4.llow 1Jstr to conntot 
[8] A How user to ch•nQt pusword 

Groups : 

[ 

~ Program Linking 

-0 Allow \IHr to l ink t<. prOQrlmJ 
on this M..cintosh 

~ 

4. Close the window and click Save in the dialog box. 

5. To give more registered users access to your programs, 
repeat steps 2 through 4. 
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Using communications products 
with System 7 

Using the Communications Toolbox 

If you are already familiar with the Communications Toolbox, 
note the following guidelines for its use with Macintosh System 7. 
See the manual that came with your communications program for 
more derailed information. 

• The Communications Toolbox has been integrated into 
System 7. 

• To use communications tools with System 7, drag them to the 
Extensions folder in your System Folder (or to the System 
Folder icon). 

• Wherever a program or its documentation refers to the 
"Communications Folder," substicute the "Extensions Folder." 
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Using Data Access Language 

If you are already familiar with Data Access Language (DAL), note 
the following instructions for its use with System 7. For detailed 
information about using your DAl application, see the manual 
that came with the program. 

To use programs that search for the "hosts.CU " file, do the 
following: 

1. Make a copy of the DAL Preferences file (in the 
Preferences folder in the System Folder). 

2. Rename the duplicate file: Hosts.CU. 

3. Move the renamed file outside the Preferences folder, 
but leave it inside the System Folder. 

Use your program as you normally do. Whenever you make 
changes ro one of these files, you must update the duplicate file. 



Chapter 14 

Expanding Your 
Macintosh System 
In this chapter 

• Connecting hard disks and orher SCSI devices 

Installing a device driver 

Setting the SCSI ID number 

Attaching a SCSI device 

• Connecting a printer 

• Connecting a modem 

• Connecting an external Aoppy disk drive 

• Connecting a trackball or other ADB device 

• Connecting headphones or speakers 

• Connecting a microphone 

• Connecting add itional monitors 

• Installing expansion cards 

NuBus'" power requirements 

• Expanding memory 

Connecting hard disks and other SCSI 
devices 
Every Macintosh computer has a socket, or jJort, for connecting 
devices that use the Small Computer System Imerface (SCSI, 
pronounced "skuh-zee"). The SCSI port permits high-speed 
communication between the computer and the device. The SCSI 
icon appears above the port on the computer's back panel. 

l.l 12 11 IO 9 8 7 6 ) 4 3 2 I 

0000000000000 
o o o o o o o o o o o o 7/-SCSI port 

!5 24 2.l !2 21 20 19 IS 17 16 I\ 14 

~SCSI icon 

6 Important: Follow the instructions in this section and the 
instructions that came with your hard disk or other SCSI 
device when connecting it to your Macintosh. 6 
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SCSI devices commonly used wirh rhe Macincosh include hard 
disks, CD-ROM drives, scanners, primers, and rape backup drives. 

By connecting SCSI devices to one another (in a "daisy chain"), 
you can have up w seven such devices, including an inrernal hare! 
disk, connected to your Macinrosh. Each device must have its 
own, unique ID number. 

Serring up a SCSI device co use with your Macintosh involves 

• insralling any necessary device drivers 

• serring rhe device's SCSI ID number 

• physically attaching rhe device to your Macinrosh 

Installing a device driver 
'Ib install a device driver: 

• Drag the device driver icon to the System Folder on 
your startup disk. 

Any device drivers needed for a SCSI device arc usually on a 
Aoppy disk that comes wirh the device. (If no device drivers come 
with the device, then ir doesn't need any.) You may have ro resran 
your Macintosh to activate the device driver, which the computer 
needs to communicate with-or "drive"-the device. 
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Setting the SCSI ID number 

See the insrructions that came with your SCSI device for 
information on sming its SCSI ID number. 

.A. Warning: Each SCSI device connected to your Macinrosh 
must have its own, unique ID number between 1 and 6 so 
thar your computer can distinguish it from orhcr attached 
SCSI devices. Using two or more devices with the same lD 
number can cause them ro malfunction. You could lose clam 
as a resulr. .A 

Give greater ID numbers to the devices you use more often. Your 
Macintosh uses the nwnbers to set priorities when ir 
communicates with its SCSI devices (the greater a device's lD 
number, the higher its prioriry). 

If you have an Apple SCSI device, set the SCSI ID number as 
follows: 

1. Make sure the device is switched off. 

2. Choose a number between 1and6 that hasn't been 
assigned to any other SCSI device connected to your 
Macintosh. 

Each device in a chain of SCSI devices connecred ro your 
computer must have its own ID number that distinguishes it 
from other devices in the chain. The ID number must be 
between 1 and 6 (i f you have an inrcrnal hard disk, its ID 
number is preset to 0, and your Macintosh irself has the ID 
number 7). 



3. Insert a straightened paper clip into the small hole 
directly below the ID number indicator (usually on the 
back panel of the SCSI device). The small hole gives 
you access to the ID number switch. 

ID number switch 

4. Push the ID number switch repeatedly until the 
number you want appears in the ID number indicator. 

Attaching a SCSI device 

To connect a SCSI device to your Macintosh: 

1. Turn off your Macintosh. 

2. Make sure the SCSI device is switched off . 

.6. Warning: Do nm connect or disconnect any device while the 
device or your Macintosh is turned on. Doing so could 
damage the device, your computer, or both . .It. 

3. Make sure the device has its own, unique ID number 
between 1 and 6. 

4. Use a SCSI cable to connect the device either to the 
SCSI port or to the last SCSI device already in the 
chain. 

If the device is the first one in the SCSI chain (or the only one 
you're connecting), use a SCSI system cable to connect it to 
the SCSI port. 

If rhe device is nor the first one in the chain, use a SCSI 
peripheral interface cable ro connect it ro the last SCSI device 
alreadv in the chain. 

6. Important: The total length of a SCSI chain should not 
exceed 6 meters (20 feet) . 6. 

co11ti1111es ..,.. 
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5. Make sure that the first device and the last device in the 
SCSI chain each have a terminator and that no other 
external SCSI device has one. 

10 ensure accurate transmission of information, a terminator 
must be at each end of a SCSI chain. 

An internal hard disk, which is always the first device in the 
chain, has a built-in terminator. The Macintosh Classic, 
Macintosh LC, and Macintosh Ilfx have built-in terminators 
(whether or not they have inrernal hard disks). 

• If you have an inrernal hard disk, or if your Macintosh has a 
built-in terminator, you only have to make sure that rhe last 
device in the chain has a terminator and that no other 
external SCSI device has a terminator. 

• If you do not have an internal hard disk or a Macintosh 
with a built-in terminator and are connecting your 
Macintosh to two or more external SCSI devices, you need 
terminators in the first device and the last device, and none 
in between. 

• If you're connecting your Macintosh to a single SCSI device 
(whether or not you have an internal hard disk), make sure 
the device has a terminator. 

If you have a Macinrosh llfx, use the black cable terminator that 
came with your computer. Do not use any ocher terminators with 
or instead of the black cable terminator. Also, you or your 
auth01ized service provider should disconnect or remove any other 
terminators built into your SCSI devices. Using terminators other 
than or in addition to the black cable terminator may cause your 
SCSI devices to malfunction, and you may lose data as a result. 
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A SCSI device may have a built-in terminator. I f a device that's ar 
the end of the SCSI chain does not have a built-in terminator, you 
need to attach an external cable terminator to it 

SCSI terminator 

To find our if your SCSI device has a built-in terminator, go to the 
instructions that came with the device. (External SCSI devices 
from Apple Computer do not have built-in terminators.) Have 
your authorized Apple service provider remove any extra built-in 
terminators. You can attach or remove cable terminators yourself. 

6. Important: Always turn on any external SCSI devices 
connected to your Macintosh before turning on the computer 
itself. Otherwise, your computer cannot recognize the SCSI 
devices. 6. 

Check the setup book that came with your Macintosh for any 
additional information on connecting SCSI devices. 



Connecting a printer 
Every Macintosh has a printer port, which you use to connecc a 
printer to your compucer. 

Printer port 

r Fl:p Printer pon icon 

The printer port accepts either a direct cable conneccion (to 
primers such as the ImageWriter II) or a network cable connection 
(to printers such as the LaserWriter llNT). Certain printers (such 
as the Personal LaserWriter SC) are connected through the SCSI 
port as a SCSI device. 

Follow the instructions that came with your printer when 
connecting it to your Macintosh. 

A printer can also be connected LO the modem port. You use the 
Chooser program Lo indicate the pore you used to connect your 
printer. (See Chapter 12, "Printing," for more information.) 

Connecting a modem 
Every Macintosh has a modem porr, which you use to connect an 
external modem to your computer. (A modem is a device that 
allows your computer to communicate with other computers over 
standard telephone lines). 

Modem port 

~Modem pon icon 

Follow the instructions that came with your modem when 
connecting it to your Macintosh. 

You can connecc a modem co the printer pon (if you're not using 
it for a primer), buc your Macintosh gives the modem port priority 
over the printer port when it checks for darn transfer activity. This 
priority better ensures that any communications link your 
computer establishes chrough the modem remains intact. 
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Connecting an external floppy disk drive 
Some .\facinrosh compurers hare a disk drive port. "·hich you use 
to connect an external floppy disk drive. 

0000000000 
000000000 

[1J Disk drive port iron 

follow the instructions char came ,,·irh your external floppy disk 
drive \\·hen connecting it to your ~lacintosh. 

If your .\facinrosh does not have a disk drive pon, you can buy an 
exrcrnal floppy disk drive rhat arraches to rhe SCSI port. 
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Connecting a trackball or other ADB device 
Every ~ lacinrosh computer has at leasr one Apple Desktop Bus 
(AOB) port, " ·hich you use ro connecr the mouse, the keyboard, 
and orher inpur devices such as a trackball. a bar-code reader, or a 
graphics rnblec. 

l@!-AOI! pon 

~ .-. --ADB port icon 

By connecting ADB devices ro one another (in a "daisy chain"). 
you can have up ro rhree such devices connected to a single ADB 
pon. The exact number depends on ho\\' much po"'er rhe devices 
require. 

6 Important: The roral power used by all Apple Desktop Bus 
devices connected to your Macinrosh must not exceed 
500 milliamperes (mA). Information about rhe power 
requirements of your mouse and keyboard arc in the setup 
book that came with your Macintosh. See the instructions that 
came with an~· orher ADB derice if you need information on 
its power requirements. ~ 



Connecting headphones or speakers 
Every Macinrosh computer has a sound output port. which you 
use ro connect speakers, an amplifier. headphones, or ocher audio 
output devices ro your compu ter. The sound output port accepts 
a standard stereo mini plug, like that used ro attach headphones ro 
a portable stereo audio cassetrc player. 

(@)-- Sow>d "'"'"" pon 

q )))- sound output iron 

Connecting a microphone 
Certain ~lacinrosh models (such as the Macinrosh LC) have a 
sound input port, which you use to connect a microphone or 
other sound source to your computer. The sound input port 
accepts a standard miniplug. 

(@)-- ~'""'' ;"''"' '""' 
0---- Sound input icon 

See the setup book rhar came with your Macintosh for additional 
information on the sound input port. 

See Chapter 11. ''Adapting Your Macintosh co Your Own Use ... for 
information about recording sound on your \1acintosh. 
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Connecting additional monitors 
Most Macintosh computers accept video cards that let you 
connect additional monitors. Your first monitor may be built-in (as 
in the Macintosh Classic), connected to a built-in video port (as in 
the Macintosh Ilci), or connected to a video card installed in a 
NuBus slot (as in the Macintosh Ilfx). See the setup book that 
came with your computer for information on installing video 
cards. 

When you set up additional monitors: 

• Make sure that the venti lation openings on the computer and 
the monitor are clear and unobstructed. 

• Some large monitors cannot safely be placed on top of the 
Macintosh. Check the instructions that came with the monitor 
for setup information. 

• If there is interference on your screens or on a television or 
radio near your Macintosh, move the affected equipment 
farther apart. 

See Chapter 11, '1\dapting Your Macintosh to Your Own Use," for 
information on configuring multiple monitors in the Monitors 
control panel. 
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Installing expansion cards 
All Macintosh computers except the Macintosh Classic accept 
printed circuit boards (called cards) for video and graphics 
applications, networking and communications, additional 
processing power, and other purposes. The cards fit into 
connectors, called expansion slots, inside the computer. 

6 Important: See your setup book for information on installing 
expansion cards. Some cards may need to be installed by an 
authorized Apple service provider. 6. 

Like all electronic components, expansion cards generate heat. If 
you install several cards in your Macintosh, leave as much room as 
possible between cards and between cards and other internal 
components. 

Macintosh expansion slots come in two types: 

• NuBus slots, which accept NuBus expansion cards 

• Processor-direct (or memory cache) slots 



All Macintosh II models have at least one NuBus slot. (An optional 
slot adapter is required in the Macintosh Ilsi.) In the models rhat 
have a processor-direct or memory cache slot (such as the 
Macintosh LC and the Macintosh llci), only one such slot is 
available. 

.A. Warning: Before your remove the lid, be sure Lo turn off 
your Macintosh. lnsrall an expansion card only in rhe slor 
designed to accepr it. Failure ro do so could damage rhe card 
and your computer. NuBus cards fit in any NuBus slur, bur a 
processor-direct or memory-cache card is ofren designed only 
for a specific Macintosh model. .A 

NuBus power requirements 
The combined power consumption of all insralled Nu Bus cards 
must not exceed the limits specified for your Macintosh model. If 
you have two or three NuBus cards installed or are concerned 
abom the amount of power consumed by a parricular card, make 
sure that your NuBus cards' power consumption is within 
specified limirs. 

1. Find out the power consumption (in amperes) of each 
NuBus card you have installed by checking its technical 
specifications. 

NuBus cards draw power from three types of current: 

• +5 volt 

• + 12 volt 

• -12volt 

2. Calculate the total power consumption in each type of 
current of all installed NuBus cards. 

3. Find out the maximum power consumption for all 
NuBus cards specified for your Macintosh by checking 
the setup book that came with your computer. 

.A. Warning: Do noc exceed the maximum power consumption 
for all Nu Bus cards specified for your computer. Doing so 
could damage your cards, your Macintosh, or both. .A 
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Expanding memory 
The random-access memory (RAM) in )'Our Macintosh can be 
expanded by adding Single In-Line Memory modules (or SIMMs) 
to chose already installed or exchanging inscalled modules for 
ones char have greacer scorage capacity. (Some Macintosh models 
also accepc memory expansion through the installation of a 
memor~· card.) 

222 Chapter 1-1: Expanding Your illacintosh System 

Make sure that SJMMs you purchase for rnemory expansion are 
the correct ones for your Macintosh. See the setup book chat 
came with your cornputer for more information. 

.A. Warning: Memory expansion on the main circuit board 
should he insrn lled onl)' by an authorized Apple service 
provider or orher qualified technician. Modification of the 
circuit board by anyone except a qualified technician voids 
your warranty and could darnage your com purer. A. 



Chapter 15 

Care and Maintenance 
In this chapter 

• Handling s~1stem components 

Moni tor 

Keyboard 

floppy disks and cl rives 

Power supply 

• Cleaning system components 

Cleaning the mouse 

• Maintaining the proper operating environment 

• Changing the clock barren' 

• Service and support 

Handling system components 
Follow these guidelines when setting up and using your 
Macintosh computer and its components: 

• Hanel le all components with care. 

• Place components on a sturdy, flat surface. 

• Carefully follow all setup instructions. 

• Always hold a cable by its connector (the plug, not the cord) 
when connecting or disconnecting it. 

• Never force a connector into a porr. I f connector and port do 
nor join with reasonable ease, they probably do not match. 
Make sure that the connector matches the port and that you 
have positioned the connector correctly in relation to the 
port. 

• Turn off your Macimosh and all its components before 
connecting or disconnecti ng any cables to acid or remove any 
component. Failure to do so could seriously damage your 
equipment. 
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• Take care not to spill any food or liquid on the computer, 
keyboard, mouse, or other components. If you do, turn your 
Macintosh off immediately and unplug it before cleaning up 
the spill. Depending on what you spilled and how much of it 
got into your equipment, you may have to bring your 
equipment to an authorized Apple service provider. 

.& Warning: Plug the power cords for the Macintosh and irs 
components only into three-prong, grounded outlets. The 
computer's grounding-type plug is a safety feature. Do not 
defeat rhe purpose of this plug. Disconnect the power plug if 
it becomes frayed or otherwise damaged. • 

Monitor 

Follow these procedures whether your Macintosh has a built-in or 
a separate monitor: 

• Turn down the screen contrast control if you leave the 
Macintosh turned on for extended periods. This prevents 
the image on the screen from "burning in" and damaging the 
screen. 

You can also use a "screen saver" program, which dims or 
varies the image on the screen when the Macintosh has been 
idle for a specified period of rime. These programs are 
available from independent suppliers and user groups. 
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• Make sure that the ventilation openings on the computer and 
the monitor are clear and unobstructed. 

• Some large monitors cannot safely be placed on top of the 
Macintosh. Check the instructions that came with the monitor 
for setup information. 

• If there is interference on rhe monitor's screen or on a 
television or radio near your Macintosh, move rhe affected 
equipment farther away. 

Keyboard 

'fake care not to spill any liquid on the keyboard. If you do, turn 
off your Macintosh immediately. 

• If you spill liquid that is thin and clear, unplug the keyboard, 
turn it upside clown ro let the liquid drain out, and let it dry 
for 24 hours at room temperature. If, afrer you rake these 
steps, the keyboard doesn't work, rake it to your authorized 
Apple service provider for repair. 

• I f you spill liquid that is greasy, sweet, or sticky, unplug the 
keyboard and take it to your authorized Apple service 
provider for repair. 



Floppy disks and drives 

Store disks at 
temperaiures 
bet ween 50°F 
and 125°F. 

l 25°F (52°C) 

~ 
)Q°F (10°C) 

Do not use 
an eraser 
on a disk label. 

Do nm touch the Keep disks away 
exposed pan of the from magneis. 
disk behind ihe 
mcial shuner. 

Keep disks thy. 

\I; 

~ 
Avoid exposing 
disks to exiremely 
hot 1e111pe1~1turcs . 

Power supply 

The power supply in your Macintosh is a high-voltage component 
and should not be opened for any reason, even when the 
computer is off. If the power supply needs service, contact your 
authorized Apple dealer or service provider. 

Cleaning system components 
'lo clean the outside of your Macintosh and its components: 

• Use a clamp, soft, lint-free cloth to clean the computer's 
exterior. Avoid getting moisture in any openings. 

• Don·t use aerosol sprays, solvents, or abrasives. 

• To clean the screen, put household glass cleaner on a sofr 
cloch and wipe the screen. Don't spray the cleaner directly on 
the screen, because the liquid might drip into the monitor or 
computer. 
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Cleaning the mouse 

The mouse conrains a small ball that must roll smoothly for the 
mouse to work properly. You can keep this ball free of dirt and 
grease by using the mouse on a clean, lint-free surface and 
cleaning it occasionally. 

You need a few cotton swabs, alcohol, and a clean, soft, linr-free 
cloth. 

1. Turn off your Macintosh. 

2. Turn the mouse upside down and remove the plastic 
ring on the bottom that holds the ball. 

The plastic ring comes in two types. You remove one by 
turning it counrerclockwise; you remove the other by pulling 
the ring downward until it pops out. 
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3. Turn the mouse right side up with one hand and catch 
the ring and the ball with your other hand. 

4. Clean the three small rollers inside the mouse with a 
cotton swab moistened with alcohol. 

Rotate the rollers to clean all around them. 



5. Wipe the mouse ball with a clean, soft, dry, and lint· 
free cloth. 

Don't use any liquid to clean the ball. 

6. Gently blow into t11e mouse case to remove any dust 
that has collected there. 

7. Put the ball and the ring back in place. 

Maintaining the proper operating 
environment 
In general, any conditions in which you are reasonably 
comforrable should be fine for your Macintosh. 

• See the setup book char came with your computer to find out 
the range of temperature and humidity that your Macintosh is 
designed co operate within. 

• Protect the Macinwsh and its components from direct 
sunlight and rain or ocher moiscure. 

• Keep all venlilacion openings clear and unobscrucrecl. Without 
proper air circulacion, componencs can overheat, causing 
damage or unreliable operation. 

Changing the clock battery 
Every Macintosh computer has a clock that runs cominuously. 
\V'hen the computer is turned off, a battery keeps che clock 
running. 

If your clock begins to keep rime inaccurately, have your 
auchorized Apple service provider replace the battery. 
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Chapter 16 

Tips and Troubleshooting 
In this chapter 

• Getting the best-looking fonts 

• 'faking a "snapshot" of the screen 

• When you run into trouble 

Take your time 

Start overRebuild your desktop regularly 

Rebuild your desktop regularly 

Solutions to common problems 

Getting the best-looking fonts 
To have fonts look their best on the screen, install bi tmapped 
fonts in the sizes you use most often. And for the closest match 
between clisplayecl fonts and printed fonts, install the 
corresponding bitmapped fonts when you install PostScript 
outline fonts. 

Your Macintosh looks for either outline fonts or birmapped fonts 
to use depending on 

• whether the font is displayed on the screen or printed on a 
printer, and 

• whether (if the font is primed) the printer is equipped to 
handle PostScript (a programming language that describes the 
charaCLers, symbols, and images appearing on each page of a 
document) 
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\Xn1en you prinr a documenr on a Postscript prinrer (such as the 
LaserWricer lINT), the system software looks for the fonts you use 
in the following places, in order: 

1. PostScript outline fonrs in the printer 's permanent memory 
(ROM) 

2. PostScript outline fonrs in the printer's temporary memory 
(RAM) 

3. PostScript outline fonrs in any hard disk connected ro the 
printer 

4. PostScript outline fonts in your System Folder 

5. 1h1e'1~1pe outline fonrs in your System Folder 

6. bitmapped fonrs in your System Folder in the correct size 

7. bitmapped fonts in your Sys1em Folder in a different size that 
can be reduced or magnifiecl to roughly approximate the 
correct size 
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When you print a document on a printer that does not recognize 
PostScript (such as rhe Personal LaserWrirer SC), and when the 
Macintosh displays fonts on the screen, the system software looks 
for the fonts as follows: 

1. bitmapped fonts in your System Folder in the correct size 

2. 'frue'Iype outline fonts in your System Folder 

3. bitmapped fonts in your Sysr.em Folder in a cl ifferenr size char 
can be reduced or magnified ro roughly approximate the 
correct size 

Taking a "snapshot" of the screen 
You can capture the image on the screen by pressing ~-Shift-3. 
The image is saved as a graphics file, which can be opened in 
many programs that handle graphics (including the TeachText 
program that's supplied with the system software). 

The graphics fi les are named "Picrure 1," "Picrure 2,·· and so on. 
The number of screen images you can take is limited only by 
available disk space. 

When you run into trouble 
For specific troubleshooting information related ro a particular 
procedure, go to the chapter that describes the procedure. 



Take your time 

When you see an error message, you don't have to rake action 
immediately. The message stays on the screen until you click the 
OK button or turn off the Macintosh. 

'IO help diagnose and correct the problem, gather as much 
information about the situation as you can before starting over: 

• Make a note of exactly what you were doing when the 
problem occurred. Write clown the message on the screen and 
its JD number (if any) as well as the programs you were using 
and the names of any items you know have been added to the 
System Folder since the system software was installed. (This 
information will help a service person diagnose the problem 
should you need to take the computer to }'Our au thorized 
Apple dealer for repair.) 

• Check the screen for any clues. Is a menu selected? What 
programs and document icons are open? otc anything else 
that seems relevant. 

• If you were typing text and were not able to save it before the 
problem occurred, you can wri te clown the pans of the text 
still visible on the screen so that some of your work will be 
easy to replace. 

• A-;k other Macintosh users about the problem you're having; 
they may have a solution for it. 

Start over 

Often you can eliminate a problem simply by clearing the 
compu ter's memory and starring over. 

If you can, save any open documents before restarting the 
Macintosh. If your system is "frozen" and does not respond to any 
input, or if you have a "bomb" message on the screen, saving may 
not be possible. You can Cl"}' pressing ~-Option-Esc to quit the 
program in use when the problem occurred: if this works, you can 
then save the documents open in other programs before 
restarting. 

'lo restart your Macintosh, try the following steps: 

1. If you can, choose Restart from the Special menu or 
from the dialog box that's on screen. 

2. If you can't choose Restart, hold down the ~ and 
Control keys while you press the Power On key. 

3. If nothing happens, look for the reset and interrupt 
switches on the front or side of your Macintosh and 
press the reset switch (the one marked with a triangle). 

Not all Macimosh models have reset and imerrupt switches, 
which are usually installed as a unit when the computer is first 
set up. 

Pressing the reset switch is like turning the power switch off 
and on. (The interrupt switch is intended for use by 
programmers who have debugging software installed.) 
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4. If pressing the reset switch does nothing or if your 
Macintosh does not have a reset switch, turn off your 
computer using the power switch, wait at least 10 
seconds, then turn it on again. 

5. If the power switch doesn't turn off the computer, 
unplug your Macintosh. 

If you suspecr rliar the problem is wirh a peripheral device, such 
as a prinrer or external hard disk, rurn ir off for 10 seconds or 
more, rhen rurn it on again and restart the Macintosh. 

Rebuild your desktop regularly 

A process known as "rebuilding the desktop'' helps your 
Macinrosh keep rrack of dara on your sranup disks. 

• 'lo rebuild the deskrop of a startup disk, hold clown the 
Option and~ keys while starting up your computer. Keep 
holding clown the keys until you see a message asking 
whether you want to rebuild the deskrop. Click OK. 

• Rebuild rhe desktop of your startup disks once a monrh or so. 
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Solutions to common problems 

The computer is turned on but the screen is dark 

The Macinrosh or rhe moniror is nor ge1ting power, or rhe screen 
is ~1cljustecl too dark. 

• Check char the power cord is plugged in and firmly connected 
10 the compurer and thar the elemical ourlet has power. 

• If you have a separate monitor, check that rhe monitor is 
turned on. 

• Check the screen's brightness conrrol and turn it up if 
necessarv. 

• Jf you use a screen saver program, press a key or move the 
mouse co turn off rhe screen saver. 



When you start up, an icon appears in the middle 
of the screen and the desktop doesn't appear 

The system software is nor installed on your hard disk or your 
hard disk is not working properly. 

When you turn on the Macintosh, one of these icons appears in 
the middle ol the screen: 

• The "happy Macinrosh ., icon indicates that your Macintosh 
has found a startup disk (which has the system software 
installed in the System Folder) and is starting up. 

• The disk icon with a blinking question mark indicates that 
your Macintosh can nor find a srartup disk. If you inserrecl a 
floppy disk, or if you have a hard disk installed, your 
Macinrosh doesn't recognize rhat disk as a startup disk. 

Use the system software disk labeled Disk Tools to start up 
your Macintosh. (See "Starting Up With a Floppy Disk" in 
Chapter 8, "Setting Up Your Macintosh System," and "Testing 
and Repairing Disks" in Chapter 9, "Hard Disks and Floppy 
Disks,'· for instructions on starting up with a floppy disk and 
repairing damaged disks.) 

• The disk icon with an X appears when your Macintosh ejects a 
floppy disk that is nor a startup disk. 

• The "sad Macintosh·' icon appears when your Macintosh 
can nor start up because of a problem wi th the system 
softi.Yare or possibly the com purer hardware. 

Eject any floppy disks by turning off the computer and then 
holding clown the mouse button while you turn the computer 
on again. 'fry starting up with a different srarrup disk. If the 
·'sad Macintosh .. icon appears again, see your service provider. 
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The pointer doesn't move when you move the mouse 

The mouse is not connected properly or its signals are not 
reaching the computer. 

• Turn off the computer using the power switch, then check 
that the mouse cahle is connected properly. 

• Clean the mouse. (Sec Chapter 15, "Care and Maintenance.") 

• Restart the Macintosh with a different startup disk. If the 
pointer still doesn·r move, consult ~1our service provider. 
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7jping on the keyboard produces nothing on the screen 

The insertion point hasn't been set, no text is selected, the 
keyboard is not connected properly, or its signals are nor reaching 
the computer. 

• Make sure the program you want to type in is the active 
program. 

• Place the pointer in the active window and click to set an 
insertion point or drag to select text (if applicable). 

• Tl.1rn off the computer, then check d1at the keyboard cable is 
connected properly at both ends. 

• If the connections are secure and typing still yields no results, 
shut clown and turn off the Macintosh, then unplug the 
keyboard cable. Connect the cable ro the other Apple Desktop 
Bus port on the computer and the other ADB pon on the 
keyboard . (You may have ro unplug the mouse to do this.) If 
typing still shows nothing on the screen, the problem is most 
likely in the keyboard itself. 

• Resrart the Macintosh with a differem sranup disk. I f typing 
still doesn't produce text on the screen, see your service 
provider. 



A dialog box with a bomb appears 

Your system has a sofrware problem. 

• Wri te down what you were doing when the message 
appeared, and write clown the number on the message, if 
there is one. 

• Restart your Macintosh (see "Start Over'· earlier in this 
chapter). 

• Check rhe startup disk ancl program you were using when the 
message appeared. Make sure that all programs, desk 
accessories. and system extensions you're using are 
compatible with the system sofrware. Reinstall ing the system 
software may correct the problem. 

• Sometimes incompatible system excensions or control panels 
can cause system software problems. Restart while holding 
clown the Shift key; this disables all syscem excensions. If 
stanup is normal with this method, then remove all 
excensions and put them back into the System Folder one at a 
time, starting up after you acid each extension. This procedure 
should identify any incompatible exrensions. 

The pointer ''freezes" on the screen 

Your system has a software problem. 

• Press ~-Option-Esc to close the program in use when the 
problem occurred. If this works, you can then save the 
clocumencs open in other programs before restarcing. 

• Restart your Macintosh (see "Start Over" earlier in this 
chapter). 

• Check the startup disk and program you were using when the 
message appeared. Make sure that all programs, desk 
accessories, and system extensions you're using are 
compatible with the system software. Reinstall ing che system 
software may correct che problem. 
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>bur program quits une.\pectedly 

The program needs more memory rhan your Macimosh has 
available, or rhe program requires a Roaring-point unit (FPU) and 
your Macintosh cloesn'r have one. 

• Quir from rhe programs rhar you have open and rhen open 
rhe program you wanr to use. or rescan your Macinrosh. 
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• Check the documcmacion thac came with che program to find 
our if the program requ ires a .Macinrosh with an FPU, and 
check rhe serup book that came wirh your Macintosh ro And 
our if your computer is equipped with an FPU, or if an FPU 
can be installed. Consult your authorized service provider for 
information about installing an FPU in your compULer. 



Summary 

Working on the 
Macintosh Desktop 
In this chapter 
• Using the mouse 

• Working with icons 

• Working with windows 

• Working with menus 

• Keyboard shortcuts in the Finder and in directory 
dialog boxes 

• Working with disks 

• Working with programs 

Using the mouse 

Point 

• Point to an object on screen by moving the mouse so 
that the pointer is over that object. 

When the poimer is an arrow, the tip of the arrow must be 
over the object. 

Click 
• Click an object on screen by pressing and quickly 

releasing the mouse button while the pointer is over 
that object. 

Clicking an object selects it. 
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Drag 

• Drag an object on screen by pointing to that object and 
holding down the mouse button while you move the 
mouse. 

Dragging an object from one disk to another copies it, 
dragging an object from one place to another on a single disk 
moves it within that disk without making a copy, and dragging 
an objecr to the Trash throws it away. 

Press 

• Press by holding down the mouse button without 
moving the mouse. 

Pressing a menu name opens the menu. 
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Double-click 

• Double-click an object on screen by pointing to the 
object and clicking twice in rapid succession, without 
moving the mouse. 

Double-clicking is a common shortcut for opening an icon or 
the selected item in a directory dialog box. 

Shift-click 

• Hold down the Shift key while clicking. 

Shift-clicking is a way to select more than one icon or item 
in a list. 



Working with icons 
Icons on the Macinrosh deskrop represent disks (floppy disks and 
hard disks) and files (programs and documents). When you open 
an icon, its window appears, showing you what's "inside" the disk 
or file. 

Selecting icons 
To do this 

Select an icon 

Deselect an icon 

Select multiple icons 

Deselect an icon in a 
group of selected icons 

Select multiple icons 
that are near each other 

Select contiguous icons 
in a list 

Take these steps 

Click the icon. 

Click anywhere except the selected icon. 

While holding down the Shift ke~, click 
each icon. 

While holding down the Shift key, click 
the icon. 

I. Place the poinrer at one corner of the 
group of icons. 

2. Drag diagonally to select the icons, then 
release the mouse button. 

1. Place the pointer to the left of the top icon 
or the bottom icon. 

2. Drag up or down the list, releasing the mouse 
button when the pointer is left of the last icon. 

Select text in an icon's 1. Click the icon's name to select it. 
name 2. Place the pointer at one end of the tex1 

to be selected. 
3. Drag to select the text, then release the mouse 

butt0n. 

Opening an icon 
You open an icon by selecting it and choosing Open from the File 
menu or using the keyboard shortcut 3€-0 or 3€-Down Arrow. Or 
you can double-click the icon. 

Moving, copying, and renaming an icon 
To do this 

Move an icon 

Copy an icon onto 
anoilier disk 

Copy an icon on the 
same disk 

Rename an icon 

Take these steps 

Drag the icon lO where you want it. 

Drag the icon to the icon of the other disk (or to 
an icon or window that belongs to that disk). 

1. Click the icon to select it. 
2. Choose Duplicate from the File menu, or 

press X-0. 
3. If you wish, rename the icon and drag it to a 

new location. 
You can also make a copy by holding down the 
Option key while you drag the file's icon to 
where you want the copy. 

1. Select the icon's name by clicking the name 
(not the icon). 

2. Type a new name and press the Return key. 
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Storing icons in a folder 
Drag the icons to the folder until both the icons and the folder are 
selected, and rhen release the mouse button. 

Removing an icon 

You remove an icon from the desktop or any Finder window by 
dragging it ro the Trash. To erase the contents of the icon from 
your disk, you choose the Empty Trash command from the Special 
menu. 

The Trash displays a warning before its contents are discarded. 
You can't throw away a locked flle or an item that's currently in 
use. 
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Working with windows 
A window appears when you open an icon to show you what's 
"inside" the icon. 

Making a window the active window 

You make a window active by clicking inside it. You may have to 
move or resize other windows if the one you want ro make active 
is covered by other windows. You can also make a window active 
by clicking its icon (even though it's dimmed) and choosing Open 
from the File menu, or by double-clicking the dimmed icon. 



Moving a window and changing its size 
To do this 

Move a window 

Resize a window 

Close a window 

Take these steps 

ro1 
~ 

~~ 
ivailable 

Drag the window's title bar (at the 
top of the window) to the new 
location. 

Drag the size box (in the 
lower-right corner). 

Or click the zoom box (in the 
upper-right corner). 

Click the close box (in the 
upper-left corner). 
Or choose Close from the File 
menu. 
Or press 3€· W. 

Scrolling through the contents of a window 

et I 
12 ittms 

~ 
S4i1s:\tm f'oldtr 

EJ LJ 
. 

Notes-Katt F' or Chinni09 

LJ EJ Frotn Ando.,! 
. 

Trees 
11.5r18 indisJc 

E!I! 
7 .:S t13 .&n11ib\f 

LJ ~I-
!...,.; 

AppHc•t ions 

1:1! 
·,:i.· 

mi 

Scroll box (shows 
relative location 
in window) 

S•r~'snpod 1·:1: 

LJ 
~ Rtports /L1u 

LJ TuchTtxt 

f'or Mimi 

lQl 

l scroll arrow used ( 
to view the conrent 
beyond the 
window's borders) 

ifi· 
...1 J0'2l 

I Ever ' window has two scroll b ) ars, one for vertical 
scrolling :ind one for horizontal scrolling. (A gray 
scroll bar indicates more content beyond window's 
borders; a clear bar indicates all conienr is visible.) 

• Click the up, down, left, or right scroll arrow. 

• Click the vertical or horizontal scroll bar (when it's 
gray). 

• Drag the vertical or horizontal scroll box along its 
scroll bar. 
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Opening higher-level folder windows 
You can open a higher-level folder window (whose contents 
include lhe active window) from a pop-up menu in the active 
window's title. 

L Hold down the :!€ key as you press the active window's 
title. 

A pop-up menu of lhe higher-level folders (and disk) appears. 

2. Drag to choose a higher-level folder (or the disk), and 
then release the mouse button. 

The folder (or disk) window you chose appears as the active 
window. 

Open pop-up menu with the 
name of the active window 
ac the top ("Old repons") 

D Ell:abf' t 4/14 3K Mtmo'w'rittr 

D Jeremv · Status 6/20 I 2K Mod•mlink doo : 

This folder contains the folder "Old reports." 

If you hold clown lhc Oplion key as well as lhe :!€ key, the old 
window closes when the new window appears. 
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Using the outline form in list views 
Any list view you choose from the View menu (chat is, any view 
except lhe icon and small icon views) shows the coments of lhe 
active window in outline form. You can see the contents of a 
folder without opening the folder in its own window. 

ID 

Open folder (with contents 
indented below) 

JH doto/ 2 

'<7Clktidus 

D listvitw 

Siz.e- Kind 

-- folder ~ 
7K docum<nt 

-- folMr r-f'<7 Q ..,.,.,, shots 
L~D_s..._.tn_, _____ ,_•K_ docum.n __ t ----t-t-- Open folder inside 

t-ti> CJ CHpor mops - fold..- another folder 
D cr~i t union .CCOl.a'lt 17K documtnt 
o Ru<111t 1K T .. chT•xt doc (wiLh conrents 

1> a s...ttns 3K •tiu indented below) 
~TuchTf'>t.l 

A downward-poiming triangle indicates that the folder's 
contents are displayed; a right-pointing triangle 
indicates that the folder's contents are not displayed. 

Click rhe triangle next to a folder name to display or hide rhe 
folder's contents in the active window. 

If you double-click a folder, it opens in its own window, and its 
omline view closes. 

·:· Shortcuts: When a folder is selecred in an outline view, 
pressing :1€-Righr Arrow displays the lisr of irs contents and 
~-Left Arrow hides the list of its concenrs. •:· 



Working with menus 
Macinrosh menus come in two rypes: pull-down menus and 
pop-up menus. The menus in the menu bar are pull-down menus. 

Menu bar (you 
pull down menus 
rrom here) 

Dimmed command 
(not available) 

Menu titles 

The Help menu, which 
you use to display 
informarion about items 
on rhe screen 

The 
Application 
menu, which 
shows the 
programs that 
are currenrly 
open 

Menu commands 
affect whatever you've 
selected- in this case, 
'"Hard disk #2." 

Pop-up menus often appear in dialog boxes that you use to set 
options or preferences. You can recognize a pop-up menu by a 
small solid triangle, pointing down, next to its name. The name 
shows the current option or preference. 

Pop-up menu (closed) 

Select a Document: 

= w e1throp ~---------1;- Clicking the rriangle 
Rpp. programs 

D Rrt Ideas 
D art - 10/ 4 
D Car Info 
D Cespor mops i,J,ii 

= Walthrop 

[ {)<Ht ] 

[ Desktop J 

displays the menu 
(but does not allow 
you ro choose a 
menu item). 

D credi t union occou t 
D Enuelopes 

~;i! ! ; ·- ····---·--·-··----­
,, ([ Open J) 

D Glossary 
D J ll es w r i t er [ cancel J 

Clicking the menu title or the icon displays 
the menu and selects rhe title (allowing you 
to choose a menu item by dragging to it). 
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Choosing an item from a menu 

To choose a command from a menu, point ro the menu name, 
press to "pull down" or "pop up" the menu, drag ro the item you 
wane to choose so that it's highlighted, and then release the 
mouse butron. 

Choosing an item from a submenu 

Some menu items are submenus. A submenu name has a small 
solid triangle next to it, pointing ro the right. The submenu opens 
when the submenu name is highlighted. 

To choose an item in a submenu: 

1. Point to the menu name and press to pull down or pop 
up the menu. 

2. Drag to the menu item so that the submenu appears. 

Justify It ~ ./Plain 
i. Bold 

Spacing ,. llolir. 

Underline 
ffimQODIIlCll 
~lllfllcilClll!!J 
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3. Drag sideways to the submenu, drag down to the 
submenu item you want to choose so that it's 
highlighted, and then release the mouse button. 

Justify 
Spacing 

Underline 
ffimOODIIlCll 
~ lilfll ([) Clll!!J 



Keyboard shortcuts in the Finder and 
in directory dialog boxes 
Key 

Up, Down, Left, 
or Right Arrow key 

Tab key 

Character 
key (a, b, c ... ) 

3€-Down Arrow 

Action 

Selects the next item in the direction of the 
arrow 

Selects the next item alphabetically (except in a 
directory dialog box and the Chooser) 

Selects the first item whose name begins with 
that character (or the character following 
closest to it in the alphabet) 

Opens the selected icon 

3€-0ption-Down Arrow Opens the selected icon and closes the current 
folder 

3€- Up Arrow 

3€-0ption-Up Arrow 

Return or Enter 

Opens the folder that contains the current folder 

Opens the folder that contains the current 
folder and closes the current folder 

In the Finder: Selects the selected icon's name 
for editing or saves the edited name 

In a dialog box: the same as cl icking the button 
with the bold outline around it 

Working with disks 
See Chapcer 9, "Hard Disks and Floppy Disks," for more 
information abouc using disks. 

Inserting a floppy disk 
1. Hold the disk between thumb and forefinger, with the 

label facing upward and the metal shutter pointing 
away from you. 

2. Gently push the disk into the floppy disk drive, label 
side up and metal shutter first, until the disk drive 
pulls the disk in the rest of the way. 

Copying the contents of a disk 
1. Click the disk icon to select it. 

2. Drag the disk icon to the icon that represents the disk 
where you want the copy made until both disk icons 
are selected. 

3. Release the mouse button. 

Respond co any messages char appear by clicking the 
appropriate bunons. 

·:· Note: You cannOL copy rhe set of Syscem 7 software disks 
chis way. Cenain files on the disks cannot be dragged co a 
new disk. ·:· 
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Removing a floppy disk from the disk drive 

1. Click the disk icon to select it. 

2. Choose Put Away from the File menu. 

3. When the floppy disk drive ejects the disk, remove it 
from the disk drive. 

You can also drag the disk icon ro rhe Trash. This anion ejeccs che 
disk; it does not erase rhe disk. 

Locking and unlocking a floppy disk 

1. Hold the disk between thumb and forefinger, with the 
label facing upward and the metal shutter pointing 
away from you (as if you were going to insert the disk 
into a drive). 

2. Find the square hole in the lower-left corner of the 
floppy disk. 

3. Lock the disk by sliding the tab on the back side of the 
disk so that the square hole is open. 

Unlock the disk by sliding the tab back so that the 
square hole is blocked. 
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Working with programs 
For specific information about a particular program, go ro rhe 
manuals that came with the program. 

Saving your work 

• Choose Save from the File menu, or hold down the 
~ key as you press the S key. 

Switching programs 

• Click anywhere in a window to make it the active 
window and its program the active program. 

You can also choose the program from the Application menu. 

Closing a document 

• Click the close box of the document window near the 
left end of the title bar, or choose Close from the File 
menu. 

Respond ro any messages that appear by clicking rhe 
appropriate bu ttons. 



Quitting a program 

• Choose Quit from the File menu, or hold down the 
3€ key as you press the Q key. 

Respond to any messages thar appear by clicki ng the 
appropriate butcons. 

Backing up your files 

1. Click to select the icon of the document or program 
you want to back up. 

2. Drag the icon to the disk icon where you want to store 
the backup copy until both icons are selected, then 
release the mouse button. 

Respond to any messages that appear by clicking the 
appropriate buttons. 

Making a copy of a file 

1. Click to select the file icon. 

2. Choose Duplicate from the File menu. 

Saving another version of a document 

1. Open the document. 

2. Make the changes you want in the new version. 

3. Choose Save As from the File menu. 

4. Type the name of the new version. 

5. Click Save. 
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Appendix A 

Keyboards and 
Character Sets 
This appendix shows the layout of the rhe Apple Keyboard 11, 
the Apple Keyboard. and the Apple Extended Keyboard l l. 

·"frping Non-English Characters and Special Symbols" is at 
the end of this appendix. 

Apple Keyboard II 
For instructions on adjusting the height of this keyboard. go to 
Chapter 8, " 'erring Up Your ~ lacinrosh System ... 

Tab key: Moves the insertion point 
horizontally to the next swpping 
place (such as a cah stop or data 

field in a dialog box or prog1~1m) . 

Caps Lock key: A locking Shift kq• 
for leuers only (numbers and 

symbols aren't alTected). 

Shift key: Produces upperca.~e lcuer~ 

(or ihe upper characcer on the key). 

Control key: Like :!€ the key 
11·orks in combination \\'ilh other 

keys to provide shonrnts 
or modify ocher act ions. 

Option key: Produces an opt ional 
set of specia l characters when 

pressed in combination 
ll'ith other keys: also 

modifies mhcr actions. 

Ji# 0 

LJ lU lU [ 
l ab _J lJ ~ 
l caps I ~ ~ lock 

' 

I shih J lJ l 
ld I option I ~ 
L_ 
~ Command ke : Works with ( ) y 

other keys as an alternative to 
choosing a menu command or 
(in some programs) canceling 

an operation in progress. 
such as printing. 



ltJ 

Power On key: On 
Macintosh II models, 
pressing this key 
turns on the computer. 
On the Macintosh Classic, 
this kev h·1s no function 1 ' ,, 

l 

lJ lL liJ 

Delete key: Deletes any material 
currently selected, or whatever 

character is to the left of the 
insertion point 

lU ·lLJ LJ lJ l delete 

Return key: Moves the insertion 
point to the beginning of the next 
line. In a dialog box, pressing 
Return is the same as clicking 
the outlined button 

ttf' 

l clear I lJ 

Numeric keys: These keys 
produce numbers and 
mathematical symbols; 
some programs allow you lO 

use these keys as function 
kevs to initiate an action. 

LJ lJ 
J lrJ lJ ~ lJ ~ lJ lLJ LU u u ~ u lJ lJ lJ 

r 

J tJ ~ lJ ';~ lJ LJ LJ I return I 
I 

~ lU ~ ~ tJ LJ lLJ I shift I I 

.) 

J~ 

Esca e ke : The function p y 
of this key depends on 

the program you're using. 

bJ bJ lU t!J 

Arrow ke s: Move y 
the insertion point, as an 
alternative to using the mouse. 
In some programs, the arrow 
keys have other funccions. 

~ u lJ lJ lJ 
·~ u~ lJ u [o J LJ 

Clear ke : Deletes the y 
current selection, just as 
the Delete key docs. In 
some programs, Clear 
has other functions. 

Enter key: In a dialog 
box, pressing Enter is the same 
as clicking the outlined button (or 
pressing Return); some programs 
require that you use Enter (not 
Return) to confirm information 
you have provided. 
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Apple Keyboard 
This keyboard has no height adjustment. 
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Escape key: The function of this ker 
depend~ on the program you·rc using. 

Tab key: ~loves rhe insertion point 
horizontally to the next stopping 
place (such as a tab stop or field 

in a dialog box or program). 

Control key: Like the 3€ key. \\·orks 
in combination with other keys to pro1·ide 

shoncuts or modify other actions. 

Shift key: Produces uppercase letters 
(or the upper character on the key). 

Caps Lock key: A locking "hift 
key for leners onl~· (numbers 
and symbols aren't affected). 

Option key: Produces 
special charncters when 
pressed in combination 

with other keys: also 
modifies other actions. 

,.1 

--~ 

3€ 

kJ LU l1J LU 
u ~ ld ~ 
l control l lu ~ 
l shift J lJ ~ 
~ k lopaon] u 
~ 

Command kc y : Combines with 
another key as an alternative tu 
choosing a menu command or 
(in some programs) canceling 

an operation in progress. 
such as printing. 

L 



Power On key: On 
Macintosh II models, 
pressing this key 
turns on the computer 

Delete key: Deletes any material 
currently selected, or whatever 

character is to the left of the 
insertion point 

Return key: M< >vcs the 
insertion point to the beginning 
of the next line. In a dialog box, 
pressing Return is the same as 
clicking the outlined button 

J ~ ~ lJ tJ LJ lLJ1i>M I 
__ _.J LJ bJ bJ lLl l!J 

--~I-~ 

Arrow keys: Move the insertion! 
point. as an alternative to using 
the mouse. In some programs, 

che arrow keys have 
other funccions. 

Clear key: Deletes the 
current selection, just as 
the Delete key docs. In 

some programs. Clear has 
other funccions. 

Numeric keys: These keys produce 
numbers and mathematical 
symbols; some programs allow 
you to use these keys as function 
keys to initiate an action. 

Enter key: In a dialog box, pressing 
Enter is the same as clicking che outlined 
bunon (or pressing Return); some 
programs require that you use Enter 
(not Return) to confirm inforn1acion 
you have provided. 
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Apple Extended Keyboard II 
A reversible plastic template that comes with this keyboard fits 
over the row of function keys. You can label the function keys by 
writ ing on the template (in pencil, not pen or marker). 

Fur instructions on adjusting the heighr of rhis keyboard, go to 

Chaprer 8, "Serting Up Your Macintosh System." 
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Function keys: Some programs allow you to use 
runction keys to give commands. You can assign 

commands or action sequences to function 
keys with special utili ty programs. 

0 

Escape key: The runction of this key --t---+ 
depends on the program you 're using. 

Tab key: Moves the insertion point 
horizontally to the next stopping 
place (such as a tab stOp or field 

in a dialog box or program). ---1-- -+ 

Caps Lock key: A locking Shift key 
for letters only (numbers and ---1---+[ f!'!'5* 

symbols aren't affected) . ~-..,.,_. _ _., ._ ___ _...._ _ ____...__~......__ _ __. 

Shift key: Produces uppercase letters ---1---+[ shih 

(or the upper character on the key). L.::· ====:::=:==:'...1.~::::'....L:::::=~:::: 

Control key: 1.ikc the ~ Key, works ---1-- ---+-

in combination with other keys to provide 
shoncurs or modiry other actions. 

Option key: Produces special 
characters when pressed in 

combination with other keys; 
also modifies other actions. 

~ (Command) key: Combines 
with another key as an alcernacivc 

for choosing a menu command or 
(in some programs) canceling 

an operation in progress, 
such as priming. 



Delete key: Deletes any material 
currently selected, or whatever 

character is to che left of the 
insercion point. 

l~J [Flo J 

Return key: Moves rhe insercion 
point to rhe beginning of the next 

line. In a dialog box, pressing 
Return is the same as clicking the 

outlined button. 

Special keys: The function 
of rhese keys depends on the 

operacing system and program 
you' re using. 

Numeric keys: 
These keys produce 

numbers and 
mathematical symbols. 

I=' I 1-1 :lfu l~J -num caps scroll 
lock lock lock 

Arrow keys: Move the 
insertion point, as an 

alternative to using 
the mouse. In some 
programs, the arrow 

keys have other 
funnions. 

Clear key: 
Deletes the 
current selection, 
just as the Delete 
kev does. In some 
pr;)grams, Clear has 
other functions. 

Power On key: On 
Macintosh II models, 
pressing this key 
turns on rhe compurer. 

0 

Enter key: In a dialog box, 
pressing Enter is the same as 
clicking the ourlincd button 
(or pressing Return); some 
programs require that you use 
Enter (not Return) to confirm 
information you have provided. 
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Typing non-English characters 
and special symbols 
You can type a variety of non-English characters (with diacri tical 
marks) and special symbols by pressing the modifier keys (such as 
Shift, Option, and Conrrol) in combination with certain letter and 
number keys. 

The Key Caps program, which is installed ,,·irh rhe s~1stern 

software, shows ~1ou the characters produced when you type 
certain keys and kev combinations in the fonts you have (choose 
Key Caps from the Apple menu, then choose the font from the 
Key Caps menu). 
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Characters appear here \\·hen rou press kers 
on rhc keyboard or click 1hcm in 1he 1rindow. 

Key Cops 

6 

Characrcrs available in rhc 
Monaco fon1 (on rhc Apple 

Ex1endcd Keyboard II) 



ID Key Cops 

The highlighted key represents the 
kev held clown on the kcvboard­
in this case, the Option ker. 

a . I • 
7 6 9 -
4 5 6 + 

I 2 3 

0 

Special characters available 
in the Monaco font when 

the Option key is pressed. 

To cype a characcer wich a diaoitical mark (such as an acute accent 
or an umlaut), you press the Option key with a specific letter key, 
then you type the characcer. 

Diacritical mark 

Grave accent (' ) 

Acute accent ( ' ) 

Circumnex (A) 

Tilde(-) 

Umlaut c··) 

The letter c with a cedilla (~) 

Key combination 

Ornion- · , then type the charaCLer 

Option-e, then type the character 

Option-i, then type the character 

Option-n. then type the character 

Option-u, then type the character 

Option-c 

If che character appears ajier the cliacricical mark (racher than 
with it), then the marked characcer is nor available in the font 
you're using. 
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AppendixB 

Exchanging Disks and Files 
With MS-DOS and Apple II 
Computers 
Apple File Exchange is a file format conversion program that is 
supplied on the system software floppy disks. The program and 
three special translator files are stored in the Apple File Exchange 
Folder. 

You can use the program to ini tialize a disk in MS-DOS or ProDOS 
(Apple II) format and convert fil es to and from MS-DOS or 
ProDOS. (Apple File Exchange cannot open convened fi les; you 
need to use an application program that recognizes the convened 
fil es to open them.) 

Apple File Exchange 
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Initializing a disk in MS-DOS 
or ProDOS format 
1. Locate the Apple File Exchange icon and open it. 

Apple File Exchange is supplied on the system software disks. 

The program's window opens. The contents of the active 
window are listed on the left side and an empty box appears 
on the right side. 

2. Place a blank disk in your floppy disk drive. 

A dialog box appears, reporti ng that the program can't read 
the disk and asking if you want to initialize it. This dialog box 
shows the names of formats available in Apple File Exchange, 
including Macintosh, MS-DOS, and ProDos. 

(You can initialize a disk that is not blank by inserting it, 
clicking the Drive button until its name appears in the 
window, and choosing Erase Disk from the File menu.) 

3. Click MS-DOS or ProDOS. 



4. If necessary, click the capacity (in K) of the disk you 
inserted. 

If you war1l Lo iniLialize a high-densiry disk in MS-DOS format, 
1440K is rhe only option and is already selecred. If you 
insened a double-sided disk, click 720K. 

fLID1 Rppl e File EHchonge connot 
l.DJ reod this disk. Do you wish to 
~--1n_111_0 1_1z_e _1t?_. _______ Disk capacity is rhe 

• 1440K Macintosh 
II 

J>roOOS 

[ lnitlallze JI[ Eject JI 

5. Click the Initialize button. 

same for Macin1osh 
and MS-DOS 
high-density disks. 

When inirialization is completed, a dialog box appears, asking 
you ta name rhe disk. 

6. Type a name for the disk, then click OK. 

MS-DOS file names can have up to eight characters, followed 
by an optional period and up ro three characters. 

The dialog box closes, and the name of rhe disk you inirialized 
appears, above an empry window. This disk's icon doesn't 
appear on your Macintosh screen (because the Macintosh 
cannot recognize a disk in MS-DOS or ProDOS format). 

7. Choose Quit from the File menu when you are fmished 
using Apple File Exchange. 

Apple File Exchange cannot initialize a high-density disk in 720K 
format, nor can ir read a double-sided disk rhar has been 
inirializecl in rhe high-density (1.4 MB) format. 

·:· 5.25-incb disks: Some Macintosh models can use an exrcrnal 
5.25-inch floppy disk drive thar can read files from MS-DOS 
disks. An inrernal adapter or expansion card is required to 
connect a 5.25-inch disk drive to the Macintosh. Apple File 
Exchange can translate files from these disks and srore files on 
them. ·:· 
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Converting files to and from MS-DOS 
or ProDOS format 
Apple File Exchange provides cwo methods of file conversion­
texr and binary. You use texr translation for text files, and binary 
translation for other files. 

In addition, Apple File Exchange can use special translator files 
designed to convert files into formats that specific programs can 
use. One of these special translator files is provided with Apple 
File Exchange: DCA-RFT/Mac\Xfrite, which converts documents 
between MacWrire " format for the Macintosh and Document 
Content Architecture/Revisable Form lext format (used by many 
word-processing programs) for MS-DOS. 

File selected 
for translation 

l l 
' File Edit Moc to MS~oos MS- DO S to Mac 

t---
Opple file (Hehn~ 

l§Tu llZI MSOOS.J Jhl 

• : '" D OUOGCT.90 
D Disk Images 

( »Translate::. ) 
D OUUGCT.9 1 

0 l obeh D OUDGCl.OUW 

I Re moue ) 

27K 
byte s 

selected 
]:@ 

c-J Hummer IX) MSOO<.j jh 

5094K byte s nuallable I 32'1K bytes auoiloble 

I CIJH!ll ) I Drlue ) I Uprn ) ~ 
(New fold er) I lj t!t l ) ~I~ 

~!enus of 
trans!awr fik:s 

Directory 
title or disk 
name 

Disk name 
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Follow these steps ro translate a file: 

1. Locate the Apple File Exchange icon and open it. 

Apple File Exchange is supplied on the system software disks. 

The program's window opens. The contents of the active 
window are listed on the left side and an empty box appears 
on the righr side. 

2. Insert the floppy disk that contains the files you want 
to translate. 

3. Use the Open, Drive, and Eject buttons to display the 
files you want to translate and the disk or folder where 
you want to store the translated files. 

4. Click the names of the files or folders you want to 
translate. 

·ro select multiple files or folders, hold clown the Shift key and 
cl ick each name. You may have to scroll to locace the names of 
some files or folders. 

The appropriate translation menus (one for translating from 
Macintosh format and another for translating to Macimosh 
format) appear on the menu bar when you select either 
MS-DOS or ProDOS files. 



5. Open the translation menu you want by pressing its 
name. 

6. Make sure that the translators for the types of files 
you've selected have checkmarks; if not, choose them 
so that checkmarks appear next to them. 

An active translator has a chcckmark. The default translator 
has a diamond (indicating that it's always active). Choosing an 
active translator makes it inactive. 

7. Compare the size of the files or folders selected for 
translation with the space available on the destination 
disk. 

The total space required appears between the lists; the space 
available on the destination disk appears below its name. 

If the size of the selected items is greater than the space 
available on the destination disk, deselect some of the items 
(by Shift-clicking them), remove some files on the destination 
disk (using the Remove button), or change to another 
destination disk (using the Eject button). 

8. Click the Translate button. 

If Apple File Exchange finds two or more active translators­
other than Text or Default-capable of translating a selected 
file, it presents a dialog box asking you to select the translator 
you want. 

If the names of files or folders on the destination disk are the 
same as those of files or folders being translated, Apple File 
Exchange presents a dialog box asking you to rename the file 
being translated. 

If a translator requires you to select options before a file is 
translated, it presents a dialog box in which you select the 
options. 

9. Respond to any dialog boxes presented by selecting a 
translator, renaming the file, or selecting options. 

The selected files or folders are translated. Messages report 
the status of copying. 

If Macintosh files are being translated into MS-DOS files, the 
names of translated files may be shortened to conform to the 
naming conventions of MS-DOS. 

colllinues ~ 
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10. When all translations are finished, choose Quit from 
the File menu. 

·:· Conuerting /v/S-DOS files on a file seruer: Some file servers 
can srore informarion created by bmh Macintosh computers 
and MS-DOS computers. For example, the AppleShare PC 
program allows MS-DOS computers to store and translate files 
on an AppleShare file server. Consult your authorized Apple 
dealer or representative for more informarion about using a 
file server and MS-DOS files. ·:· 

Other file-conversion options 

Apple file Exchange's File menu provides several other options to 
assist you with file conversions. 
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The program keeps a log of all files translated, 
showing the date, time, and type of conversion. 

Show User Log 
[lose 
Sm•e U~Pr !.o~J fl~ ... 
[ h~ar BS(!I' l.IH.l 

The active translators and the 
opcions for each translator can 
be saved in a special file with the 
"'Save settings as" command. You 
can then use these options any 
time bv choosing the "Rescore 
settings from" command and 

Restore settings from ... 
Saue settings as ... 

t--t--- opening the file. 

Page Setup ... 
Print !JS(ll' l.1H.J ... 

B•~nanu~ !h~stirwHon f'ih>s ... 
v'Show Only Eligible Files 3€E 

Erase Disk ... 

Quit 

You can rename destination 
(translated) files. 

The names of files that 
can't be converted bv the 
active translators arc. 
dimmed when this item 
is checked. 

You can reinitialize a disk in anv 
available format with this comri1and. 

More information about Apple File Exchange options 

l b see explanations of the translarors Apple File Exchange uses, 
choose Abour the Apple File Exchange from the Apple menu. 
Select a translator in the list that appears, then click the About 
button for information about that item. (Click Done to return to 
the program's window.) 



Appendix C 

Where to Get More 
Information About 
Your Macintosh 
A-:, you increase your knowledge of computers and develop new 
uses for your Macintosh, you may want to know what other 
Macinrosh users in your area arc doing with their computers, or 
you may wanr to learn more about programming, hardware 
design, or other technical topics. 

The information in this appendix provides a starting point for you 
to expand your Macintosh knowledge and contacts. 

Macintosh user groups 
Whatever your level of computer experience, you can get lots of 
support by joining a Macintosh user group. Macintosh user 
groups are composed of people who work with Macintosh 
computers and who enjoy sharing what they know with ochers. 
Activities may include demonstrations of new produces, question­
and-answer sessions, and classes on using popular programs or 
learning to write your own programs. Many user groups have 
special beginners' meetings. 

A'ik your authorized Apple dealer for the name of the Macintosh 
user group nearest you, or call 800-538-9696. For names of user 
groups outside the United States, or if you're interested in starting 
your own user group, conract: 

Berkeley Macintosh User's Group or 
14'12-A Walnut Street, # 62 
Berkeley, CA 94709 
U.S.A. 
510-549-BMUG (510-549-2684) 

Boston Computer Society 
One Center Plaza 
Boston, MA 02108 
U.S.A. 
617-367-8080 
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Technical information 
A variery of technical documentation is available for the 
~ laci nrosh . Apple Computer releases cechnical informacion 
ch rough three primary outlets: the Apple Technical Library and 
the Apple Communicacions Library, borh published by Adclison­
Wesley Publishing Company, and che APDA developers' source. 

Apple Technical Library 

The Apple 1cchnical Library includes comprehensive cechnical 
documemacion for all Macincosh compucer models and che 
mulcivolume guide co che Macinmsh operating system for all 
models, !11side ,\/aci11tusb. 

Other books in the Apple 1echnical Library cover designing 
expansion cards and programming device drivers for che 
~1acintosh, wri ting application programs for che Macintosh, and 
designing che user interface for Macincosh programs. 

You ·11 find che Apple 'lechnical Library in masc well-scocked 
books cores. 
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Apple Communications Library 

The Apple Communications Library offers complete cechnical 
information about ~ lacintosh communications produces and the 
Macintosh in a network environment. The library includes an 
incrocluctory volume, Unden;tclJlding Computer Networks, and 
che comprehensive guide to the AppleTalk network system, !11sicle 
AppleTalk. 

The books in the Apple Communicacions Library are aYailable ac 
bookswres. 

APDA 

APDA offers convenient worlclwicle access co over 300 
clevelopmenc tools, resources, training products, and information 
for anyone imerescecl in developing applications on Apple 
plarforms. C11s1nmers receive 1 he f]uarterly APDA "fools Catalog 
feacuring all of our most popular and most current versions of 
Apple ancl third-party clevelopmcm tools. Ordering is easy: there 
are no membership fees ancl application forms arc nor required 
for most of our products. APDA offers convenient payment and 
shipping options, including site licensing. 



·10 order produce or ger additional information, comacr: 

APDA 
Apple Computer, Inc. 
20525 Mariani Avenue, M/S 33-G 
Cupertino, CA 95014-6299 
U.S.A. 

800-282-2732 (United Stares) 
800-637-0029 (Canada) 
408-562-3910 (International) 
P'ax: 408-562-3971 
'lelex: 171576 
AppleLink: APDA 

Assistance for hardware and software developers 

If you plan to develop hardware or software produces for sale 
through retail channels, you can ger valuable supporr from Apple 
Developer Programs. Write to: 

Apple Developer Programs 
Apple Computer, Inc. 
Mailsrop 51-W 
20525 Mariani Avenue 
Cupertino, CA 95014-6299 

Information about copying ~oftware 
Jf vou want or need more information about when it is OK to copy 
so.ftware and when it isn't, or about related consumer issues, you 
can contact rhe Software Publisher's Association (SPA) and ask for 
their free brochure. Call or write: 

Software Publisher's A'isociarion 
1730 M Street N\Xl, Suire 700 
Washington, DC 20036-4510 
800-338-7478 
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Glossary 

A 

access privileges The abiliry to see folders, see files, or make 
changes co a shared disk or folder. Access privileges are 
gramed by the owner of the shared item and are used to 

determine what other network users can do with the disk or 
folder and its conrems. 

active program The program you're currenrly using. You can 
have several programs open ar a rime, but only one of them 
is the acLive program. Open programs appear in the 
Application menu at the right end of the menu bar, with a 
checkmark next to the name of the active program. The 
menu icon changes to indicate which program is the active 
program. 

active window The window that's on top of all others on the 
Macinrosh deskrop. The active 
window has solid lines running 
across its title bar and it "belongs" 
to the active program. 

ADB See Apple Desktop Bus. 

Alarm Clock A desk accessory program (an Apple menu item) 
that works like a digital alarm clock. 

alert box A box thaL appears on the screen to give a warning or 
other message, sometimes accompanied by an alen sound. 

!.\ This process will erase nll 
ill Information on t his disk. 

Cancel H Erase B 
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alias A Ille rhar srancls for and poinrs ro a file, folder, or disk rhar 
you use as if it were the original. When you 

- open an alias. you're actually opening its 
V original. 

T~~T~xt~lios ~ 

Apple Desktop Bus (ADB) Jn put circuitry built in co most 
C. Apple computers. You use ADB porrs (marked 
9 "·ith the ADl3 icon) ro arrach the keyboard , the 

mouse, and other devices, such as graphics tablets 
ancl bar-code readers. See also bus. 

Apple menu The menu ar the left encl of the menu bar. 

Rboul This Macintosh ... 

(!/ nlarm Clock 
tTJ Clllculotor 
% Chooser 

indicated by the Apple svmbol. 
You choose items from this 
menu to get information about 
programs' memory use and 
open items placed in the Apple 
1\lenu ilems folder (in the 
Sysrem folder). 

AppleShare file server A Macintosh computer running 
ApplcShare File Server soft\\'are that allows network users to 
stare, rerrieve, and share files and application programs on 
that computer. 
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AppleTalk network A combination of devices, cables, and 
software that operate according to che protocols (rules) 
developed by Apple Computer. A communicarions 
environment in which many different kinds of compurers, 
peripherals, and software can work together. Uses LocalTalk, 
EtherTalk, or 'lbkenTalk nerwork connecrion types. 

Application menu 

Hide Finder 
Hide Others 
Show All 

../~ Finder 
~ TeochTe11 1 

The menu at the right encl of rhe menu bar 
(its icon changes ro indicate \\'hich 
program is the acrive program). You 
choose items from this menu to hide 
windows belonging to open but inactive 
program· and to make an open program 
the acrivc program. Sec also active 
program. 

application program A program that you use to clo your work 
on rhe computer, such as word processing, database 
management, graphics, or telecommunication. 

B 

back panel The back of the computer, where you find the 
power switch and pons for attaching exrernal devices. 

back up To make a copy of a disk or of a file on a disk. Backing 
up your files and disks ensures that you won' t lose 
information if the original is lost or damaged. 



balloons Small boxes containing rexr identifying objects on the 

;:; Use this menu to 9et 
:~; information that helps 
~ :: you use your compu1er. 

screen and explaining their 
use. You can hide or shm\" 
balloons by choosing rhe 
appropriate command 
from the Help menu. 

bit Binary digit. The smallest unit of informarion chat a computer 
can hold. The value of a bit (either 1or 0) represents a 
two-way choice (on or off, true or false. black or white). 

bitmap A sec of bi rs thar represents a graphic image. 

bitmapped character A charaCLer in a font that's rendered as a 
biu11aµ and drawn as a pixel parcern on the screen. See also 
font, pixel. 

bitmapped font A fonr in a single point size made up of 
birmapped characters (also called fixed-size font). Some 
fonts stored in rhe Macinrosh Sysrem file are bitmapped 
fonts. Compare outline font, TrueType font. 

buffer A ··holding area., in memory where information can be 
stored by one program or device and rhen read by anorher. 
For example, some primers have built-in memory to srore 
rext that comes from the com purer faster than it can be 
primed. This memory, which frees the com purer for orher 
work while the printer is printing, is called a print b11ffe1: 

I bus Circui ts inside the computer that transmit informarion from 
one parr of a com purer system to anorhcr. for example, rhe 
Apple Desktop Bus transmits information about mouse 
mo\"ement or keyboard input. In a nenrnrk, a bus is a line of 
cable with connectors thar link devices together. 

button An image, sometimes resembling a pushbutton, that you 
click co designate, confirm. or 

~[ OK ]~ [ l cancel an aCLion. Com1)are 
~· JJ Cancel 
~-::.::===~ mouse button. 
[Options] [ Help ] 

byte A unit of infonnation consisti ng of a fo:ed number of bits. 

c 

One byte usually consists of a series of eight bits. See also 
kilobyte, megabyte. 

cache See memory cache, disk cache. 

Cancel button A button that appears in most dialog boxes. 
Clicking it cancels any command or options you might have 
chosen and closes the dialog box. 

central processing unit (CPU) The '·brain" or [he computer; 
the microprocessor that performs rhe actual computations. 
See also processor, coprocessor. 

character Any symbol thar has a widely undersrood meaning 
and thus can convey information (letters, numerals, 
punctuation marks, and other symbols). 
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checkbox A small box associarecl wirh an option in a dialog box 
or window. You click che checkbox ro cum che option on or 
off. An opcion is "on" when there's an X in the checkbox. 

chip See integrated circuit. 

choose To give a command by dragging chrough a menu and 
releasing che mouse button when rhe command is 
highlighced. 

Chooser A program rhar lers you designate devices, such as 
rrinters and shared disks on a network, for your Macintosh 
to use. 

Clear A command in che Eclir menu rhar removes selected 
marerial wirhour placing ir on rhe Clipboard. You can use 
1 he Undo rnmmancl immediately after using Clear if you 
change your mind. Compare Cut. 

click To posirion rhe pointer on an objecr on che screen, and 
rhen co press and quickly release che mouse button. 

Clipboard An area in che compucer's memory chat functions as 
a holding place for what you last cue or copied. lnformarion 
on rhe Clipboard can be pasted in co documents. 

close box The small box on rhe left end of the ti rle bar of 
an accive window. Clicking ir closes che 

~ window. 
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color wheel Available on computers with color capabiliry, che 
color wheel dialog box lers you adjusr hue, saturation, and 
brightness of rhe highlighr color and orher color choices. It 
is also used co adjusc shades of gray. 

command An insrruccion rhat causes the computer co perform 
some action. 

configuration (1) The wa~· you have your computer sec up. 
(2) The combined hardware components-compurer, 
monirors, keyboard, and peripheral devices-that make up a 
computer system. (3) The software settings that allow 
various hardware componenrs of a computer system to 
communicate with each orher. 

control panels Programs chat let you change various Macinrosh 
fearures, such as sound, mouse movemem, and keyboard 
options. Control panels are located inside che System 
Folder. 

coprocessor An auxiliary processor designed LO relieve rhe 
demand on che main processor by performing a few speci fic 
casks. Generally, coprocessors handle tasks that would be 
performed much more slowly by the main processor, such 
as machemarical calculacions. 

Copy A command in che Edie menu chat copies selecced macerial 
and places icon che Clipboard, wichour removing che 
macerial from rhe original document. See also Clipboard. 



copy-protect To make a disk difficulr if nor impossible ro copy. 
Software publishers somerimes copy-protect their disks to 
prevent them from being illegally duplicated. See also lock. 

CPU See central processing unit. 

current application ee active program. 

current startup disk The disk rhar contains the System Folder 
the computer is currently using. The startup disk icon 
appears near rhe upper-right corner of the desktop. 

cursor See pointer. 

Cut A command in rhe Edit menu that removes seleCLed material 
and places it on the Clipboard; from there you can pasre it 
elsewhere. Compare Clear. See also Clipboard. 

cut and paste To move text, graphics, or other material from 
one place in a document ro anorher place in the same or a 
differenc document. 

D 

default A value, action, or setting that a computer system 
assumes, unless you give ir a different instruction. (Also 
called preset. ) 

deselect To change a selected item, such as an icon, so that it is 
no longer selected. In the Finder, you deselect highlighted 
icons by pressing the Shifc key and clicking the icon you 
want to deselect, or by selecting something else. 

desk accessories Small application programs char you can add 

Abou t This Moclntosh ... 

~ Alarm Clock 
~ Colculot or 
~Chooser 

9a con t ro l Pon e l s 
[@)Key Cops 
[,J Note Pod 

to your system. Desk 
accessories (DAs) are often 
installed in the Apple menu. 
Those provided with the 
Macincosh include the Alarm 
Clock, the Calculator, the 
Chooser, control panels, Key 
Caps, and the Scrapbook. 

desktop Your working environment on the computer (the menu 
bar and the background area on the screen), on which you 
work with icons and windows. 

1--o1_ r_11e'--'-cd'-it_u...;;1c'-w-'L'--•b...;..e1_ s;.;..p_et1_01 _______ J[~~=-' .-l -Ir Menu 
J ·· bar 

Macintosh HO 
l1t lftl$ J,,..._~ J41ta •vailwk-J. c:::::J .. 

li!m:i!liiii!iiii!iiii!i~SJl'~•~tem~r~o1@ide~r !!!!!!!!!i!!!!~i!i~ -~""' "'-r- Desktop 
l rtf'IM l'l"llW'llhst J4 lta •·o1W. .. 

w LQ] ~ [9) 
~pk-MttoultffnJ h \• M it-nJ ContnlP-k fW'ldtf' 

1111 ~ - !A§) I]] LID 

destination The disk or folder that receives a copied or 
translated file, as in destination disk. 
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dialog box A box rhar conrains a message, ortcn requesting 
more information from you or allowing you ro selecr 
options. 

dimmed Gray or fi lled in with a pm ern or dots, indicating that 
an icon is already open or a menu, menu irem, or ocher 
option is not available. 

~Dimmcdcommand 

lllllllllWlil---Dimmed folder icon 

·ll!i!lllliili;: ___ Dimmed program icon 

directory A lisr or rhe conrenrs of a folder or a disk. 

directory dialog box A dialog box that lets you see rhe 
contents of disks and folders so that you can save a 
documcnr in a particular folder or disk, or open a document 
that's in a particular folder or disk. A directory dialog box 
appears when you choose Save or Open from a program's 
File menu. 

disk A flat , circular object with a magnetic surface rhac 
computers use ro score files (programs and documenrs). 
The files arc stored as magnetic signals, similar to the way 
sounds are recorded on tape. See also floppy disk, hard 
disk. 
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disk cache A pC!rrion of rhe computer's random-access memory 
(RAM) that is set aside for programs to store frequently used 
insrrucrions. You use rhe Memory conrrol panel ro adjusr 
the size of rhe disk cache. Compare memory cache. 

disk capacity The maximum amount of data a disk can hold, 
usually measured in megabytes (MB) or kilobytes (K). 

disk drive The device rhar holds a disk. retrieves information 
from ir, and stores information on ir. 

document Whatever you create \\'ith an applicarion program. 
ee also file. 

double-click To position rhe pointer on an object, such as an 
icon. and then to press and release rhe mouse bunon twice 
in quick succession without moving the mouse. 

drag To position rhe pointer on an objecr, press and hold the 
mouse button, move the mouse, and release rhe mouse 
button. 

driver A program rhar the computer uses to direct the operation 
or a peripheral device. such as a prinrer or scanner. (Also 
called a resource.) 

drop folder A shared folder with access privileges that clori'r 
allm\· network users ro open it bur do allow nerwork users 
ro place files or folders into it. 



E 

Easy Access A conrrol panel that you use to adjust the keyboard 
so that you can control the pointer from the numeric 
keypad, type keyboard shortcuts without having ro press the 
keys at the same time, and rype very slowly. You also can 
make these keyboard adjustments without opening the 
control panel. 

Edit menu A menu that is available in most programs and lists 
editing commands-such as Cut, Copy, and Paste. 

eject fo remove a disk from a disk drive. 

error message A message displayed on the screen that tells you 
of an error or problem in a program or in your 
communication with the computer system. 

Ethernet A high-speed, widely used network type. 

EtherTalk A type of network connection (provided by Ether'falk 
software installed in your Macinrosh) that allows you to use 
AppleTalk nerwork services on an Ethernet network. 

Everyone A category of users for whom you can set access 
privileges to shared folders and disks. The category refers to 

anyone who connects to a computer as a guesr or registered 
user. 

expansion card A removable circuit board that plugs into one 
of the expansion slots in some models of Macintosh 
computers. Expansion cards enable the computer to use a 
special device or to perform an additional function. 

expansion slot A long, rectangular socket on the main circuit 
board of some Macintosh models into which you can install 
an expansion card that gives the computer additional 
capabilities. 

extension See system extension. 

F 

file Any named, ordered collection of information stored on a 
disk. Application programs and documents are examples of 
files. You create a file when you type text or draw graphics, 
give the material a name, and save it on a disk. 

File menu A menu that lists commands that affect whole 
documents and other files- commands such as Save, Print, 
and Qui t. 

file server A computer with special software that allows network 
users to store and retrieve files on the hard disks or other 
storage devices attached to it. 

file sharing The capability of sharing files among computers on 
a network. 
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Finder Part of the system software, the Finder is the program 
that creates the Macinrosh cleskrop and keeps track of your 
files. 

floppy disk A disk made of flexible plastic that stores compurer 
data. The 3.5-inch disks used in Macintosh floppy disk drives 
are floppy disks housed in rigid plastic shells for support 
and protection. Floppy disks come in three types: high­
density (1.4 Ml3 capacity), clouble-sidecl (SOOK), and single­
sidecl ( 400K). 

folder A container for documcnrs, programs, and orher folders 
on the desktop or in directory windows. 

font A collection of letters. numbers. and svmbols in a distinctive 
typographic design. See also 

This is New York font. bitmapped font, outline 

This is Geneva font. font, TrueType font. 

format See initialize. 

G 

guest A person thar connects to another computer on a network 
without having to give a name or password . 

guest access A type of access to a computer that permits any 
network user to connect to the computer for the purpose of 
file sharing or program linking. Each Macintosh owner can 
control whether guest access is allowed on that computer. 
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group A set of registered users on a network for whom you set 
access privileges as a unit. Groups are a conven ient way for 
a person who is sharing files ro control access privileges for 
a number of users at once. 

H 

hard disk A disk made of mecal and permanently sealed in a 
disk drive or cartridge. A hard disk can hold much more 
information than a nappy disk, and a hard disk spins much 
faster. 

highlighted Visually distinct, usually because the colors are 
reversed. 

I, J 
I-beam A rype of poi mer shaped like the capital letter I, used 

for entering and editing rexr. See also I insertion point. 

stationl yI- I-beam 

icon A small pictorial representation of a file, disk, menu, option, 
or or her object or f ea tu re. 

Q 
D 

Document 
I 
Trash Floppy Disk 



initialize To prepare a disk to receive information by organizing 
irs surface into cracks and sectors; also known as.format. If 
you initialize a disk with informarion on it, the in formation 
is erased. 

input Information transferred into a computer from some 
external source, such as the keyboard, the mouse, a disk 
drive, or a modem. Compare output. 

insertion point The place in a document where text you type 
will be added; you set it by clicking at the spot I where you want to make the insertion. The 

_ insertion point is marked with a blinking 
st.:itiorli vertical bar. 

I insertion point 

installer A program that you use to install or update your 
sysrern software or ro add resources such as networking 
software. 

integrated circuit (lC) An electronic circuit entirely contained 
in a single piece of semiconducting material, usually silicon. 
Often referred to as a cb1p. 

interface The way a computer communicates wi th external 
devices, such as a printer (through its printer porr, or 
printer interface), or with you (through its user interface or 
human interface). 

K 

K See kilobyte. 

keyboard equivalent See keyboard shortcut. 

keyboard shortcut A combination of key presses that you can 
use to give a command or set an option. Keyboard shortcuts 
always involve the use of at least one modifier key, such as 
the ~ key or the Option key. 

Key Caps A desk accessory that shows you rhe characters 
available for each font in your system. 

kilobyte 1024 bytes. See also byte, megabyte. 

L 

label A word or shon phrase that you can assign to an icon by 
using the Label menu. (You can also assign the color thac's 
associated with a label if your Macintosh displays color.) You 
can change labels and their associated colors in the Labels 
control panel. 

Loca!Talk A built-in network connection that allows a Macintosh 
computer to participate on an AppleTalk network. 

LocalTalk cable system A system of cables, cable extenders, 
and connector boxes that connect computers and network 
devices to an AppleTalk network system. 
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lock fo prevem files or disks from being changed or delerecl 
(but they can srill be opened or copied). 

M 

main logic board A circuit board rliat holds RA~ I . ROM, the 
microprocessor, cusrom integrated circuirs, and orher 
componenrs thar make the computer work. 

main memory Sec random-access memory. 

megabyte (MB) 102"1 kilobytes. or l.0~8,576 bytes. See also 
byte, kilobyte. 

member A registered user on a net work \rho belongs co a 
group. 

memory A hardware component of a computer system char can 
srorc information for later retrieval. See also main 
memory, random-access memory, read-onJy memory. 

memory cache ~1emorr that is set aside w increase the 
efficiency and operaring speed of the computer. Compare 
disk cache. 

menu A lisr of items from which vou can choose. ~lcnus 

commonly appear when you press menu names in rhc 
menu bar or in a dialog box. You choose a command by 
dragging through the menu and releasing the mouse button 
when the command you \\·anr is highlighted. Sec also 
pop-up menu. 
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menu bar The white strip across the top of your screen that 
contains the names of the menus available to you. 

menu name A word, phrase. or icon in the menu bar or in a 
dialog box that gives you access to rhe menu. Pressing the 
menu name opens the menu. 

modem Shore for 111od1i/a101Jdemod11/a101: A device that links 
your computer to orher computers and informarion services 
over telephone lines. 

modem port A socket on the compurel"s back panel marked by 
a telephone icon, used co connect a modem to your 
Macinrosh. 

monitor See video monitor. 

mouse A device that controls rhc pointer on the screen. 

mouse button The mechanical bu non on top of the mouse. In 
general, pressing rhe mouse bucron iniriares some action on 
wharever is under the pointer on the screen, and releasing 
the button confirms the action. 

Mouse Keys An Easy Access feature char lers you use keys on the 
numeric keypad to control the pointer. 

MS-DOS Microsoft Disk Operating System, a commonly used 
com purer opcraring system. 



N 

network A col lection of devices such as compurers and primers 
that are connecred rogether. A network is a tool for 
communicarion rhat allows users to store and rerrieve 
information, share prinrers, and exchange information. 

network administrator A person responsible for secring up, 
mainraining, or troubleshooring your nerwork. 

network service A capability such as file service or prinr service 
provided by special software on the network. 

network user A person whose computer is connecced to a 
nem·ork. 

Note Pad A desk accessory rhat lers you enrer and eclir small 
amounrs of rexr. 

Nu Bus An addn.:s~ bus and data bus used in the Macinrosh II 
family and some other ~lacintosh computers. '.'iuBus lcrs 
you add a variety of components ro the computer system, 
through expansion cards installed in NuBus expansion slots 
inside the com purer. See expansion slot. 

numeric keypad A calcularor-sryle keypad, to the right of the 
alphabet keyboard, that you can use ro rype numbers. Some 
application programs designare the keys on the numeric 
keypad as function keys. 

0 

open 'lo make available. You open files in order ro work wirh 
rhem. Opening an icon usually causes a window to appear. 
revealing rhe document or application program rhe icon 
rcpresenrs or showing you the conrenrs of a folder or disk. 

operating system A program thar organizes the internal 
acrivities of the computer and irs peripheral devices. An 
operating s~'stern performs basic tasks such as moving dara 
ro and from devices and managing in formation in memory. 

outline font A font rhat describes each character mathematically 
as a set of formulas. The mathematical description adjusts 
itself ro render the charaner in different sizes. See also 
TrueType font, bitmapped font, font. 

output Information rransferred from the computer's 
microprocessor to some external device. such as the screen. 
a disk. a printer. or a modem. Compare input. 

owner The owner of a Macintosh is named in rhe Sharing Setup 
conrrol panel. On a network, the owner of a shared folder 
or disk is named in the Sharing dialog box, idenrifying rhe 
person who can set or change the access privileges assigned 
to the shared item. 

owner name The name of the owner of a shared folder or disk 
that appears in rhe Sharing dialog box. The owner can be 
the Macinrosh owner, a registered user, or a registered 
group. The owner can se1 or change rhe access privileges of 
rhe shared icem. 
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password A unique word or set of characters that must be 
entered before a network user can gain access to a 
computer that he or she is registered on. 

Paste A command in the Edit menu that places the con rents of 
the Clipboard- whatever was last cur or copied-at the 
location of the insert ion point. Sec also Clipboard. 

peripheral device A piece of hardware- such as a monitor, disk 
drive, prin ter, or modem- used with a computer and under 
the computer's control. 

PICT A file format used by a number of graphics and page layout 
programs. 

pixel Picture element. The smallest dot that the computer and 
monitor can display, or rhe representation on the screen of 
the value of a bic. Also, a location in video memory that 
corresponds to a pixel on the screen. See also bit. 

pointer An arrow or ocher symbol on the screen thar moves as 
you move the mouse. 

pop-up menu A menu (usually in a dialog box) in which the 
selected option is shown next to a 

Tabloid ...,. solid triangle and inside a box with a 
shadow around ir. The rest of rhe 
menu "pops up" when you press the 
box. Compare pull-down menu. 
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port A socket on the back panel of the computer where you can 
plug in a cable to connect the computer ro anorher device. 

printer port A socket on the computer"s back panel marked 
with a prinrer icon, used ro connect a prinrer or an 
AppleTalk network connector to the computer. 

privilege See access privileges. 

processor The computer hardware component that performs 
the computations directed by software commands. In 
microcomputers such as the Macinrosh, the processor is a 
single inregrated circuit called a microprocessor. See also 
central processing unit. 

program A set of instructions describing actions for a computer 
to perform ro accomplish a rask, conforming to the rules 
and conventions of a panicular programming language. 
Computer programs are collectively referred to as software. 
See also application program. 

program linking The ability of an application program to 

exchange information directly with another program over a 
network. To use program linking, borh programs must have 
the capability. 

pull-down menu A menu (usually in rhe menu bar) whose 
name or icon is shown. You '·pull down" the menu by 
pressing the name or icon. Compare pop-up menu. 
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RAM See random-access memory. 

random-access memory (RAM) The pare of a compurer's 
memory available for programs and documenrs, also known 
as main memory. The comenrs of RAM are lost when rhe 
computer is rurned off. Compare read-only memory. 

Read Me document A document that is included on some 
applicarion program and system software disks to provide 
you wirh !are-breaking information abour chc producL. 

read-only memory (ROM) Memory whose contents the 
computer can read, but nor change. Information is placed 
into read-only memo1"}' only once, during manufacturing. 
The mn1cnt'i of ROM are not erased when the computer's 
power is turned off. Compare random-access memory. 

registered group A group of registered users rhat is listed on a 
computer on a nerwork. 

registered user A nerwork user whose name and password are 
listed on a computer on 1he network. Usually, registered 
users have greater access privileges to shared folders and 
disks rhan do guest users. 

resource A Ille that is comained in the System Folder and that 
the computer uses for its operations. Sysrem files and 
device drivers arc examples of resources. 

RGB monitor A type of color monitor that receives separate 
signals for each primary color (red, green, and blue) and 
uses rhese signals ro display color images. 

ROM See read-only memory. 

s 
save To srorc information by transferring it from main memo1"}' 

(RAM) to a disk. Work that is nor saved disappears when you 
rurn off rhe computer or if the power is interrupted. 

scanning order The order in which the Macincosh searches the 
disk drives for a startup disk. See also startup disk. 

Scrapbook A desk accessory in which you can save frequently 
usetl piuurcs or passages of text. The Scrapbook can score 
multiple images. You can cue or copy images from the 
Scrapbook and paste chem into documents created wich 
most application programs. Compare Clipboard. 

scroll ·10 move a document or directory in its window so that a 
differe111 part of it is visible. )bu scroll using the scroll 
arrows, scroll bars, or scroll box. 

SCSl See Small Computer System Interface. 
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SCSI cable terminator A device used in a SCSI chain LO 
maintain che integrity of the signals going through the 
chain. \Vith ·ome devices. such as che Apple incernal hard 
disk, the terminator is built in. 

SCSI chaii;i A group of SCSI devices linked co one another 
through SCSI peripheral cables and linked to the SCSI porr 
on the computer through a SCSI system cable. 

SCSI port The socket on the back panel of the computer LO 

which you connect SCSI devices. 

select 'lb designate which object will receive the nexc action you 
take. Selecting is usually clone by cl icking or dragging. 

selection The selected object or objeccs. A seleccecl object is 
usually highlighced. 

serial ports The connectors for peripheral devices that receive 
data in a serial format (that is, one bic at a cime). The printer 
and modem pons on the Macintosh are serial pons. 

shared disk A hard disk, CD-ROM disc, or other medium whose 
concents can be retrieved over the network. A disk can be 
shared by a file server or a Macintosh computer that has file 
sharing curned on. 

shared folder A folder that is available to some or all network 
users over che necwork. 
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Shift-dick To click the mouse bu non while holding clown the 
Shifc key, used to extend or shorten a selection and co select 
more than one item. 

Shift-drag lb drag while holding clown che Shifc key, used co 
selecc two or more groups of objects by holding down che 
Shift key while you drag diagonally to enclose each group of 
objects in a rectangle. 

SIMM Single In-line Memory Module, a circuit board that 
contains eight RAM chips. SIM Ms are conneCLed to SIMM 
sockets on the computer's main circuit board. See also 
random-access memory. 

size box A box on the botcom-righc corner of the active 
window. Dragging the size box resizes the 
window. 

Slow Keys An Easy Access feature that lets you sec a delay before 
each keystroke is accepred by che compuLer. 

Small Computer System Interface (SCSI) A specification of 
mechanical, eleccrical, and f unccional scanclards for 
connecti ng peripheral devices such as hard disks, printers, 
and optical disks to small computers. 

sound output port A socket on the back panel of the 
Macincosh marked wich a speaker icon, used to connect 
headphones or speakers to your Macimosh. 



source The disk or folder that holds the original of a file to be 
copied or translated, as in source disk. 

startup disk A disk with all the necessary program files- such as 
the Finder and System files conrained in the System 
Folder-to set the computer into operation. 

startup drive The disk drive from which you start up your 
computer system. The disk in this drive must contain a 
System Folder. 

stationery A document that serves as a template. When you 
open a stationery documem, a copy of the documem is 
created and opened. The original remains unchanged. 

Sticky Keys An Easy Access feature that lets you type 
combination keystrokes without actually pressing the keys 
simultaneously. 

system extension A program that expands the capabilities of 
system software (for example, device drivers). System 
extensions are stored in the Extensions folder in the System 
Folder. 

System file 

System 

The file that Macintosh computers use to start up 
<md to provide systemwide information, 
including foms, sounds, and keyboard layouts. 
The System file must be in the System Folder. 

System Folder A folder containing the programs that Macintosh 
computers use to start up and operate. A 

('~ I disk that conrains a System folder is a 
System Folder Startup disk. 

system software Software components that support application 
programs by managing system resources (such as memory) 
and input and output devices. Also known as the operating 
system. 

T 

Teach Text A program provided with the Macintosh system 
software that functions as a limited word-processing 
program, used primarily to open Read Me documents. 

tenninator See SCSI cable terminator. 

3.5-inch disk A flexible, plastic disk measuring 3.5 inches in 
diameter encased in a rigid plastic shell. These disks come 
in three types: high-density (1 .4 MB capacity on the 
Macintosh), double-sided (SOOK) , and single-sided (400K). 
See also floppy disk. 
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title bar The bar ar the top of a window Lhat shows the name of 
Lhe window. When the window is active, rhe title bar is 
highlighted with horizontal lines. 

To Do miil 

Token Ring A widely used network type originally clcvclopec.I by 
Internacional Business Machines Corporation. 

TokcnTalk A type of nmvork connection that allows you LO use 
Appletalk services on a Token Ring network. 

Trash An icon on the desktop thar you use co discard 
programs, documems, and folders. 

I 
Trash 

Truelype font A type of outline font supplied with the 
Macintosh system software. See also outline font. Compare 
bitmapped font. 
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u 
unlock To allow a locked disk or clocumenr to be changed, 

deleted, or renamed. Sec also lock. 

user group A computer club where computer users exchange 
rips and information. 

User/Group A category of users for whom you can set access 
privileges ro shared folders and disks. Can be any user or 
group that is registered on rhc computer containing the 
shared folder or disk. 

user interface See interface. 

user name The name chosen by a Macintosh owner or network 
administraLOr to identify a user. After rhis identification is 
complete, rhe user is a registered user and can connect ro 
char computer as such. 

v 
version A number indicating a program's chronological position 

relative ro previous and subsequent releases of the program. 

video monitor A display device that can receive video signals by 
direct connection. Also known as a monito1: 



virtual memory Hard disk space set aside and used as an 
extension of the computer's main memory. 

virus A program designed with malicious intent to damage flies. 
Virus programs can be spread though networks and 
bulletin board services as well as on disks. Virus-detection 
and -elimination programs arc available through dealers 
and user groups. 

volume Space on a hard disk or a Ale server that's defined and 
named as a place to smre files. A hard disk is usually a single 
volume, but it can be partitioned inro several volumes. 

W, X,Y 

window A rectangular area that displays information on the 
desktop. You create and view documenrs through windows, 
and you view the contents of disks in windows. 

z 
zone Zones arc set up by a network administrator and are used 

to group the devices on the network for easier access. 

zoom box A small box in rhe top-righr corner of the title bar of 
the active window. Clicking the zoom box 

~~~ie:i~;;; resizes rhe window so that you can sec all 
34

· 1 MB available Of ilS COlllelllS (if pOSSible); clicking j( 

again returns the window to its previous 
size. 
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Index 

A 
About This Macintosh (Apple menu) 154 
accent marks, typing 254-255 
accessing. See also opening 

Ales on other computers 183-187 
Macintosh while away from it 202- 203 

access privileges (nerworks) 187-189, 
204- 211 

checking 207 
setting 205-206 
srraregies for 206 

activating. See also disabling; opening 
Alarm Clock 133-134 
Applelalk 59, 162. 180 
CloseView 152 
Ale sharing 190 
Finder 45-46 
Help Balloons 80 
Mouse Keys 136 
program linking 210 
Slow Keys 137 
sofrware programs 42, 98, 246 
Sticky Keys 137 
32-bit addressing 159 
·n·ash icon 14-15 
virtual memory 157-158 
windows 14-15, 45-17, 240 

active desk accessory 98 
actire soft\\'are program 2'16 

idenri~1ing 45.....i7, 98 
multiple 45-47, 98 
opening documents in 46, 50, 70 
quick reference for 246 
switching between 45.....i7, 98 

active window, closing 14- 15, 33, 45-47, 240 
adapting Macimosh to your own use 

125-159 
ADB devices 218 
ADl3 pon 218 
adding 

alen sounds 140 
device drivers to System Folder 214 
files ro folders 71-72 
folders to folders 114 
fonts to System Folder 172 
items to Apple Menu 11 7, 126 

adjusting 
blinking of menu items 143 
disk cache 156 
keyboard 91, 135-136, 137 
mouse operations 134-135 
speaker volume 139 
virtual memory 157- 158 

agreemems about software use 96, 192, 263 

Alarm Clock, sening 133-134 
alert sounds 

customizing 139-J'l l 
disabling 139 
inscalling 140 
recording and removi ng 140- 141 
Sticky Keys and 137 

aliases 72-74, 116-11 7. See also documents; 
files; folders 

connecting to shared disks with 186 
creating 116 
definition of 73 
getting information about (Get Info) 117 
locating original of 117 
locking 108 
opening 116 
opening at startup 126 
purpose of 116 
trouble with 116 

APOA 262-263 
Apple Communications Library 262 
Apple Desktop Bus devices 

connecting 218 
power requiremems of 218 

Apple Desktop Bus pon 218 
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Apple Extended Keyboard II 91, 252- 253 
Apple File Exchange 256-260. See also 

networks 
convening files co and from MS-DOS or 

ProDOS with 258-260 
initializing MS-DOS or ProDOS disks with 

256-257 
Apple HO SC Serup program 

icon for 102, 112 
initializing hard disks with 102-103 
testing hard disks with 112 

Apple Keyboard 250-251 
Apple Keyboard II 91. 2-18-2-19 
Apple menu 

About This Macintosh 15-1 
Alarm Cluck 133- 13 i 
Chooser 57-59. 161- 164, 180 
Control Panels 105. 128-151, 156-159, 

182 
installing items in 11 7, 126 
Key Caps 254-255 
removing items from 117, 126. 127 

Apple ,\lenu I!ems folder 117. 126 
Apple Programmers and Developers 

Association 262-263 
AppleShare 184. See also Applcfalk; networks 
Applcfalk l 79. See also AppleShare; networks 

acti\•ating 59, 162, 180 
choosing primer for 163-164 
inact ive 58, 162 
zones 58-59, 163, 184 

Apple 'lechnical Library 262 
Apple II computers, exchanging disks and 

files with 256-260 

28~ Index 

Applicarion menu 42, 46-47, 98-99, 243 
Finder command 46 
Hide Others command 99 
icon for 42, 98 
Show All command 99 

application programs. See software programs 
arranging icons on desktop 113 
arranging your office 89 
arrow keys 22, 245, 2-19. 251, 253 
arrows, scroll arrows 17, 20-21, 241 
a11aching. See connecting 
audio pons 140, 219 
NUX 93. 102 

B 
background printing 164, 169-170 
backing up files 61-62, 108, 247. See also 

copying 
backspacing with Delete key 43 
backup disks 96 
Balloon Help 80-81 
battery, clock 227 
beeps. See alens 
bitmapped fonts 171- 172, 229-230 
black and white 147, 148 
blinking inserrion point, changing 144 
blinking menu items, adjusting 143 
blinking question mark disk icon 233 
bomb error message 231, 235 
borders, window, changing colors of 148 

brightness 
of color wheel 147-148 
of screen 151, 224, 232 

Brightness control panel 151 
Brightness icon 151 
bulletin boards. See also networks 

folders as 205 
viruses and 97 

bus. See Apple Desktop Bus 
By Label command (View menu) 146 

c 
cables 

handling 223 
Local'falk-compatible 179 
SCSI peripheral interface cable 215 
SCSI system cable 215 

cable terminators, built-in 216 
cache. See disk cache; memory 
calendar, setting 129-131 
canceling 

initiali7.ation I 04 
printing 170 

Caps Lock key 248, 250, 252 
cards 

expansion cards 220- 222 
memory expansion cards 222 
NuBus expansion cards 220-221 
video cards 220 

CDEVs 126. See also Concrol Panels 
CD-RO~I discs, sharing over networks 

191-192 
chains. See daisy chains 



changing 
alert sounds 139-141 
Apple menu 126 
blinking rates 143 
clock battery 227 
colors 

in color wheel 147-148 
in Label menu 128-129 
in Monitors control panel 149 

desktop pattern 142-143 
documents 50-56 
icon names 66-67 
icons, appearance of 145-146 
keyboardlayout 136 
keyboard operation 135-136, 137 
keyboard shortcuts with Sticky Keys 137 
Label menu items 128-129 
memory used by software 99-100 
mouse operations 134-135, 136-137 
paper size 164 
passwords 188, 203 
screen brightness 151 
speaker volume 139 
system startup 126 
window color 147-148 
window displays 144-145 

character keys 137, 245 
characters, non-English and special symbols 

254-255 
character sets 248-255. See also fonts; 

keyboards 

Chooser (Apple menu) 57-59, 161-165 
activating AppleTalk with 180 
connecting to shared disks with 184 
choosing printer with 161-165 
networks and 163-164 

choosing 
items from menus 244 
items from submenus 244 
printers 57-59, 161-165 

cleaning system components 225-227 
Clean Up command (Special menu) 12, 113 
Clear command (Edit menu) 55 
clearing memory 231 
Clear key 249, 251, 253 
clicking. See also choosing; mouse; opening; 

pointer; selecting 
clicking with mouse 9, 237-238 
clicking with numeric keypad 136 
double-clicking 50, 56, 238 

changing speed of 135 
with keypad 136 

Shift-clicking 54 
Clipboard 54 
clock 

battery, changing 227 
setting 129-130 

close box for windows 23, 33, 241 
Close command (File menu) 246 
CloseView 152-153 
Close Window command (File menu) 25, 33 

closing. See also quitting 
documents 47 
Trash 25, 37 
windows 23-25, 33, 241 

Color control panel 147, 148 
color documents, printing 167 
color, monitor, turning on 149 
colors, changing 

desktop pattern 142 
highlight 147-148 
icons 146 
in color wheel 128-129, 147-148 
in Labels control panel (Label menu) 

128-129 
windows 147-148 

Command kev 22, 248, 250, 252. See also 
keyboard shortcuts 

commands. See also menus or specific 
command 

choosing from menus 12 
dimmed 243 
help for 80-81 
shortcuts for. See keyboard shortcuts 

communication. See networks 
communications products, System 7 and 212 
Communications Toolbox 212 
components. See also peripheral devices or 

specific component 
connecting 213-220 
handling 223-225 

computers. See specific computer or topic 
computer viruses 97 
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configuring 
Macintosh for networks 179-182 
multiple monitors 150-151 

connecting 213-220 
ADB devices 218 
external floppy disk drive 218 
hard disks 213-216 
headphones 219 
LocalTalk cables 179 
microphone 219 
modem 217 
monitors 220 
printers 217 
safety tips for 223 
SCSI devices 213-216 
speakers 219 
to network 179-180 
to shared disks 184-185 
trackballs 218 

connectors, handling 223 
contrast control 151 
Control key 248, 250, 252 
Control Panels (Apple menu) 105 

Brightness control panel 151 
Color control panel 147, 148 
Date & Time 129 
File Sharing Monitor control panel 200 
General Controls 142 
Keyboard control panel 135-137 
Labels control panel 128-129 
Memory control panel 156-159 
Monitors control panel 149-151 
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Control Panels (continued) 
Mouse control panel 134-135 
Network control panel 180-181 
Numbers 138 
Sharing Setup control panel 182, 190, 210 
Sound control panel 139-141 
Startup Disk control panel 105-106 
Users & Groups control panel 190-191, 

193, 194-195, 196, 197, 198, 
202-203, 211 

Views control panel 144-14 5 
controlling pointer from keyboard 136-137 
converting 

documents to stationery pads 122 
DOS and ProDOS disks and files 258-260 

copying 
disk contents 108, 245 
documents 

to backup disk 61-62, 108, 247 
to or from shared disks 187 
with Duplicate command 66, 247 
with Save As command 68-69, 247 
with shortcut 247 

graphics 145 
icons 61-62, 239 

from one disk to another 61-62, 
238 
on same disk 239 
onto another disk 239 

restrictions on 263 
software licensing agreement 96, 192, 263 
sofcware onto hard disk 31-33, 38-39 

copyright laws 96, 192, 263 
correcting mistakes. See editing 
crealing 

aliases 72-74, 116 
documents 43 
folders 71, 114 
on shared disks 187, 189-191 
stationery templates 75-77, 122-123 

currency 138 
current sta11up dis~. See starcup disk 
cursor. See pointer 
customizing 125-159 

alert sounds 139-141 
Apple menu 126, 127 
blinking rates 143 
colors or grays 128-129, 148 
desktop pattern 142-143 
highlight colors 147-148 
icon appearance 145-146 
keyboard 135-137 
keyboard shortcuts 137 
Label menu 128-129 
menu items, blinking of 143 
mouse operations 134-135 
screen 151-153 
Svstem Folder 126-127 
s~1stem software 92, 94-95, 126-127 
system startup 126 
window display 144-145 

Cut command (Edit menu) 54. See also 
deleting; editing; erasing; Paste 
command 

cutting text 54 



D 
daisy chains 214-216, 218 
damaged disks 108 
darkened icons. See highlighted icons 
Data Access Language (DAL) 212 
date and time 129-134 
Date & Time control panel 129 
default network zones 181 
Delete kev 43. 51, 55, 249, 251, 253 
deleting. See also Clear command; Cuc 

command; editing; erasing; 
removing; Trash 

files from System Folder 127 
fonts from System Folder 127, 172 
items from Apple menu 127 
items from disks (Trash) 36-37 
System Folders, extra 39 
text 54-55 

deselecting icons 239 
designating startup disk 105-106 
desktop. See also files; Finder; folders or 

~pecijlc desktop element 
activating windows on 240 
arranging icons on 113 
changing how icons are displayed on 

(View menu) 124, 242 
changing icon names on 66-67 
changing window display on 144-145 
cleaning up 12, 113 
copying icons on 239 
creating folders on 71, 114 

desktop (continued) 
description of 5, 18-19 
disks and 245-246 
displaying window contents on (View 

menu) 124, 242 
dragging icons on 238 
failure to appear 233 
folders and 19, 70-72, 114, 240, 242 
hiding and showing windows on 98 
icons and 18, 237-240 
introduction to 7-25 
key commands and 22, 245 
menus and 19, 243-244 
moving icons on 239 
moving items to 118 
moving windows on 23-25, 241 
naming folders on 114 
naming icons on 66-67 
opening higher-level folder windows on 

242 
opening icons on 13, 239 
pattern, changing 142-143 
printing files from 167 
printing window contents from 168 
quick reference for 237-247 
rebuilding 232 
removing hard disk icon from 109 
removing icons from 36-37, 240 
renaming icons on 104, 239 
selecting icons on 237-238, 239 
shortcuts for 245 
software and 246-247 
Trash and 19, 36-37, 238, 240 
windows and 14-21, 23-25, 240-242 

developers, assistance for 262-263 
device drivers 

installing 126, 162-167, 214 
networking 127 
printer 162, 163, 165-167 
removing from System Folder 127 
scanner 126 

device numbers. See SCSI ID numbers 
devices. See peripheral devices or specific 

device 
diacritical marks, typing 254-255 
dialog boxes 115, 245. See also menus 
dimmed commands 243 
directory dialog boxes. See also menus 

purpose of 115 
shortcuts for 245 

disabling 
Alarm Clock 134 
alert sound 139 
CloseView 152 
Empty Trash warning 154 
file sharing 199 
Mouse Keys 136 
Slow Keys 137 
Sticky Keys 137 

disconnecting 
from shared disks 185 
network users 201 

discs. See CD-ROM discs 
disk cache, adjusting 156. See also memory 
disk drive port 218 
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disk drives. See also noppy disks drives; hard 
disks 

accessing with Drive button 102 
care and maintenance of 225 
connecting 218 

diskettes. See floppy disks 
Disk First Aid program 111 
disk icons 18, 233 

blinking question mark on disk 233 
X on disk 233 

disks 28-39, 101-112. See also CD-ROM 
discs; floppy disks; hard disks; 
icons; initializing; starcup disk 

backup disks 96 
care and maintenance of 110, 225 
copying 245 
damaged 97, 108 
directories of 115 
Disk 1bols 96, 102, 111, 112 
ejecting 34, 62, 109, 246 
exchanging with MS-DOS and Apple II 

computers 256-260 
5.25-inch (MS-DOS) 257 
handling 225 
initializing 101-104 
in MS-DOS or ProDOS format 256-257 
inserting into drive 28, 245 
introduction to 28-39 
locking/unlocking 35, 106-108, 246 
opening. See icons, opening 
Printing disk 165 
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disks (conlinued) 
privacy and 206 
protecting information on 106 
quick reference for 245-246 
reference for 101-112 
saving files on. See saving 
shared 18, 183-192 
startup disk, purpose of 5 
switching between 103 
testing and repairing 110-112 

Disk Tools disk 96, 98, 111, 112 
displaying 

folder contents 242 
fonts 174 
menus 243 
numbers and currency 138 

documents. See also files; icons; software 
programs; text 

adding to folders 71-72 
alias 72-74, 108, 116-117 
backing up 108, 247 
changing 50-52, 53, 54-56 
closing 47, 246 
copying with Duplicate command 66 
creating 43 
creating templates for 122-123 
empty 43 
erasing with Trash 36-37 
getting information about (Get Info) 

76-77, 123-124 
locked, searching for 121 
locking 107-108, 123 
naming 43-44, 65 

documents (continued) 
opening 

at startup 126 
by double-clicking 50, 238 
with Open command 13, 14, 17 

organizing 63-77, 113-124 
printing 59-60, 161-176 
purpose of 19 
saving 

aliases of 72-74 
as stationery pads 76, 122 
different versions of 68-69 
on different disk 61-62 
trouble with 108 
with Duplicate command 66 
with Save As command 68-69, 247 
with Save command 43-44, 53, 246 

searching for 118-121 
sharing over networks 187-201 
stationery pad 75-77, 122-123 
unlocking 121 
"untitled" 43 

DOS. See MS-DOS 
double-clicking 50, 56, 238. See qlso clicking; 

mouse 
changing speed of 135 
with numeric keypad 136 

double-sided floppy disks (SOOK). See also 
disks; floppy disks 

description of 28-29 
initializing 103-104 

downloading fonts 173-17 4. See also fonts 



dragging 
icons 10-11, 238 

from Trash 3 7 
on a single disk 238 
to another disk 108, 238 
to desktop 118 
to System Folder 126-127 
to 'frash 238 
with keypad 136-137 

over text 51 
size box 16 
window title bar 23-24 

Drive button, switching disks with 103 
drivers. See device drivers 
Duplicate command (File menu) 66, 247 
duplicating documents 64-66, 247. See also 

copying 

E 
Easy Install option (Installer) 93 
editing 

desktop pattern 142-143 
text 42, 50-52, 54-56 

Edit menu 
Clear command 55 
Cut command 54 
Paste command 55 

SOOK floppy disks. See double-sided floppy 
disks; floppy disks 

Eject Disk command (Special menu) 109 

ejecting disks 
shortcut for 109 
with Eject Disk command 109 
with Put Away command 34, 62, 109, 246 
with Trash 109 

electrical grounding 224 
electronic bulletin boards 97, 206. See also 

networks 
empty documents 43 
Empty Tmsh command (Special Menu) 37 

disabling 154 
Erase Disk command (Special menu) 105 
erasing 

floppy disks 

text 

during initialization 30-31, 101, 104 
with Erase Disk command 105 
with Trash 36-37, 240 

with Clear command 55 
with Clear key 249, 251, 253 
with Cut command 54 
with Delete key 55, 249, 251, 253 

error messages 231, 235. See also 
troubleshooting 

Escape key 249, 250, 252 
Ether1alk networks 179-180. See also 

networks 
exchanging disk and files with MS-DOS and 

Apple II computers 256-260 
expanding 

Macintosh system 213-222 
memory 222 

expansion cards 220-221 

expansion slots 220-221 
Extended Keyboard II 252-253 
external devices. See also peripheral devices 

or specijic device 
connecting 213-216 
turning off 6 
turningon 4 

external floppy disk drives. See also disk 
drives; floppy disk drives 

connecting 218 
ejecting disks from 109 

external hard disks. See also disks; hard disks 
connecting 213-216 
ensuring recognition of 106 
SCSI ID number for 110 
turning off 6 
turning on 4, 106 

eyestrain, avoiding 90 

F 
fatigue, avoiding 90 
File menu 

Close command 246 
Close Window command 25, 33 
Duplicate command 66, 247 
Find Again command 119-120 
Find command 118-121 
Get Info command 76, 100, 1-07, 117, 123 
Make Alias command 73, 116 
New Folder command 71, 114 
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File menu (continued) 
New User command 193 
Open command 13-14, 17, 33 
Page Setup command 164-165 
Print command 59-60 
Print Window command 168 
Put Away command 34, 37, 62, 109, 118, 

185 
Save Ai:, command 68-69, 122 
Save command 43-44, 53 
Sharing command 205 

files. See also directories; documents; folders; 
icons; software programs; system 
software; text 

accessing on other computers 183-187 
adding 

to folders 71-74 
to system software 94 

aliases for 72-74, 108, 116-117 
arranging on desktop 113 
backing up 61-62, 108, 247 
closing 47 
converting to and from MS-DOS or 

ProDOS 258-260 
copying 61-62, 66, 239 
creating 43 
damage from viruses 97 
directories of 115 
erasing with Trash 36-37, 240 
exchanging with MS-DOS and Apple II 

computers 256-260 
finding 118-121 
folders and. See folders 
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files (continued) 
getting information about (Get Info) 

76-77, 123-124 
graphics 230 
installing in Apple menu 117, 126 
locked 121 
locking 107-108, 123 
moving 

on desktop 239 
to desktop 118 

MS-DOS 256-260 
naming 43-44, 65, 66-67 
networks and 177-212 
opening 

at startup 126 
by double-clicking 50, 238 
with Open command 13, 14, 17 

organizing 63-77, 113-124 
Postscript 176 
printing 63, 161-176 
ProDOS 256-260 
protecting 106 
removing 

from disk 36-37, 240 
from System Folder 127 

renaming on desktop 66-67 
saving. See saving documents 
searching for 118-121 
sharing over networks 187-201 
storing in more than one folder 72-74 
unlocking 121 
"untitled" 43 
viewing on networks 204 

file servers. See also networks 
aliases and 116 
converting MS-DOS files on 260 
definition of 183 
system software and 93 
viruses and 97 

file sharing 183, 187-201. See also networks 
activating 189-190 
disabling 199-200 
software licensing agreement 96, 192, 263 
monitoring activity of 200 

File Sharing Monitor control panel 200 
filing system. See desktop; files; Finder; 

folders 
Find Again command (File menu) 119-120 

shortcut for 119 
Find command (File menu) 118-121 

shortcut for 118 
uses for 121 

Finder. See also desktop 
activating 45-46 
icon for 45, 98 
printing documents from 167 
printing window contents from 168 
purpose of 45-46 
shortcuts for 245 

Finder command (Application menu) 46 
finding files or folders 

with aliases 116-117 
with Find command 118-121 

5.25-inch disks (MS-DOS) 257 
fixed-size fonts 171-172 



floppy disk drives. See also disk drives; floppy 
disks 

care and maintenance of 225 
connecting 218 
ejecting disks from 34, 62, 109, 246 
external 109, 218 
inserting disk into 28, 245 
SuperDrive 28, 34 

floppy disk icon 18, 32 
floppy disks 101-112. See also disks; floppy 

disk drives; hard disks 
as stanup disks 92, 96 
capacities of 29 
care and maintenance of 36, 225 
compared with hard disks 32 
copying contents of 31-34, 108, 245 
damaged 108 
description of 29, 32 
double-sided (SOOK) 28-29 
ejecting 

shortcut for 109 
with Eject Disk command 109 
with Put Away command 34, 62, 
109,246 
with Trash 109 

erasing 
during initialization 30-31, 104 
with Erase Disk command 105 
with Trash 36-37, 240 

5.25-inch (DOS) 257 
full 108 
handling 225 
high-density (1.4 MB) 28-29, 35 

floppy diskc; (continued) 
initializing 30-31, 101-104 
in MS-DOS or ProDOS format 256-257 
insening into drive 28, 245 
labeling 28 
locking/unlocking 35, 106-108, 246 
naming 104 
older Macintosh computers and 29 
1.4 MB 28-29, 35 
quick reference for 245-246 
reference for 101-112 
removing from drive 246 
renaming on desktop 104 
saving files on. See saving 
testing and repairing 110-112 
types of 28-29 
untitled 104 

folders. See also files; icons; software; System 
Folder 

access privileges and 187-188, 205-206 
adding files to 71-74 
aliases and 72-74, 116 
Apple Menu Items folder 117, 126 
as bulletin boards 206 
creating 

on desktop 71, 114 
on shared disks 187-189 

directories of 115 
dragging icons to 240 
erasing with Trash 36-37 
finding with Find command 118-121 
higher-level, opening 242 
locking 108 

folders (continued) 
naming 71, 114 
nesting 114 
networks and 187-189, 205-206 
opening 13, 242 
organizing icons in 70-72 
outline views of 242 
owned 187-189, 198, 204 
privacy and 206 
purpose of 19, 114 
searching for 118-121 
shared 191-192 
Startup Items folder 126 
storing files in more than one 72-74 
"untitled" 71 
viewing contents of 242 
viewing on networks 204 

fonts 171-176 
adding to System Folder 172 
appearance of 229-230 
bitmapped 171-172, 229-230 
definition of 171 
displaying 174 
downloading 173-174 
installing 172 
outline 171-172, 173, 229-230 
PostScript 173 
printing 229-230 

list of 174 
samples of 174 

removing from System Folder 127, 172 
software programs and 17 4 
transferring to LaserWriter 173-177 
TrucType 171, 230 
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forms. See siacionery pads 
"frowning" Macincosh icon 233 
frozen system 231 , 235 
full disks ]Q8 
function keys 22, 252 

G 
General Controls (Apple Menu) 

changing blinking of insertion point with 
Jli!i 

changing desktop pattern with 142-143 
changing menu item blink rate with 143 
seuing rime and date with 129-134 

Gee Info command (File menu) 76, 100, 107, 
11 7, 123 

aliases and ] 17 
reference for 123-124 
shortcut for 123-124 

graphics 
copying 145-146 
pasting 146 

graphics files 230 
graphics programs lli5 
gray-scale printing 167 
gray shades, customizing 149 
grounded outlets 224 
Group icon 195 
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guest network users 

H 

access privileges for 190-191 , 204 
connecting to shared disks 184-185 
denying access ro 197-198 
linking to programs 211 
sharing owned folders with 187 

halftone printing 167 
handling system components 223-225 
"happy Macintosh" icon 5, 233 
hard disk drives. See hard disks 
hard disk icon 18, 32 
removing from desktop 109 
hard disks 101-112. See also disks; floppy 

disks 
as startup disks 92. 105-106 
NUXand 93 
compared wich floppy disks 32 
descripcion of 32 
external 32 

connecting 213-216 
Macintosh recognition of 106 
SCSI ID number for 110 
turning off 6 
turning on 4 

hard disk space as memory 157-158 
initializing 102-103, 175 
installing sofrware on 31-33, 38-39, 96 

hard disks (continuetO 
internal. built-in terminator for 216 
naming 103 
precautions for 110 
reference for 101-112 
SCSI ID numbers of 102-103 
sharing over networks 183, 191-192 
testing 110-112 
volume names of 103 

hardware developers, assistance for 262-263 
hardware, setting up 87-91 
HD SC Setup. See Apple HD SC Setup 

program 
headphones, connecting 219 
Help icon 80 
Help menu 243 

Hide Balloons command 81 
Shem· Balloons command 80, 165 

Help System 80-81, 243 
Hide 13alloons command (Help menu) 81 
Hide Others command (Application menu) 

99 
high-density disks (1.4 MB). See also floppy 

disks 
description of 28-29 
initializing 30-31, 103-104 
locking/unlocking 35 

highlight colors, changing 147-148 
highlighted icons 9, 13, 31 
highlighted text 51 



I, J 
I-beam pointer 50 
IBM-compatible disks and files. See MS-DOS 
icons 239-240. See also desktop; disks; files; 

folders 
ADB port 218 
adding to folders 71 
Alarm Clock 133 
alias 73 
Apple HD SC Setup 102, 112 
AppleSharc 184 
Application menu 42, 98 
arranging on desktop 113 
assigning colors to 146 
Brightness 151 
Calendar 129-134 
changing appearance of 145-146 
changing name of 66-67 
clicking 9, 237-238 
CloseView 152 
copying 61, 239 
deselecting 239 
device driver 214 
dimmed 98 
disk 18 
disk drive port 218 
double-clicking 50, 238 

icons (continued) 
dragging 10-11, 238 

from Trash 37 
on a single disk 238 
to another disk 108, 238 
to desktop 118 
to System Folder 126-127 
to Trash 238 
with keypad 136-137 

Finder 45, 98 
floppy disk 18, 32 
folders and 70-72, 192, 240 
getting information about (Get Info) 76, 

100, 107, 117, 123-124 
Group 195 
"happy Macintosh" 5, 233 
hard disk 1-5, 18, 32 
Help 80 
highlighted 9, 13, 31 
Keyboard 135 
labeling 146 
Labels 128 
Memory 156, 157-158 
modem port 217 
Monitors 149 
naming 66-67 
Network 180 
New Group 194 
opening 13,50,238,239 
organizing 70-72 

icons (continued) 
pointing to 8 
pressing 9 
printer 58, 162 
Printer port 217 
purpose of 18, 239 
question mark (?) disk 5, 92, 233 
quick reference for 239-240 
removing 240 
renaming 66-67, 104, 239 
"sad Macintosh" 233 
SCSI 213 
selecting 239 

by clicking mouse 9, 237-238 
by clicking with keypad 136 
more than one by Shift-clicking 238 

shared folders 192 
Sharing Setup 182, 190 
Sound 139 
sound input 140, 219 
sound output 219 
Stationery pad 122 
Trash 14-15, 19, 24, 36-37 
types of 18 
Views 144-145 
Xdisk 233 

ID numbers. See SCSI ID numbers 
images. See also icons 

inverted 153 
reduced 164 
snapshots of 230 
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ImageWrirer primers. See also primers; 
printing 

connecting 217 
Page Setup dialog box for 164 
Select light on 168 

initializing disks 101-10-1 
floppy disks 30-31, 101-104, 256-257 
ha rel disks 102- 103, 175 
MS-DOS or ProDOS disks 256-257 

l:.JITs 126 
inserting 

floppy disk into drive 28, 245 
text 51-52 

insertion point. See also poi mer 
changing blink rate of 144 
definition of 50 

Installer 92-95 
Customize option 9-t-95 
Easy Install option 95 
Minimal software option 95 
networks and 93 
updating printer drivers on networked 

compmers with 165-167 
installing 

alert sounds 140 
CloseVie\\· 152 
drivers 126, 162-167, 214 
expansion cards 220-221 
files in System Folder 125- 126 
fonts 172 
items in Apple menu 117, 126 
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installing (conti1111ed) 
printer d1ivers 

in System folder 163-164 
on networked computers l65-167 

software on hard disk 31-33, 38-39, 96 
system software 92-95 

customized system 9ti-95 
small system 95 
standard system 93 

interference, radio and 'IV xiii, 220. 224 
inrernal floppy disk drive. See floppy disk 

drives; SuperDrive 
inrernal hare! disks. See disks; hard disks 
inrernational keyboards 136 
inrerrupt and reset switches 231 
inverting images on screen 153 

K 
Keyboard conrrol panel 135-137 
keyboard files, removing from System Folder 

127 
Keyboard icon 135 
keyboards. See also keyboard shortcuts; keys 

adjust ing 
for slow typing 137 
position of 90, 91 

Apple Extended Keyboard II 252-253 
Apple Keyboard 250-251 
Apple Keyboard 11 248-249 
care and maintenance of 224 

keyboards (co11ti1111ed) 
character sets and 248-255 
customizing 135-136, 137 
description or 248-255 
imernarional use of 136 
layout, changing 136 
non-English charnners and 2'i4-255 
special characters and 254-255 
spills on 224 
trouble with 234 

keyboard shorrcuts 
CloscView and 153 
customizing with Sticky Keys 137 
ejecting floppy disks 109 
Find Again command (:ll:·G) 119 
Find command (:ll:·F) l 18 
f inder and directory dialog boxes 245 
Get Info command (:1€-I) 123 
Print (:1€-P) 167 
purpose of 53 
Quir command (:ll:·Q) 60 
Save (:ll:·S) 53, 2-i6 

Key Caps (Apple menu) 254-255 
keyboard commands 22 
keypad, numeric 

controlling pointer with 136-137 
descri ption of 249, 251 , 253 



keys. See also keyboards; keyboard shortcuts; 

L 

keypad 
arrow keys 22, 245, 249, 251, 253 
Caps Lock 248, 250, 252 
character keys 137, 245 
Clear 249. 251. 253 
Command 22, 2-18, 250, 252 
Control 248, 250, 252 
Delete 51, 55, 249, 251. 253 
Enter 249, 251.253 
Escape 249, 250, 252 
function keys 22, 252 
layout of, changing J36 
modifier keys 22. 137, 254-255 
numeric keys 249, 251 , 253 
Option 11 3, 248, 250, 252 
Power On 4, 249, 251 , 253 
repetition rate of 135-136 
Ret.urn 249, 251, 253 
Shih 22, 53,248, 250, 252 
"lab 245, 248, 250, 252 

labeling. See also naming 
floppy disks 28 
icons 146 

Label menu, changing items in 128-129 
Labels icon 128 

LaserWriter Font Utili ty 173-176 
downloading fonts with 173-174 
finding out about foms with 174 
ini tializing hard disks with 175 
restarting LaserWritcr with 176 
transferring PostScript files with 176 
turning sample page on or off with J 75 

l.aserWritcr primers. See also printers; 
printing 

background p1iming "·i1h 169-170 
connecting 21 7 
LascrWriter Fom Utility and 175- 176 
t.aserWritcr llNT 217 
Personal LaserWriter SC 58. 162, 217 
Prim dialog box for 167 
restart ing 176 
transferring foncs to J 73-174 
transferring PostScript files to 176 

linking programs over nerworks 208-21 1 
LocalTalk networks 179. See also networks 
locating files or folders 118-121 
locked files, searching for 121 
locking 

files 107-108, 123 
floppy disks 35, 107, 246 
folders 108 
mouse button with keypad 136 

M 
Macintosh. See also spec((ic model or topic 

adapting to your own use 125-159 
basic skills for 1-83 
care and maimenance of 223-227 
connecting componcms 10 . See 

connecting 
expanding 213-222 
naming for network use 182 
nel\\urks and 177-212 
obtaining additional information about 

261-263 
operating environment for 227 
reference for 81- 263 
restarting 231 
seuing up 87- lOO 
Starting 4-5 
"talking .. 10 l 2 
trouble with. See troubleshooting 
turning on and off 4-6 
viruses and 97 

Macintosh Classic 
moniwrs and 220 
turning on/off 4, 6 

Macintosh desktop. See desktop 
1\lacimosh l.C 

expansion slm in 22 1 
soundinputand 140 
turning on/off 4, 6 
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Macintosh II 
NuBus slots and 221 
turning on/off 6 

Macintosh Ilci 
expansion slot in 221 
monitors and 220 

Macintosh Ilfx 
cable terminator for 216 
monitors and 220 

Macintosh Hsi, slot adapter for 221 
Macintosh user groups 261 
magnifying screen images 152-153 
maintenance 223-227 

cleaning components 225-227 
floppy disks 36 
keyboard 224 
monitor 224 
spills, dealing with 224 

Make Alias command (File menu) 72, 116 
Make Changes access privilege 204 
managing memory 154-159 
manual paper feed 170 
memory 154-159 

checking use of 154-155 
clearing 231 
disk cache 156 
expanding 222 
hard disk space as 157-158 
managing 154-159 
memory cache expansion slots 220-221 
Memory control panel 156-159 
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memory (continued) 
memory expansion cards 220-221 
networks and 155 
RAM 154-159 
software programs and 99-100 
32-bit addressing 159 
video and 149 
virtual memory 157-158 

Memory icon 156, 157-158 
memos. See stationery documents 
menu bar, appearance of 5 
menus 18-19, 243-244 

changing blinking rate of items in 143 
choosing items from 12, 244 
dimmed icons in 98 
displaying 243 
opening 238 
pop-up 115, 243-244 
pull-down 243-244 
purpose of 18-19 
quick reference for 243-244 
submenus 244 
titles 243 
viewing options in (pressing) 9 
working with 243-244 

microphones 140-141, 219 
modem port 58, 162, 217 
modem port icon 217 
modems, connecting 217 
modifier keys 22, 137, 254-255. See also keys 

monitors. See also screen 
additional 150-151, 220 
care and maintenance of 224 
configuring multiple 150-151 
connecting 220 
icons for 149-150 
ID numbers for 150 
interference on 220 
large 220, 224 
position of 89 
trouble with 232-235 
turning on/off 4, 6 

Monitors control panel 149-151 
Monitors icon 149-150 
mouse 

button 
changing double-click speed of 135 
locking and releasing with 
keypad 136 

cleaning 226-227 
dicking (selecting) objects with 9, 

237-238 
controlling with keypad 136-137 
customizing operation of 134-135 
double-clicking (opening) objects with 50, 

56,238 
dragging objects with 10-11, 238 
holding 10 
pointing at objects with 8, 237 
pressing objects with 9, 238 



mouse (continued) 
quick reference for 237-238 
Shift-clicking (selecting) objects with 54, 

238 
techniques for 8-11, 237-238 
trouble moving pointer with 234 

Mouse control panel 134-135 
Mouse Keys, controlling pointer with 

136-137 
moving 

icons (dragging) 10-11, 238 
items to desktop 118 
text 54-55 
windows 23-24, 241 

MS-DOS 256-260 
converting files to and from 258-260 
initializing disks for 256-257 

multiple monitors, configuring 150-151 

N 
naming 

documents 43-44, 65 
floppy disks 104 
folders 71, 114 
groups of network users 194-195 
hard disks 103 
icons 239 
Macintosh and owner for network use 182 
registered network users 193 
users to link programs 211 

network administrator 179, 181, 183 
Network control panel (Apple menu) 

180-181 
network drivers, removing from System 

Folder 127 
Network icon 180 
networks 177-212 

accessing Macintosh while away from it 
202-203 

access privileges and 187-189, 204-211 
AppleTalk 58-59, 163, 179-180, 184 
capabilities of 177-178 
choosing printer for 163-165 
configuring Macintosh for 179-182 
connecting to 179-180 
copyright laws and 192 
disconnecting users on 201 
EtherTalk 179-180 
groups of users on 194-198 
guest users on 184-185, 187, 190-191, 

197-198,204,211 
Installer and 93 
installing printer drivers on 165-167 
LocalTalk 179 
memory and 155 
naming Macintosh and its owner 182 
passwords and 182, 185, 187, 188, 203 
printers and 58-59 
privacy and 192, 206 
registered groups on 189, 204-205 

networks (continued) 
registered users on 185, 187, 189, 192, 

193, 194,204-205 
restricting access to 197 
selecting network connection 180 
setting up Macintosh for 179-182 
shared disks and 18, 182-189 
sharing files and folders on 187-192 
software programs and 207-211 
TokenTalk 179, 180 
viruses and 97 
zones 58-59, 181 

default 181 
selecting 59, 163, 181, 184 

New Folder command (File menu) 71, 114 
New Group icon 194 
New User command (File menu) 193 
non-English characters 254-255 
NuBus expansion cards and slots 220-221 
Numbers control panel 138 
numeric keypad, controlling pointer with 

136-137 
numeric keys 249, 251, 253 

0 

office, arranging 89 
on/off switch 4, 6 
1.4 MB floppy disks. See floppy disks; high­

density disks 
Open command (File menu) 13-14, 17, 33 
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opening 
aliases 116 
documems 50, 70 
files 

at starlllp 126 
by double-clicking 50, 238 
with Open command 13, 14, 17. 70 

folders 13, 242 
icons 50, 238, 239 
menus 238 
software programs 42, 98, 2~6 
stationery pads 122- 123 
System Folder 17 
'Ii-ash 37 

open software programs. See active soft\\'are 
program 

operating environment for Macintosh 227 
operating systems. See also system software 

NUX 93, 102 
~IS-DOS 256-260 
ProDOS 256-260 
System 6 95, 171, 212 
System 7 95, 96. 154. 212 

Option key 113. 248. 250. 252 
organizing files 11 3-12-i 
organizing your work 63-77 
outline fonts J7J - 172, 173, 229-230 
outline views of folders 242 
owned folders 187- 189, 198. 204 

transferring ownership of 189, 198 
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p 

Page Setup (File menu) 164--165 
paper. See also printing 

feed, manual 170 
sizes, changing 164 
supply, moni1oring 170 

passwords. See also ne1works 
changing 188, 203 
selling 194 
typing 182, 187 
unaccepted 185 

Paste command (Edit menu) 55 
pasting 

graphics 146 
text 55 

paltern of desktop, changing 142-143 
peripheral devices. See also specific device 

connecting 213-221 
handling 223-225 

peripheral interface cable. See SCSI 
peripheral interface cable 

Personal LascrWriterSC 58, 162, 217 
phono jack adapters 140 
pictures. See graphics 
pointer 

arrow 8 
controlling from keyboard 136-137 
rnntrolling with mouse 8-1 l , 237 
I-beam 50 
trouble moving 234, 235 

pointing at objec1s with mouse 8, 237 
pop-up menus 115, 243-244. See also menus 
pons 

ADB pon 218 
definition of 213 
disk drive port 218 
modem port 58, 162, 21 7 
printer port 58, 162, 179, 217 
SCSI port 213, 215 
sound input port 141. 219 
sound output pcm 219 
video pore 220 

Postscript 173 
files, transferring to l.aser\Xfritcr 176 
foms 229-230 
primers 230 

power 
rcquircmen1s 

of ADB devices 218 
of Nu Bus expansion cards 221 

1rouble with 232 
wrning on/off 4-6 

Power On key 4, 249, 251, 253 
power supply 225 
power switch ~ . 6, 232 
preparing disks for use. See initializing 
pressing objects with mouse 9, 238 
Print command (File menu) 59-60, 167 

shortcut for 167 
printed circuit boards. See cards 



primer drivers. See also system software 
installing in System Folder 163-164 
installing on networked computers 

165-167 
printer fonts. See fonts 
printer port 58, 162, 179, 217 
Primer port icon 217 
printers. See also priming or specific printer 

choosing 57-59, 161- 165 
connecting 217 
drivers ror 162, 163, 165-167 
icons for 58, 162 
lmageWriter 162, 164, 167, 168, 21 7 
l.aserWriter 58, 162, 164, 167, 175-176, 

217 
networks and 58-59 
PosrScripr 230 
telling computer which ro use 57-59, 

161- 164 
trouble with 168 

Printer Update document (Pri11ti11g disk) 165 
printing 59-60, 161- 176. See also primers 

background 164, 169-170 
canceling 170 
color or gray-scale documents 167 
fonts 171- 176, 229-230 
from Finder 167 
learning about 59-60 
manual paper feed 170 
monitoring status of 170 
options for 164-165, 167, 168 

printing (co11ti11uecO 
reduced images 164 
reference for 161-176 
sample pages 175 
setting print time 170 
several documents 170 
while using computer ror Other work 164, 

169-170 
window contents 168 

Printi11g disk 165 
PrinrMonitor 164, 169-170 
Print Window command (File menu) 168 
problems. See troubleshooting 
processor-direct expansion slots 220-22 I 
ProDOS 256-260 

converting files to <1nd from 258-260 
ini tializing disks for 256- 157 

programs. See software programs 
pratecting disks. See locking 
pull-down menus 243- 244. See also menus 
Put Away command (File menu) 

Q 

disconnect ing from shared disks with 185 
ejecring disk with 3~. 62, 109 
moving items to deskmp with 1 l8 
restoring 'li'ash items with 37 

question mark (?) disk icon 5, 92, 233 
Quit command (File menu) 60. 247 
quieting sort ware programs 60, 247 

R 
radio interference xiii, 220, 224 
RAM (random-access memory). See also 

memory 
checking use of 154- 155 
expanding 222 
managing 154-159 

rearranging icons on desktop 113 
recording sounds 140-1 ~ l 
recovering items from 'li<1sh 37 
reduced images, printing 164 
registered network groups. See also networks 

access privileges for 204- 206 
giving folder mrnership to 189 

registered network users. See also networks 
access privileges for 20'1- 206 
connecting ro a shared disk 184-185, 187 
giving folder ownership 10 189 
naming 193-195, 196, 198 
removing membership of 197-198 

reinstalling system software 92-95 
releasing mouse butcon with keypad 136 
removing. See also deleting; erasing 

alert sounds 140 
disk from drive 34, 62, 109, 246 
files from System Folder 127 
fonts from System Folder 172 
icons from desktop 240 
items from Apple menu 117, 126, 127 
System Folders, extra 39 
users from a network 197-198 
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renaming icons 66-67, 104, 239 
repairing disks 110-112 
reset and interrupt switches 231 
resizing windows 16-17, 45, 241 
Restart command (Special menu) 231 
restarting 

LaserWriter 176 
Macintosh 231 

restricted network access 187, 197 
restrictions on copying sofcware 96, 192, 263 
Return key 249, 251, 253 
rules about copying software 96, 192, 263 

s 
"sad Macintosh" icon 233 
sample pages, printing 175 
Save As command (File menu) 68-69, 122, 

247 
compared with Save command 69 

Save command (File menu) 43-44, 53, 246 
compared with Save Ai:, command 69 
shortcut for 53, 246 

saving documents 
as aliases 72-74 
as stationery pads 76, 122 
different versions of 68-69 
on different disk 61-62 
trouble with 108 
with Duplicate command 66 
with Save As command 68-69, 247 
with Save command 43-44, 53, 246 
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scalable fonts 171-172 
scanners, drivers for 126 
screen. See also monitors 

brightness control 151, 224, 232 
burn in, avoiding 151, 224 
capturing "snapshot" of 230 
changing colors and gray shades on 

147-149 
cleaning 225 
contrast control 151 
damage to 151 
dark 232 
interference on 220, 224 
inverting images on 153 
magnified images on 152-153 
trouble with 232, 234-235 

screen saver programs 151, 224, 232 
scroll arrows 17, 20-21, 241 
scroll bars 17, 20-21, 241 
scroll box 21, 241 
SCSI cables 215 
SCSI chains 214-215 
SCSI devices 213-216 

built-in terminators for 216 
chains of 214-215 
connecting 213-216 
turning on 216 
types of 214 

SCSI hard disk, testing 112 
SCSI icon 213 
SCSI ID number indicator 215 

SCSI ID numbers 
hard disks 102-103, 110 
monitors 150 
setting 214-215 

SCSI ID number switch 215 
SCSI peripheral interface cable 215 
SCSI port 213, 215 
SCSI terminators 216 
searching for files and folders 118-121 
See Files access privilege 204 
See Folders access privilege 204 
selecting 

disks or folders to share 191-192 
icons 

by clicking mouse 9, 237, 238 
by clicking with keypad 136 
by Shift-clicking 238 

multiple items 54, 238 
programs for linking 210 
text 

by double-clicking 56 
by dragging and highlighting 51-52, 
54-56 
by Shift-clicking 54 

Select light (ImageWriter printer) 168 
setting 

Alarm Clock 133-134 
alert souncb 139-141 
date and time 129-134 
network access privileges 204-207 
network passwords 188, 194, 203 
numbers and currency 138 
print time 170 
SCSI ID numbers 214-215 



setting up 87-100 
for networks 179-182 
hardware 87-91 
system software 92-96 

shared disks 18, 183-192. See also networks 
access privileges and 187, 204-207 
connecting to 184-187 

at startup 186-187 
with aliases 186 

copying files to or from 187 
copyrights 96, 192, 263 
creating folders on 187-189 
disconnecting from 185 
limited access to 183 
privacy and 192, 206 

sharing files and folders on 187-189 
shared files 189-203. See also networks 
shared folders 191-192. See also networks 
Sharing command (File menu) 205 
Sharing Setup control panel 182, 190, 210 
Sharing Setup icon 182, 190 
sharing software 96, 192, 263 
Shift-clicking 

to select multiple items 238 
to select text 54 

Shift key 22, 53, 248, 250, 252 
Show All command (Application menu) 99 
Show Balloons command (Help menu) 

80, 165 
Shut Down command (Special menu) 

disconnecting from shared disks with 185 
shutting down Macintosh with 6 

silent alerts 139 
SIMMs (Single In-Line Memory modules) 222 
size box for windows 16-17, 45, 241 
slots. See expansion slots 
Slow Keys 137 
Small Computer System Interface. See SCSI 
small system software, installing 95 
smiling Macintosh icon 5, 233 
software developers, assistance for 262-263 
software programs. See also documents; files; 

menus; system software 
activating 42, 98, 246 
active 45-47, 50, 70, 98, 246 
aliases for 116 
backing up 96 
copying restrictions 96, 192, 263 
documents and. See documents 
folders and 114 
fonts and 174 
graphics programs 145 
installing 

in Apple menu 117, 126 
on hard disk 31-33, 38-39, 96 

licensing agreement 96, 192, 263 
locking 107-108 
memory usage, changing 99-100 
networks and 207-211 
opening 42, 98, 246 
purpose of 19 
quick reference for 246-247 
quitting 60, 247 
saving documents in. See documents, 

saving 

software programs (continued) 
screen saver 151, 224, 232 
setting up 27, 39 
switching 45-47, 98, 246 
trouble with 235-236 
types of 46 
upgrading 96 
virus-detection/elimination 97 
working with several at once 98 

Sound control panel 139-141 
Sound icon 139 
sound input devices 140-141 
soundinputport 141,219 
sound output port 219 
sounds 

customizing 139-141 
recording 140-141 
removing from System Folder 127 

speakers, connecting 219 
speaker volume, changing 139 
Special menu 

Clean Up command 12, 113 
Eject Disk command 109 
Empty Trash command 37, 154 
Erase Disk command 105 
Restart command 231 
Shut Down command 6, 185 

special symbols 254-255 
spills, dealing with 224 
starting up Macintosh 4-5 
startup. See startup disk; system startup 
Startup Disk control panel 105 
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startup disk. See also disks; System Folder; 
system software; system startup 

bypassing internal hard disk as 106 
floppy disks as 96 
hard disks as 105-106 
purpose of 5, 32 
rebuilding desktop of 232 
removing extra System Folder from 39 
search sequence for 106 
setting up 92-96 
System Folder and 39 
virtual memory and 157 
viruses and 97 

Startup Items folder 126 
stationery pads 75-77, 122-123 

creating 75-77 
icon for 122 
opening 122-123 
saving 76, 122 

Sticky Keys 137 
straightening up files 113 
submenus 244 
SupcrDrive 28, 34. See also disks; floppy disk 

drives 
switches. See on/off switch; reset and 

interrupt switches; SCSI ID switch 
System 6 95, 171, 212 
System 7 95, 96, 154, 212 
system cable. See SCSI system cable 
system extensions 126 
System file, installing alert sounds in 140 

302 Index 

System Folder. See also startup disk; system 
software 

adding alert sounds to 140 
adding fonts to 172 
Apple Menu Items folder 117 
customizing 126-127 
danger of using more than one 95 
dragging items to 126-127 
fonts and 170-176 
installing device drivers in 162-163, 214 
installing files in 126-127 
installing printer drivers in 162-163 
on software program disks 96 
opening 17 
purpose of 32, 92 
removing extra 39 
removing files from 127 
removing fonts from 127, 172 
setting up 92-96 
Startup Items folder 126 

system software. See also software; startup 
disk; System Folder 

customizing 126-127 
fonts and 171-176 
installing, reinstalling, updating 92-96 

customized system 94-95 
small system 95 
standard system 93 

networks and 93 
purpose of 46 
trouble with 233 
virtual memory and 156 

system startup. See also startup disks 
connecting to shared disks during 

T 

186-187 
customizing files for 126 
floppy disks and 96 
trouble with 233 

Tab key 245, 248, 250, 252 
"talking" to Macintosh 12 
technical information, obtaining 262-263 
television interference xiii, 220, 224 
templates (stationery pads) 75-77, 122-123 
terminators. See cable terminators 
testing and repairing disks 110-112 
text. See also documents 

accent marks and special characters 
254-255 

curring 54 
dragging over 51 
editing 42, 50-52, 54-56 
erasing 

with Clear command 55 
with Clear key 249, 251, 253 
with Cut command 54 
with Delete key 55, 249, 251, 253 

highlighted 51 
I-beam pointer and 50 
inserting 51-52 
moving 54-55 
pasting 55 



text (continued) 
selecting 51-52, 54-56 

by double-clicking 56 
by dragging and highlighting 51-52, 
54-56 
by Shift-clicking 54 

typing 43 
32-bit addressing 159. See also memory 
3. 5-inch disks. See floppy disks 
time 

setting Alarm Clock 133-134 
setting system clock 129-132 

tips and troubleshooting 229-236 
title bar for windows 23-24 
TokenTalk networks 179, 180. See also 

networks 
tracking speed (mouse), changing 135 
transferring 

fonts to LaserWriter 173-177 
PostSctipt files to LaserWriter 176 

translating MS-DOS and ProDOS files 
258-260 

Trash 36-37 
activating 14-15 
closing 25, 37 
deleting items with 36-37, 240 
disconnecting from shared disks with 185 
dragging icons to 238 
ejecting floppy disks with 109 
emptying 37; warning, 154 
opening 37 
purpose of 19 
recovering items from 37 

troubleshooting 229-236 
aliases 116 
Apple menu items 117 
dark screen 232 
desktop fails to appear 233 
disks 110-112 
error messages, responding to 231 
expansion cards 220-221 
frozen system 231 
monitors 232 
network passwords 185 
pointer does not move 234, 235 
printing 168-169 
saving files on floppy disk 108 
software program quits unexpectedly 236 
system software 233 
system sta11up 233 
typing produces nothing on screen 234 

TrueType font'; 171, 230. See also fonts 
turning Alarm Clock on/off 133-134 
turning AppleTalk on 180 
turning CloseView on/off 152 
turning external devices on/off 4, 6 
turning external hard disks on 106 
turning file sharing off 199-200 
turning file sharing on 189-190 
turning Macintosh on/off 4-6 
turning monitor on/off 4, 6 
turning SCSI devices on 216 
turning Slow Keys on/off 137 
turning Sticky Keys on/off 137 

turning 32-bit addressing on 159 
turning virtual memory on 157 
'IV interference xiii, 220, 224 
two-sided disks. See double-sided floppy tli:-;ks 
typefaces. See fonts 
typing. See also keyboards; keys; text 

non-English characters and special 

u 

symbols 254-255 
practice for 43 
slow, adjusting keyboard for 137 
trouble with 234 

unlocking 
files 121 
floppy disks 35, 106-108, 246 

untitled 
<lisks 104 
folders 71 
windows 42, 43 

updating system software 92, 95 
user groups for Macintosh 261. See also 

registered network user groups 
Users & Groups control panel (Apple menu) 

accessing your remote computer with 
202-203 

linked programs and 211 
naming users with 193, 194-195 
restricting access with 197 
setting passwords with 194 
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v 
variable-size fonts 171-172 
video, built-in 149 
video ca rds 149, 220-221 
View menu 124, 144-145, 242 
Views control panel 144-145 
Views icon 144 
virtual memory 157- 158. See also memory 
viruses 97 
volume, changing 139 
volume names of hard disks 103 
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w 
windows 

activat ing 14-15, 45-47, 240 
border color, changing 148 
closing 23-25, 33, 241 
color, changing 148, 149 
customizing display of 144-145 
displaying contents of (View menu) 124 
hiding and showing 99 
highlight color, changing 148 
moving 23-24, 241 
plinting contents of 168 
purpose of 18-19 
quick reference for 240-242 
scroll bars 241 
scrolling 17, 20-21, 241 
size,changing 16-17,45,24 1 
title bar 23- 24, 241 
untitled 42, 43 
viewing contents of 14-21 
viewing in outline form 242 
zoom box and 16-17, 241 

work groups, viruses and 97 
work space. See deskcop 

X,Y 
X disk icon 233 

z 
zones, Apple'falk 58-59 
zoom box 16-17, 24 1. See also windows 



The Apple Publishing System 
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